Eureka Master Table of Contents

Eureka Master Table of Contents

PAGE
CHAPTER ONE
L1 PP 3
Learning TO USE BUMEKA ........cceuruiiiiiiiiis e rrss s re s s s rn s s e n s s s e s rn s s e e nnnnas 5
Changing Your EUreka PasSWOId..........oiiviiruniiiiiiinsisiiris e s srs e s sss s s sr s s s sennnnssssanes 7
SELING Pref@r@NCES ..uuuiiiie i i i e e e ce ettt e e e e e e e e e e e e e s s s e s e e aeeeeeeeeeeeeernrnnnn s 9
CHAPTER TWO
Getting Oriented With The QuickQuery WINAOW .........coccuuiiiiiiiiiiiin e rrr e 11
Opening A New QUICKQUENY REPOIM.......ciiiiiiiiiiiiiiri s e e s s eran e 12
Building A QuickQuery With The Query Wizard ............coiiiiiiiiiinnniirr e e e 15
IST= 1Y/ o (01U O 1T TP 22
Printing YOUF QUETY ....ccvuiiiiiiiiri i eerer e r s e r e s rra s s s s s e as e s s s en s s e s e e e an s s s e e nnnnas 23
Activity: QuickQuery With The Query Wizard .............cccccooiiiiiiiiniir v, 25
Skill Builder: QuickQuery With The Query Wizard................ccccceeiiiiiiriiiinnciennn, 26
Practical Exercise: QuickQuery With The Query Wizard...............ccccceeiiiiiiinininnnnns 28
Building A QuickQuery Without The Query Wizard.........ccoooiiiiiiiiiiiiirrrii e e 30
Changing The Name Of A Column HEadiNg.......ccoeveieiiieiiiiiieeeiiees e 32
Changing The FONS......cccuuuiiiirii e e e s r e s 35
14T Y7 0o 0] [0 o 1T 1P 36
Deleting COIUMNS ....ccviriiiiiceii e s e e s s e s s s s r e s s s s enrna s eaeenns 37
Freezing/Unfreezing Column HEAINGS ........cceererrrrmrmmiiiies e e eeeeeeeeeeeennssss s e e e e e eeeeeeeeees 38
Adding CUSEOM COIUMNS ...uuuiiiiiiii e iiri s s e s e e s s e e e e e s s e rn s 39
o]0 Y7 o T 1= TP 40
NS0 o o] [ 4] P 42
Grouping/UNngrouping COIUMNS ....ccuuuuiiiiiiiiiierirss s rrar s s rs s s r e s e r s e ernn s 43
Activity: QuickQuery Without The Query Wizard................ccccceeiiviiriiinineeenne, 44
Skill Builder: QuickQuery Without The Query Wizard..............cccccooovvviiniinnnnens 46
Practical Exercise: QuickQuery Without The Query Wizard ................c.....c... 47
Building A Summary QUICKQUETY .....ccccuruuiiiiiiiis i irris s rss s s res s s s resa s s ren s s s ennnnns 49
Building A Quick Filter In QUICKQUETY ...vuuiieruie i is s e e er s e s e e s e r s e s e en s e era e e ennas 51
Building Translate Values UsSing QUICKQUETY .......cccuuuuiiiiniiiiinin e srrs s s ssss s ssren s e ennnans 54
EXPOrtiNg YOUr QUETY ..cvvvuiiiiiiiiiisieeiirss e e s ess s s s ress s s s s s ras s s s s s e na s s s e ran s e s e e nnn s s s e ennnnas 56
[ =T T I 01U T U= o TP 58
T L= o TP 59
CHAPTER THREE
| aLugoTe 8 oiuTo] o TN Ko T == o] o o TP 63
Getting Oriented With FrE@EFOIM ....ccvvuei it e s s e 65
Building A FreeForm With The Query Wizard ..........ooouvuiiiiiiiiiiniiri e e e 71
Designing A Customized FreeForm Report Without The Query Wizard ........cccovveviiviiiiiinnnnee, 77
Page Header/FOOLEr ArEAS .......uiiiiiiiiiiiiis i essrr s s s s s e s s s s e e s s s s s nasa s e s eenns 81
Selecting Multiple ODJECES ...ccuuuiiiiieii e s 82
Adding Document File Name ObJECES .....cccuuiiiiiiiiiiiiiri e e e 84
Changing Column HEadiNgS........cuuuiiiiiiiiiiiiiiiir s s r e r s 87
L1 =Ta o [ 1o To T ] | PP 89
Document Header/FOOLEr ArEaS.....uiiiuiiiiiiiiiiiiiii it st st s e e s e ra s e s e e e e s ranees 91
e o 11T IR I @ o) =T o PP 92
Adding Date ODJECES.....cuuuuiiiiiiiii i e s e 94



Eureka Master Table of Contents

PAGE
CHAPTER THREE (CONT'D)
Adding Time ODJECES. ... e e e e e e e e e e e e e e e e e e e e e e eees 96
Adding Page NUMbEr ObJECES ...coeeureeiiie e e 98
Adding Counter ODJECES .....oeiiieieieie e e e e e e e e e e e e e 100
Activity: Designing A Customized FreeForm Report Without The Query
WIZAKd ... e rraan 102
Skill Builder: Designing A Customized FreeForm Report Without The Query
WIZAKd ... e 104
Practical Exercise: Designing A Customized FreeForm Report Without The
QUEKY WIZArd ... e e e e e e r e e 106
Building A Sort Order In A Freeform RePOIt........ooiiiiiiiieiiiaiee e e e eeeecereee s e e e e e e e e eeneees 108
GroUP HEader/FOOTEr AraS...... i iiiiriiiiieeirriie s e e s eerss s e s s s rrras e s e s errae s e s s e rr e e e s ser s eseeennnnnseneenns 111
Building A Page Break In A Freeform REPOIT........cooiiiiiiiiiieiei e eeecceeene e e ee e eeneees 114
Inserting A Filter In A Freeform REPOIT ...coovveieeeeieie e e s 116
Hiding An Object In A FreeForm REPOIT ......cooiiiiiiieieiiiee e e e e e e e e e e e e ennnnes 120
Inserting A Prompt In A FreeForm RePOIt ....... e 122
Designing A FreeForm Report Using Double Detail Areas.........cccooviieririiieemmmiiieieeee e eeeeeeeees 128
Using Translate Values In A FreeFOrm REPOIT.......cooiiiiii e e e e e e e e e e e e e ennnees 132
Using Output When In A FreeFOrm REPOIT .....ovviiiiiiiiiiiccirris s serns s er s r s s ern s 135
Skill Builder: Introduction To FreeForm And Designing A Customized FreeForm
2= Lo ] o N 137
Practical Exercise: Introduction to FreeForm And Designing A Customized
FreeFOorm REPOIt....... .o e e e 139
CHAPTER FOUR
Building A FreeForm Query Using The Parent/Child FUNCHION...........ccormimmimiiiiiiie e 141
Child DOCUMENE OBDJECES ... .o i et e e e e e e e e e e e e e e e nn s 141
Child DOCUMENE...cettuiiiii i e s e s e e e s e s e e e s e e s rr s e e s e e e r s e e e e ernnaeees 144
(@ 11 {o I o 1T 2 4] o £ SRR PP 145
(@ o ]1Fo I T T PR PPPTP PP 146
Inserting the Child DOCUMENL .......cooiiiii e e e e e e e e e e e eneenes 148
Activity: Designing A Parent/Child FreeForm Report................cccccceeiiiiinnnnenn. 151
Skill Builder: Building A Parent/Child FreeForm Report.................ccoeeiiieeennns 158
Practical Exercise: Designing A Parent/Child FreeForm Report ..................... 160
(01311 (ol D= = @ o) <ot 1P PPTPPUPTTN 163
[ (o1 o @)1= £ PP 169
Creating a Child for HOt ObJECES ...coeieieeiiieieie e s 170
Creating a Prompt for @ Hot Object Child.........ccoooi i 171
Adding a Filter to the Hot Object Child ........coeeeeiiiiiiie e 171
Creating the HOt ObJECt ......coe e e e s 172
CHAPTER FIVE
Introduction To ENhanced EUFEKa ........covuuueeummiiieeee e 175
L1 - T 176
L1 0131 = | o1 181
C] 1= o 01 ol 185
Creating IcoNS FOr YOUI DESKEOP ..vvuuiiiiiiiiiiiiiii et s et ee s et e s e s s e s e s s e e e e e e e e aanas 188
Creating LabEIS ....cuueiiiii e 190



Eureka Master Table of Contents

PAGE
CHAPTER SIX
Creating A Personal Data Mart........cooo i e e e e s 193
Using A Personal Data Mart.........coooiiiiiiiiiiiiiie e e e e e s e er e e e e e e e e e e e e e e e e e e s s s 196
REFERENCES
Toolbars, Status Bars ANd Operators........eeiiiieeriiiiieeriris s s errris s s s e s s srrs e s s s rrrnn e s s ersnans 199
7T o LU = LN 202
Changing Your Eureka PasSWOIQ. .........coeeuuururuuiaaae e eeeeeeeeeeeeeeees s e e e e e e e e ee e e e eeeennnnn s 206
Installation Of The Eureka RepOrter VIEWET .......cccvvuiieiiiiiiiiis s eersiss s serss s s se s s s eenn e e e ees 208
L@ = o o Yo =PSRRI 213
SEYIE PrOfilES cuu it e e 216
What If SEatEMENTS .....iiiciiiic e e s e e enn 219
Structured Query Language (SQL) .euvuiiiiierrieiieeiriiissessersis s s s s ssssss s s s serrn s s s sersn e s s s ennnnseseenns 222



Eureka Master Table of Contents




Eureka

Eureka

OVERVIEW

Eureka is an independent software package used in conjunction with DPAS to enable users the
capabilities to view pre-existing reports, perform ad hoc queries, analyze data, and create simple to
sophisticated reports from within a Microsoft Office Desktop environment.

Documents may begin as a simple QuickQuery and evolve into sophisticated FreeForm presentations.
Eureka offers two ways to create documents:

QuickQuery - provides you a set of interactive tools that let you view data as you build your
query in a spreadsheet-like environment. It provides the fastest way to build design
documents whose content is limited to column values and custom calculations. You can add
page headers and footers. You can group data and include totals for each group. QuickQuery
also lets you define and store multiple query filters and apply them individually or in
combination with each other.

FreeForm - allows you the ability to lay out your document without the constraints of
QuickQuery. You can add page headers and footers, document headers and footers and
group headers, and other types of document areas. Using the FreeForm function, you will
develop a customized report, with the capability to make that report as simple or complex as
necessary. FreeForm allows you the freedom to design all aspects of the report.

Both QuickQuery and FreeForm offer a step-by-step Wizard in designing reports.

Design documents can be quick and simple, composed of just a few unformatted database columns
arranged in rows. They can be complex, highly formatted documents that include charts and
crosstabs as well as other documents. When you create output documents, Eureka creates and
submits database queries. A document may include one query or several.

Eureka Reporter Designer comes packaged for DPAS in these editions:

Reporter Designer - gives you both interactive QuickQuery tools and powerful FreeForm
tools to create queries, reports, charts, and crosstabs.

Reporter Viewer - lets you submit queries for already defined documents and view, print,
export, and save the results. The Reporter Viewer is designed for users that do not have
Eureka installed.
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OBJECTIVES

This course is designed for you to develop progressively greater competencies in the use of the Eureka
Reporter Designer.

Upon completing this course, you should be proficient in the use of Eureka to retrieve from DPAS, the
information necessary to accomplish your assigned duties.

CH1 386
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Learning To Use Eureka

The process of creating a document using Eureka is as simple as defining the objects you want to
appear on your document and placing them on the document. Eureka also includes many advanced

query design features.

Terminology

Eureka has its own set of data base terminology, such as areas, area objects, hot objects, iqo, iqr,
etc. These will be explained during the course of this training.

Mouse Terminology

This is the terminology used for mouse actions:

Click Move the mouse pointer to an object. Then press and release the left mouse button (without
moving the mouse).
In Eureka, clicking an object selects it or deselects it. When an object is selected, menu items
and keyboard actions affect that object (unless they are global actions).

Double-click Move the mouse pointer to an object. Then press and release the left mouse button twice in
rapid succession, without moving the mouse pointer.
In Eureka, double-clicking opens a dialog box that lets you define or change the object you
have double-clicked.

Drag Move the mouse pointer to an object, press and hold the left mouse button. Then move the
mouse and release the mouse button at a new location. The object moves to the new location.
In Eureka, you can drag objects to move them, to add them to your document, and use them
in many dialog boxes

Right-click Move the mouse pointer to an object. Then press and release the right mouse button without
moving the mouse.
In Eureka, a right-click opens a shortcut menu. This is a menu of actions associated with the
object on which you right-click.

CTRL+click Hold down the CTRL key while you press and release the left mouse button.
In Eureka, this selects an object for further manipulation without deselecting any already
selected objects.

SHIFT+click Hold down the SHIFT while you press and release the left mouse button. Whenever you are
selecting items from a list that allows more than one item to be selected, you can use
SHIFT+click to select a range of items. Click the first item and then SHIFT+click the last
item. Eureka selects the two items you click and all items in between them in the list.
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On-Line Help

The help system in Eureka includes a list of frequently asked questions.

To view the description and help information for a specific object in an object directory, move
the mouse pointer to the object and then press and hold down the right mouse button.

To get help in a dialog box, press the F1 Function Key or select the Help button.

To get help in a Eureka window, press the F1 Function Key or select Help from the menu
bar.

To view the frequently asked questions list, open the help system and select Frequently
Asked Questions from the contents page.

When you are using the help system, these shortcuts are available:

There is a Chapter menu included as part of the help system menu bar. Use it to go directly to
another chapter.

Use CTRL+PAGE UP and CTRL+PAGE DOWN to go through a chapter page by page. You
can use the browse buttons on the toolbar (< and >) to do this.

Use the icons above each topic title to help you find topics and navigate the help system. See
the help topic Hints for Using Help for information about using these icons.

Using the Context Help Button

&2 To get help on anything that is displayed in the Eureka window, select the Context Help button from

the toolbar. When you do so, your pointer changes to look like the Context Help button. You can
then click any part of the Eureka window, including a menu selection, toolbar button, an so on, to get
help on that item.

Object Help

To see a description of a business view, folder, or column shown in the object directory, place the
mouse pointer on the object. Eureka displays a help message for the object.

CH1
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Changing Your Eureka Password

INTRODUCTION

This process will show you the procedures used to change your password in Eureka Anytime you
change your login or password for DPAS, you must also change them to the same for Eureka. When
you change your password in DPAS, you will get a pop-up message to change your password in
Eureka.

OBJECTIVES

To allow the user to understand when and how to change the Eureka password.
APPLICATION

You have just changed your DPAS password and now you need to change it in Eureka.

PREREQUISITES

Eureka Reporter Designer is correctly loaded and configured.

ACTIVITY
Instructor-led demonstration
STEPS TO PERFORM ACTION

1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

ct Query Type [ x| STEP 1:

e If you get the wizard, click Finish;
otherwise, go to the next step.

what type of query would you like?

(Customers by M’:rﬂ';‘:
Region (O

Begion  Omt®  company  phened ' Summary

AfRricds EPOD0Z Sharts Jdak (A0 34~ r G[Uuped D Btail
Aprricds SPOOWD Shaortlg THeGhoe (60869132

Americes 300001 Saccer Mank {34 T " Overall Summary
Apwrkds AEMIL  Fhet Feat [ TS| 444190

Africas  SETO0Z S0 T Yau Deap Ltd (303(677-192 € Create TM1 Cube
Aprricds SPO00L Sharts Wdrddause (202|224-123

AHRricds SO0 Sharts Carducah [ 24| Fre-T3z

Apwrkds 20Ul Sautumesters Sparts  (208] E3F-ET . .
Buane  SPOOTD Snortd SCelr AR LPADEELD Thiz type of query allaws you ta list
Burape  EAVOOL Brvar SpoctsGmoe 304 352 detail infarmation frorm pour databaze.
Burape  SPO003 Sportscenelinfed 43455524 For example, all orders.

Eurape. SPOO3 Sportsd Lebure Pk LSLATL AT34
Eurane SPOORS Sporhereh DU Gm  39L 34102
Eurane FOO0OL Faatleg 4 LT E

Fike Mamee. 117_gat e Paga: L

[ Do not show this wizard in the: future.

< Black I Mest » I Finigh Cancel Help
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STEP 2: [Tools

Preferences...
a. From the menu bar, select Tools.

b. Select Database Connection Defaults...

Database Conneckion Defaulks, .
HTML Defaults, ..
Cache Defaults, ..

[MiSCamnes

Object Skyles Editor. ..
Gt Stk Buider,.
QDEC Diata Source Administrator ..

[Metadata anager:..
e MiEWEr .
Publisher. ..

Lonnection | FPreferences I HTML Defaullsl Lache I

STEP 3:
~ Default D atabaze Connection

Data Sovce: | = a. Data Source: Make sure that your DPAS Site

ID is displayed.
b. Login ID: Make sure that your DPAS User ID
is displayed.
Password: Enter your NEW DPAS password.
Server Name: Leave this field blank.
Database Name: Leave this field blank.

= Prompt For Data Source at Runtime: Do

Personal Data Matt: | Ll not check this box. If checked, you will be
[ Dovnioad Metadata File from Report Server prompted to enter your DPAS Site ID each time
servr Neme: =] FefeshSorves| you run a report.

Hast Name: | IREEEN g. Default Metadata File: Browse for where
the DPAS programs reside on you workstation.
If all the defaults were taken during

EE | = installation, then the path is normally:
C:\Program Files\DOD\DPAS\DPAS.iqk.

Lagin ID: |

Pazzword: I

Server Mame: I

[ratabasze Mame: I

™ Prompt For Data Source at Runtime

o ao

Default Metadata File: I

If you are unable to locate the DPAS.igk file, click on the START button, select Eind (or Search if using
Windows ME or 2000), Eiles or Folders..., enter dpas.igk look in the Local Hard Drives.

h. Server Name: Leave this field blank.
i. Host Name: Leave this field blank.
j.  Click OK.
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Setting Preferences

INTRODUCTION

Eureka gives you control over your working environment in the following areas:

e Which tools are displayed for use in report design windows
e The appearance of windows and objects in them
e General preferences and database connection preferences

PREREQUISITES
None
STEPS TO PERFORM ACTION

1. Open or create a FreeForm report.
2. Select Tools from the menu bar.
3. Select Preferences... from the program group.

Preferences...

Database Connmection Defaults. ..
HTML Defaults. ..

Cache Defaults...

[SCOnNIEE:

Ohbjeck Styles Editar. ..
At ShtEeutBuilder
ODEC Data Source Administrator ...

[Metadata Manader., .

(Eite Yiewer. .
Publisher ..,

Preferences |Eiles I Qonnectionl HTML Defaultsl Qachel

— Drefault

V' Use Query Wizard
™ Use TM1 Cube Wizard On New
[ Manual Re-query

[V Prirtt Charts Using Pattems
v Diefault To QuickBuen View
[™ Discormect Betwesn Dusries

— Display

Object Placement

Fiepart Fows Limit: ID E
Prampt Fow Limit: |1 i} E
Browse Fow Limit: |1 oo E

Dizplay Mull D ata Az I v Auto Headings
Display Scale: |1 kil E |+ Predefine Objects
— Query

[ [
v Use Aliases
[~ Trace ODEC Calls

Time Limit:

Trace File: I
()8 I Cancel

CH1
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STEP 1:
a. Defaults Group Box: Make any necessary
changes.
NOTE:

Q\Q  Preferences in the Eureka dialog box
\,///// are global - they apply to all documents
by default unless otherwise specified.
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b. Display Group Box: If desired, make any changes to the display.

Defaults Display

Use This controls whether the New Document tool- | Display Null By default, Eureka displays null values as
Query bar button starts the Query Wizard or whether | Data As blanks or spaces. If you want null values
Wizard it opens an empty new window for you to add to be output differently, such as NULL or
columns and objects directly. It also controls N/A, enter the string you want Eureka to
the default for Use Query Wizard in the New output.
Document dialog box.
Use TM1 This controls whether the New Document tool- | Display Scale This controls the scaling of objects in
Cube bar button starts the TM1 Cube Wizard or FreeForm windows and output windows.
Wizard whether it opens an empty new window for Eureka always attempts to display objects
On New you to add columns and objects directly. It at actual size. To compensate for some
also controls the default for Create TM1 Cube video drivers for your monitor, you might
in the New Document dialog box. This option need to adjust the scale up or down.
is not available in DPAS. Values less than 131 reduce the size of
objects displayed while values greater
than 131 increase the scale. Values
smaller than zero or extremely large will
probably cause problems. The value of
131 is the default.
Manual This should be used if you do not want Eureka
Re-query to re-query your database automatically every
time you add another column while working in
QuickQuery window.
Restore This controls what Eureka does when it starts
File On up. When this option is active, Eureka opens
Entry all files that were open when you last ended a
Eureka session. When it is not active, your
session opens a new window depending on
your setting for Default to QuickQuery View.
Print This will print colors in a chart as patterns
Charts when printing to a non-color printer.
Using
Patterns
Default This controls whether the New Document dia-
To Quick- | log box defaults to QuickQuery or FreeForm as
Query the window type to open for a new design doc-
View ument. It also controls whether the New Doc-
ument toolbar button creates/opens a
FreeForm window or a QuickQuery window.
Discon- This causes Eureka to disconnect from your
nect database after each query. This may make
Between each query after the first one in a session take
Queries a little longer to get started, but may be neces-
sary if your database allows only a limited
number of connections. This is not typically
necessary with DPAS.
CH1 392
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c. Object Placement Group Box: If desired, change the Object Placement preferences.
d. Query Group Box: If desired, change the Query preferences.

Object Placement Query

Auto Headings | This causes Eureka to automatically add | Report Row Acts as a global default for limiting the
column headings to your document as Limit number of rows Eureka gets from DPAS.
you add column objects in FreeForm Use zero to indicate that no row limit is to
windows. It adds a text object to your be set for your document (zero is the
page heading area(s) each time you default).
add an object (text, column, custom,
and system). The heading text is the
object label that can be changed in the
object's attribute dialog box.

Predefined This causes Eureka to open the object Time Limit Acts as a global default for the time limit

Objects attributes dialog box for each new for query processing. Use zero to indicate
object as you place it on your docu- that no time limit is to be set. However,
ment. This makes the process of defin- DPAS has a time limit on inactivity of 45
ing the object and places the object as minutes.

a single action. This option applies to
text, child data, column, custom, user
prompt, and system objects.
Prompt Row This controls how many rows (values) are
Limit retrieved from the database when a
dynamic choice list is generated for a user
prompt.
Use Aliases This controls whether an alias reference
should be used for all tables queried.
DPAS uses aliases, so this option should
remain turned on.
Trace ODBC You can use ODBC call tracing to provide a
Calls log of ODBC calls and the result of each.
This may allow you to determine the cause
for any database access problems you may
have.
Browse Row This controls how many rows (values) are
Limit retrieved from the database when you
select the Browse button in an object
directory or object source.
Trace File This is the name of the file to which to log
database calls. This should be left blank.
e. Click OK.
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Getting Oriented With The QuickQuery Window

INTRODUCTION

In this Chapter we will begin producing reports and queries using the QuickQuery process. You will
see a window and toolbars that may be new to you. This lesson will familiarize you with the terminol-
ogy and function of the Eureka QuickQuery window environment.

OBJECTIVES

The student will be able to identify the parts and explain the functions of the QuickQuery window and
the associated toolbars.

APPLICATION

Understanding the QuickQuery window and associated toolbars is necessary for you to further your
understanding of the QuickQuery process.

PREREQUISITES
Eureka Reporter Designer is correctly loaded and configured.
ACTIVITY

Instructor-led lecture

This is an example of a QuickQuery Window:

& EUREKAReporter Designer - [Untitled1] =1
EF Fle Edit Yew Insert Query Took Window Help -18]x
DEESEEm| 4 2R |f e
B! |BE (2| 2%%Y |82 | E
o = : H
‘i [lmes Hew Roman af—r === ;|i rorm ing Tool r
QuickQuery Objects Toolbar PI—ry—tr
Tre @
H H UNTING TRENSACTI <
ick ries T cccuring
CICIPAWIP
— AUTHORIZATIONS
F ) Autharization
1 Bulk_Hand_Receipt
t(C1Catdog
(1 Serial_Hand_Receipt
F Uit
CATALOG
(CCatalog

] Mit_Model/Pait_Number
“§ COMPONENT BULK

F (0! Quick_Start

b +CatslogRef._Pub.

F 1 4ppn_Data

k) Catden

() Component_Hand_Recei
-1 Hand_Receipt_Holder
() Mir_Model/Part_Number
b Serisl_Hand_Receipt

b5 Uit

~§ COMPONENT SERIAL
FC1'Buick_Start

(] +Catalog Ref._Pub.
(1 +Comp._Hand_Rept. Dey
(1 +Comp._Hand_Rept Imp
(1 +Comp._Hand_Rept. Wa
tC1ppn_Data
F(1Catdog

(1 Companent_Hand_Recei
(1 Hand_Receipt_Holder

Status Bar |- Mir_ModelPan_Humber

[ 15erial_Hand_Rieceipt

F o Unit
F ) Wananty/Service/Loand|
| ||=3 DEPRECIATION EXPENSE
2 (0] 'Quick_Start
Wil Record [0 Yl e | E‘ = Catalog d|

Open an existing query document [ [ [ Iom
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Opening A New QuickQuery Report

INTRODUCTION

QuickQuery is a fast, interactive way to shape your query/report while viewing the data it returns in a
spreadsheet-like layout. QuickQuery is an excellent tool if your intention is to create a query for
yourself in order to answer a question, or to prepare a report that is to convey information, but will be
used internally by you and your organization. It is the easiest and most structured method to develop
that information.

OBJECTIVES

To create a query/report using the QuickQuery function both with and without the QuickQuery
Wizard.

APPLICATION

You need to create a basic report quickly. You do not need anything fancy or complex. For example,
you are asked to provide a list of items on your property book that are under the $5000 minor
property threshold.

PREREQUISITES
Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Instructor-led demonstration
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STEPS TO PERFORM ACTION

While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

[Ey

-OR-

3. From you computer desktop, double-click the Eureka Reporter Designer icon.

NOTE:
If you do not have a shortcut to £ureka on your desktop, then click Start>Programs>
Eureka Reporter Designer.

\

Z

The Query Wizard will display:

Step 1. Select Query Type ﬂ
e o s 1ae ‘what type of query would you like?
ustemers by W47
Region i £
Begion  omt#  compamy Prone # = Summary
Atecicas  SPO00Z Sports Josk (406| 3-TE i Grouped Detail
Aricds  SPOOW Spartig Tre Ghie  (BOB[E9-133
Aiicds SOC0OL Saccer Maak e b " Overall Summary
Aricds FLEAIL  Flkaet Feat [ S| A4~ 130
Ateeicds SETO0Z 540 THl Vou Drap L (303677-192 ~ Create TM1 Cube
Aricds EPOOIL  Sharts Wdrdinuse (202|224-123
Atricds  SPOOM Spaets Corsucaph (2| FTE092
Aricds SOUIL Sautumesterd Sharfs (300 E27-6T . -
burape  SPODTS Spartd ScunclrAG  LTASSELD Thiz type of query allows you to list
Puape  BAVOOL Edyerd SportsGmod 3046832 detail information from your databaze.
Furape  SPO003 SportscescLinfted 1434 Sa2A Far example, all orders.
Burape. SPOOK Spartsd Lekure Pl Lol 47449594
Burape EPO00E Sharheeeld DUA G 3313402
Burape. FOOGOL Faathg 54 UM
Flle Mt wiz_det g Page: L
[T Do not show this wizard in the future.

< Back I Mest » I Finizh Cancel Help

4. Click Finish if you do not want to use the Query Wizard. This will take you into QuickQuery.
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Opening A New QuickQuery Report

If you are already in QuickQuery and you want to open a new report:

Chrl+H STEP 1:
Cpen... ChrH0
» a. Select File from the menu bar.
ew From Template,.. Ctrl+T
b. Select New... from the program group.
PFinE. .. Ctrl+P
Print Setup...
Print Preview ChrlH-
Export... CtrH+E
Repaort Server 3
Send [Mail
Fecent File
Exit
STEP 2:
:
a. View As: The default is QuickQuery. If you View b Region | Order | Amount B
. ' QuickBuery Americas 0103 | $20,396 - -
want to create a report in FreeForm, select that © FieeFom = o8 | ez | bl
radio button. Europe oot | $e.82
b. Create TM1 Cube: NEVER select this check = e el U
box; DPAS does not support this. ¥ Use wizard Pecifie Bim 001 |_#odon
c. Use Wizard: If you want to create a new
QuickQuery or FreeForm report using the Wizard,
then leave this box checked; otherwise, uncheck
it.
d. Click OK.
CH?2 14
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Building A QuickQuery With The Query Wizard

Building A QuickQuery With The Query Wizard

INTRODUCTION

This section outlines building QuickQuery reports by using the Query Wizard. The query wizard is the
easier way to create a query and takes you step-by-step through:

O STEP 1: Select Query Type O STEP 4: Select Columns to Sort By
Q STEP 2: Select Columns 0 STEP 5: Select Columns to Aggregate
0 STEP 3: Setting Column Filters a STEP 6: Select QuickQuery Style Profile

Using the query wizard produces a spreadsheet-type report or query.
OBJECTIVES

Using the QuickQuery Wizard, you will develop a spreadsheet-type of report with columns of data
(detail) that have been filtered, sorted, and aggregated (totaled for the column). You will present a
sample page of this finished report to your instructor.

APPLICATION

This type of query can be used when you need a simple report fast. For example, you want to build
a simple report that displays certain data fields for your Hand Receipt Holders.

PREREQUISITES
Eureka Reporter Designer is appropriately loaded and configured.
ACTIVITY

Instructor-led demonstration

CH2 15
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Building A QuickQuery With The Query Wizard

REPORT TYPE

A complete asset listing by UIC/Major Hand Receipt Holder showing stock number, bar code,
nomenclature, and acquisition cost of each asset.

This is a sample of a QuickQuery report that will be built in this demonstration:

' EUREKA:Reporter Designer - [Ul &l x|
EF Fle Edt View Insert Query Tools Window Help & x|

SEIET IR T A

BB ! |re %% B E
[T Times New Flaman =1 |[o ;” B I U |i||| 2 |
Acy Cost BarCd Nomen SerialNbhr StockNbr uic =
7500 ANSWERING MACHINE | 66739 T0I000N452825 | WOVGAA
1000.00 | WOV GAADD | AUTOMOTIVE TOOL KIT | TOOLKIT? 3180001777002 WOVGAL
1426900 [DPO1000031 | AV NV 3¥ AN/AVI-60NZ | 4397101 5855011334743 WIVGAL
1426900 [DPO1000032 | AV NV 3¥ AN/AVI-60NZ | 4397102 5855011334743 WIVGAL
2322.00(0300100203 | BARCODE READER 332-0010103 5833331 IFLM WIVGAA
150.00 | DFO1000037 |CODE CHGR KYK-38/TSEC| RKD098184.01 5810004715068 WOVGAL
150.00 | DPO1000038 | CODE CHGR KYK-38/TSEC| RKD092184.02 5810004715068 WOVGAL
1350.00 | WOV G440 [COMPUTER, LAPTOP DS123456 0250100342350 | WOVGAA
1550.00 | WOVGAADD |COMPUTER, LAPTOP D312345610 025010034250 |WOVGAA
1550.00 | WOVGAADD |COMPUTER, LAPTOP D312345611 F02501D034250 | WOVGAL
1550.00 | WOVGAADD |COMPUTER, LAPTOP D312345612 F02501D034250 | WOVGAL
155000 | WOV 4400 |COMPUTER, LAPTOR D1234564 T0S0ID034250 | WOVGAAL
1350.00 | WOV G440 [COMPUTER, LAPTOP DS1234565 0250100342350 | WOVGAA
1350.00 | WOV G440 [COMPUTER, LAPTOP DS1234566 7025010034250 | WOVGAA —
1350.00 | WOV G440 |COMPUTER, LAPTOP DS1234567 025010034250 | WOVGAA
1550.00 | WOVGAADD |COMPUTER, LAPTOP D31234562 F02501D034250 | WOVGAL
1550.00 | WOVGAADD |COMPUTER, LAPTOP D31234568 F02501D034250 | WOVGAL
1532.00 |L000000504 | COMPUTER, PENTIUM I | 100-KM-00501 7025010000563 WIVGAL
133200 COMPUTER, PENTIUM I1I | DS003 7025010000568 WOVGAL
1332.00 COMPUTER, PENTIUM 111 | DSO04 7025010000568 WOVGAL
1339.00 | WOV GAA0D |COMPUTER, PENTIUM 111 [OD0007 7025010000568 WOVGAL
2332.00|000223 COPIER 33 XEROX 6100DLA0ZE 3610011297764 WOVGAA
1000.00 | WOVGAA0D |DIZK DRIVE UNIT: COMP | TOOLKIT? 7025013409810 WIVGAL
363200 |DP01000043 |ENCDECKIV7HISFD | MD1002348-01 5310014313264 WIVGAL
263200 |DF01000044 |ENCDECKIV THISPD | MD1002348-02 5310014318364 WOVGAL
499,00 5003205 H&NDHELD COMPUTER |HH-323-005 TOS0IN000433 | WOVGAA
499,00 5003206 H&NDHELD COMPUTER |HH-323-006 TOS0IN000433 | WOVGAA
222647 |[DP01000039 | KEY GEN TSEC/KG-81 V194975401 5810010550048 WOVGAL
322647 |[DP01000040 |KEY GEN TEEC/KG-21 V194975402 5310010550043 WIVGAL
2733200 | 000202 LATHE, ENGINE 3411BLAOD2 3411001364013 WIVGAL
93300/ 40000015 [MONITOR, 17" 100HS 721-EV-A0019 T025703616122 WIVGAA ';1
Ml 4] Record [31 Tl <] |
Ready [ UM

STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.
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Building A QuickQuery With The Query Wizard

Step 1. Select Query Type x| STEP 1 select Query Type:

ot o ‘what twpe of queny would pou ke ? a. Select the type Of query you Would I|ke_

ICusiomers hy i

i
Begion  fst#  compan Prone #  Summary
Atwrkds EPO0DZ Sports Dosk (405 244-FF (" Grouped Deta“
Amgekas  SPOOW Smartlg TreGhoe  (60R|6B-133 o
Aneekds 300001 fucceruu (zulxl;zae\ Owverall Summary
T o e e e @ Eae T Bhe Query Types
Admeekcas  SPOOOL Sports Weedtouse  (B02|3A-133
T D St G - - - - -
e e e | This type of query allows you ta st Detail Detail queries return detailed data without any
Eurone BAVOOL  Bapard Sports Geod 3046552 detail information from your databage, 1 H
:::: oo SP::‘R:";::E":‘L o For example, all orders aggre.gate fl,!nCthnS appIIEdl the aggregate
e el functions being average, count, minimum,
Furant FOO0OL Faathig 54 00 .

maximum, and sum.
Fik Mt ir_det e Page: |
T Summary Summary queries are useful when you want to
it t t tuire. . . .
o ek shan s izt in e BALE summarize data for a number of different items.

e [ e | = r— Hep | Grou_ped Grouped detail queries let you view the query
Detail results grouped by one or more columns.
Overall Overall summary queries give the highest level

Summary view of your data.

Create This is not available.
TM1 Cube
b. Click Next>.
STEP 2 SElect C0|umnS: Step 2. Select Columns x|
Choose whiﬁ_cqlugms _l,lboudwouh;l Iikehin = Customers
i i i N t Ompan
a. From the Object Directory, select the Business o ko et p e er | [EComea
View you wish to use to build your columns. column st on the right orders R
i Date Py codter
. FPackicRim §1/022 0422
To select the fields, you can: Euvoe  HI00G% 1)
Eurcpz  §1233 1333
« Double-click each field and the field will P2 PR [cotumn |+
move to the Column Window at the right. @[A:'u R e i
¢ Click, drag and drop each field to the (] Buthorization x
Column Window at the right. %gu'tklﬁandﬁeceim &
. . atalog
e To select multiple fields, hold the CTRL L5 Hone n_:l;l

key down and select the desired fields
(DO NOT LET UP ON THE CTRL KEY). [
Click, drag and drop to the Column
Window at the rlght_ < Back I Mest > I Finish Cancel Help
b. Click Next>.
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Building A QuickQuery With The Query Wizard

Eurek, i Dir ri

Object directories make it easy to add columns to your documents and dialog boxes. Eureka Reporter
Designer includes an object directory in QuickQuery and Free Form windows. The main object directory
can be docked or floating. You can hide and unhide it by selecting from the menu bar View>Object
Directory or by using the F2 key on your keyboard.

[F= ACCOUNTING TRAMSAL &

Business View. Business view names are at the top level of the
tree and are indicated in ALL CAPS. A business view is an object
in your Metadata File that corresponds to the data for a particular
part of your business.

fifl ACC
[ Acct Fpt M

[ Acct Svs Cd

[ &eq Dt

Folders. A folder can correspond to a table in your database or fE ction Cd

it can be made up of columns from more than one table. It can | HI Ackimbd L|j
also include custom objects--objects that are calculated from
database columns.

Data Objects. These are the actual data elements that are used to make up your report.

In this class, we will be referring to tables (pictured above) that will direct you to the Business View,
Folders, and Data Elements that you will use in order to complete any activities and/or exercises.

- NOTE:
\ > You cannot select fields from 2 different Business Views (such as, END ITEM SERIAL and
\\///// END ITEM BULK) on one report unless you are writing a Parent/Child report.

Step 3. Select Column Filters = x| STEP 3A Select Column Filters:
Te | m . _ ) ] )
TR What canditions should your data salisfy? a. From your list of selected fields, double-click or
E Barcd [Lldeeniions drag and drop the data field(s) you want your
&| Momen 1] Drag a column ta the column list below.

& Serial Nbr 2] Select an operator from the drop down list. query to SOI’t on.
J Stock Mbr 3] Set the valuelz] that govern the condition.
o L
— - W NOTE: _
\ \//\ Filters let you limit the data displayed to
Oxﬁlcmumn [operator _[value 1 Vae2  [Group | V7 only that which meets the criteria you
L = o n a
set. When a query has no filter, you will
see ALL the data from your database.
When you define a filter condition, you
will limit the data that meets the

condition. Every additional filter or

< Back I Mest » I Finizh Cancel Help ﬂlter C0ndItI0n you apply further
narrows the view of your data
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Building A QuickQuery With The Query Wizard

b. The default operator is equal to (=). If you want to change the default, click on the equal sign (=)
and you will get a drop down list box which contains the other operators. To delete a filter condition,
select it (by clicking the X or check mark under OK) and press the DELETE key.

Operators Definitions

Equals (=)

When you want the result to equalthe value entered.

Not Equal To (<>)

When you want the result not equal to the value entered.

Less Than (<)

When you want the result to be /ess than the value entered.

Less Than or Equal To (<=)

When you want the result to be /ess than or equal to the value entered.

Greater Than (>)

When you want the result to be greater than the value entered.

Greater Than or Equals To

(>=)

When you want the result to be greater than or equal to the value entered.

Between When you want the result to be between the range of values entered — this will include
the values entered. Example: Bar Codes between 56012 and 80921.

Like Same as =, but allows the use of wildcards. (Example: if you wanted all Stock Nbr start-
ing with 7, the statement would be "STOCK NBR like (operator) and 7*(value 1)).”

Not Like Opposite of Like.

In When looking for specific values in a field (example: FSC In 7025, 7030. This will display
records with those values). Cannot be used with the wildcard (* or %). A comma must
separate inputs (example: 15,16,170).

Not In Opposite of In.

Is Null When you want the result to not have a value. This can be done using numerical fields.
No value; not even a space, can exist in a field.

Is Not Null When you want the result to contain a value. This can only be done using numerical

fields. Must have a value in the field.

c. Enter the condition that needs to be met under Value 1. If you are using the Between operator,
then you will need to enter values in Value 1 and Value 2.

ALL VALUES ARE CASE-SENSITIVE!!

d. Click Next>.

By default, all the conditions of your query are AND operators (i.e., all conditions have to be met before it
will return your results). However, you can connect your statements with OR operators, which divide your
statements into groups. For example, if you wanted to set your conditions by Stock Number AND
Serial Number OR Bar Code, the OR’d Group would be set to 0 (zero) for Stock Number and Serial
Number, and set to 1 for Bar Code.

The RULE is...If the OR’d Group numbers on any two statements are the same, those two statements
are connected by the AND condition. If the OR’d Group numbers on any two statements are different;
those two statements are connected by the OR condition.

CH 2
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Building A QuickQuery With The Query Wizard

STE P 4 SeIeCt col u m ns to So rt By: Step 4. Select Columns to Sort By x|

a. From your list of selected fields, double-click on How would you ke your dta sored? |
the data fleld(s) you Want your query to be Sorted First, move a column to the list on the right, Feaen
by. To de-select a field, highlight the field you then use the &2 push button o set the s 1022 052
want to de-select and click on the arrow that B a1

Eurcpz  §3007 0911

points to the left.

Women

Serial Mbr
Stock Mbr

HINT! uic
~ Once you have selected your columns, you Use this to d
can click on Order button and change how
you want your query to sort. For example, it
would be either A-Z or Z-A.

b. C||Ck Next> . < Back I et > I Finigh | Cancel | Help

e-select a field

Step 5. Select Columns to Aggregate x| STE P 5 select COI u m nS tO
Aggregate:

“what totals would you lke in your query?

Ragien  Amounk Oirdar

Dmaricas 5306 (7
Amaricas §a053 1058
Amaricas 509 00

a. Click Entire Document. You will not be able to
click any of the check boxes unless this step is

First select a group, then set agaregate
functions for each of the desired columns. FE
Ewrcpz 53077 0911
Ewrepz  §I00G 1330
Euro,

" i performed.
E ntire Document Column |Sum |Aug |Max |Min |Cnt | b. CheCk the fle|d(S) you want to total.
Aog_Cost r r £ £ £ |c Click Next>.
Bar Cd r r r
Momen r r r
Serial hor r O r
Stock Mhr r r r
uie r rr

< Back I Hext > I Finizh Cancel Help

\ﬂ’“&\ NOTE:
\ > Only pure numeric fields can be summed or averaged.

\_\\/

t
Z

When using the Count, you will get the total number of records returned from your query.
When you are counting a data field, if you desire to get a count of ALL assets, you must count

on a mandatory data field, such as Acq Cost. You would ony count on an optional field, such as
Bar Cd, if you wanted to know how many bar codes you had.
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Building A QuickQuery With The Query Wizard

STE P 6: Step 6. Select QuickQuery Style Pr: |

‘wihich QuickQuery style profile would vou like?

This screen will allow you to choose from a style Dttt =
profile that was previously created.

tem Vendor Date Amount
o Click Finish. Golf Clubs Alcanzar 10/2096  |$2,164.45
Galf Clubs Rapide 412586 $1,122.95
Galf Clubs Rallo 114086 $3,659.00
Galf Clubs TeedOff Inc. G786 Fa73.2
Snowy Skiis Alabarze 12186 §3,001.23
Snowy Skiis hogul kaniza 1102786 | §2,115.350
Snow Skiis Rallo 1112586 $3,699.31

< Back I Tewt > I Finizh Cancel Help

Your report should look similar to the following:

& EUREKA:Reporter Designer - [Untitled2] i =& x]
File Edit Miew Inssrt Query Tools Window Help == x|
DEH|SRE BB~ | Fy (O]
RE| ! sl L% v (B E|
I Times Hew Foman 3 || A3 | B A
Acy Cost BarCd Nomen | Seriallhr StockNbr Juce =
7500 ANSWERING MACHINE | 66739 TOI000N452835 | WOVGAA
1000.00 | WOVGAAQD | AUTOMOTIVE TOCL KIT |TOOLKIT? 3180001777002 WOVGAA
14269.00 | DPOI00003L | AV NV 57 ADN/AVE-6002 4897101 3253011384748 WOVGAA
14269.00 | DPOI000032 | AV NV 57 AN/AVS-602 4897102 3253011384748 WOVGAA
2372.00|0300100203 | BARCODE READER 3320010103 383333L1PLM WOTGAA
150.00 |DP01000037 | CODE CHGR KYK-38/TSEC | RKD098184-01 3810004715068 WOVGAA
150.00 | DP01000038 | CODE CHGR KYK-38/TSEC | RKD098184-02 3810004715068 WOVGAA
155000 | WOVGAAQD |COMPUTER, LAPTOP | DS123456 T03501D034250 | WOVGAA
155000 | WOVGAAND |COMPUTER, LAPTOP | DS12345610 T0201D034250 | WOVGAA
155000 | WOVGAAND |COMPUTER, LAPTOP | DS12345611 T02301D034250 | WOVGAA
155000 | WOVGAAND |COMPUTER, LAPTOP | DS12345612 T02301D034250 | WOVGAA
155000 | WOVGAADD |COMPUTER, LAPTOF | D31234564 TOBOID034250 | WOVGAA
155000 | WOVGAAQD |COMPUTER, LAPTOP | DS1234365 T03501D034250 | WOVGAA
155000 | WOVGAAQD |COMPUTER, LAPTOP | DS1234566 T03501D034250 | WOVGAA L
155000 | WOVGAAQD |COMPUTER, LAPTOP | DS1234567 T03501D034250 | WOVGAA
155000 | WOVGAAND |COMPUTER, LAPTOP | DS1234568 T02301D034250 | WOVGAA
155000 | WOVGAAND |COMPUTER, LAPTOP | DS1234569 T02301D034250 | WOVGAA
1532.00 |LODOO00S04 | COMPUTER, PENTIUM II | 100-KIM-00301 7023010000368 WOVGAA
153200 COMPUTER, PENTIUM I | DS003 7025010000368 WOVGAA
153200 COMPUTER, PENTIUM I [ DS0058 7025010000368 WOVGAA
1539.00 | WOWGA A0 | COMPUTER, PENTIUM III |ODO00T 7025010000368 WOVGAA
233200000223 COFIER 5V5 XEROX G100DLAD23 3610011297764 | WOVGAA
1000.00 | WOVGAA | DISK DRIVE UNIT: COMF | TOOLEIT? 7023013409210 WOVGAA
3632.00| DP01000043 |ENCDECEKIV7HISFD | MD1002343-01 3310014313264 | WOVGAA
363200 DFO1000044 |ENC DECKIV7HISFD | MDI002343.02 5310014318264 | WOVGAA
499.00] 5003205 HANDHELD COMPUTER |HH-323-005 TOSOLNOODA33 | WOVGAA
499,00 5003206 HANDHELD COMPUTER |HH-323-006 TOSOLNOODA33 | WOVGAA
8226.47 | DPD1000039 | KEY GEN TSEC/KG-81 W194975401 3810010550048 WOVGAA
8226.47 | DP01000040 | KEY GEN TSEC/K(-81 W194975402 3210010550048 WOVGAA
27333.00 | 000202 LATHE, ENGINE 3411BLA0O02 3411001364013 WOVGAA
933,00/ 40000019 | MIONITOR, 17" 100HS 7215740013 7025703616122 WOVGAA 'j
W[ 4l Record [21 D1 | >
Ready [ [om
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Saving Your Query

Saving Your Query

INTRODUCTION
When you have created a file, which is useful, you might want to save that file to use the format
again. By using the Save command, you can save the active window to a new or the same name. By
using the Save As command, you can save the active report to a new name.

OBJECTIVES

Use Save and Save As to create and update your files.

APPLICATION

Self-explanatory
PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.

Understand the layout of DPAS file structure, and complete the Orientation section of this manual.
ACTIVITY

Instructor-led demonstration.
STEPS TO PERFORM ACTION

1. Select File from the menu bar.
2. Select E or select Save... from the program group.
NOTE:

> There are two ways to save your query. You can save the design (report format) or the output
2~ (data).

\ %

If you save the design, this will allow you to update and rerun your query at a later time. If you
save the output, then you are essentially saving the data and it cannot be updated.
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Printing Your Query

CAUTION!
S Before you print your report, you will need to click the last page button to ensure that ALL
pages of your report are printed.

INTRODUCTION

If you want a hard copy printout of your query, you will need to use the print function. Eureka uses
the Windows common dialog box, the same as any other Windows-based product.

OBJECTIVES

To learn how to, and to print out a copy of a £ureka report.
APPLICATION

Self-explanatory

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.
Understand the layout of DPAS file structure, and complete the Orientation section of this manual.

ACTIVITY

Instructor-led demonstration
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STEPS TO PERFORM ACTION

1. Open or create a QuickQuery.
2. Select File from the menu bar.
3. Select Print... from the program group.
-OR-
=
4, Select the print icon .
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Activity: QuickQuery With The Query Wizard

Activity: QuickQuery With The Query Wizard

Student Hands-On With Instructor Directi
Unit of Study: QuickQuery (with the Wizard)

Application: This type of query can be used when you need a simple report fast.

Report Type: This is a report by your UIC listing by Stock Number, Bar Code, and Nomen. This
report will also list the Acquisition Cost for each asset and give you the total sum of the assets.

Instructions:

STEP 1: Detall
STEP 2:  Select the following fields for your QuickQuery Wizard report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

1Quick_Start Acq Los Nomen
Bar Cd Stock Nbr
HRH Nbr Mjr UIC

STEP 3: Filter by the UIC given to you by your instructor.

STEP 4:  Sort by the Nomen field.

STEP 5A: Click on Entire Document.

STEP 5B: Set the Columns to Aggregate to sum for the Acq Cost.
STEP 6: Select Finish to process your report.

Example of Finished report:

EF Ele Edit Yiew rt Query Took ‘Window Help =121 x|
Dedaie|ias - - |Ffz|ew|
RE ||~ B 252 A
I Times New Foman = | ECa [ A R == | K |
Nomen [SteckMiLEAA | HRHNbrMj [BarCd AcqCost e
1013000247668 TWOUZAL T4, 00 | WO ZA |
BLOCE, TRAM 1013000247668 WOUZAA T4.00 | WOUZ2A |
BLOCK, TEAM 1013000247662 WOUZAS T44.00 | WOZA|
ELOCE, TRAM 1015000247668 WOUZAA 700 | WOUZA
CMPT ST DGOL-586/TYQ | 7010014126702 WOUZAA 60000.00 | W24 |
CMEPT 3T DG OL-526/TYQ | 7010014126702 WOUZAA 600000.00 | WOU24
FILTER,GUN DRIVE 1003000012676 WOUZAA 131.80 | WOUZA |
FILTER,GUN DRIVE 1005000012676 WOUZAS 1311.80 | WOUZA |
FILTER,GUN DRIVE 1003000012676 WOUZAA 131.80 | WOUZA |
FILTER,GUN DRIVE 1005000012676 WOUZAA 131.80 | WOUZA |
MEL 7023001111111 WOUZAA 5345.00 | WOUZA|
MONITOR 7025000320001 WOUZAA 34534.00 | WOUZA |
MMONITOR 7025000320001 WOUZAS 53453.00 | WOUZA |
MONITOR 7023000320001 WOUZAA 3423.00 | WOUZA|
MONITOR 7025000320001 WOUZAL 3423.00 | WOUZA|
MONITOR 7023000220001 WOUZAA 60000.00 | WOU2A|
MONITOR 7025000320001 WOUZAA 5345.00 | WOUZA|
MONITOR 7023000220001 OUZAA T263.00 | WOU2A]
MONITOR 7023000320001 WoUZAA |RLEEL60103 435400 | WOUZA |
MMONITOR 7025000320001 WOUZAS ATER.00 | WOUZA |
MONITOR 7023000320001 WOUZAA BTE3.00 | WOUZA|
TeEan— e e enn, T Y. i i '_I
Ready T [ mm,
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Skill Builder: QuickQuery With The Query Wizard

Skill Builder: QuickQuery With The Query Wizard

Objectives: You will:

> Review Building a QuickQuery With The Query Wizard (Word
Exercise)

> Discussion Questions

> Practical Exercise to build a QuickQuery with the Query Wizard

Complete the following exercise:

1. Name the type of queries you can select when building a QuickQuery with the Query Wizard?

2. List the 6 steps of the Query Wizard (in order).

a d.
b. e
C f.
3. The contains the business views, folders and data fields for building

your report.
4. All values entered in Eureka are case sensitive. (True or False)
True __ False

5. List five types of operators.

a d.
b. e
C.

6. What is a structured pathway for a new user to build a report?

CH2 26
1 October 2004



Skill Builder: QuickQuery With The Query Wizard

7. In Step 5 Select Columns to Aggregate name 3 aggregate functions you can perform.

8. When working with QuickQuery, you can only work in one business view at one time? (True or
False)

True False
Discussion Questions:
1. Review the use of the Business Views and Folders.
2. Why is it important to use the filter function in some reports?

3. Discuss the different types of queries and what would be an example of how you
would use them.
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Practical Exercise: QuickQuery With The Query Wizard

Independent Student Report

Unit of Study: Building a QuickQuery With The Query Wizard
Application: This type of query can be used when you need a simple report fast.

Report Type: Accounting report, filtered by UIC displaying serial number, stock number, fund code
and dollar amount with sum and average.

Instructions:

1. Create a new report using the QuickQuery Wizard.
2. Select the following fields for your QuickQuery Wizard report:

BUSINESS VIEW: CATALOG

FOLDER(S) DATA ELEMENT(S)
Catalog Stock Nbr
Generic Nomen
Mfr._Model/Part_Number Mfr_Name
Mfr Part Nbr

3. Filter:

Column: Stock Nbr
Operator: Like

Valuel: 70%*
Sort: Stock Nbr
Click on Entire Document.
Aggregate: Stock Nbr using Count

o vk

~ 5 HINT!
@5 For your Filter: Remember to use the value of “like” because we are using the wildcard to look
' for Stock Numbers that begin with “70". Refer to the list of operators on page 19 .
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Example of the finished report:

& EUREKA:Reporter Designer - [Untitled2]

=¥ File Edit Yiew Insert Query Tools ‘Window Help ;Iilll
DEH SR @~ |FE|Ow|
WE (N D[ LY B B
I':ﬂ'j Times Mew Roman j“‘lﬂ j| B 5 U |§ = = |£I I j ‘

SerialMNbr StockNbr DollarAmt FundCd | UIC =
TO36-MH-206 FO21703593020 11100000 | P& WATED
TIIRI-BV-138 FO21703593008 111302.00 | P& W4aa07
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV
TIIRI-BV-137 FO21703593105 11130200 |FB WAV -
TFO36-MH-108 025011725133 11100000 |FB WAV
TFO36-MH-107 025011725133 11100000 | P& W4aa07
TFO36-MH-106 025011725133 11100000 | P& WATED
102-3V-7310 025011725133 11100000 |FB WOUEA
102-3V-7410 025011725133 11100000 |FB WOVG
102-3V-7510 025011725133 11100000 |FB WOWL1
102-3V-7610 025011725133 11100000 |FB WIOVPA
102-3V-7710 025011725133 11100000 |FB WY
102-3V-7810 025011725133 11100000 |FB WiDCn
102-3%-7910 025011725133 11100000 |FB WIEAZ
102-3%-79110 025011725133 11100000 |FB WIHC
102-3v-79111 025011725133 11100000 |FB WINW0
1070 ST 70147 TOLN1ATIE T 111000 nn |l oo TETARTTRT il

M4 Record [1 AL IER! | »IJ

Ready [ [ ’W_
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Building A QuickQuery Without The Query Wizard

INTRODUCTION
This section outlines building a QuickQuery report without using the query wizard.

OBJECTIVES

Learn how to build a QuickQuery without the Wizard to include functions and processes that could be
used in any QuickQuery that you build.

APPLICATION

This type of query can be used to generate simple reports “on the fly” without having to use the
query wizard. For example, you could create a listing of all your hand receipt holders by UIC, stock
number and acquisition cost. In this report we will be using different functions to manipulate our
data.

REPORT TYPE

A listing of all your HRH Nbrs by UIC displaying nomenclature, stock number and acquisition cost. We
will use different functions to practice manipulating the data.

PREREQUISITES
Eureka Reporter Designer is accurately loaded and configured on your system.
ACTIVITY

Instructor-led demonstration

Example of the finished report:

i URLEAREporter Designer - (Untitled]

EF Fle Edt View fnsort Guery Took Widow Mok =18 x|
DR sk B FE e
|| || 8[| A A e | B |
|'r Twrusez: M Frsruar 3 { | = [ Hl -
UIC_ | amen SuckIMLUAA | HRITW:Mr [Acteal Cost |
HGI00L | TRE G0 12T 6000 TI0IROTIRL | ST0 27439.00
HEINL | LATHE, ENCINE [ranmnasanz |=m [ 11508.00
AL |3610001z57764  |5TOL | 13566.00
[ |Haon | TRELF W00 |F700 263300
[T [mooon [ TeERRONE STUNT | ssoneEr S0 [ 1,00
[T |HQI00! | BARCODE REATEER: [semEmurLM |ST0 I 2532.00
[ [121001 | ANSWERING MACIINE 7010000452825 |STON 2200 L]
[T [ [MokmoR, B coLoR | msmesz s [ 933,00
[T |HOI0! |COMPUTER, PENTIUM [ | F02M010000348 |70 I 3101.00
[ |icioon [comMPuTer FENTIUM D |F028100027  |5701 5365.00
[0 W [PrRINTER, LaskR [msmozzzn =m0 [ A622.00
[ [Hoioor | SERVER [rozsoniTzszz [sTon | 110000.00
[ |iioo [cpu, DEseTOR MNINIFNIIT  |ST08 499,00
[ [Heion [ HANDHELD COMPUTER | fsnmmnes s [ 499,00
[ |HOI0! [ HANDHELD COMPUTER: |F0ZM0INO0043E  |S701 I 499,00
[ [ncuon |cru, DEskTOR UMM [s802 273400
[ [Remon maonrroR, e e | msieslalz: |san [ 565,00
[T |Hom | TRE G0 (/2T a0 B I 27439.00
1 0 G T ST Soomee (I
Ready MM
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STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.
3. If the Wizard is displayed, click Finish.
4. Select New from the file menu.
STEP 1:
& e % || a. Uncheck the Use Wizard choice on the new
* Lluckluen mericas 20, = - .
 FresFom — ozs | sazet| | | Gancel | document dialog box.
Europs oeor | gose2 — b. Click OK.
[" Create TM1 Cube [Sum = %% —
p Use wizard Facific Rim 0321 $2 490
STEP 2: 2

a. Depress the F2 Key on your keyboard to
display your Object Directory (if it isn't
already displayed).

b. Use the scroll bars to select the appropriate
Business View from which you will select the
columns you want displayed on your report.

~ <5 HINTS!
%@; It may be a good idea to change your
' Preferences to do a Manual Re-Query.

See page C7-15, Setting Preferences,
for more information.

In order to get your data fields to your
working window, you must click on the
ield and while holding the click, drag and
drop the field to any place in the working
window.

Gt it ey i ek

To select MULTIPLE fields, hold the
CTRL key down and select the desired
fields (DO NOT LET UP ON THE CTRL
KEY). Click, “drag and drop” to any
place in the working window.

c. Select the following fields for your QuickQuery report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

IQuick_Start Nomen Bar Cd
Stock Nbr Acq Cost
HRH Nbr Mjr  UIC
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hanging The Name Of A Column H in

If the name of a particular column is not useful or clear to you or used by your Activity, you have the
capability to change the name of that column heading.

e = STEP 1:

.« Double-click on the column heading you
- wish to change. In this exercise, we will
change the Acq Cost field.

STEP 2: Column: AcqCost {Untitled1.igr) ﬂ
Colurnn | Faont I Iranslatel
a. The current name of the column is displayed. T
Change the Object Label to Actual Cost. S [Fumeric
b. Folder: This displays the folder your data field = Fomat
was chosen from. This field cannot be changed. pore = DTSN [rabsaianan00 |
c. Business View: This displays the Business View Colum [hca Cot P&W'd‘”
your data field was chosen from. This field cannot el e
be changed. 3 Serisl_Hand_Fiec a Norel -
d. Column: This displays the system column B
heading from the object directory. This field Aog Cast
cannot be changed. %iiﬁﬂca
P
%\ =\ NOTE: g™
\ If your report is not working, you may want
7z to check each of your data elements to see 0K | Concel Help
if they are from the same Business View.
To do this, you will need to double-click on
each column heading to make ensure that
all data elements are from the same
Business View.
e. Type: This field displays the characteristics of the data (string, numeric, or date).
CH?2 32
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Building A QuickQuery Without The Query Wizard

f.  Format: If you selected to change a cost field, you can change the format of that field. Change the
Format to Windows Currency.

Format Functions

FORMAT SAMPLE DATA VALUE FORMATTED APPEARANCE

####0.00 1234.5 1234.50
#HRHHH 1234.5 1,234.5
#.HH# 1234.5 1234.5
#0 1234.56 1235
$#,###,##0.00 1234.5 $1,234.56
$#,##0.00 100.5 $100.50

0 $0.00

2500.25 $2,500.25

-145.10 -$145.10
$#,##0.00;($#,##0.00) 100.503 $100.50

-145.10 ($145.10)
$#,##0.00"CR"; $#,##0.00 $1,234.50CR 1234.5

-1234.5 $1,234.50
0[S/1000] 12375 12

199 0
dd Mmmm yyyy Oct 1, 1966 10 October 1966
dd-MMM-yy Oct 1, 1966 01-OCT-66
mm/dd/yy Jan 15,1991 01/15/91
dddd Oct 1, 1966 Saturday
hh:mm 9:43am 09:43
hh:mm AM/PM 9:43am 09:43 AM
hh:mm:ss 9:43am 09:43:00
hh:mm:ss.ssssss 09:43am 09:43:00.000000

Click on the pick list to review additional Format Functions

g. Charater Width: This field defaults to the actual field length, but can be changed. Keep in mind
that if you make the length shorter that the actual field length, it will truncate the field.

h. Aggregate Function: Select if you want to an average, count, maximum value, minimum value, or
sum for your data field.

~ 5 HINT!
%Qgi If you select the Sum Aggregate Function, after you change the Format, the Format is set back

' to the default. Therefore, set the Aggregate Function before the Format.
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Example of the finished report:

E EUREKA:Reporter Designer - [Fureka 7 Reports.iqr]
Fle Edt View Insert Query Iools Window Help

CH 2
1 October 2004

DEH(SRe BB~ F|rKe
Wl |t BT s8s sy By B
[ Times New Roman 52 || EEa | B A | [ |[enannnnannnoo
TNomen H. BarCd Actual_Cost uc |
TRE. GO L/2T 6000 30010007201 [ 701 167240
LATHE, ENCINE L1001364013 | 8701 167241
COPIERSYS¥EROX | 36100L1297764 |5701 167242
TRK LF 6000LE LT-60RS | 3960000251015 |5701 167204
TELEPHONE, STUII | 318000NO00SZ7__|S701 167243
BARCODE READER SEIIUELM (w701 7251001100
ANSWERING MACHINE | 701000N453825___|8701 HODoO!
MONITOR, 19" COLOR__| 7023000001952 | 701 1503001
COMPUTER, PENTIUM IIl | 7025010000568 | 5701 1593002
COMPUTER, PENTIUM II | 7025010001317 |S701 734201
PRINTER, LASER TUS010032221 |70l 1593003
SERVER. U253 |RT00 1593004
CPU, DESKTOF TUL0IFI03ZE2_[R700
HANDHELD COMPUTER._|70230LN000433 | 8701 HQDOL
HANDHELD COMPUTER. | 70230LN000433___|701 HQIZ
CPU, DESKTOP 021703511000 | 5803 1663321
MONITOR, 17" 100HS | 7025703616122 | 9802 1667201
TRK CGO 1/2T 6000 2E0010907891 |70z 167246
LATHE, ENCINE 4001364013 |702 167247
COPIER B3 XEROX 3610011297764 BT02 167242
TRE LF 6000LE LT-60RS | 3930000251015 |8702 167245
TEI TDIICAIE STTEITT £1 BANNKIANNNST. LAY 127940 h
W] Record |1 TN | »IJ
Ready [ hm
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Changing The Fonts

You can change the font attributes for the column headings in your report.

i [UREKAReporter Designes - [Lureka T Reports.iar]
CFpe BR Yow fret Query Tock Winkm Heb

D Sa @ -
8l %l

BB o~ ! B

el AL s
Al -

| T Times Hew Roman

=/

r

Tl e s v EEa B|[EEmmmnnn 1]

TELEPHONE, ETU I

0]

NTER. LASER

LATHE, ENGI
SV

'UTER, PENTIUM III
COMPUTER, PENTIUM I

{ELD COMPUTER
{ELD COMPUTER

Wl rrecoea |1
eady

SEOO0NO00YET
IRREITNIPLM

i

I 6NF

T025703616122

751

You can also double-click on the column heading.
you selected.

1.

=181

STEP:

Click on the column heading you wish to
change. In this exercise, click on the
Actual_Cost column heading.

Using the Formatting toolbar, change the
type of font you wish to use.

You can also use the Formatting toolbar to
change the size, alignment, style, and color
of the font.

It will display the Column Dialog box for the the column

Click on the Font tab to display the font attributes.

2. Make any necessary changes. Notice that in the Sample box, a sampling will be displayed.
3. Click OK.

Example of the finished report:

CH 2
1 October 2004

EUREKA:Reporter Designer - [Untitled1]

File Edt View Inssrt Query Tooks Window Help

=1alx]
=181 x|

windaws Curency - ‘

uic B
HO1001
HQI001
HOQ001
HOL001
HQI00L
HQ001
HOL001
HO1001
HQI00L
HQ001
HOL001
HO1001
HQ001
HOQ001
HOL002
HQ1002
HQI002
HOQ002
HO1002
HQI002
HQI002
HOL002
HO002
HQI00Z
HOQI002
HOL002

Trinm

DEH|SE|smR- - |Fe en
! Hi L% ev By E|
i Tahoma =|f2 j”?1 U= |l|
Momen lj [BarCd
TRE CG0 12T 6000 2320010907291 3701 012221
LATHE, ENGINE 3411001364013 3701 167241
COPIER 575 XEROX 3610011297764 3701 167242
TRE LF 6000LE LT-60R3 3930000231015 701 167244
TELEFHONE, 3TUII S18000M000927 =701 167243
BARCODE READER 58383311 PLM B701 7251001101
ANSWERING MACHINE | 701000452825 3701 HQO001
MONITCR, 19" COLOR 7025000001952 =701 1593001
COMPUTER, FENTIUM III | 025010000562 =701 1593002
COMPUTEE, PENTIUM II | 7025010001217 =701 2334201
FPRINTER, LASER TF025010032221 3701 1593003
SERVER F025011725133 3701 1553004
HANDHELD COMPUTER. | 702301 NO00433 3701 HQOo1
HANDHELD COMPUTER. | 702301 MO00433 3701 HQoo2
TRE COO 1/2T 6000 2320010907891 702 167246
LATHE, ENGINE 3411001364013 =702 167247
COPIER 575 XEROX 3610011297764 B702 167248
TRE LF 6000LE LT-60RS 3930000251015 3702 167245
TELEPHCONE, 3TUIIT 518000M000927 =702 167243
BARCODE READER 53383311PLM B702 7251001102
ANIWERING MACHINE | 701000MA52825 3702 HQOo02
MONITCR, 19" COLOR TF025000001952 3702 1593005
COMPUTER, PENTIUM IIT | 7025010000568 =702 1553006
COMPUTER, FENTIUM II | 7025010001217 3702 233404
PRINTER, LASER. TFO25010032221 3702 1593007
SERVER TFO25011725133 702 1593008
L
Ready
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Moving Columns

If you decide that you do not like where a column is displayed in your query, you can simply move it.

1. Highlight the UIC column by clicking in the UIC column heading. Your cursor will change to a black
arrow when you place the cursor on the heading.

2. Click and drag the column (while still holding the click) into the first position of your report. As you
move across the screen, you will notice that there is a red line. Use this as a guide to where you want
to position the column.

3. Once you have positioned the red line to where you want the column to be located, release the click
on the mouse.

Example of the finished report:

& EUREKA:Reporter Designer - [Untitled1] ==l x|
X File Edt Wew Insert Query Tools ‘Window Help ===l
DEH Sha|s i~ |Ff e8|

SRR T
T Times New Foman Zlfe =B 7z u=== |M“ﬁ|

StockNhr HRHNheMj |BarCd Actual Cost =
TRE CGO 1/2T 6000 2320010907891 701 0012221 $27,439.00
LATHE, ENGINE 3411001364013 5701 167241 $11’5[]8,[][]
COPIER VS XEROX 3610011207764 S701 167242 $13,566.00
TRE LF 6000LE LT-60RS 3930000251015 701 167244 $27,633.00
TELEPHONE, 3TU III S512000H000927 5701 167243 $1.00
BARCODE READER 58383311PLM S701 7251001101 $2,532.00
ANSWERING MACHINE | 701000452825 701 HOQO001 $232.00
MONITOR, 19" COLOR 7025000001252 5701 1393001 $933.00
COMPUTER, PENTIUM 1 | 7025010000563 S701 1593002 $3,101.00
COMPUTER, PENTIUM 11 7025010001217 a0l 9334301 $5,365.00
PRINTER, LASER. 7025010032221 5701 1393003 $4’522,[][]
SERVER T025011725133 S701 1593004 $110,000.00
HANDHELD COMPUTER | 702501H000433 a0l HOQO01 $499,00
HANDHELD COMPUTER | 702501000433 701 HQD02 $499.00
TRK CGO 1/2T 6000 2320010907891 a702 167246 $27,439.00
LATHE, ENGINE 3411001364013 a702 167247 $11,508.00
COPIER 53Y3 XEROX 3610011207764 5702 167248 $13’555,00
TRE LF 6000LE LT-60RS | 3930000251015 S702 167245 $27,633.00
TELEPHONE, STU 11T 512000H000927 a702 167249 $1.00
BARCODE READER 52333311PLM 5702 7351001102 $2’532.[][]
ANSWERING MACHINE | 7010004452825 S702 HQO002 $232.00
MONITOR, 19" COLOR | 7025000001952 a702 1593005 $933.00
COWMPUTER, PENTIUM III | 7025010000562 5702 1393006 $3’ 101.00
COMPUTER, PENTIUM Il | 7025010001217 S702 933404 $5,365.00
7025010032221 a702 1593007 $4,622.00
7025011735133 5702 1393008 $11[],[][][],[][]

M e T P R T ann Ao . ';I

Ready [ MUM
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Deleting Columns
If you decide that you do not want a column to be displayed in your query, you can simply delete it.

1. Highlight the Bar Cd by clicking once in the heading area.
2. Depress the Delete key on your keyboard.

Example of the finished report:

& EUREKA:Reporter Designer - [UntitledL.igr] o _&l x|
EF Fle Edit Wiew Insert Query Took Window Help 18] %

EECIEFCIEE T R I

ENEEIEF AR V-1
[T Times New Foman Hijfe =& £ u|= - = |

UIC  |MNomen [Stockmbr HRHNbrM; | Actual_Cost =
HQI001 | TRK CGO 1/2T 6000 T0NeEe | S701 $27,439,00
HQL00! |LATHE, ENGINE 341001364013 5701 $11,508.00
HQL001 | COPIER 5YS KEROX 001297764 | 5701 $13,566.00
HQL001 |TRK LF 6000LBLT-60RS  |3030000251015  |3701 $27,633.00
HQL001 | TELEPHONE, STU 11 SIS000NO00SZ7 | 5701 $1.00
HQL001 |[BARCODE READER 53EBUELM 5701 $2,532.00
HQL001 | ANSWERING MACHINE |701000H453825 | 8701 $232.00
HQL001 |[MONITOR, 19" COLOR.  |7023000001932 | 701 $933.00
HQL001 |COMPUTER, PENTIUM [Il |7025010000368 | 5701 $3,101.00
HQL001 |COMPUTER, PENTIUM I |7023010001217  |3701 $5,365.00
HQL001 |PRINTER, LASER TomsalomEzzl | S701 $4,622.00
HQL00! |SERVER 02011725133 |8701 $110,000.00
HQL001 |HANDHELD COMPUTER |702501H000433 | 8701 $499.00
HQL001 |[HANDHELD COMPUTER |702301H000433  |3701 $499.00
HQL002 | TRK CGO 1/2T 6000 TN |S702 $27,439.00
HQL002 |LATHE, ENGINE 341001364013 5702 $11,508.00
HQL002 | COPIER 5YS KEROX 001297764 | 5702 $13,566.00
HQL002 | TRK LF 6000LBLT-60RS  |3030000251015 |72 $27,633.00
HQL002 | TELEPHONE, STU 11 SIS00NO00SZ7 | 5702 $1.00
HQL002 | BARCODE READER 53EBUELM 5702 $2,532.00
HQL002 | ANSWERING MACHINE |701000H452825 | 8702 $232.00
HQL002|MONITOR, 19" COLOR.  |7023000001932 |72 $933.00
HQL002 | COMPUTER, PENTIUM [Il | 7025010000568 | 5702 $3,101.00
HQL002 | COMPUTER, PENTIUM I |7023010001217  |3702 $5,365.00
HQL002 |PRINTER, LASER TomsalonEzI 8702 $4,622.00
HQL002 |SERVER 02011725133 5702 $110,000.00
L1101 007 T 6 BITITRT Dy %O ADTITED | 0 an hINnnA237. ELht] b ASE OO hd

Tl 4l Record [1 P o v

Ready [ om
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Freezin nfreezin lumn H in

When your query has numerous columns, it may be impossible to view them all at one time. Freezing a
column(s) helps you identify the content(s) of the row(s). When you freeze a column(s), they are moved
to the left-most position of your query. As you scroll to the right, the column(s) that you freeze will stay in
place, but the other columns will move. Unfreezing will return your query to its original state.

1. Using the table below, add the following fields:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Serial_Hand_Receipt Serial Nbr Fund Cd
Loc
Unit Activity Name

2. Highlight the HRH Nbr Mjr field by clicking once in the heading area.
3. Right-mouse click to display the shortcut attributes menu.
4. Select Freeze Column.

Attributes. ..
Font...
Translate Value. ..

Sork
Group

Count
in
Max

Freeze Column

Filker...

The HRH Nbr Mjr field is moved to the left-most position and there is a fine blue line separating the frozen
column with the unfrozen columns.

5. Scroll to the right.

Notice how the HRH Nbr Mjr field does not move but the other fields move.
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Addin m Column

1. Select the custom column icon or select Insert from the menu bar, and then select Custom.
2. Enter an Object Label of your choice.

3. User Function: Check this box if you want to
Gt |Fogt | Tnsite| pull in calculations that are not defined by the
o _ database administrator.
ObictLabe fnlton Eot [ eerfieien 11 4 Double-click on the Detail folder.
vt Cost = 103 =] 7| 8| 9] « 5. Double-click on the Actual Cost field. You can
il 1|1 choose values for your custom column either by
8 EREE selecting the Columns tab (this is the Object
Directory) or clicking on the Detail folder (these
Qolumnslm Brawse |Euncti0n| T}'DEZINumeric jv are the fle|dS y0u Selected for your I‘epor‘t) ora
= Detall N Format:lﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ vl Comb|nat|0n Of both.
i Ohrace 15— 2] 6. Click on the X (multiply) button.
::‘tg:bg:is[t Aggregate Function:lm 7. Enter -03 (thIS iS jUSt the |nﬂat|0n amount). If
uc you want the total inflated cost, the formula must
erhr & be Actual_Cost * 1.03.
4 »
’TI Cancel | Help |

Example of the finished report:

g}'EUREKA:Reporter Designer - [Eureka 7 Reports.iqr]

E! File Edit Yiew Insert Query Tools ‘Window Help == =]
DESHESREm| @ =~ |Fx|[Ow|
L ERNEE R A Y -
I':ﬂ'jTimesNewF!oman j“‘lﬂ j|B FANN |§ = |.|' I j‘
HRHIMNbrMjr |Loc om_ A
3701 BLDG 24 DEFENSE FINANCE & 2 UNTING SERVICE-TRAINOL
3701 BLDG 24 L3 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 34524
3701 BLDG 24 L3 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL A06 98
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 22899
3701 BLDG 24 L3 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 0.o3
3701 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL T506
3701 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 6.96
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 2709
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 0303
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 16095
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 138 66
3701 BLDG 24 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 3300.00
3701 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 14097
3701 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 14097
3701 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL 14097
2802 BLDG 15 c1 DEFENSE FINANCE & ACCOUNTING SERVICE-TRAINOL #2111 Ij
Ml [ Recora [16 ]I >
Ready [ [ [ |
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Applying Filters

Apply filter conditions to help narrow down database output so that it includes only the relevant data that
you selected.

Filters are defined in the QuickQuery window using displayed values.

1. Click onthe ™ icon.

Sort Order/Filter: Dy My

2. Double-click on Actual_Cost.

Biter | ot Orcer | 3. Set the Operator to <= (less than or equal to).
— Select Query Data ‘When oA 4 Enter 5000 |n Value]..

Object: Operator: WValuel: ialued: Group

| [« =l &

0: Actual C s Than or Equal To 5000

{-\ﬂ*"“’@ NOTE:
\ > Remember the RULE for OR’d Group
7 numbers on any two statements are the

Columns [ Objects Browse| | 20 Modity Delete | same, those two statements are connected
bet;ilomen I Disinct Vebass Orip_[Fier Tymes by the AND condition. If the OR’d Group

Sttt o & Cunert numbers on any two statements are

. uztom Uvernde: -
HRHNbikir — (‘: 238: different, those two statements are
oc pe

U ~ Quick Fiters connected by the OR condition.

SenialMbr

E L hd -
i . -

5. Click Add to activate the filter. If you have an

| existing filter and you need to change it, highlight
the condition, change the condition and then click
Modify. If you have an existing filter that you no
longer need, highlight the condition and click
Delete.

Distinct Values Only: Check this box when you want to eliminate any duplicate rows.

7. Custom Override: This displays any overriden SQL statements.

Filter Types

o

Current Displays the current filter(s) that is in effect.
Base These are always in effect and have no conditions defined, and perform no filtering.
Ad Hoc These are defined in the QuickQuery window using displayed values.
Quick These are given a name and saved. These filters can only be created using the QuickQuery window.
8. Click OK.
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Building A QuickQuery Without The Query Wizard

Example of the finished report:

g UREKA:Reporter Designer - [Untitled2]

E‘ File Edit Wew Insert Query Tools Window  Help == x|
DR gRem 2B o | F e
A EEEEE AR T

[T Times New Roman 3 || T [ 3 A = =]
HEHNbrAj (Nomen StockNbr SerialNhr Loc =
701 TELEPHONE, ST 11 518000MO00527 1,00 324230R ELDG 24
701 BARCODE READER 58383311PLM 25372, ()| ERD-001.001 UNASSIGNED
701 ANSWERING MACHINE | 701000N452825 232.00 AF-0! UNASSIGNED
701 MONITOR, 19" COLOR. | 7025000001552 933,00 173004103 ELDG 24
701 COMPUTER, PENTIUM III | 7025010000568 3101.00/5%667% ELDG 24
701 PRINTER, LASER 025010032221 46272.00 | 777664ED ELDG 24 —
701 CPIU, DESKTOP 02501 FO03222 499,00 TODAYTEST UNASSIGNED
701 HANDHELD COMPUTER. | 702501000433 499,00 53001 UN ASSIGNED
701 HANDHELD COMPUTER. | 702501000433 499,00 535002 UN ASSIGNED
802 CPII, DESKTOP 021703511000 273700 00344801 ELDG 15
802 MONITOR, 17" 100HS 025705616122 565.00 1997341 ELDG 13
2702 TELEPHONE, 3TU I 518000M000927 1,00 72423081 ELDG 3
2702 BARCODE READER 52323311PLM 25372, ()| ERD-001-002 UN ASSIGNED
2702 ANSWERING MACHINE | 701000M452825 232,00 AF-002 UN ASSIGNED
2702 CPU, DESKTOP 021703511000 499,00 TESTING: UNASSIGNED
2702 CPU, DESKTOP 021703511000 499,00 TESTINGS UNASSIGNED
M 4Recora [17 DD | ;lJ
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Building A QuickQuery Without The Query Wizard

Sorting Columns
Use the Sort function when you want your data sorted in a particular order (ascending or descending).
1. Highlight the Nomen field by clicking once in the heading area.

z
2. Click on the %l (to sort in ascending order) or ﬁl (to sort in descending order) from the toolbar.

Example of the finished report:

Q’.:"EUREKn:Reporter Designer - [Untitled2]
%? File Edit ‘iew Insert Query Tools ‘Window Help =&l
DEH SRm|[L @0~ |[Ffy e

JIENEE=APF A AR YA

JJ|'@ Times News Raman j“m j| B U | E = = |£I | I~
HRHMNbhrMj | Nomen Stocklbr Actual_Cost SerialMbr Loc =
=701 ANSWERING MACHINE | 701000M 452825 232.00 AF-001 UNASSIGHNED
=702 ANSWERING MACHINE | 701000M452825 232.00 AF-002 UNABSIGHED
3703 ANSWERING MACHINE | 701000M452825 232.00 AF-003 UNASSIGHED
2704 ANSWERING MACHINE | 701000N452825 232.00 AF-004 UNASSIGHNED
2705 ANSWERING MACHINE | 701000M 452825 232.00 AF-005 UNASSIGHNED
2706 ANSWERING MACHINE | 701000M452825 232.00 AF-006 UNASSIGNED =
=707 ANSWERING MACHINE | 701000MN452825 232.00 AF-007 UNABSIGHNED
=702 ANSWERING MACHINE | 701000M 452825 232.00 AF-003 UHNASSIGHNED
2709 ANSWERING MACHINE | 701000N452825 232.00 AF-009 UNASSIGNED
210 ANSWERING MACHINE | 701000M 452825 232.00 AF-010 UNASSIGHNED
2T ANSWERING MACHINE | 701000452825 232.00 AF-011 UNASIIGNED
2712 ANSWERING MACHINE | 701000M452825 232.00 AF-012 UNASSIGNED
2713 ANSWERING MACHINE | 701000M 452825 232.00 AF-013 UHNASSIGHNED
2714 ANSWERING MACHINE | 701000N452825 232.00 AF-014 UNASSIGNED
=715 ANSWERING MACHINE | 701000M452825 232.00 AF-015 UNABSIGHED
a7la ANSWERING MACHINE | 701000M452825 232.00 AF-0la UNASSIGHED =

I Record [1 IR | ;IJ
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Building A QuickQuery Without The Query Wizard

roupin n

r

in lumn

Use the Group function when you want your data grouped by like items.

1. Highlight the HRH Nbr Mjr by clicking once in the heading area.
2. Right-mouse click to display the shortcut attributes menu.
3

Select Group.

-OR -

4. Click on the B button from the toolbar. (If you want to ungroup, simply highlight the grouped

column and click on the button.

5. Save your report as QQGROUP.
6. Close your report.

Example of the finished report:

E'.:"EUREKH:Reporter Designer - [Untitled2]

E? File Edit Yew Insert Query Tools MWindow Help =18 x]
DEHSREm 2@~ |[Ffy e

WE X! o2 |E% %Y B H

I']]j Times Mew Roman j“m j| B I U |§ = = |£I I j
HRHNbrMj | Nomen StockNbr Actual Cost SeriallNhr Loe E

LATHE, ENCINE 3411001364013 43722,00 1BL0009 BLDG 27 SEC 7

N151 TELEPHONE, STU III S18000N000927 1.00 | 120sT000 BLDG 27 8EC 7
N151 EARCODE READER 5§3%331 1PLM 25372, 00| EFD-01028 UNASSIGNED
H151 ANSWERING MACHINE | 7010001452525 232,00 AF-0008 UNASSIGNED
151 MONITOR, 19" COLOR. | 025000001952 933,00/ 178201 LMo BLDG 27 SEC 7
H151 COMPUTER, PENTIUN I | 7025010000565 3101,00 00-KM-009 BLDG 27 SBC7  —
N151 PRINTER, LASER 025010032221 3622.00 %771-LF-0009 BLDG 27 S 7
N151 HANDHFLD COMPUTER | 702301000433 499.00/|33-010-017 UNASSIGNED
N151 HANDHELD COMPUTER | T0Z301M000433 499,00 |2-010-0: UNASSIGNED
Ni3z CD ROM 025703601000 123,00 |vD-3221115 BLDG 222435
Hi52 MONITOR, 17" 100HS 025703616122 455,00 3234201010 BLDG 22
190 LATHE, ENCINE 3411001364013 43722,00 61000100019 ELDG 74
N190 COPIER Y3 XFROX 3610011297764 23727, ()() | 6100DL0034223 UNASSIGNED
M190 TELEPHONE, STU III S18000N000927 1,00/ 3180570001 ELDG 74
M190 EARCODE READER 5§38331 1PLM 2633.00|Ec-300-007 UNASSIGNED
Mis0 ANSWERING MACHINE | 7010001452525 232,00 | AF-0010 UNASSIGNED

M 4] Record [45 [Tl e | ;'J
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Activity: QuickQuery Without The Query Wizard

Activity: QuickQuery Without The Query Wizard

nt Hands-On With Instr r Direction
Unit of Study: QuickQuery (without the Wizard)

Application: This activity will be used to apply what you have learned in the previous lesson. You will
build a query without the wizard and then use various functions to manipulate your data.

Report Type: This report will display assets with acquisition cost, filtered by major hand receipt
holder number and grouped by nomenclature.

Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Select the following fields for your QuickQuery report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog ARC Stock Nbr
Nomen
Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Rcpt.-Auth |Acq Cost Auth Qty
Cond Cd Qty On Hand
3. Change the name of Acq Cost to Actual Cost or a comparable term.
4. Delete the ARC.
5. Group on the Nomen.
6. Count on the Nomen.
7. Build a Custom Column labeled Over/Short.
8. Subtract the Qty On Hand from Auth Qty, which will equal the Over/Short column.

9. Filter for HRH Nbr Mjr Like W*,

10. Sum on the Acq Cost.

11. Save the report in the Eureka folder on your Desktop as QQACTY.
12. Close the report.
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Activity: QuickQuery Without The Query Wizard

Example of finished report:

a?EUREKn:Repurter Designer - [Untitled3]

E!Eile Edit Yiew Insert Query Tools Window Help ;Iilﬂ
EEEIEEE T

E-NEERE =R A4 Y -]
|

Jl'ﬁ| Times Mew Foman j“w j| B 7 I |§ = = |£| I j ‘
Nomen |Smckor |HRHIVhrMj | Actual Cost CondCd| AuthQty | QiyOnHand| OverShort | =
TO1000H 452525 WOUZE & T500 | A 3 1 2
ANSWERING MACHINE | T01000H452525 WIUGCE T500 A 3 1 2
ANSWERING MACHINE | T01000H452525 WOVG3S 7500 A 3 1 2
ANSWERING MACHINE | T01000H 452525 VWOVLOS 7500 A 3 1 2
ANSWERING MACHINE | T01000H 452525 WOVEAM T500 | A 3 1 2
ANSWERING MACHINE | T01000M 452525 WITLE 500 | A 3 1 2
ANSWERING MACHINE | 701000452525 WD T500 | A 3 1 2
ANSWERING MACHINE | 701000452525 WIEALL T500 | A 3 1 2
ANSWERING MACHINE | T01000N452525 WIHCRZ T500 | A 3 1 2
ANSWERING MACHINE | T01000N452525 WINV04 T500 | A 3 1 2
ANSWERING MACHINE | T01000H452525 WINWSA T500 | A 3 1 2
ANSWERING MACHINE | T01000H452525 WIVSO7 T500 A 3 1 2
ANSWERING MACHINE | T01000H452525 VWINETS 7500 A 3 1 2
ANSWERING MACHINE | T01000H 452525 WWEVE10 7500 A 3 1 2
ANSWERING MACHINE | T01000H 452525 Wa020 T500 | A 3 1 2
ANSWERING MACHINE | 7010001452525 WATE10 500 | A 3 1 2
ANSWERING MACHINE | 701000452525 WARJE6 T500 | A 3 1 2
ANSWERING MACHINE | 701000452525 WEBZTAZ T500 | A 3 1 2
ANSWERING MACHINE | T01000N452525 WOdAL A T500 | A 3 1 2
ANSWERING MACHINE | T01000N452525 WDOTAG T500 | A 3 1 2
Court |20
Sum | ANSWERING MACHINE 130000
IT LITr o4, RIS ATIC ST LRLON 120 ATAD TEROTTOS A 1420 N0 A a ] nl T
M4l Record |51 ISR | »IJ_
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Skill Builder: QuickQuery Without The Query Wizard

Skill Builder: QuickQuery Without The Query Wizard

Objectives: You will:
e Review Building a QuickQuery Without The Query Wizard (Exercise below)
e Discussion Questions
e Practical Exercise to build a QuickQuery Without The Query Wizard

Complete the following exercise:

1. Outline the steps to perform when setting your preference for Manual Re-Query

2. What action(s) take place when you depress the F2 key?
3. You cannot change the name of a column heading. (True or False)
True False

4. To delete a column, you first the column then depress the key on
your keyboard.

5. When your query has too many columns, it may be impossible to view them all at one time.
a column helps you identify the content(s) of the row(s).

6. are used when you want to apply values to a query that are not avail-
able in the database.

7. You display the shortcut attributes menu by doing a
with your

8. Where is the keypad located that enables you to create numerical calculations?

Discussion Questions:

1. Review the Grouping/Ungrouping Column Function.

2. Discuss why you would use and what are the advantages of QuickQuery without using the
Query Wizard.

3. Describe the Ad Hoc Filtering process.
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Practical Exercise: QuickQuery Without The Query Wizard

Practical Exercise: QuickQuery Without The Query Wizard

Independent Student Report
Unit of Study: Building A QuickQuery Without The Query Wizard

Application: This activity will be used to apply what you have learned in the previous lesson. You will
build a query without the wizard and then use various functions to manipulate your data.

Report Type: Asset listing by major hand receipt holders beginning with “W”, grouped by
nomenclature, displaying actual dollars or quantity on hand.

Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Select the following fields for your QuickQuery report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Catalog Nomen Local Use
Stock Nbr

Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Receipt Acq Cost
Serial_Hand_Rcpt.-Auth. |Qty On Hand

Change the name of the Acq Cost column.

Delete the Local Use column.

Group on Nomen.

Build a Custom column labeled Total Cost.

Multiply Qty On Hand by Acq Cost.

Change the Format to Windows Numeric.

Filter on HRH Nbr Mjr Like W*,

10 Sum for on the Custom column.

11. Save the report to the Eureka folder on your Desktop as QQPE.
12. Close your report.

©ONOUT AW

CH?2 47
1 October 2004



Practical Exercise: QuickQuery Without The Query Wizard

Example of the finished Report:

E8 EUREKA:Reporter Designer - [QQPE.igr]
=F Fle Edt Yew Insert Query Tools ‘Window Help == =]

DEHSRm|) 2o |[Ffy(en]
BE xtoE 2 R% v BB

I'_|11 Times New Roman j“‘ID j| B 5 U |§ = |£I I j ‘

MNomen StockINbr HEHMbhrDj | Actual Cost QiyOnHand| Total Cost J
AMNZWERING MACHINE | 701000H452825 WATEL0 75,00 1 7500
ANIWERING MACHINE | 701000H 452825 WARS20 75.00 1 7a00
AMNZWERING MACHINE | 701000H452825 W3AVE10 75,00 1 7500
ANIWERING MACHINE | 701000M 452825 WL 3 75.00 1 7500
AMNZWERING MACHINE | 701000H452825 WLVSUT 75,00 1 7500
ANIWERING MACHINE | 701000M 4352825 WSS 75.00 1 7500
AMNZWERING MACHINE | 701000H452825 WHV04 75,00 1 7500
ANIWERING MACHINE | 701000M 4352825 WIHCRZ 75.00 1 7500
AMNZWERING MACHINE | 701000H452825 WIEALL 75,00 1 7500
ANIWERING MACHINE | 701000M 4352825 WIDC11 75.00 1 7500

ANIWERING MACHINE | 701000H452825 WYL 75,00 1 7500 =
ANIWERING MACHINE | 701000M 4352825 WOVE A 75.00 1 7500
AMIWERING MACHINE | 701000H452825 WOVLOS 7500 1 7500
ANIWERING MACHINE | 701000M 4352825 WOV 75.00 1 7500
AMIWERING MACHINE | 701000H452825 WIUECE 7500 1 7500
Sum ANSWERING MACHINE 1,500000
AV HVEY AN/AVIE-AVIZ [3855011384748 WIUECE 14245.00 2 2073200
AVHVIY ANFAVEA(V)Z | 5233011334742 WOUECE 14269.00 2 2073200
AV HVEY AN/AVIE-AVIZ [3855011384748 WOVE3S 14245.00 2 2073200
AVHVIY ANFAVEA(V)Z | 5233011334742 WAOVGEES 14269.00 2 2073200
AV HVEY AN/AVIE-AVIZ [3855011384748 WOVLOS 14245.00 2 2073200
AVHVIY ANFAVEA(V)Z | 5233011334742 WAOVLOS 14269.00 2 2073200

TT LITX i, BRI A TTCE ST LOLINT 120 AT AP TEMNUTDA®N 1. A2E0 NN 2 A0 T N0 x

] 4] Recaord 51 DI I;IJ_
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Building A Summary QuickQuery

Building A Summary QuickQuery

Unit of Study: Creating Summary Documents. A Summary Document provides summary information
instead of detailed information. This reduces the amount of detail—multiple rows are aggregated
together.

Application: This report is used when only summary information is requested.

Report Type: A summary report of all Hand Receipt Holders showing the total value of all their
assets.

Activity: Student Hands-On with Instructor direction
Instructions:

1. Open a new QuickQuery report without the Wizard.
2. Depress the F2 Function Key if your object directory is not open.
3. Select the following fields for your QuickQuery report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! HRH Nbr Mjr
Acq Cost

4. Double-click on the Acq Cost column heading.

5. Click on the drop down arrow for the Aggregate Function.
6. Scroll and select Sum.

7. Click OK.

8. View report.

9. Close the report.

10. DO NOT save the report.
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Building A Summary QuickQuery

Example of the finished report:

& EUREKA:Reporter Designer - [Untitled3]

e

275083.00
7200
262871.00
97700
281731.00
1777.00
28328000
1777.00
28326500
1777.00
28396500
1777.00
28272400
1777.00
28312000
1777.00
247399300
1166.00
47322800
1385.00
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Building A Quick Filter In QuickQuery

Building A Quick Filter In QuickQuery

Unit of Study: Creating Quick Filters in your QuickQuery Documents.

Application: Use this function when you want to reduce the amount of detail information on your
query.

Report Type: UIC total dollar amounts under each individual fund code.
Activity: Student Hands-On with Instructor direction

Instructions:

1. Open a new QuickQuery report without the wizard.

2. Depress the F2 Function Key if your object directory is not open.
3. Select the following fields for your QuickQuery report:

BUSINESS VIEW: DEPRECIATION EXPENSE

FOLDER DATA ELEMENTS
Catalog Stock Nbr
Serial_Hand_Receipt Acq Cst Serial Nbr
Fund Cd UIC

g EUREKA:Reporter Designer - [Untitled2]
E!Eile Edit  Wiew Insert Query Tools Window Help

DEH SR 2r- = |F (e

BB |22 L2%v By H|

I':ﬁj Times New Roman L”I‘ID LI| B I U === |M|I_

AcqCost FundCd | StockMNbr SerialMbr c

445.00 [FB 1005000735421 | 1892874P5-01 W1DCO3
445.00 |FB 1005000735421 | 1892874P5-02 W1DCO3
445.00 |FB 1005000735421 | 2226201 WIMKAA
446.00 |FB 1005000735421 | 22262-02 WIMKAA
446.00 |FB 1005000735421 | 4259830-01 WLNVO3
446.00 |FB 1005000735421 | 4259830-02 WLNVO3
445.00 |FB 1005000735421 | 4751401 WIHCAA
445.00 [FB 1005000735421 | 47514-02 WIHCAA
44600 1005000739421 |48174178-01 WoAAAL
44500 P4 |100500073942L | 48174175-02 WCALAL
44500 |FB 1005000739421 | 4871301 WOUGAAS
44500 |FB 1005000739421 | 48713-02 WOUGAAS
4500 (P4 [1005000739421  |487141091-01 WDCTIM

4. In the Fund Code Column, highlight one cell of Fund Code PA.

5. Click on £ (Apply Filter Icon). This will apply a filter to the current section. This action will

automatically filter your report to show only the assets with the fund code of PA.

CH2 51
1 October 2004



Building A Quick Filter In QuickQuery

Example of the finished report:

& EUREKA:Reporter Designer - [Untitled1] S & x]
EF Fle Edt Yiew Insert Query Tools indow Help =18 %]
DEMSRm|i el - 7% (0w
T @ || %%V B |
[ Tmes New Fomen i | [ |- - ‘
AcqCost FundCd | SeriallNbr StockNbr uic =]
4600[FA  |48174175-01 1005000730421 | WCAAAA
M600[PA  |4BIT417802 1003000739421 | WCAAAA
M600[FA  |4E714100101 1005000730421 | WDCTOM
M600[FA  |4E714100102 1005000730421 | WDCTOM
M600[PA | 389T2LKF-01 1003000739421 | WATH09
M600[PA | 389TILKF-02 1003000739421 | WATH09
4600|FA  |FE2075.01 1005000730421 | WOUZAA
M600|FA  |FE20875-02 1005000730421 | WOUZAA
M600[PA  |HTED919.01 1003000739421 | W69y
44500|PA  |HTEO919-02 1005000739421 | WWds907
M600|FA  |KF30127401 1005000730421 | WAXAA
M600[PA  |KFa9IZ7402 1003000730421 | WAL
M600[PA | XSWHUINLOL 1003000739421 | WBZTAA |
M600[FA | HEWOUONL0Z 1005000730421 | WEZTAA
31600[FA  [3252501 1005006780838 | WATS0D
31600[PA  |3252502 1003006789828 | WATHOY
31600[PA  |489714R01 1003006789838 | WDCTOM
31600[FA  |480714R-02 1005006789838 | WDCTOM
31600 |FA 01 1005006780838 | WCAAAA
31600[PA | 576839090002 1003006789838 | WCAAAA
31600[PA  |RQZILOL 1003006789838 | WOUZAA
31600|FA  |RQ232-02 1005006780838 | WOUZAA
31600[FA  |RT20901-01 1005006789838 | Wd6o07
31600[PA  |RT29010Z 1003006789838 | WHI6907
31600[PA  |T28949-01 1005006789838 | WEZTAA
31600[FA  |T28040-02 1005006780838 | WEZTAA
31600[PA | TU13508-01 1003006789838 | WANOAA
31600[PA | TU13908-03 1003006789838 | WAXDAA
38500[FA  |4897113101 1005013368365 | WOUZAA
38500[FA  [4897113102 1005013368365 | WOUZAA
38300[PA  |525258DT-01 1003019368265 | WATH09 'j
M 4TRecord [1 WMl <] I+
Ready [ |mum

6. At the menu bar, select Query>Filter>Save As.

Tools  window Help

“Wizard, .,
TM1 Cube Wizard. .,

Sort Order...

Cuick Filkers. ..

Setup...
Defaul: Font, .,

Please enter Quick Filter name: IFund Code PA
coen |

8. Click OK.

9. Click on % (Clear Filter Icon). This action will clear your document of the Quick Filter.
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Building A Quick Filter In QuickQuery

10. At the menu bar select Query>Quick Filters...

ety
Wizard, ..
TML Cube \Wizard, .,

Sort Order. ..
Filter 3
Guick Filters. ..

Sekup...

Default Font. ..

Database Connection Crverride. ..
QL Dverride, .,

Cache Override...

QuickQuery Properties, .

View

Refresh Cache

This will bring up the Quick Filter Screen that will list your Quick Filter. From here you can select the listed
filter and it will apply it to your document.

11. Highlight Fund Code 98.
12. Click OK. Your document is now filtered again by the fund code of 98.

Qe

Wizard. ..
THM1 Cube Wizard. ..

Sort Order, .,
Filter 3
Quick Filters, .,

Setup...

Default Font. ..

Database Connection Crerride. .
SgL Override. .

Cache Cwverride, ..

GQuickQuery Properties. ..

Views

Refresh Cache

13. Clear the filter by using the Clear Filter Icon.
14. Repeat the process for Fund Code PA (start at Step 4 through Step 8).
15. After filtering by PA, save your report as QQFILTER, we will be using it in the next exercise.
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Building Translate Values Using QuickQuery
Unit of Study: Creating Translate Values within a Document.

Application: Value translations allow you to substitute one value for another.
You can use value translations to:

Replace a technical term or code with a familiar term

Draw attention to a significant value

Add more information about certain values
Express a numerical month as an alphabetic month

Report Type: Continuation of fund code report (QQFILTER) translating dollar amount.

Activity: Student Hands-On with Instructor direction

Instructions:
1. If closed, open QQFILTER report.
2. Double-click on the Dollar Amt column heading.
3. The Column Dollar Amt window will appear.
4. Select the Translate tab.
5. Double-click on the Detail folder in the Object Source.
6. Double-click on Dollar Amt to move it to the Object field.
7.  Set the Operator to >= (greater than or equal to).
8. Enter 100000 in Valuel.
9. Then Become: Enter "CAPITAL ASSET".
10. Click Add Case.
11. Otherwise Become: Enter "NON-CAPITAL".
Column: DallarAmt (Untitledl.igr)
Column | Font  Translate |
Object: Operator: Walue 1: el 2
Whenl b- =l ! Add Case Activates your condition.
then Become: ICAF'TIAL ASSET
Delete Case This will remove an
Dollardmt Greater Than or Equal To 100000 Become CAPTIAL ASSET [Value] eXiSting Condition. YOU
q | O will ngedt tt:)o Pighlight the
- Object Source fdd Case I [elete Case [ adify Case | (S:ZIS:CtIEfIIS suﬂsnyou
Otherwize Become
& Dollatbmt |DD||a,;mt Modify Case This will allow you to
FundCd _ — make a change to an
o= | [ existing condition. You
EI| _.|—| will need to highlight the
case first before you
select this button.
QK Cancel Help
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Building Translate Values Using QuickQuery

12. Click OK.
13. Save your report.
14. DO NOT close the report — we will continue to use it in the next Unit of Study.

Example of the finished report:

g.:"EUREKA:Reporter Designer - [CZ2-61.iqr]

E_! File | Edit  Wiew Insert Query Tools ‘Window Help =1
[oedglm|ima- |7z |ew|
|8 ||x ¢ e8| 2% %Y & B
“I']lﬂ Times Mew Roman j ||1U j| B I U | E = = | .|'| I j ‘
DollarAmi FundCd | Seriallhr StockNhr uIc I
CAPTIAL ASSET |C1 64634563446 025011725133 HGLO0L
CAPTIAL ASZET |C1 SHAARIA6344T FO25011725133 HO1o02
CAPTIAL ASSET |C1 ShddE350344E T025011725133 HOQ1003
CAPTIAL ASZET |C1 6440345634471 FO25011725133 HOL005
CAPTIAL ASSET |C1 SodsA34563447 20 TO25011725133 HOQ1006
CAPTIAL ASEET |Cl 6446345653446 TO025011725133 HO1001
NON-CAPITAL |C1 SHAAG34563446 025011725133 HO1001
NON.CAPITAL |C1 3644834565446 TO25011725133 HO1001
CAPTIAL ASZET |C1 34567 F021035000322 HO1020
CAPTIAL ASSET |C1 34567 TO21035000333 HOQ1020
CAPTIAL ASZET |C1 34568 FO021035999332 HO1020
CAPTIAL ASSET |C1 34569 021035999373 HOQ1020
CAPTIAL ASEET |Cl 34568 TO021035000332 HO1020
CAPTIAL ASZET |C1 34569 T021035999322 HO1020
4[4l Recard [1 3 N | »IJ
Ready WM |
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Exporting Your Query

INTRODUCTION

If you want to share your query or output document with someone who does not have the Eureka
software, then you can export the data to another application.

Exporting a document creates a file in the format you choose. You can export from QuickQuery
windows, FreeForm windows, and output windows.

When you export from a FreeForm window or QuickQuery window, Eureka Reporter Designer submits
the query, formats the data if necessary, and exports your document.

When you export from an output window, Eureka Reporter Designer exports the already-created
output.

Reports or data can be sent to a comma-delimited files, or most commonly to a text, Excel, or HTML
file.

OBJECTIVES

To show how a user can provide the results of a Fureka Report electronically to someone who does
not have Eureka on their PC.

APPLICATION

The most common use of this function is to send information which a user pulls out of £ureka, and
wants to share it electronically with someone who does not have Eureka installed, but does use a type
of file, like Excel or an Internet Browser (HTML).

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.
ACTIVITY
Student Hands-On with Instructor direction

REPORT TYPE

We will use the Fund Code report (QQFILTER) for exporting.
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STEPS TO PERFORM ACTION

1. If closed, open the report named QQFILTER.
2. Select the Export icon &

-OR-

Select File from the menu bar.

Select Export... from the program group.
Change Save in to Desktop.

Change Save as type to Excel File (*.xls).
Click Export.

Nounhrw

If you have any quick filters in your report, the Quick Filter selection window will display. If this happens,
just click OK.

\’O\ NOTE:
\ \////2 There are several different formats that you can export to (i.e., HTML, text file, Excel file).
\Z

8. Close your report.
9. Double-click on QQFILTER.xIs from your Desktop.

Example of the finished report:

™ Microsoft B
”E File Edit View Insert Format Tools Data Window Help _Iﬁllil
DEEESRAY s2ad > « @z s 4indg -0
A w0 -B7USE=E %%, $8EE _-0-A-
A1 j =| DollarAmt
A | s | ¢ | b [ E | F [ & | H [ 1 T b [ ¥k
1 |DollarAmt IFundsd  SerialMbr StockMbr Iz =
| 2 | o1 SE4AR3AE63446  FO25011725133 HR1001
| 3 | 0 SE4ARZAEE3447  TO250117251535 HO1002
| 4 | o SB4AG34563445 7025011725133 HQ1003
| 5 | 01 SE4AR345634471 025011725133 HO1005
| B | 01 SE4AR34563447 20 FO25011725133 HO1005
| 7| 0 SEAAE34EE3445  FO25011725133 HQ1001
| 8 | 0 SE4AR3AEE3446  TO25011725133 H10M
| 9 | 01 SE4AR3AE63446  FO25011725133 HR1001
| 10 | 0 SE4ARZAEE3446  TO250117251535 HQ1001
1Al
12,
13
14
15
15
17
18
15
0
21
22
4[4 |» | ¥ Sheet1 |4
”Dguwv%@j AgfoShupssv\\DO‘|&viv&v —ﬁ.e‘
Ready —r— [ [ m®m[ [ [
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Emailing Your Query

INTRODUCTION

It is possible to share query/report results with others by attaching the query/report to an electronic
mail.

OBJECTIVES

To practice and learn how to attach files to electronic mail.
APPLICATION

Used to email your queries to other users.

REPORT TYPE

Fund Code report (QQFILTER).
PREREQUISITES
Eureka Reporter Designer is appropriately loaded and configured.

ACTIVITY

Instructor-led lecture
STEPS TO PERFORM ACTION

If the recipient is located on your email server, use these steps:

1. Open the QQFILTER report.
2. Select Eile from the menu bar.
3. Select Send Mail... from the program group.

If the recipient is NOT located on your email server, you will need to open your email application and
type in the recipient’s email address and send the query as an attachment.
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Page Setup

INTRODUCTION

Setting up your page allows you to control the appearance of your document through several page
options, including titles, page numbers, layout, margins, borders, headers and footers, background
images, etc.
OBJECTIVES
To practice and learn how to change the page setup.
APPLICATION
Used to set up page headers, footers, page numbers, etc.
REPORT TYPE
None
PREREQUISITES
None

ACTIVITY

Instructor-led lecture
STEPS TO PERFORM ACTION

1. Select Eile from the menu bar.
2. Select Page Setup... from the program group.

x| STEP 1:
Page |Header.-"Footer| QuickQueryI i
~Page Size———— - Page Margin a. Page Size: This option is not available in
Height: I I Top: E In. Left: IF In. QuiCkQuery.
witk [ I oo [15 [2]in fighe [55 3] in b. Page Margins: Your page margins are
defaulted to the current Windows settings,
Rzl -F'(rijting but you can change, if needed.
[ Seale bo Fit .
N of Colanrs: [ e seer [ % c. Page Layout: Page layout controls how
& Down than asross _ dqcuments that_ are W|de_r than your
€ Across then down ‘fﬂdu . printer’s page size are printed (when they
SE AT .
— Center on Page Orientation CellHeinht l— s are_ no_t scaled to ﬂt the page)' . .
I Vettical £ Portait - _ d. Printing: This option is not available in
v Huorizontal ! Landscape (ol I i QuiCkQuery.
Save &s Defaults_| e. Center on Page: Select how you want
your output displayed on you page.
T He || f. Orientation: This option is not available
in QuickQuery.
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g. Grid: This option is not available in QuickQuery.
h. Select the Header/Footer tab.

STEP 2:

a. Click the location where you want to insert the
item (for example, if you want it centered on the
first line of the header, select the header page
and click in the first cell under Centered.

b. Use the tools along the side of the screen to
change the font, enter the application name, file
name, add page numbers, and add the date to
your report.

c. Click the Footer tab.

Page Setup m

Page Header / Footer | Quickﬂuer}ll

—Header/Footer

Left Aligned | Centered Right Aligned ||
30 Sage §F OFf $rl

5 W SN ER ST S

-

Header iy Footer f

Header: |0.0 @n. Footer: IDD En. First Page #: |auto

Save As Defaults |
Cancel | Help |

i~ Distance to Frame: "Paga Mumbering:

Page Header / Footer | QuickDuewI

~Header/Footer
Left Aligned [ Centered rightpiigned  [=] A
=
— &
&
Header F Footer Vi
r— Distance to Frame; Page Mumbering:
Header: IU.U—H. Footer: IU.D—n. ’7 First Page #: W
Save Az Defaults

Cancel Help |

STEP 3:

The default is to print the date and time on the
bottom left and then the page number on the
right. These can be changed.

ooo

d.
e.
f

g.

Delete the page number from Right Aligned.
Click in the first cell of the Centered column.
Enter Page and then add a space.

Click on .
Position your cursor after the $P.
Enter Of and add a space.

Click on &l . This will cause your page
numbers to read: Page X of XX.

h. Distance to Frame: To change the distance between the header or footer and the frame containing
the QuickQuery, enter the distance you need in the Header and Footer boxes.
i. Page Numbering: If you wish the page numbering to begin with a specific number other than 1,

enter it in this box.
j.  Select the QuickQuery tab.

CH 2
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STEP 4:

a. Titles and Gridlines: Check or
uncheck the desired title or gridline box
to control the appearance of your query
for printing.

b. Save As Defaults: If you want to save
your settings to use with future queries,
click this button.

c. Click OK.

CH 2
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Page IHeader.-"Footer QuickQuery

— Titles and GridLine:

V' Column Headers

¥ Fririt Frame

v Wertical Lines

V¥ Huorizontal Lines

™ Orly Black and White

— Previe

@ || ok

Save Az Defaults |

o]

Cancel |

Help |
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Introduction To FreeForm

INTRODUCTION

FreeForm is a powerful tool set that lets you:

Add text and columns as well as other objects to different areas of your design document:
document header and footer; page footer and header; group header and footer; and detail.

Use multiple areas of the same type (for example, you can have two detail areas or more than
one group header).

Specify Output When conditions that determine, row by row, when objects (and areas) should
or should not be included in your output.

Specify borders and backgrounds for an object.

Create user prompts objects, child document objects, chart objects, crosstab objects, system
objects, and graphic objects.

FreeForm allows you to develop customized reports, making the report as simple or complex as you

need.

In FreeForm you have the freedom to design all aspects of the report.

FreeForm vs QuickQuery

In addition to the additional object types and object attributes you can use in FreeForm, the following
are features that distinguish it from QuickQuery:

a
Q

You are able to position objects anywhere on a grid.

FreeForm is not interactive. To view data while you are working in a FreeForm window, you
must select the print preview. When you do this, Eureka submits your query and opens an
output window with the information returned from your database.

OBJECTIVES

You will demonstrate an understanding of FreeForm by showing the steps necessary to create a cus-
tomized report.

Units of Study:
O FreeForm Orientation
o Designing A Customized FreeForm Report
0 FreeForm Area Objects
0 FreeForm Query Design
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APPLICATION

N/A

PREREQUISITES

Complete Chapters 1 and 2 of this manual.
Example of a FreeForm Report:

& EUREKA:Reporter Designer - [Eureka FreeForm] M= E |

@‘Eile Edit Wiew Tools ‘window Help

=18 ]

G IR TR A CRER ] = - e

Eureka FreefForm
2/712002
1042 am

Women
TRK GO 12T 6000

LATHE, ENGINE
COPIER 5YS XEROX
TRK LF G000LE LT-60RS
TELEPHOME, STU I
BARCODE READER
AMSWERING MACHINE
CPU, DESKTOP

MONITOR, 19" COLOR

StockNbr
2320010907291

2411001364012
2610011297764
2930000231015
S518000MN000927
S8383311PLM

F01000MN452825
7021703511000

7025000001952

Actual Cost

27439.00

11508.00

13566.00

27633.00

1.00

2532.00

232.00

2737.00

933.00

Ready

|Mx DPAS ReEort I

BarCd Serialbr
167240 32423415333
167241 F7a53
167242 SO0XELZ
167244 4363464FG44
167243 32423GR

7251001101 BRD-001-001
HQOooO1 AF-001
1663321 1003442561

1593001 1330041032

IC

HQ1001
HO1001

HQ1001

HQ1001 —
HO1001
HQ1001
HQ1001

HO1001

HQ1001 -
3

lPg: 10f 1

o
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Getting Oriented With FreeForm

INTRODUCTION

We will begin producing reports and queries using the FreeForm process, and gradually add more
sophisticated functions. You will see a window and toolbars that may be new to you. This lesson will
familiarize you with the terminology and function of the Eureka FreeForm environment.

OBJECTIVES

The student will be able to identify the parts and explain the functions of the FreeForm window and
the associated toolbars.

APPLICATION

N/A
PREREQUISITES

Complete Chapters 1 and 2 of this manual.
ACTIVITY

Instructor-led lecture

For an explanation of each tool on the toolbars, refer to the References section of this manual.

& EUREKA:Reporter Designer - [Untitleds]

B B e B FreeForm Objects | Allows you to quickly

Top Marain |0

EF Bl Edt View Insert Query Tools Window Help RIS
Dodgim|iea - = |7z e
SRR T s R P AN =R =R
'&TimasNewF\umanA | = B2 o = \iﬂﬁﬁ
D‘..l.l.‘ﬁ‘.‘l...\Z‘.‘l...|3u‘|‘..|4‘.‘ L

B - GreeF insert new objects,
GreeForm Objects Toolba} such as the date,
T time, page number,
Headsr | graphics, etc.

orm Queries Toolbar

Detail i
Page Footer| 04

FreeForm Queries | This allows you to
Boton | sort, filter, add docu-
] ment header/foot-
1 ers, page header/
footers, and group
header/footers.

[ I T
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D ment Windows An i Dir ri

Document window is a term used to describe windows that an application opens to display documents,
files, views of data, reports, and so on. Document windows always exist inside program's application win-
dow and share the application window's menu bar. Because Eureka follows the Multiple Document Inter-
face (MDI) standard, you can have several design and viewer windows open at one time, limited only by
the amount of available memory.

Eureka uses the same interface used by other Windows applications and makes use of standard graphical-
interface options-move, resize, close, minimize, maximize, and drag-and-drop.

Document Window Types

Eureka has three types of document windows:
0 QuickQuery window
0 FreeForm windows
0 Document output window

Fl ing Window

. . . . o 1zl ]
Floating windows are specially used windows that can be positioned any- T M
where on the screen. All floating windows can be displayed by selecting -
them from the view menu or hidden by de-selecting them. The object direc- ’EE&‘PQ'JEI:“' SeRiAL L

tory is a good example of a floating window. = +CatalogRef._Pub.
-] +Senal Hand_Rept-Aut
(] +Serial Hand_Rept-Dep

T L] = +5ernial_Hand_Rcpt.-|
K @\ NOTE: —% +S§::I_H::d_HEEt.-\$2
\ \//\ Floating windows are not applicable when using the Query 1 Appr_Data
7 Wizard. They are only available in QuickQuery and FreeForm. :g g‘zﬁ'ggianm

1 Hand_Receipt_Holder
] Improvement/&dditional
1 Mir_Model/Part_Numbe:
] Serial_Hand_Receipt
] Uit

] W aranty/Service/Loan/
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FreeForm Windows

FreeForm windows give you access to all object types and object attributes that Eureka supports.

B FURFKA:Rmparter Desigres - [Untibledi]

Ein Edb Yew josort Query Took odow Hel

S E3
HETET

== R Ao T -
abe =7 A3 )
e g e
Yo T L T I I A e P T [ T A |
E Areas These are defined as area objects that
make up each Eureka document. Each
fon |5 area object serves as a container for
Dm0 output objects such as text objects, col-
e umn objects, graphic objects, etc.
Eollom |0
i Object Eureka Reporter Designer provides a
Alignment grid that is used to align your output
Grid objects.
Page A page header is included at the top of
: Header each page. When you move an object
Area (field) in this area Eureka outputs the

Changing Area Attributes

By double-clicking an Area, you can change certain attributes.

a.

CH 2
1 October 2004

Area Level: Change this when you use the
same area multiple times. This will designate
the process order. For example, you may
have two detail areas.

Area Description: This is the description of
the area. This description does not print on
the report.

Print Options: This is used in conjunction
with multiple area levels. This will tell when
certain rows to print.

Area Height: This sets the area height of
your report.

Reset Page Number to: This will reset the
page number after each page break, area, or
group. For example, if your report breaks for
each Hand Receipt Holder Number, it would
reset the page back to whatever page
number you specify.

value of that column, taken from the
first row, on the page.

Detail Area

The output for a detail area is once for
each database row included on your
document.

Page Footer
Area

A page footer is included at the bottom
of each page. When you move an object
(field) in this area, Eureka outputs the
value of that column, taken from the last
row, on the page.

Area: Page Header (Untitled1.iqr)
Area |Bo[der| Olutput whenl HTMLI
— |dentification
Area Description:
Area Level: El |
v
— Print O ption
& Print All Dccurrences
¢ Print Only 1gt Occurence Area Height: Ir@ln.
€ Print &l But 15t Decurence
¢ Frint Only Last Dccurence I Feset Page Number to ID_
€ Print &)l But Last Dccurence
— Spacing FPage Skip
Before Area: lﬁ In. Before Area: ID_E
Alfter Area: lﬁ In. Alfter Area ID_E
QK | Cancel Help




Getting Oriented With FreeForm

f. Spacing: If you want to leave space before or after an area object, enter the amount of space you
want.

g. Page Skip: Use these controls to have Eureka skip to the top of the next page before or after this
area is output. A value of 1 causes output to skip to the next page. A value of 2 causes a blank page
to be output. A value of 3 causes 2 blank pages to be output, etc.

h. Click OK.

j Dir
The Object Directory makes it easy to:

0 Add columns to your documents and dialog boxes

0 Add copies of existing objects to your document

0 View database values for a column and insert them in dialog boxes
Eureka Reporter Designer includes an Object Directory in the FreeForm windows. You can open and close
it by selecting View>Object Directory (F2 Function Key) from the menu bar. Many Eureka dialog
boxes also have Object Directories built into them.
Object Directories let you select:

0 Objects from your Metadata file (that is, column objects and custom objects that are defined in

the Metadata file).

0 Objects that are already in place on your design document.

Many Object Directories also let you browse database values for a column.

@ ==l| Business View. Business view names are at the top level of the tree and
/ are indicated in ALL CAPS. A business view is an object in your Metadata
[ EMD ITEM SERIAL 2] . . .
0 Quick_Start File that corresponds to the data for a particular part of your business.

- _ 1 +Catalog-Ref._Pub.
1 +Seral_Hand_Rcpt.-2uth

I ey oy Ao Folders. A folder can correspond to a table in your database or it can be
[ el et Wy made up of columns from more than one table. It can also include custom
-] Catalog objects--objects that are calculated from database columns.
2 Accumd Depmn
Z% o e Lowt <d——1— Data Objects. These are the actual data elements that are used to make up
[ Do ith e N || YOUT report,

T Deprn Office
T Deprn Periad

— F Cost s =

—% Full Doesprn Ccd mb t D"‘Qgtg! ! T! !! !Ibgr
"I Impee Cost

7T Installation Cost

"I Pricr Deprm

— Fesidual V¥ al

R Lo Tes i i

LT Trnsp Cost
_1 Hand_Receipt_Halder
1 Impravement A4 dditional_

- Mir._Model/Part_Murnbe T
=] Ferial Hand_Receint J Columns. This displays the Object Directory.
El Document Objects. This displays the data fields that you selected on
your report.
il Browse. This browses your database for a selected data field (this is
only accessible if a data object is selected).
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Ar i Li

The Area Object List (F4 Function Key) is a tool that allows you to view area
objects that are shown in your current FreeForm window. The Area Object List

is displayed above your Object Directory.

Data Object Placement
Page 0
Header
Acg Cost  BarCd
Detail a ﬁ ﬁ
Page Footer 0

2l

Page Header
Detail
Page Footer

=1 x|

e H

ACCOUNTING TRANSACT] a
[ Accaounting
COCIPAWIP

—H AUTHORIZATIONS

When dropping data objects on your report, column headings (the gray) will be placed in the page header
area. Data objects (the turquoise), will be placed in the detail area. This is done by placing your mouse
arrow on top of the data object in the object directory, holding down the left mouse button, dragging over
to the grid area, and placing the tip of the arrow INSIDE the detail area. Let go of the mouse button. If
the tip of the arrow is not inside the detail area, a column header will not be produced.

Detail Areas
& EUREKA:Reporter Designer - [Untitleds] M= E

¥ Fle Edk Wiew Insert Query Tools Window Help

=1=1x|

DoH Shem|: =@ ~ |[F¥ €|
A2 Do E W@ Ny DoBe® ||

[ Times New Foman Hile H=ife £ o= = = || ;||
T T P T P T - T o T LT I - I S P

Top Margin |0

Page 0

Header .

Detail D:

Page Footer 04

Battarm ]

M argin .

<
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Placing data objects in the
detail area will result in
output once for each
database row included on
your document. If an
aggregate function (sum,
average, etc.) is applied to
any of the columns in the
detail area object, each row
returned from the database is
a summary row.
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Page Setup

Setting up your page allows you to do several page options, including titles, page numbers, layout,
margins, borders, headers and footers, background images, etc.

.
a. Select File from the menu bar. Page | o
L order

b. Select Page Setup from the program s Eu——

gI‘OUp. Height: IW In. Top: |1 il E In. Left: |05 E In.
c. Page Size: Allows you to adjust the size _——

. . th: . : ight:

of your page. Your page size is defaulted to | in o G iz RS e

the current Windows settings, but you can JE—— Rl

change if needed.  Celi " Seale toFi
d. Page Margins: Your page margins are Nomberof Coams i (2] @ geaez [in (5]

. . " Down then acioss
defaulted to the current Windows settings, 5 Ao e o - Giid
but you can change if needed. S o ¥ Uss Grid
. [ EETLET LT a nentation .

e. Page Layout: Allows you to use multiple N g @ Pt Cell Heioht [1.17 I

COlumns' ™| Herizarntal ' Landscape Cell'width: ID'W In.
f. Center on Page: Select how you want

your output displayed on your page.
g. Orientation: This will allow you set how 0K | cancel | Heb |

you want your page to print.
Printing Group Box:

h. Scale to Fit: Controls what happens when you print your document to paper with different
dimensions than are specified for your document. When Scale to Fit is checked, Eureka scales the
document to fit the page. It either enlarges or reduces all of the objects.

i. Scale: Allows you to select al exact scaling percentage.

~ 5 HINT!
% If you plan to exchange documents between people with American and European printers, it is a
! good idea to turn on Scale to Fit.

j. Use Grid: To assist in creating FreeForm documents with a neat appearance, you can specify that
objects are to be placed on an alignment grid which appears only in the FreeForm window (and not in
output).

k. Cell Height: You can enter the vertical spacing for objects.

[. Cell Width: Enter the horizontal spacing.

~ 5 HINT!
%@; A good starting point for cell height and width is 20% greater than the size of the font you plan
‘ to use most. For instance, if you plan to use a 10-point font, enter 12 points as the grid setting.

m. Save As Defaults: To have your changes from the Page tab apply to future documents as well as to
the current document, select Save As Defaults after making your changes. To have your changes
apply only to future documents, select Cancel after you select Save As Defaults.

n. Click OK.
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Building A FreeForm With The Query Wizard

INTRODUCTION

This section outlines building FreeForm reports by using the Query Wizard. The query wizard is the
easier way to create a query and takes you step-by-step through:

OBJECTIVES
0O STEP 1: Select Query Type O STEP 4: Select Columns to Sort By
0 STEP 2: Select Columns Q STEP 5: Select Columns to Aggregate

O STEP 3: Setting Column Filters

OBJECTIVES

Using the FreeForm Wizard, you will develop a spreadsheet-type of report with columns of data
(detail) that have been filtered, sorted, and aggregated (totaled for the column). You will present a
sample page of this finished report to your instructor.

APPLICATION

This type of query can be used when you need a simple report fast. For example, you want to build
a simple report that displays certain data fields for your Hand Receipt Holders.

PREREQUISITES

Eureka Reporter Designer is appropriately loaded and configured.
Complete Chapters 1 and 2 of this manual.

ACTIVITY
Student Hands-On with Instructor direction

REPORT TYPE

A complete asset listing by UIC/Major Hand Receipt Holder showing stock number, bar code, nomen-
clature, and acquisition cost of each asset.
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This is a sample of a FreeForm report that you will build in this lesson:

g}'EUREKA:Reporter Designer - [Untitled3]

@‘Eile Edit Wiew Tools ‘Window Help

=@l x|

W< » M 2@ e (@

HEHMbrMjr
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUECs
WOUaC?
WOUaC?
WOUECs
WOUECs
WOUECs

AcyCost
75.00

1456900
1456900
232200
150.00
150.00
1532.00
233200
363200
363200
49900
49900
8226 47
8226 47
2T838.00
933.00
933.00
543.00
12861.00
12861.00

StockMbr
T01000N 452825
5855011384748
5855011384748
58383311PLM
5810004715068
5810004715068
025010000568
3610011297764
5810014318264
5810014318264
T02501N000433
T02501N000433
5810010550048
5810010550048
3411001364013
025703616006
025703616122
025000001952
5810013761380
5810013761380

Nomen

ANSWERING MACHINE
AT NV 5Y ANIBVE-6(V)2
AT NV 5Y ANIBVE-6(V)2
B&RCODE READER.
CODE CHOR KYK-38T3EC
CODE CHOR KYK-38T3EC
COMPUTER, PENTIUM III
COPIER. 573 XEROX

ENC DEC KIV 7 HI 3FD
ENC DEC KIV 7 HI 3FD
HANDHELD COMPUTER.
HANDHELD COMPUTER.
KEY GEN TIEC/KG-81
KEY GEN TIEC/KG-81
LATHE, ENGINE
WMONITOR, 17"
WMONITOR, 17" 100HS
WONITOR, 19" COLOR
WTU K¥-100 AIRTER

MTU KY-100 AIRTERIW -
| 3

Ready

STEPS TO PERFORM ACTION

[Pg: 10f 1 [ o |

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

ADD AD HOC REPORTS ICON HERE

ADD EUREKA MENU HERE

72



Building A FreeForm With The Query Wizard

Step 1. Select Query Type

tan 14, 1998
Wi

Customers by
Region

fAct#  Sorpan: Prone #

ERO0IZ Sparts Jdsk

4z SPOOLD Spartlg Twe Ghie
S00MIL Saccer Mdd

az  FLEGOL ket Faot

SET0Z Sk Tl Yau Drop Lt
4z SPO0OL Sparts Wastouse

SO0 ShurTs Carucant

a5 SOUIL Sawtwnesterss Sports
SPOOTS SharTd Scunair A5
BAVOOL  Bayars ShartsGmiH
SPO003 Shartatese Lintted
PO006 Spartsd Lekure Bk
SPO00E Sparterele Dus om
FIOOIL Fantlig 54

(406] 244973
(0RIeRLEE
[ET R
{ FOzjd4-190
(e IIRE
(202354-153
[ER e
(505 eBT-6T
LrzEs0

046552

L3 SpE T
Lol A7 2734
T

00

 Summary

" Grouped Detail
" Overall Summary
" Create TM1 Cube

This type of query allows you to list
detail infarmation from pour database.
For example, all orders

<Select the type of query you would Iike.)

< Back I Neat » I

Finish |

Cancel | Help

STEP 2:

a. Select the following fields from the table below:

BUSINESS VIEW: END ITEM SERIAL

STEP 1:

a. Select Detail.
b. Click Next>.

Query Types

Detail Detail queries return detailed data without any
aggregate functions applied, the aggregate func-
tions being average, count, minimum, maximum,
and sum.

Summary | Summary queries are useful when you want to
summarize data for a number of different items.

Grouped Grouped detail queries let you view the query

Detail results grouped by one or more columns.

Overall Overall summary queries give the highest level

Summary | view of your data.

Create This is not available.

TM1 Cube

Step 2. Select Columns

Chooze which calumng pou would like in
pour query. This iz done by dragging them
from the object directary on the left to the
column list on the right.

P~ Customers

Mmerica HE0EF 091
Amaricas $a 60 1055
Eurpa £ 027
PackicRim §1[22 (42

Eurcpz  H100635 1320
Amaricas BP9 0905

P omgany
Eurcpz  §1.233 1333

-

Orders
FfDate
ACCOUNTING TRANSAE o] [commn |

i

FOLDER(S) DATA ELEMENT(S)
Hand_Receipt_Holder | HRH Nbr Mjr
Serial_Hand_Receipt Acq Cost
Catalog Stock Nbr

Nomen

E

b. Click Next>.

HINT!

A AUTHORIZATIONS

1 Gerial Hand Pereint T
| »
Add Custar.. |

1 Accaunting —
TICIPAIP ¥

From the Objects Direct-
ory select the Business
View you wish to use to
build you columns.

([ Autharization
[ Buk_Hand_Receipt
[ Catalog

B

Finizh | Cancel Help

< Back I Next > I

~ To select MULTIPLE fields, hold the CTRL key down and select the desired fields (DO NOT LET UP
ON THE CTRL KEY). Click, "drag and drop" to any place in the working window.
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[
Step 3. Select Column Filters [ x| STE P 3 [
a.

We are going to filter on a field that we are not dis-

“what conditions should your data satisfy?

T Sely Sprt O To buid condiions: playing in our report. To do this, click on the E

1) Drag a column to the column list below ICOI’]
2] Select an operatar fram the drop down list. '

3 Setthe valusls)that govem ths condiion. | | D, Scroll up to the END ITEM SERIAL Business

T Swvea Activity ©

T UIC Activation

T UIC Sts Cd _I_I View.
e = c. Open the Unit Folder.
A »
0K|Cnlumn |0peratnr |\l’alue1 |\lalue2 |Gmup | d. SeIeCt the UIC ﬁeld.
~ UE - WOLEAR 0 e. Make sure that the operator is set to equal (=).
From vour list of selected f.  Filter on UIC WOUG6AA. Remember to turn your
rom your li
fields, double-click or drag CAPS LOCK on!
and drop the data field you g. Click Next>.
want your query to filter on.
< Back I Hext> >y T e Help |
~ HINT!

~ Filters let you limit the data displayed to only that which meets the criteria you set. When a
query has no filter, you will see ALL the data from your database. When you define a filter con-
dition, you will limit the data that meets the condition. Every additional filter or filter condition
you apply further narrows the view of your data.

STE P 4: Step 4. Select Columns to Sort By ll
d. DOU b|e-C| |Ck on Nomen . Hows would you like your data sorted? T
i i Region
b. The Sort order defau.lts to Ascendlng’ bUt If First, move a column to the list an the right, ® x"‘"f‘“’ g ﬁ
you want to change it, click on the A->Z but- then use the A2 push button to set the Packiin 122 0023
' sort order. Euopz  §1233 1555
ton. fimaricz. §4.01 1058
urope  BI0MRG 1390

Eurcpz 30,27 0911

|Aci Cost 2 [column order |
Serial N + +

c. Click Next>.

~ HINT! hack Ner ]
From your list of selected fields, double-
~ Once you have selected your columns, you click or drag and drop the data field you
can click on Order button and change ::!?:ctt?;'i;ﬂluiriv I:‘I)I blftst?‘f:*:_i I':lv- oTu° ‘::;t
how you want your query to sort. For to de-select éndgcligk on the arrgw that
example, it would be either A-Z or Z-A. points to the left.

< Back I Mest » I Finizh | Cancel | Help |
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Step 5. Select Columins to Aggregate

‘what totals would you like in pour quen?

Ragion  Amount Order
Mmaricas BN L7
Mmarica §i4/053 1038
Amaricas__ §799 0905

First select a group, then set agaregate
functions for each of the desired columng. Taa
Ewope  $50:27 0911
1003 130
Ewom HoH B
AN

STEP 5:

a. Click on Entire Document.
b. Sum on the Acq Cost.
c. Click Finish.

Entire Dacument Column |Sum |Aug |Max |Min |Cnt | \ NOTE:
Acg_Cost I I I I N H
S R S \ Only pure numeric fields can be
Momen r - r / summed or averaged.
Serial Mo I I I
Stock Nbr I I I . )
uic r O r When using the Count, you will get the
total number of records returned from
your query.
< Back I Mest » I Finizh Cancel Help
Example of the Design Document: [ unexamepontespesgner Tumzean) e )
Ef Ele Edt Yew Insert Query Iools Window Help =lexi|
. NEHSRe| B o o | FfX (e
a. De'etetheUICCOthn headlng. klﬁg‘hig;‘@@l‘mmaﬁ \‘%uv|“
) . . Ty Times New Floman 2 | | Eo= | i [ == |£|”—L||
b. Click the @Prthrewewbuttonto = UD.H..‘.n‘.mH\z”..‘..\a‘.‘m|4‘..\..‘\5.”.”.\5...\.@7”.‘.‘|S.\
process your report. ]
Page 0
Head_er ] | HRENb-MGy AcaCost| StocklNbr Nomen s ()
e
Enctument 0 L SmegCost]
Bottom |04
Margin
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Example of the finished report:

& EUREKA:Reporter Designer - [Untitled3]
@‘Eile Edit Wiew Tools ‘Window Help

W< » M 2@ e (@

HEHMbrMjr AcyCost
WOUECs 75.00
WOUECs 14869.00
WOUECs 14869.00
WOUECs 232200
WOUECs 150,00
WOUECs 150,00
WOUECs 1532.00
WOUECs 233200
WOUECs 3632.00
WOUECs 3632.00
WOUECs 49900
WOUECs 49900
WOUECs 5226 .47
WOUECs 5226 .47
WOUECs 27838.00
WOUaC? 933.00
WOUaC? 933.00
WOUECs 543.00
WOUECs 12861.00
WOUECs 12861.00

StockMbr
T01000N 452825
5855011384748
5855011384748
58383311PLM
5810004715068
5810004715068
025010000568
3610011297764
5810014318264
5810014318264
T02501N000433
T02501N000433
5810010550048
5810010550048
3411001364013
025703616006
025703616122
025000001952
5810013761380
5810013761380

Nomen

ANSWERING MACHINE
AT NV 5Y ANIBVE-6(V)2
AT NV 5Y ANIBVE-6(V)2
B&RCODE READER.
CODE CHOR KYK-38T3EC
CODE CHOR KYK-38T3EC
COMPUTER, PENTIUM III
COPIER. 573 XEROX

ENC DEC KIV 7 HI 3FD
ENC DEC KIV 7 HI 3FD
HANDHELD COMPUTER.
HANDHELD COMPUTER.
KEY GEN TIEC/KG-81
KEY GEN TIEC/KG-81
LATHE, ENGINE
WMONITOR, 17"
WMONITOR, 17" 100HS
WONITOR, 19" COLOR
WTU K¥-100 AIRTER

MTU KY-100 AIRTERIW -
| 3

Ready

a. Click on the
b. Close your report without saving it.

&= to close your output window.

Pgi1ofL

T hon
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Designing A Customized FreeForm Report Without The Query
Wizard

INTRODUCTION

FreeForm is a powerful tool set that allows more complex design of reports, or when the user wants
to include any of the objects that are not supported by QuickQuery. It allows the user to:

O Add areas to the document

O  Add text and columns as well as other objects to different areas of the design document: doc-
ument header and footer; page header and footer; group header and footer; and detail object
areas.

Q  Specify font types, alignment, point size and colors to customize an object.

OBJECTIVES

We will design a series of progressively more complex FreeForm documents, using this effective tool
to output information from DPAS.

APPLICATION

FreeForm is an excellent tool if your intention is to create a query or printed report which will most
likely be used to present to others outside of your organization, to those who are not necessarily
familiar with DPAS terms, or that requires more sophistication than QuickQuery. We say that Free-
Form is more sophisticated, but it can be easy to use once you learn the fundamentals. It allows
more creativity in design and presentation of information.

PREREQUISITES

Complete Chapters 1 and 2 of this manual.

ACTIVITY

Student Hands-On with Instructor direction

REPORT TYPE

Depreciation report listing accumulated depreciation and activation date by UIC

CH?2 77
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This is a sample of a finished FreeForm Report:

g}'EUREKA:Reporter Designer - [Untitleds]
ED, Fle Edit Wiew Tnoks MWindow Help =

W< » M 2@ e (@

Nomen SiockMNbr AcqCost  BarCd SeriallNbr uc
SERVER, MINI COMPUTER. 7021703593020 111000.00 0000206 T036-IN-206 W4TE0
SERVER. 021703593098 11130200 100000132 T3282-3V-138 W90,
SERVER. 021703593105 11130200 100000131 T3282-EV-137 W3V52
SERVER. 025011725133 11100000 A00000310 102-5¥-7310 WOl64
SERVER. 025011725133 11100000 A00000410 102-5¥-7410 WOVGL
SERVER. 025011725133 11100000 A00000510 102-5¥-7510 WOVLL
SERVER. 025011725133 11100000 A00000&10 102-5¥-7610 WOVE L
SERVER. 025011725133 11100000 400000710 102-5¥-7710 WOXYD
SERVER. 025011725133 11100000 A000OOZ10 102-5¥-7810 W1DC0
SERVER. 025011725133 11100000 A00000910 102-5¥-7910 WIELT
SERVER. 025011725133 11100000 A00001010 102-5¥-79110 WIHCE
SERVER. 025011725133 11100000 400001011 102-5v-79111 WINV0
SERVER. 025011725133 11100000  A00001012 102-5¥-79112 WINW:
SERVER. 025011725133 11100000 A00001013 102-5¥-79113 WIV5LA
SERVER. 025011725133 11100000 AD0OO1014 102-5V-79114 WKL
SERVER. 025011725133 11100000 A00001015 102-5¥-79115 W3V52
SERVER. 025011725133 11100000 A000O1016 102-5¥-79116 W90
SERVER. 025011725133 11100000 A000O1018 102-5V-79118 W4 QL
SERVER. 025011725133 11100000 A00001019 102-5¥-79119 WBZT!
SERVER. 025011725133 11100000 A00001020 102-5¥-79120 WC4iJi;|
| 3
Ready Pgi1ofL [ I_IW_

STEPS TO PERFORM ACTION

1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.

2. Select Eureka from the program group or from you computer desktop, double-click the Eureka
Reporter Designer icon.

3. If the Wizard displays, click Finish.

4. Select Tools from the menu bar.

5. Select Preferences... from the program group.

6. Uncheck Use Query Wizard and Default To QuickQuery View.

7. Click OK.

NOTE:
. If you do not have a shortcut to Eureka on your desktop, then click Start>Programs> Eureka
-~ Reporter Designer.

\Z

8. Select File from the menu bar.
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STEP 1:
Page |Bo[der|
PageSize—— | [-PageManghn Refer to Getting Oriented With FreeForm for
Height [55  [2]In. Top [10 [2]In Left: o5 [2] In information on Page Setup.

‘width: |11-U In. Eottom: I‘I.D In. Right: ID.5 In. .
If you have numerous columns that you will be

- Page Layout R adding in your report, it is always a good idea to
~ Calurr © Seale to Fit

Mumber of Columrs: [1 (3] & sedex [0 ] widen_ your report I_engthwise to add more room.
€ Do then across : Keep in mind that if you change the width of
(= Asross then down 'f;du » your page size to greater than 11, make sure
e Larn . .
= Center on Fage Orientation C L that YOU have paper n y0u pr|nter tO
ell Height: ID.‘I? In. . .
I ertical € Portrait _ accommodate the wider page; otherwise, your
o i & Landscape Cellviar [o17 in report may not print properly.

a. Make any necessary changes.

ok | e | Wb || b, Click Save As Defaults.

c. Click OK.

d. If your Object Directory is not displayed, depress the F2 Function Key to display it.

e. Select the data fields from the table below. Click, drag, and drop the field(s) to the Detail Area of your
FreeForm report. Remember, if the tip of the arrow is not inside the Detail Area, a column header will
not be produced.

BUSINESS VIEW: DEPRECIATION EXPENSE

FOLDER(S) DATA ELEMENT(S)
Catalog Nomen Stock Nbr
Serial_Hand_Receipt Acq Cost Serial Nbr
Bar Cd uIC
Depreciation Accumd Deprn Activation Dt

You cannot select fields from 2 different Business Views (such as, END ITEM SERIAL and END ITEM
BULK) on one report unless you are writing a Parent/Child report.

For more information on Parent/Child reports, see Chapter 4.
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STEP 2: & FUREKA:Reporter Designer - [Untitleds]
EF Fle Edt View Inset Query Took Window Help =Bl xI
DEHEgRaizae o |[fT BN

a. After you have selected your data objects, A B2 BOEME HBEE x HY 0 o

depress the F2 Function Key to remove "y Ties e Foran Hfc HesuE==ml |
the object directory because it covers part [y it B B B
of your design document.

3
b

— SHORTCUT! Zd
% If you want to select multiple data F
: fields, hold the CTRL Key down while
highlighting the desired fields. While
still holding the CTRL Key down,
drag and drop the fields into the
Detail area of the FreeForm Window.

I}
il

=

=i

S2
£l

b. Save your report as FFQUERY before pre-
viewing it.

——
Eureka uses output windows to show you the results of queries that you are working with. In order to

view all pages of your report, you should click the Last Page icon ﬁ .

STEP 3:

a. Close the output window by clicking on the ﬂ icon.
b. DO NOT close the report - we will continue to use it in the next Unit of Study.
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P

H r/E r Ar

A Page Header/Footer area outputs for each page within the document. Placing objects in these areas will
result in output values for each page of the document (i.e., average, sum, text, etc.).

The Page Header/Footer is already the default in the FreeForm window. If you wish to add additional page
headers/footers, use the Insert>Area>Page Header or Page Footer. If you prefer, you can simply

select the Page Header/Footer icon . If you select this icon, it will produce both a Page Header and
a Page Footer!

g}'EUREKA:Reporter Designer - [Untitleds]

E!Eile Edit Wiew Insert Query Tools Window Help

DEHSRE B0~ |Fx e
A kB2 DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Times Mew Roman j“‘lﬂ j| B I U H%% = |.|'|| j‘
O v e B B B e B B R L 5|
Top Margin [0
FPage 0 |
Header 7
__ Nomen S5tockiNbr AcgCost|  BarCd SerialNbhr
Detail 04
Page Footer| 0 -
Battam 0
M argin o

3

o

If you are going to be adding a lot of items to the page header area, it may be a good idea to resize the
area to make it larger. To do this:

1.
2.
3

CH 2

Click in the area. The area will be surrounded in blue with black handles (small blocks).
There is one handle that is solid in color. Click on that handle (it will change to a two-way arrow).
Hold the click, and the drag down to make as large as you want. If you do this, you will need to move

your objects to where you want them.

1 October 2004
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This process will show you how to select multiple objects at one time. This procedure is referred to as
"rubberbanding".

& EUREKA:Reporter Designer - [FFQUERY.igr] =18 x|
EF Fle Edit View Insert Query Tooks Window Help =
DSH|SEm|: R0~ |F (e
N B TR -
[T Times New Foman Hific =z 2 v == = | mi| = ‘
_ e 2 e B i o B e
TopMargin |0
PageHeader |0 |
] StockNbr | AcgCost| BarCd | SerialNbr uic
1]
Detail 0
Page Footer |0
: Position the mouse at a
Bottom Margin |0 point just outside of the
1 outermost object to be
selected.

. FUREKA:Reporter Designer - [FFQUERY.iqr] = x]
EF Fil= Edt Yiew Insert Query Iools Window Help _18] x|

DEH (SR L nBo | Ffy|ew|

AEeE2B O EmE R ||w (4B
= \ =

| |

[ Times New Roman ||1EI

TopMargin |0

Page Header [0
Nomen StockNbr \ AcqCost|  BarCd | SerialNbr uic
Dretail
Page Footer
/ Hold down the mouse button and drag the pointer
Bottom Margin |0 to create a rectangular “container”.
When the container includes at least part of each
object to be selected, release the mouse button. All
of the objects will be selected and you can move or
delete all data objects together.
<
[ e
CH?2 82
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Below is an example of items that were "rubberbanded": GET UPDATED SCREEN!!

& EUREKA:Reporter Designer - [FFQUERY.igr] ?2: =18l x]
EF Fle Edt View Insert Query Tools Window Help -1=1x]
sl @) ee ) n ‘ek?| ﬁ‘{otice how the items you
R E-2h ROAWB R E% N 47 HEB8 [ upberbanded have handles
7 Tine: e Foman L ER L E N around each object. You can
toagn e B Fen e Bl now drag the items to where you
] Qant to place them.

Page Header |0
i Nomen thtutthr F d cqCostp JBarCd bjsErialNhr F 3U1C

Detail ]
Pags Footsr |0 |

Eottom Margin [0 |

<
Primary Selected Object: UIC [

]
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Adding Document File Nam j
Use this process when you want to add the file name of your document that you are saving.
1. Click on the Document Name icon.
-OR-
2. Select Insert from the menu bar.

3. Select System from the program group.
4. Select Report Name from the program list.

& EUREKA:Repotter Designet - [Untitled5] [_[&]x]
E_!E\Is Edit View Insert Query Took ‘Window Help -|5‘|5|
DEH|SRE y 2@ |FY €8
k(B2 Mo EEE|[REEES |4y FEER B
[ Times Mew Roman 52 EEES| Uul===m]| = |
R P R s N T R e A R

Top Margin |0

E < Report Name Icon )
Page 0]
Header ]

E Nomen SiockMNbx AcgCosi  BarCd SexialNbx
Detail 0
Page Footer 0
Bottom [E
targin
< »
Primary Selected Object: ActivationDt muM |

5. Place the object on the left side of the Page Footer area.

EF Fle Edt Yew Insert Query Took Window Help NS
DEH|GRm|aao - &2 e NOTE:
N E2R @B IME BuER || 4y BEDB|H | \\ It is recommended that
[T Times New Roman =z E|e r o === |m = .
. D-w-l...\2‘..\..‘\3."..‘.|4".\‘..|5....‘..\s‘."..‘|‘7.H.H.|a‘\ \// repon':]ameObJeCtSbe
e placed in the Page Footer
E _ area (if you want the name
E of the report to appear on

Header

each page of your report).
If you want the name of

Page o ‘

- 10:: Nomen SinckNbx AcqCost| BarCd Serialihr your report WI" appear on
Fage Foote 1 the first page of your
: report only, place the
FEa object in the Document
Header area.
il
Bead [ [ [ |
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6. Double-click on the report name object.

& EUREKA:Reporter Designer - [Untitleds]
Qﬁile Edit Miew Insert Query Tools Window Help _|ﬁ| 5'

DESH SRm| s 2B~ |FT (08|
A e@20 DO EEE (K@ |x Y D EBR |6

I’l}j Times Mew Roman j“w j| B 7 U ”g% = |.|' |I j|
T W W [ A I R W e W P W £
Top kdargin |0 ]
Page 0]
Header
T Nomen StockNhr AcqCost| BarCd Seriallhr
Detail 0
F'ageFootalUi

2

Bottom
hdargin

Double-click on the report name object.
4 —

Primary Selected Object: DOCUMENTNAME [ [ WM |
System: DOCUMENTNAME {C3-23.iqr) [ %]

7. Make any necessary changes.
System | Bo[derl Faont I Hot Qbiectl HTMLI Olutput whenl

F”“ Type: This displays the type of object.
e Object Label: This determines the type of value
e that is output for the object.
Objsct Label: [DOCUMENTNAME Character Width: 8 2] Character Width: Controls the length of the
Fermat. [Name Ony = object for output purposes. Eureka always pro-
vides a default width. If you enter a number
[ Appearance smaller than the width of the system object as
[ Suppress Duplicates V¥ Snap To Grid formatted by EU/"e/(a, the Output W|" be truncated.
™ WordWiap I Hide Format: When you same your report, the file
name will be displayed in the area where you

placed the object.

¢« Name Only displays just the file name
(for example, UICRPT).
][ o e e Name and Extension displays the entire
file name including the extension (for
example, UICRPT.iqr).

¢ Full Path displays the entire path and file
name including the extension (for exam-
ple, C:/Program Files/Reports/UICRPT.iqr).

NOTE:
\
'& For the Character Width, truncation will also occur if the size of the object's output is larger
\// than the object size. Factors that affect this include the typeface style and size, and the format
applied to the object. You can avoid this truncation by selecting Word Wrap.
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Appearance: Select the appearance option(s) for your report.

Suppress Duplicates Outputs the same object contents only one time. When there is more than one consecutive
row that has the same data for your object, Eureka suppresses output of duplicate values.

Word Wrap If you want output that exceeds the object width to be printed on successive lines. The spac-
ing between lines when objects wrap is based on the font you are using. When you select
Word Wrap, be sure that there is enough room between the object you are defining and any
objects directly below it in the same area to allow for multiple lines of text. Eureka does not
add space under objects when they wrap.

Snap To Grid If you want your object always to be placed on the alignment grid (when Use Grid is turned
on). When Snap to Grid is not selected, you can place your object at any location.

Hide If you want your object to be moved to a hidden area object. If you do so, your object will
not be included in your output.

8. Click OK.

HINT!

9. Process your report.

~ Remember...you can change the characteristics of your report name object (such as font size,
color, add borders, etc.).

Below is a sample of a finished FreeForm report displaying the document file name:

& EUREKA:Reporter Designer - [FFQUERY] [ [= =]
@_ File Edit Mew Tools Window Help =& x|
K4r Mp?laakaa|o|
ERVER TOAT0359310 TITZ000 TO0000TST TIIEIEYCIET WIVSIL]

SERVER 025011725133 11100000 400000310 102-5%¥-7310 WOTaL
SERVER 025011725133 11100000 A00000410 102-5%-7410 WOVGLE
SERVEE. T023011725133 11100000 400000510 102-3¥-7510 WOVLL.
SERVEE. T023011725133 11100000 400000610 102-3¥-7410 WOVPL
SERVEER. T023011725133 11100000 400000710 102-3¥-7710 WOEYD
SERVEE. T023011725133 11100000  &00000E10 102-3¥-7210 WiDco
SERVEE. T023011725133 11100000 400000910 102-3¥-7910 WIEAZR
SERVEE. T023011725133 11100000 400001010 102-5¥-79110 WIHCE
SERVER T025011725133 11100000 00001011 102-3v-79111 WINva
SERVEE. T023011725133 11100000  A&00001012 102-3¥-79112 WINW
FFQUERY

Ready

10. Save your report.

CH 2
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Changing Column Headings

Eureka will allow you to change the column headings of your data object to make them understandable to
you and others that will be reviewing your report.

Changing attributes is not a mandatory process.

1. Double-click on the Acq Cost field.

g}'EUREKA:Reporter Designer - [Untitleds]
E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁ||1||

DEH SRE )20~ |[FE |0
A @2 BOEED Kb | x4y

Double-click on the column

Times New Roman | |10 *IB F U0 === - . -

E = “ = | ”t |M heading (the gray object) for
TM_DU...|...|1...|...|2...|...|3...|...|4...|.. which you are changing the
op Margin |0 -

1 Kattrlbutes.
FPage 0
Header ]
E Nomen S5tockiNbr AcgCost  BarCd SerialNbhr
Detail 0
FPage Foater 0
_' DOCTMENTHAME F
Battam 04 v "
M argin o
| 3
Primary Selected Object: DOCUMENTNAME MUM
Text: Page Header {C3-23.igr) [ %]

2. Enter Actual Cost over the displayed value.
3. ImportFile: Click this button to import text

Teut |Bo[der| Fant I Hot Qbiectl HTMLI Output whenl

v pesetiest into the value field.
[Ectual Cos =] imponFie._| 4. Appearance: Select the appearance
| option(s) for your report. Refer to Adding
! \ _>ILI Document File Name Objects for defini-
tions of the Appearance options.
’“:38 e s 5. Click OK.
uppress Duplicates ide
 word i B BB 6. Process your report.
V¥ Snap To Grid

Type over the existing value
to generate the column
heading you want to display
on your report.

QK I Cancel Help
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Below is an example of a finished FreeForm report with the column headings changed:

& EUREKA:Reporter Designer - [FFQUERY] MEE]

@‘ File Edit Yiew Tools Window Help ;Iilll
N 4r MM @ e |k By
Notice how the column
heading reflects your
change.
Nomen StocklNbr Actual Cost BarCd SerialNbr uIc
SERVER, MINI COMPUTER 7021703593020 11100000 40000206 T036-IIN-206 WATS0!
SERVER 021703593098 11130200 100000132 73282-5V-138 WSO
SERVER 021703593105 11130200 100000131 73282-5V-137 WS
SERVER 025011725133 11100000 400000310 102-5¥-7310 Willes
SERVER 025011725133 11100000  A00000410  102-5¥-7410 WOVCHE
SERVER 025011725133 11100000  A00000S10  102-5¥-7510 WOVLL.
SERVER 025011725133 11100000  A0000010  102-S¥-7610 WOVPA
SERVER 025011725133 11100000  A00000710  102-S¥-7710 WOKY0
SERVER 025011725133 11100000  AO000CS10  102-5¥-7810 WLDCD_
. o
Ready Pgi1ofL [ I_IW_
7. Save your report.
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Changing Fonts

Eureka will allow you to change the font of your data object(s) for your report.

If you want to change the font of the column heading, then double-click on the column heading (gray
object). If you want to change the font of the output for a particular object, then double-click on the detail
object (turquoise object).

Changing fonts is not a mandatory process.

1. Click on the Actual Cost column heading.

& EUREKA:Reporter Designer - [FFQUERY.iqr]
E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DEH SR ) 2@~ |[FfE|ON|
A kB2 DodEBE Hu@B (N MV EEDR B

I':ﬂ'j Times Mew Roman j“‘lﬂ j“?! ’E|§ EE|.|‘| I j ‘
R N R T T e N

Top Margin [0

B Click on the object for

which you are changing the

I attributes.
FPage 04
Header ] /\

i Nomen Stockih Bascd SerialNbe
Deta 0] .
PageFooterU_—

_' DOCUMENTHAME
Bottam 04
M argin o
«| ‘ >‘

Primary Selected Object: AcqCostHeader |

2. Using the Formatting Toolbar change the font, point size, color, alignment, and characteristics of
your font.

~ <5 HINT!
% You can also double-click on the object to display the fonts attributes. Once you double-click on
' the object, click on the Font tab. Here you can change all the font attributes of your object. As
you change your font attributes, it will be displayed in the Sample box.
The alignment feature aligns within the object, not the object itself.

The selections shown are the default for the column headers.
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3. Process your report.

Example of the finished design document and report:

& EUREKA:Reporter Designer - [FFQUERY.iqr] HEE
EF Fle Edt View Insert Query Tools Window Help 1= x|

DEHSRm s~ |[FE 08|
N E2h RO SR | KMER| K M7|C DR (|
H Tahoma He = s 2o (= 2 |

I T P T R - T R SR | R - R R T P N

Top Margin | 0]
Page 0]
Header ]

7 Nomen StockNbr Actual Cost BarCd SerjalNbr
Detail 0] & EUREKAReporter Designer - [£3-23]

1 (B, Fle Edt View Took Window Help =lelx|
Page Footer 0

] A W2 @e ko

] DOCUMENTHAME
Bottom 0
Hargin 1
<

Primary Selected Object: AcqCostHeader Nomen SteckNhrLHA4 Actual Cost BarCd SerialNbrLHAS UICLI
SERVER, UNIX 021035999322 133000.00 34569 HOL0Z
SERVER, UNIX 021035050322 13300000 876352 27652 WiDC

SERVER, UNIX 021035999322 13300000 87853 3653 WlDC_
SERVER, UNIX 021035050322 13300000 87654 37654 WiDnc
SERVER, MINI COMPUTER. 7021703593020 11100000 40000206 T036-IIN-206 WATEl
SERVER 021703393058 13300000 30 Wiv3,
SERVER 021703553008 13300000 31 WiVs,
SERVER. 021703593098 13300000 32 WLV,

SERVER 021703393058 13300000 33 WOVG

| of

Ready [Pg:2oF2 [ mom |

4. Save your report.
5. DO NOT close the report - we will continue to use it in the next Unit of Study.
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D ment H r/F r Ar

A Document Header/Footer area outputs for the entire document. Placing objects in these areas will result
in output values for the document as a whole (i.e., average, sum, text, etc.). Document header outputs
for the first page only. The document footer outputs for the last page only.

1. Click on the Document Header/Footer icon.
-OR-

2. Select Insert from the menu bar.

Select Area from the program group.

4. Select Document Header or Document Footer from the program list; this will allow you to insert
either the document header or the document footer, depending on which area you selected.

w

& EUREKA:Reporter Designer - [FFQUERY.iqr] [ =]
EF Fle Edt View Insert Query Tocls Window Help =1=xi|

SEEIE I
ATk B =2 80 [0 &) 6 [ |0 Lah (D0 | o8 2 ¥ [ B D D |
ip Tahoma =z Ee 2o |=

L L - T < R

N4 1Bt P 18]

Top Margin |0

4
]
|

/ This is the Document Header/\
Footer icon. Selecting this icon
will create both the document
header and footer.

A Actual Cost] BarCd SerialNbr

Detai

Fage Footer 0

DOCTMENTHAME

Bottom |0
Margin

< 3
Primary Selected Ohject: AcqCostHeader WUM. |
& EUREKA:Reporter Designer - [FFQUER Y.iqr] [_15]x]
Ef Bl Edt Yiew Insert Query Tools Window Hslp 1= x|

DEHE SREE| 4 &E o o &2 P
- B =Ecl= - R A= i == =)

T Toos o[ ]EEEE  ETE —)
Tmaon 1 -7 Notice how both the document - -
] &header and footer is created.
Document |0
Header ‘/
Page 0

Header

1 Actual CostE

i
Detail 0

Page Faster 0]
DOCUMENTHAME

Document
Footer

Bottom |04 L
Maigin b
< | »
Primary Selected Object: AcqCastHeader [ oM |
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Adding Text Obiect

Use this process when you want to add your own text to your report. For example, use a text object to
add titles, signature blocks, etc.

1. Click on the text icon.
-OR-

2. Select Insert from the menu bar.
3. Select Text from the program group.

& EUREKA:Feporter Designer - [FFQUERY.iqr]
E_!E\Ie Edit Miew Insert Query Tools ‘Window Help _|5 ﬂ

DEH Sk@m |y BR- - FL 0K
NGB (PO EED B ER X4y ([DLn®

[ Taror fz_Ejfe z[u|= == | |
T P e R E N L R T A I LA
Top Margin (0]
7 This is the text object icon)
Document D_i
Header 7
Page 0
Header b
1_: Nomen Stocklibx :I Actual CostE BarCd SexialNbr
Detail (E i
4 Homen | StockMbx | heqCost|  BaCd | Seriallbe
Page Foater 0
_: DOCUMENTHAME
Document |0
Footer 7
Bottom ] =
Margin b
4 - | 3 =
Frimary Selected Object: AcqCostHeader fililim_
ka FreeFaorm.igr) i
Ton | ogtr] Font | ot Obiet] HTHL | it when] 4. Do not change the Object Label.
4 order onl ol (== urpul 1=} . . .
e 5. In the Value window, enter the desired title
Object Label: ITEXT f t
e or your report.
;I Import File... | 6' ClICK OK' . .
7. Place the text object in the center of the Page
_I;I Header area of your report.
2
—Appearance
™ Suppress Duplicates L1 |
W wiord wiap If it is desired to have two lines of text,\
¥ Snap To Grid before typing in your text, first click
on Word Wrap and then click back in the
text box and enter your text. Enter your
text. Once this is done, you can
enhance the text by clicking on the
Border or Font tab(s).
QK I Cancel | Help |
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When you place a multi-line text object you will only see the top line. To display all lines:

a. Click the text object once. Notice the solid black box in the center of the bottom of the box.

b. Place the tip of your mouse arrow on the black box until you get a two-way arrow.

c. Hold down the left mouse button and pull down, enlarging the box until the lower lines are dis-
played. If Word Wrap was not selected, then doing this will only enlarge the font of your text.

& EUREKA:Reporter Designer - [FFQUERY.iqr] [_[=]x]
EF Fle Edt Yew Inset Query Tools Window Help =S

DEH|EkE $mBo - 7o 0K
AexE2h POEEE HnAR ||~ MY (500D |
Iy Tahoma =lz"=|e 2 [u)|=

BT —
L T Y Y Y = =

Tap Margn |1

Document |0
Reader | 1

Page o
Header

&' FUREKA:Rerorter Designer - [FFQUERY.iqr]

i Nomen StockNbz A€ wiew Insert OQuery Iools Window Help -8l x|
iE I — 4
peal 1" [ stocty LipfR@ne| o Fylew
Page Footer 0 .
] N BT EE N R A ===
] DOCUMENTHAME
Document |07 | By Tirwes Hesw Floman (e Efere o= E = |mE| v ‘
Footer
T e e e e e B
Place your text where Tor Haigin 7
you want it displayed ]
on your report.
Document |0
Header |
Page 0]
Header | My DPAS Report
iE Nomen Siocklbr Actual Cost BarCd SerialNbr
Detail 0
; Homen | StockiThr | Aeqlest| BarCd | Serialibx
Page Footer 0]
. DOCUMENTNAME
Document |0 ‘
Faoter ]
Bottom |0 [
Margin 1
4 | L|J
[ om

4. Save your report.
5. DO NOT close the report -- we will continue to useit in the next Unit of Study.
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Adding Date Objects
Use this process when you want to add the system date to your report.
1. Click on the date icon.
-OR-
2. Select Insert from the menu bar.

3. Select System from the program group.
4. Select Date from the program list.

& FEUREKA:Reporter Designer - [FFQUERY.igr]
EF File Edt View Insert Guery Tools Window Help [

DS H Sam|; @0 FY €|

W == T EI T A =
I']jj Times Mew Roman ‘iLm j| B r U ”%% = |.|~|“ j ‘
P N I I P IO 5
Top Margin |04
g \/This is the date object icon. )
Document |04
Header ] \
Page N
Hodor | My DPAS Report |
i Nomen StockNhr Actual Cost BarCd SerialNbr
Dretail 0 .
] Homen | Stockibr l Acqlost| Bacd | Serialifby
Page Footer| 04 |
] DOCUMENTHAME
Document |0
Faooter ]
Bottom 0] L
tdargin ]
4 »
(] B T

5. Place the date object on the left side of the Page Header area.

It is recommended that date objects be placed in the Page Header area. This is so that the date will
appear on each page of your report.

If it is desired to re-format the date presentation, double-click on the date object, click the down arrow on
the format box of the dialog box and select the desired format. The DPAS format is on the bottom of the
list.
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6. Process your report.

& EUREKA:Reporter Designer - [FFQUERY.igr] [_[B1x]|
EF fle Edt Yew [sert Query [ooks Window Help =l81x]
DEHSRE kB |72 eN
R T EE E RS =
B Tmes Hew Roman sz e ru 1) | |
W_g._,_ummle‘.‘.‘.‘la”mH.u.‘.\.‘.\s‘H\m\sm\mlh.‘.‘.‘lu
op Magn [
& EUREKAReporter Designer - [FFQUERY.iar] =1 E ]
N Ef Fie Edt Yew Inset Query Tods Window Help =18 x|
DEW SRR R« |[FL K
Docurent |0 A eecE@20 BOABE | B hG8s
Headsr
Ty Tines New Fomen i |
Page I ‘ ;
Header 0 I 1 I |2 L
u Top Margin | 0
] =laix
i Nomen slalel
Detsl O [ —
= Documert |0
Fage Footer 0 ez
] DOCUMENTHAME| Page ] JSUSTENDATE 1
Document |0 ez
Footer E
Botom 01
Maigin 71
. el 0] o
4 =
Ready Page Footer 0
— o duton Homen Actual Cost Barcd SeriallNbr {1
Document |0 S
Footer ER. MINI COMFUTER 111800 00
Botom 04
Mergin
4

Primary Selected Object: SYSTEMDATE

111600.00
111000.00
111000.00
11100000
111800.00
111800.00

7. Close the report viewer.
8. Save your report.
9. DO NOT close the report — we will continue to use it in the next Unit of Study.
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Adding Time Objects
Use this process when you want to add the system time to your report.
1. Click on the time icon.
OR-
2. Select Insert from the menu bar.

3. Select System from the program group.
4. Select Time from the program list.

& EUREKA:Reporter Designer - [FFQUERY.iqr]

E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DEH SRE )20~ |[FE |0
A keE2h DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Timez Mew Roman - j|B Ir u H%% = |.|'|| j‘
T e e - e =
Top Margin [0
3 This is the time object icon)
Document o
Header ]
Page 0] TTEMDATE E
Hoador | - IMy DPAS Report |
1: Nomen Stocklbr Actual Cost BarCd Serialthr
Dretail 04 .
= Homen | StockHbr | AeqCost| BarCd | Serallfhz
Page Footer| 04
A DOCUMENTHAME
Document |04
Foater ]
Bottom 0 =
M argin ]
«| | _’I_I
Primary Selected Ohbject: SYSTEMDATE [ [ o |

5. Place the time object below the date object in the Page Header area.

It is recommended that time objects be placed in the Page Header area. This is so that the time will
appear on each page of your report.

If it is desired to re-format the time presentation, double-click on the time object, click the down arrow on
the format box of the dialog box and select the desired format.
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6. Process your report.

ver Designer - [FFL

DEE SRe s ha- - F|tw|

x meB2h DodEE 0B = #v DR E

T Tones Mew Roman e =|mry=xa ﬂl—3|
i 2, 3 B 7

& EUREKA:Reporter Designer - [FFQUERY.iqr]
1 EF Fle Edt Ve Dnset Query Iook Window Hep BEES

{1  |pz@skm isex- £y ew
R Ralal = TGS RS ==Y
[ Tines New Feman Him =w 2w | g

R I R T T T e T B

Top Maan |

M alalz
D L& e Lok ow e aldlx]

HakW ¥ ®& K oD

Docunen! |0
Headst

Page [ STSTEMDATE
I
Header TIME

flomen

Detal 0

b Mi DPAS RcErl .

Page Footer 0

DOCUMENTHAME Namen BnckNb Actual Cost Barcd ulG

Document | ) SERVER. MINI COMPUTER 021703553020 11100000 ADOOOZ0S
Footer R MBI 130200 100000132
| M2 MISGII0% LIL30200 100000131
Botom |0 MSONITESIIR 11100000 ABDODO3ID
Margin EEOLITESII 11100000 ADDOD041D
ML) L1L000 00 ADOODOSLD

TESOLITESE 11100000 AGDOD0EID i

SONITRIR L0000 ADOOOOTLD
LIL00000  ADCOSOSLD
11100000 ABOOIO9LD
11100000 ADOOLOD
L1L00000  ABIOLON
1100000 ADDODLDIZ
11100000 ADOODLDLS
L0000 ADIODLOM
11100000 ABOODIOLS
11100000 ADOOOLOLE

wavess =l

7. Close the report viewer.
8. Save your report.
9. DO NOT close the report -- we will continue to use it in the next Unit of Study.
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Adding P Number Obj

Use this process when you want to add a page number to your report.
1. Click on the page number icon.

-OR-
2. Select Insert from the menu bar.

3. Select System from the program group.
4. Select Page Number from the program list.

g:'EUREKA:RepDrter Designer - [FFQUER Y.igr]

E!E\Ie Edit Yiew Insert Query Tools Window Help =11 x]
DESH SR@m L =@o | &Y (0|
N |7Em=?|@®muhaa IEIE A E=1=00=0

“I'ﬁ! Times New Roman j“‘lﬂ HL L ”g% = | .|'||| I |
O P T - P e W - W P B P W [ 2 B | =
Top Margin |0
3 This is the page number
1 object icon.
Document |0
Header ]
Page 0 SYSTEMDATE
] i
Hoader - ‘M My DPAS Report |
1: Momen StocklNhr Actual Cost BarCd SeriallNbr
Detail 0 :
B Homen | Stockibr | heqCost| BarCd |  Seriallfbr
Page Footer| 0 -
3 DOCTMENTHAME
Document |04
Footer b
Battom 0 =
I argin ]
< I ;I_I

5. Place the page number object in the center of the Page Footer area.

It is recommended that page number objects be placed in the Page Footer area. This is so that the page
number will appear on the bottom of each page of your report.

If it is desired to re-format the page presentation, double-click on the page object, click the down arrow on
the format box of the dialog box and select the desired format.
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6. Process your report.

& EUREKAReporter Designer - [FFQUERY.igr]

[ELx]
EF Fle Edt View Inset Query Toos Window Help N
DEHESRa| ;B |FfZ ex
R e T EE SR E=E
[ Times Hew Foman Eo Eje 2 o= = = 7
[ P O [ BN = P [y A YR e
Top Margin | 0
I
E8 Fle Edt Vew Inset Query Tods Window Help =l&ixl
DEH|gRa|s2go e |(f#D o8
A e E=20 DO E DB | &b EEE ||| 4T BE|H|
- 2 7 l== = [mpl — -
e 0 Yo Ik tb b 'l—‘—r — . 7 " DPASReportI
HAabr W/ B8 B D@ O
Place your page number EEEN
object where you wantitto [ ol s
be displayed on your report. T
ASASReportI
SarCd Sariallhe Jﬂ
5
poi| sE—
PAGENO

HBLES0
HowoI
FFQUERY

LAl

7. Close the report viewer.
8. Save your report.

9. DO NOT close the report — we will continue to use it in the next Unit of Study.
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Addin nter Obj
Use this process when you want to count each row of your report.
1. Since we are going to add the counter object in the first column, you will need to move all of your col-
umn headings and detail objects over to the right.
2. Click on the counter icon.
-OR-
Select Insert from the menu bar.

Select System from the program group.
Select Count from the program list.

ko

& EUREKA:Reporter Designer - [FFQUERY.iqr]

E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DEHSREm | c@o0 = |[F |0 |
A kxE2h DodmBE Hu@B (N MV EEDR B
JJI':&_' Times Mew Raman =l ||1D SO H%% E | .|'| I = ‘
R R N T T T T
Top Margin [0
T This is the counter
object icon.
Documert |0
Header ]
Page 0] SYSTEMDATE
i I
Hoager g My DPAS Report |
1: Nomen Siocklbr Actual Cost BarCd Seriallbr
Dretail 04 .
= Homen | StockHbr | AeqCost| BarCd | Serallfhz
Page Footer| 04
] DOCUMENTHAME PAGENC
Documernt |04
Faooter ]
Battam i O
M argin ]
«| | _’I_I

| T hon

6. Place the counter object to the left of your columns in the Detail area.
7. Delete the Counter column heading.

It is recommended that counter objects be placed in the Detail area. This is so that each row of the
report will be numbered.
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8. Process your report.

-E’!Elde Edt Imlew l:vsertl Query ll;u\s V\_Innduw Help =18l x|
DS @hm|) 2@o = |F8|0w

» heB3 BOAmB|HNER |n4v|nR(H|
|| O A T

| & Times New Roman

o, AW 2 3
Top Margin |0 S & FUREKA:Reporter Designer - [FFQUERY.iqr] MEIE|]
ﬁ{ Fle Edt ‘View Insert O MEE|
] DEH &R
N [T o @2 8 Place your page number ks |
Dosunas 0 (5t ToesHowionon object where you want it to |
Bader H
——— be displayed on your report. 3 -
Page i§ SYSTEMDATE Top Margin 0
Header |
] TIME ] _ lalE
leix
HarW ¥ ®& K oD o
— foent |0 =
1 "%:g
Detal B ]
- I i Page ] ‘SYSTEMDATE
Page Footer 0 Header TIME
] DOCUMENTHAME
Document |0 o
Foater
= ATAT004
0
(L b 1] couEE 756 My DPAS Report]|
Margin Page Footer 0
- D ¢ |0 Namen ek
ccmen
| Footer | ER. MINI COMPUTER,
Read | 2
z Bottom |0 1
Margin 4
“
3
w
"
1z
13
4
1
17 ot
2
[rem—— o

9. Close the report viewer.
10. Save your report.
11. Close your report.

HINT!
~ If you place the counter object in the detail area, you may want to delete the column heading.
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Activity: Designing A Customized FreeForm Report Without The
Query Wizard

nt Hands-On With Instr r Direction
Unit of Study: Designing A Customized FreeForm Report

Application: In this activity, your instructor will guide you through building a listing of Hand Receipt
Holders for a specified UIC using the FreeForm method of query and functions to customize your report.

Report Type: Hand Receipt Holder By UIC

Instructions:

1. Create a new FreeForm report.

2. Enlarge your Page Header.

3. Using the counter icon insert counter in the Detail area.
4. Delete the Counter column heading.

5. Select the following fields for your FreeForm report:

BUSINESS VIEW: HAND RECEIPT HOLDER

FOLDER(S) DATA ELEMENT(S)

Hand Receipt Holder HRH Nbr Mjr Office Name
HRH Name
Unit uIC

Insert the date and time in the Page Header area.

Using the text box icon, give your document a title name and customize with fonts, etc., and place in
the Page Header area.

8. Add a Document Footer area.

9. Add “End of Report” in the Document Footer.

10. Insert the document name, using the document name icon, in the Page Footer area.

11. Using the page number icon, insert a page number in the page footer.

N o
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& EUREKA:Reporter Designer - [C3-50.iar] [_[=]

EF File Edit Wiew Insert Query Tools Window Help

=121 %]

DEEHSEE | =@ o &P
A EeB2hmodmE (@R ||& M@ E|
[ Times New Flaman = = 2 ulE = = mE| 2 |
0 L il L |2 L |3 L 14 L |5 L |8 L Iz L =
Top Margin |01

=

Document
Header

=

STSTEMDATE
TIME

Page
Header

HRHNb:Mjr | HRHMame

=7

Detail
Page Footer

=

DOCUMENTHAME

["counTeR [ MmNebye | RENasa ] oM ] mes

Hand Receipt Report by UIC I

OfficeName uIc

PAGENO

=]

Document
Foater

Exd of Report

=]

Battam
Margin

4

12. Save your report as FFACTY for later use.
13. Close your report.

Example of finished report:

g?EUREKA:Reporter Designer - [C3-59]
@‘Eile Edit Wiew Tools ‘Window Help

»
[ T

W< » M 2@ e (@

Hand Receiet Reeort bx UIC I

811412002
9:20 am
HRHMNbrMjr  HRHName

1 701 KEN MOORE - TRAINOL
2 5802 WMARK MURPHY
3 5702 CRAIG ROSS - TRAIN02
4 5802 JIM RIGGS
5 5703 CINDY BEAN - TRAIN03Z
4 5803 LESLIEROSE
7 5704 RON HESS - TRAINO4
8 S804 RIT& KEWP
9 505 MWIKE WHEELER. - TRAINOS
10 5805 LAVADA GORE
11 5706 LEN JONES - TRAINOS
12 S804 JOHN SREEN

Ready
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OfficeMame uc

LOGISTICS HGQ1001
INTEL HGQ1001
INFORMATION TECH HQ1002
SYSTEMS SUPPCRT HQ1002
SUPPLY HOQ1003
EQUIFMENT MGIT HOQ1003
M&P HQ1004
CUSTOMER. SERVICE HQ1004
TRANSPORTATION HQ1005
LCISPATCH HQ1005
QUALITY ASSURANCE HQ1006
ANALYEIS HQ1006

Pgi1ofL [

T hon
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Skill Builder: Designing A Customized FreeForm Report Without
The Query Wizard

Objectives: You will:
e Review, Introduction to FreeForm & Desighing a Customized FreeForm Report
(Exercise Below)
e Discussion Questions
e Practical Exercise to build a Customized FreeForm Report

Complete the following exercise:

1. Name any two features that distinguish FreeForm from QuickQuery.

2. FreeForm is a powerful tool set that allows you to: (Circle all that apply)

a. Use multiple areas of the same type.

b. Specify Output when conditions that determine, row by row, when objects (and areas) should or
should not be included in your output.

¢. Add date and time to your reports

d. All of the above

e. None of the above

3. The F4 Function Key opens the

4. Folder Names are at the top level of the tree and are indicated in all caps? (True or False)
True False

5. Why is it important when dropping data objects inside the detail area to make sure the tip of the arrow
is inside the detail area?

6. Name the three areas your FreeForm window defaults to when it is opened.

7. Eureka will not allow you to change the column headings of your data objects. (True or False)

True False

104



Skill Builder: Designing A Customized FreeForm Report Without The Query Wizard

8. Match the Tool Bar Icons with the correct definition. Insert the alpha character on the blank line.

=
Example:A. ﬂ 7

B. —

£
C. —
D. — |

[t ]
E. —
3
6. 2

ahc
H.

Discussion Questions:

. Time Object

Counter Object

Document Name Object

Page Number Object

Date Object

Text Object

Page Header/Footer Icon

Document Header/ Footer Icon

1. Discuss the advantages of using FreeForm.
2. Summarize the process of the report you completed in the previous activity.
3. What types of reports are needed at your facility?
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Practical Exercise: Designing A Customized FreeForm Report
Without The Query Wizard

In nden nt R I
Unit of Study: Building and customizing a report using FreeForm

Application: In this activity you will build a customized accounting report using processes learned in
this unit of study.

Report Type: A customized Accounting Report by UIC, showing the stock number, serial number,
dollar amount of the assets, the fund codes used to procure the asset and the acquisition date of the
asset.

Instructions:

1. Create a new FreeForm report.

2. Enlarge your Page Header area.

3. Using the counter icon, insert the counter object in the detail area
4. Delete the Counter column heading.

5. Select the following fields for your FreeForm report:

BUSINESS VIEW: ACCOUNTING TRANSACTIONS

FOLDER(S) DATA ELEMENT(S)

uIC Dollar Amt
Stock Nbr Fund Cd
Serial Nbr Acq Dt

Accounting

6. Insert the date and time in the Page Header area.

7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in
the Page Header area.

8. Add a Document Footer.

9. Add “End of Report”. in the Document Footer.

10. Insert the document name, using the document name icon, in the Page Footer area.

11. Using the page number icon, insert page number in the page footer.
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Practical Exercise: Designing A Customized FreeForm Report Without The Query Wizard

12. Save the report as FFPE1 for later use.

& EUREKA:Reporter Designer - [C3-56.iqr]
=¥ File Edit View Insert Query Tools ‘Window Help 18] =

DEHSREm | c@o0 = |[F |0 |
A kB2 DodEBE Hu@B (N MV EEDR B

I':ﬂ'j Times Mew Raman =l ||1D j| Bl 71 ”? |.|'| I [ ‘
N N T e
Top Margin [0
P ] SYSTEMDATE -
e - — Accounting Report by UIC I
_ | L me StockiNbr SerialMNbhr DollarAmi  FundCd AcgD
Detél (0] [COUNTER " UiGH Stoslbe i Semen 0 Dotk Bunacd | AeqD
FPage Foater| U
_' DOCUMENTHAME PAGENC
Document |04
IFaetEn i End of Feport
Bottom o
M argin ]
| I >‘

[ ot

=
=

13. Print (if a printer is available) the report for the Instructor.
14. Close your report.

Example of the finished report:

CH UREKA:Reporter Designer - [C3-56]
@‘ File Edt Wew Tools Window Help 18] x|

HarHp? @& k@@ o

2’?5”33 Eccounting ReEort bz UIC I

uc StockNbr SerialMNhx DollarAmi FundCd  AcgDt
1 HQIO01 7025011725133 5644634563446 11000000 C1 20010314
2 N00204 7025011725133 721-3v-0001 11000000 98 20010314
3 MO0210 7025011725133 T21-5v-0002 11000000 98 20010314
4 MOO216 7025011725133 T21-5¥-0003 11000000 98 20010314
5 NO0281 025011725133 721-5V-0004 11000000 98 20010314
é N0O0750  I025011725133 721-5¥-0005 11000000 98 20010314
T MO0%4E  T025011725153 721-3V-0006 11100000 98 20010315 —
3 MO9239 9025011725133 T21-5¥-0007 11100000 98 20010315
9 MO92s1 7025011725133 T21-5¥-0008 11000000 92 20010315
10 M10151 025011725133 721-5¥-0009 11000000 92 20010315
11 N31954  I025011725153 721-3v-00010 11100000 98 20010315
12 N32739 7025011725133 T21-5¥-00011 11100000 98 20010315
13 N35970 7025011725133 T21-3¥-00012 11000000 98 20010315
14 N45679 7025011725133 T21-5¥-00013 11000000 98 20010315
15 Ma0308 025011725133 721-5v-00014 11100000 92 20010315
16 Nal665  T025011725133 721-5v-00015 11100000 98 20010315
17 Na1690  T025011725153 3411BLO0OLG 11000000 98 20010315
12 MALADN 9075011775132 2A11RT NNNTA 1annn NN as NATA S _>|LI
View specified page Pa: 1aof i l_ W_
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Building A Sort Order In A FreeForm Report

Unit of Study: Building a sort order in a FreeForm report when you want to sort items in your report.
Eureka Reporter Designer lets you sort your document or chart by any column or columns that you use in
it. By default, sorts are ascending. If you wish to define a descending sort, you will have to select it by one
of the methods you will learn in this course.

Application: This will show you how to sort in ascending or descending order, any field in your report.
Report Type: Asset listing by UIC and major hand receipt holder number.

Activity: Student Hands-On with Instructor direction

Instructions:

1. Create a new FreeForm report.

2. If your object directory is not open, depress the F2 Function Key.
3. Select the following fields for your FreeForm report:

BUSINESS VIEW: HISTORIES

FOLDER(S) DATA ELEMENT(S)
History UIC Serial Nbr
HRH Nbr Mjr Pgm Desc
Stock Nbr
4. Process report for viewing.
5. Close the output window.
6. Click ¥,
7. Highlight the HRH Nbr Mjr field.
CH2 108
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Building A Sort Order In A FreeForm Report

8. Click the arrow to move the field into the Ordered Objects window.

Sort Order /Filter: Untitled1

PomDesc
SerialMbr
StockMbr
uic

9. Click OK.
10. Process the report for viewing (go to the second page of the report; this is where the HRH Nbr Mjr
starts).

11. Try sorting on different fields and processing the report to see how your report will look.
12. Close and DO NOT save the report.
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Example of the finished report:

g}'EUREKA:Reporter Designer - [Untitled1]

@‘Eile Edit Wiew Tools ‘Window Help

Kar M2 @Q |k Bs

uc HEHMbiMjr  SiockNbr SeriallNbr PgmDesc
7010014126710 STE NBR.MAS CHG
010014126711 STE NBR.MAS CHG
010014126712 STE NBR.MAS CHG
010014126713 STE NBR.MAS CHG
010014126714 STE NBR.MAS CHG
010014126715 STE NBR.MAS CHG
010014126716 STE NBR.MAS CHG
010014126717 STE NBR.MAS CHG
010014126718 STE NBR.MAS CHG
010014126719 STE NBR.MAS CHG
7010014126720 STE NBR.MAS CHG
025010004322 STE NBR.MAS CHG
DP&A3S01 AUTHORIZATION U
WOUZAL PARS NBR.CHG
WOUZAL PARS NBR.CHG
WOUZAL PARS NBR.CHG
WOlGAL DoC REG CLO
WOVL1S DoC REG CLO
WOVGLA DoC REG CLO
WOVGLA DoC REG RED
|
Ready |Pg: Zaof 2
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Group Header/Footer Areas

Group Header/Footer Areas

INTRODUCTION

When you format a document, you can output information quickly and easily through group headers
and footers.

Group Header Areas are output at the beginning of each group of rows that have the same value in
a column you specify. When you place a column object in this area, Eureka outputs the value of that
column, taken from the first row in the group. However, if you use an aggregate function for the col-
umn, Eureka outputs the value for the group as a whole, i.e., the average, sum, etc., for that column
for all rows included in the group.

Group Footer Areas are output at the end of each group of rows that have the same value in a col-
umn you specify. When you place a column object in this area, Eureka outputs the value of that col-
umn, taken from the last row in the group. However, if you use an aggregate function for the column,
Eureka outputs the value for the group as a whole, i.e., the average, sum, etc., for the column for all
rows included in the group.

Group headers (and group footers) have a special relationship with the sort order for your document:

O When you add a group header or footer, £ureka automatically sets the document sort order
based on the object associated with the group header.

O When you have more than one group header or footer, £ureka sets the document sort order to
use each of the columns for which you have group header or footer areas. It sets the sort
order to match the order in which you add the area objects.

If you change the sort order for your document, Eureka rearranges the order of the group headers
and footers to match the new sort order.

Q\fﬂ\ NOTE:
N\ You must select a column or custom object before you can add a group header area. The

N\ 2
\\,// group header area is based on the object that is selected at the time the group header is cre-
ated. The object can be in any area.

OBJECTIVES

In learning how to create and use group headers and footers, you will also learn why to use them.

APPLICATION

There are advantages to grouping your data within your report. For example, by grouping stock
numbers, the user can see all examples of the specified stock number in one, order place.

PREREQUISITES

Complete Chapters 1 and 2 of this manual.
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Group Header/Footer Areas

ACTIVITY

Student Hands On with Instructor direction

REPORT TYPE

Open the HRH by UIC report, page FFACTY.

STEPS TO PERFORM ACTION

1. Open the FFACTY report.
2. From the Detail Area, click once on the field you want to group. We will be grouping on the UIC.
3. Select Insert from the menu bar.
4. Select Area from the program group.
5. Select Group Header from the program list.
-OR -
6. Select the Group Header icon .
7. Move the field(s) that you want in the Group Header from the Detail area. We will be grouping by
UIC.
8. Move the UIC column heading to the far left of the Group Header area.
9. Move the UIC data object (blue object) next to the UIC column heading (gray object).

g}'EUREKA:Reporter Designer - [C3-59.iqr]

2l

10. Process the report and view.
11. Close the report viewer.
12. Save the report.

CH 2
1 October 2004

E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁ||1|
DEHSRE B0~ |Fx e
A kB2 DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Times Mew Roman j ||1D j| B I U H%% = |.|'| I j ‘
R R T N T T
Top Margin [0
3 i SYSTEMDATE H
== | — Hand Receipt Report by
= HEFNbrMjr | HRHName ___OfficeName
UIC Group |04
Header i jis (o) me |
Dietail 0 | COUNTER =~ HEHWE:Mj | HEHHame | Officelame [
Page Footer| 04
] DOCUMENTHAME PAGENC
Documernt |04
Faooter 7
- End of Report
Battam 0-
M argin
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Group Header/Footer Areas

13. DO NOT close the report — we will continue to use it in the next Unit of Study.

& EUREKA:Reporter Designer - [[3-59]

@‘Eile Edit Wiew Tools ‘Window Help

=@l x|
W< » M 2@ e (@

21052002 H

o o Hand Receipt Report bx UIC I
HEHMbrMjr HEHName OfficeName

uc  HO1o001

1 5701 KEN MOORE - TRAINOL LOGISTICS

2 5802 MARK MURPHY INTEL

-
| »
Ready

[Pg: 10f 1 [ o |
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Building A Page Break In A FreeForm Report

Building A Page Break In A FreeForm Report

Unit of Study: Often a single document consists of sections that need to have individual page
numbers. For instance, a single document might consist of hundreds of (HRH) Hand Receipt Holder
Reports, each to be distributed to a different HRH. When you do this, you would probably want to have:

1. Each HRH Report or UIC report starting at the top of a new page.
2. Each time a new UIC is reached, page numbering re-starting from one.

You can do this in a FreeForm window by including a group header area based on HRH Mjr. Nbr. For that
area object, you would enter 1 under Page Skip Before Area on the Area tab of the Area dialog box.
This causes one page break before the area is output. You would also check the Reset Page Number To
box and then enter 1 as the number to which to reset the page numbering.

You can use these controls for a variety of purposes. For instance, if you want group footers on a page
without any other area objects, you could enter 1 under both Page Skip Before Area and Page Skip
After Area. If you wanted document totals on a separate page, you could enter 1 under Page Skip
Before Area in the Area dialog box for the document footer area.

Application: This report will show you how to insert a page break every time a new UIC is
encountered.

Report Type: Hand Receipt Holder by UIC (FFACTY)
Activity: Student Hands-On with Instructor direction
Instructions:

1. If closed, open the FFACTY report.
2. Double-click in the blank portion of the UIC Group Header area.

aZIEUREKA:Reporter Designer - [C3-59.iqr]
I‘E__!Eile Edit Miew Insert Query Tools Window Help - ﬁ'lﬂ

NEHgRe o - | Fy e8|

SN BNt NElol - T ORdiEEi=1=11=0
Hls 2 v [FEF [m] =)
T I T [

Ew g R A I I S

I':& Times Mew Roman j ||1D
Ll 12

0 e 1

Tap Margin |0

Fage 0 STSTEMDATE =
EZ TIME Hand Receipt Report by

_ HEHNbsMir | HRHName __OfficeName
UIC Group |0
Header ] i) Cof o1c |
Detail i | COUNTER |  HEHHEME HEHName | OfficeName |
Page Footer| 0 -

= DOCUMENTHAME PAGENO
Document |0
Foater 7

End of Report
Battom 0
Margin
[ | _’l_l
MUK |
CH 2 114

1 October 2004



Building A Page Break In A FreeForm Report

3. In the Page Skip group, change Before Area from 0 to 1.

Area: Page Header (Untitled1.iqr)

Area |Bo[der| Olutput whenl HTMLI

— |dentification

Area Description:

Area Level: E

~

r— Print Options
& Print All Dccurrences
¢~ Print Only 15t Occurence
€ Print &l But 15t Decurence
¢ Frint Only Last Dccurence

Select whether you want the page to
break before or after the group.

Use the spin button to select the
number of blank pages you want to
print between groups. /

\

€ Print &)l But Last Dccurence

— Spacing FPage Skip
Before Area: lﬁ@ln.
Alfter Area: lﬁ In.

Before Area: ID_E
Alfter Area ID_E

QK | Cancel Help

4. Click OK.
5. Save your report.
6. Process your report to view the results.

& EUREKA:Reporter Designer - [C3-59]

@‘Eile Edit Wiew Tools ‘Window Help

W< » M 2@ e (@

81972002
B:56 am
HEHMbrMjr HEHName
uc  Hoo0t
1 701 KEN MOORE - TRAINOL
2 5802 WMARK MURPHY

Hand Receiet Reeort bx UIC I

OfficeName

LOGISTICS
INTEL

Ready

7. Close your report.

CH 2
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Inserting A Filter In A FreeForm Report

Inserting A Filter In A FreeForm Report

Unit of Study: Each document always has a single base filter. This base filter is always in effect and
initially has no conditions defined for it and performs no filtering. You can add conditions incrementally to
narrow the focus of your query. Unless query filtering conditions are applied, £ureka presents all of the
rows in the database as part of the output. If the database is large, however, such output can be difficult
to present and understand. Filter conditions help to narrow down output so that it included only relevant
database rows.

Application: Filtering conditions to narrow down output so that only relevant data base rows are
presented in the document output.

Report Type: This report will list only computers that were manufactured by DELL and/or GATEWAY.

Activity: Student Hands-On with Instructor direction

Instructions:

1. Open a new FreeForm report.

2. In Page Setup, make sure that the Height is set to 8.5 and the Width is set to 11.
3. Enlarge the Page Header area an additional 3 blocks.

4. Select the following fields for your FreeForm report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Mfr._Model/Part_Number Mfr Name
Catalog Nomen
Stock Nbr
Serial_Hand_Receipt Acq Cost
Serial Nbr
Unit UIC
5. Add a title for your report, date, and time for your report to the Page Header area.
6. Add the document name and the page number to the Page Footer area.
7. Add a Group Header for the MfrName.
8. Move the MfrName column heading and data object into the Group Header area.

9. Select the filter icon ¥ to display the filter dialog box.

10. Double-click on the Detail folder.

11. Double-click on UIC to move it to the Object Window.

12. Select the drop down arrow and chose “like” for the operator.

13. Enter W* for the value. Remember to turn your Caps Lock on.

14. Click Add.

15. Double-click on MfrName Group Header.

16. Double-click on MfrName to move it to the Object Window.

17. Select the drop down arrow and chose “like” for the operator.

18. Enter *DELL* for the value. Remember to turn your Caps Lock on.
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19. Click Add.

Eilter |§0rt Drderl
— Select Query Data ‘When
OR'd
Object: Operator: ialued: ialued: Group
| | =l [0 &
0: Mfiame Iz Like *DELL®
0: UIC I= Like W=
Columns [ Objects. £/0vi:c sdd | Modiy Delete
= MM ame Group Hea a .
Wit ame [ Distinct Valueg Only Filter Types
] & Cument
5 Detai [Eurstan Wvermides
StockNbr : " Base
AcqCost " adHoc
aTga'Nbf ' Quick Filers
MNomen ILI I vl
| i -

Once your condition is set, click Add to activate it. If
you have an existing filter and you need to change it,
highlight the condition you wish to change, make the
change to the condition and then click Modify.

If you have an existing filter that you no longer need,
highlight the condition and click Delete.

20. Click OK.
21. Save your report as FFFILTER.
22. Process and view your report.

Example of finished report:

& EUREKA:Reporter Designer - [FFFILTER] MEE|
@‘Eile Edit Wiew Tools Window Help _|ﬁ||1|

Kar M@k Be| e

pi FreeForm Filter Report |

Nomen StockMNbr AcyCost  SerialMbr
MifrMame DELL
ZERVER 7021703593105 11130200 73282-57-
MONITCR, 17" 100HS 025703616122 03300 T21-5V-AC
MONITCR, 17" 100HS 025703616122 03300 T21-5V-AC
WONITOR, 17" 100H3 025703616122 93300 TZI-5V-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITOR, 17" 100HS 025703616122 03300 T2-SV-AL
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITCR, 17" 100HS 025703616122 03300 721-SV-AC
MONITOR, 17" 100HS 025703616122 | 033.00 721-SV-A_|E;I
3
View specified page [Pg: 1af1 [ I_IW_
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23

. Close the output window.

Now, if we wanted to put another filter in to display information where the UIC began with W and the
MfrName was Gateway, we would have to put in an OR condition.

24,
25,
26.
27.
28.
29.
30.
31.
32.

Select the filter icon 3| to display the filter dialog box.

Double-click on UIC, from the Detail folder, to move it to the Object Window.
Select the drop down arrow and chose “like” for the operator.

Enter W* for the value. Remember to turn your Caps Lock on.
Change the OR’d Group from 0 to 1. This will set an OR condition.
Click Add.

Double-click on MfrName, from the MfrName Group Header, to move it to the Object Window.
Select the drop down arrow and chose “like” for the operator.
Enter *GATEWAY* for the value. Remember to turn your Caps Lock on.

The OR’d Group should already be set to 1 since we changed it in the previous condition.

33. Click Add.

34.

Sort Order/Filter: DMy Ti

Eilter l Sort Order ]
Select Query Data ‘When

Object: Operator:

‘RPTS~1\filter report.i.. [E

OR'd
WValuel: Group

[ [Like

=l e

0: Mfiame Iz Like *DELL®
(: LIIC |z Like W™
1: MfiMame |5 Gy

=
12 UIC |z Like ™

Columns | Objects Browse

= MM ame Group Hea a

B MfiName

= Detail
StockMNbr
AcqCost
SenialMbr
uic

MNomen =
4 »

Todify Delete

[ Distinct Walues Only Filter Types
{* Current

" Baze
" AdHoc
" Quick Filters

|

Custom Override:

QK | Cancel | Help

Click OK.

- NOTE:
\\. \//\ By default, all the conditions of your query are AND operators (i.e., all conditions have to be
> met before it will return your results). However, you can connect your statements with OR
operators, which divide your statements into groups. For example, if you wanted to set your
conditions by Stock Number AND Serial Number OR Bar Code, the OR’d Group would be
set to 0 (zero) for Stock Number and Serial Number, and set to 1 for Bar Code.

Remember, the RULE is...If the OR’d Group numbers on any two statements are the same,
those two statements are connected by the AND condition. If the OR’d Group numbers on
any two statements are different, those two statements are connected by the OR condition.
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35. Save your report.
36. Process and view report.
37. Close your report.

Example of the finished report:

& EUREKA:Reporter Designer - [FFFILTER] MEE]
@‘Eile Edit Wiew Tools ‘Window Help _|ﬁ||1|

Kar M2 @Q |k Bs

o5 FreeForm Filter Report |

Nomen StockMbr AcqCost  SerialMNhr
MfrName DELL MABKETING LP

WMONITOR, 19" 025703614377 03300  7036-IIN-
MfiName DELL POWEREDGE

CPU, DESKTOP 021703531020 132200 7036-WIN-—
MftName GATEWLY (SYSTERMS) INC

WONITOR, 19" COLOR 025000001952 54300 1787201-L

COMPUTER, PENTIURM IIT 7025010000563 153200 100-KM-0

WONITOR, 19" COLOR 025000001952 54300  100-KEM-0

COMPUTER, PENTIURM IIT 7025010000563 153200 971-LP-00.

WONITOR, 19" COLOR 025000001952 54300 178201-Lh

COMPUTER, PENTIURM IIT 7025010000563 153200 100-KM-0

WONITOR, 19" COLOR 025000001952 54300 178201-Lh

COWPITTER. PERTIIIR TIT T02 5010000 568 | 153200 ANN-K 0T

»
Ready Pgizofz [ hUM |
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Hiding An Object In A FreeForm Report

Unit of Study: If you choose to hide an object on your document, Fureka automatically creates a
hidden area object to hold it. These area objects are visible only in FreeForm windows. They are not
output as part of your document. Hidden areas are also created when you base Output When, prompts,
query filter, or value translation conditions on columns that are not included in your output.

Application: In this activity, you will take the query from the previous exercise and hide the prompt so
it will not be printed out on your report.

Report Type: Asset listing by major hand receipt holder number (FFACTY).

Activity: Student Hands-On with Instructor direction

Instructions:

1. Select the Prompt object in your Page Footer area as the object to be hidden.

2. Right-mouse click to display shortcut commands.

3. Select Hide Toggle.

4.  You can see the hidden prompt by displaying your Area Object List by depressing the F4 Function

Key.

g}'EUREKA:Reporter Designer - [C2-78.iqr]

E!Eile Edit YWiew Insert Query Tools ‘Window Help == =]
DEHSRE B0~ |Fx e
A kB2 DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Times Mew Roman j ||1D j| B I U H%% = |.|'| I j ‘
N R T T N T o=
Top Margin [0 Page Header
B Detail
_ Page Footer
Document Footer
Hidden Document
Page 0 STSTEMDATE
Header b TIME PRO'{
1] I ActivityName HEHNhxMj AcyCa
Netail 0
Page Footer| 0 -
J DOCUMENTHAME
Documert |0
Faooter ]
Battam 0]
M argin o
| | >|
| | [ |
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5. Click on Hidden Document and your prompt will display in the Hidden Document area of your
design document.

g}'EUREKA:Reporter Designer - [C2-78.iqr]
E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DSHSGRE | @0~ |[F 0N
ool e =2 0 |01 @ 0 O |t Lk 008 | [ [0 7 |0 - D@ ||

I':ﬂ'j Times Mew Raman =l ||1D j| Bl 71 H%% E |.|'| I = ‘
: I e e = [
Top Margin [0 Page Header
B Detail
N Page Fooker
p Document Footer
T Hidden Document
Page 0 STSTEMDATE
Header ] TIME PRO'{
1] e ActivityName HEHMheMjs AcgClo
Netail o
FPage Foater| 0
] DOCUMENTHAME
Documert |0
Faooter ]
Hidden |0
Document ] HEH_Prompt_|
Battam i
M argin ]
« | _>l_I

Creake a new query | | l_ ’W.
To hide it again, simply click on Hidden Page in the Area Object List.
Save your report.

Process your report.

Close your report.

©ENO
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Inserting A Prompt In A FreeForm Report

Inserting A Prompt In A FreeForm Report

Unit of Study: A user prompt is an effective tool which allows input from the user to query the
database. There are varied user prompts you can utilize in FreeForm to add to your report and permit the
user to access information promptly. The objective of this lesson is to add a user prompt to a report.

When working with large databases, it may be a good idea to adjust the Prompt Row Limit. Do this by
choosing Tools > Preferences. The default is 100 rows. A value of 0 retrieves all rows (but this is not
recommended for large databases).

Application: In this activity, your instructor will guide you through creating a simple Hand Receipt in
FreeForm. After creating the query you will then insert a prompt which will ask the user which Hand
Receipt Holder they would like to view.

Report Type: Complete listing of assets by major hand receipt holder number.

Activity: Student Hands-On with Instructor direction

Instructions:

1. Open a new FreeForm report.
2. Enlarge the Page Header area.
3. Select the following fields for your FreeForm report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Unit uIC
Activity Name
Hand_Receipt_Holder HRH Nbr Mjr
Serial_Hand_Receipt Acq Cost
Catalog Nomen
4. Add a title, date, and time for your report to the Page Header area and customize with fonts, etc.
5. Add the document name, using the document name icon, to the Page Footer area.
6. Add the page number to the Page Footer area.
7.  Add a Document Footer area.
8. Add “End of Report” in the Document Footer area.
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Inserting A Prompt In A FreeForm Report

Save your report as FFPROMPT.

g}'EUREKA:Reporter Designer - [C2-78.iqr]

E!Eile Edit Wiew Insert Query Tools Window Help

DEHSREm | c@o0 = |[F |0 |

A kB2 DodEBE Hu@B (N MV EEDR B

I':ﬂ'j Times Mew Roman j ||1D j| B I U H%% = |.|'| I j ‘
[ R R T T - L
Top Margin [0
Page 0 STSTEMDATE
Headert | 1 |Tmae [PROMPT REPORT |
1 uc ActivityName HEHNbxrMja AcgCost Nomen
Dt 0 (e [ ActivityWawe [ EREWWMp[  AeqCost( Momen |
Page Footer| 0 -
J DOCUMENTHAME PAGENC
Documert |0
Foater o End of Report
Battam 0
M argin ]
| 3

ow

10. Select the prompt icon ﬂ from the tool bar.

User Prompt: PROMPT {C2-78igr) E .
_ _ _ 11. Object Label: Enter HRH Prompt
Prompt | Bo[derl Faont I Hot Qb|ec:t| HTMLI Olutput whenl Qonnectlonl SAL Dvemdel . . -
— 1 in the Object Label. This is where
O ol Seauence Number you would enter the descriptive name
prev T for your prompt
Type: m " )
N hmactrwighe [0 2] 12. Sequence Number: Accept the
~ Cheice List : default of 1. If you have more than
Colurns | Biose proceVae ToAdd one prompt, you can designate the
A ACCOUNTING T a . H H . .
o Accouning e order in which it will run by changing
CICPAIP _ the sequence number.
3 AUTHORIZATIO " Use Choices Only . “ ” .
3 Authorizaton & Allow User Input 13. _Prompt. Entgr Entgr HRH". This
[a Seie Hend_ [ Allow Mullipls Choices is the prompt instruction.
5| _>|—| I Requirs Input 14. Type: Accept the default of String.
—I_Appearancc o Default Choice: If you selected a cost or date field,
Suppress Duplicates  |v Snap To Grid
i A | you can change the format of that
field.
QK I Cancel Help
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Inserting A Prompt In A FreeForm Report

15. Format: The field displays the characteristics of the data (string, numeric, or date). These come
from the database file structure.

String These are alphanumeric characters.
Numeric These are pure numeric characters.
Date Self-explanatory.

16. Character Width: Select the amount of characters you want to display.

17. Choice Value To Add: Leave this field blank. This field will allow you to enter the fields that the
user will select. The choices will display in the window to the left.

18. Use Choices Only: Do not select this radio button for this report. Use this field to only select
choices from a choice list. You cannot type an entry for the prompt. The choice list will consist of the
entries you add to the Choice List.

~ <5 HINT!
&Qgi To add an item to the Choice List, enter the choice in the Choice Value To Add field and click
' Add.

If you want to delete a value from the Choice List, highlight the value in the Choice Value To
Add field and click Delete.

19. Allow User Input: Accept this default radio button for this report. This radio button allows you to
type an entry for the prompt or make a selection from a drop down box. If you have defined a choice
list, you can choose from the choice list or type an entry.

20. Allow Multiple Choices: Do not check this box for this report. Check this box to select multiple
items from the choice list. Each choice is added to the value of the user prompt object. Choices are
separated by semi-colons (;) or commas (,). This option works in conjunction with the above two
options.

21. Require Input: Do not check this box for this report.

~ <5 HINT!
% Dynamic Choice List - A dynamic choice list is a list of choices that is generated at the time
' Eureka presents a prompt to the user, that is, at the time a user selects to preview, print, or
export the document. It is created from the values returned by a database query, that is, it is a
list of current database values

Steps to create a Dynamic Choice list:

1. Use the Object Directory to find the column you want to use.

2. Double-click or drag the column to the unlabeled choice list. You can choose more than one column
underneath one Business View.

Steps to create a Static Choice list:

1. Use the Object Directory to find the column you want to use.

2. Highlight the column and click on the Browse button from the Choice List.
3. Add your values to the unlabeled choice list by double-clicking on the items one at a time.
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22,

23.

24,
25,

Appearance: Refer to Designing A Customized FreeForm Report Without The Query Wiz-

ard for definitions for the appearance options.

Default Choice: Leave the Default Choice blank for this report. If you want a specific value to be

defaulted in the prompt, enter the default choice.
Click OK.
Place the prompt in the Document Footer area.

g}'EUREKA:Reporter Designer - [C2-78.iqr]

E!Eile Edit YWiew Insert Query Tools ‘Window Help == =]
DEHSRE B0~ |Fx e
A kB2 DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Times Mew Roman j ||1D j| B I U H%% = |.|'| I j ‘
O v e B B A B B e T R
Top Margin [0
Page 0 STSTEMDATE
Hewder |4 |tmee [PROMPT REPORT |
1] I ActivityName HEHNhxMj AcyCost Nomen
Dkl 0] [UIC [ MctivityMame [ HEHWuMp[ | AeqCost| Momen
Page Footer| 0 -
J DOCUMENTHAME PAGENC
Documert |0
Foater ] HEH Prompt | End of Report
Battam 0]
M argin i
| | >|

o

In order to get the data you want from the prompt, you will need to apply a filter. Filters make prompts

active

1. Select Filter icon.

2. In the Objects window, double-click the Detail folder.

3. Double-click on HRHNbrMjr to move it to Object.

4. Set the Operator to = (equal).

5. In the Objects window, double-click on the Document Footer folder.
6. Double-click HRH_Prompt to move it to Valuel.
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7.

w

Click Add.

~

Sort Order/Filter: C:\Documents and Settings',magriffit'My Documents'Eu... B3

Filtes |§ort Order I

— Select Query D ata When

Object: Operator:

OR'd
Waluel: ialled: Graup

| - =l [0 &

Liddl Modify Delete

= - !

& ActivitM ame [ Distinct Yalues Only Fier Types

| HRHNEebr Custam Override: - e

&l AogCost : " Base

& Momen =1} AdHoc
b DounFther " Quick Filterz

I tH_Frompt

Cancel | Help |

NOTE:

When adding the filter, you will need to select the data element as the Object and the prompt
as the Value.

8. Click OK.
9. Save your report.
10. Process your report.
11. When prompted, enter W1NW54.
Prompts to answer Answers K I 12 CIICk OK
Enter HRH VTS| Cancel |
Help |

@‘E\Ie Edit Wew Tools window Help

=lex]

A A R A RCROR s e - Hfia

2972002
112 pm
uic ActivityName

WINWS4  JROTC FLOWING WELLS HS - TRAINI0
WINW34 JROTC FLOWING WELLS HS - TRAINIO

WIHWS4

PROMPT REPORT |

Ready

HEHMbrMjr AcgCost  MNomen
WINW54 93200  CDREAD WRITER
WINW54 o33.00 MONITOR, 17" 100HS
End of Report
| »
Pg:1afl MM |
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13. Close the output window.
14. Save your report.
15. DO NOT close the report — we will continue to use it in the next Unit of Study.
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Designing A FreeForm Report Using Double Detail Areas

Unit of Study: Designing a FreeForm Report

Introduction: Itis possible using Fureka to have multiple detail areas. If you want to have extra
information printed for certain rows, you can use a second detail area for the extra information. You can
also use multiple detail areas when you want to include detail about on/y some of the data returned. For
example, if you want to see a list of all computer monitors but were only interested in the cost for those
that were manufactured by Dell, you would create a second detail area. If adding a second detail area,
you would want to use Output When (this is discussed later), otherwise, objects in the second detail area
alternate output within original detail area. Using Double Detail ensures that you will be able to print on
standard paper, because you can limit your margins to the 82" and use the second detail area for the
additional information.

Application: When designing a report where you need extra information printed for certain rows you
can use the double detail process.

Report Type: A Property listing showing the additional information Stock Nbr., Mfr Name, and Qty. On
Hand in the double detail area.

Activity: Student Hands-On with Instructor direction

Example of the Design Document:

g}'EUREKA:Reporter Designer - [Doubledetail.iqr]
E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DEH SRE )20~ |[FE |0
A kxE2h DodmBE Hu@E KMV BEDR B

[T Times New Froman =l ||1u j| B I U | = = E| M| |[##au0.00 =l ‘
_|...|1...|...|2...|...|3...|...|4...|...|5...|...IB...|...|?...|...|3...:|
Documert |0 -
Header | 1 DPAS Double Detail Report
Page 0] [SYSTEMDATE Dauble Detail
Header 5
. Acqg Cost  HEHNhxMj Nomen SerialNbr LIN
Detaill) |0 feq Cost|  HEHNbeMjr [ Homen [ Seriallfbr [ L  AwhOog
il AuthOt
Detailz) |0
7 StockNbr MfrName iy Onka
StockMbr | MirHame | CtyCmH.
Page Footer| 04
_ PAGENC
Documernt |04 |
Faooter
] End of Report
Battam 04
I argin 3 =
4] | 3
Primary Selected Object: AuthCty MUM
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Example of the finished report:

& EUREKA:Reporter Designer - [(3-87]
ED, Fle Edit Wiew Tnoks MWindow Help _15] x|

N4> H|>?|@1Q|ri:||z|=a|o\

DPAS Double Detail Report
21912002 Double Detail
Acy Cost HEHNbrMjr Nomen SeriallNbr LIN
ATEIR00 WINWSS TR CGO 12T 6000 109-TR-010 Z30E03 Auih
3
StockMNbr MeName QiyOnHand
2320010907891 UHASSIGNED 1
211200 WINWSS LATHE, ENGINE 3411BLADOID L3321 Auth
3
StockMNbr MeName QiyOnHand
3411001364013 UHASSIGNED 2
233200 WINWSS COPIER. 5¥5 XEROX A100DLAOSL C13298 Auih
3
4 | _’I_I
Ready Pgi1ofL hUM |
INSTRUCTIONS:
L]

STEP 1. BUILDING THE BASICS

1. Create a new FreeForm report.
2. Save your as FFDOUBLEDETAIL.

STEP II: DOCUMENT DESIGN WINDOW
Insert a Document Header area.

Insert a Document Footer area.
Insert a Detail Area:

W

a. Click on Insert from the menu bar.
b. Click on Area from the program group.
¢. Click on Detail Area from the program list.

Enlarge the Page Header area 2 more blocks (for a total of 5 blocks).
Enlarge the first Detail area 3 more blocks (for a total of 4 blocks).
Enlarge the second Detail area 2 more blocks (for a total of 5 blocks).

N ou s

Click on the text icon ﬂ and type a title that will go in the Document Header area; remem-

ber, to use the font tab and enlarge and bold the text plus add any other preferences you

may want.
8. Repeat Step 7 for the Page Header area.
9. Add “End of Report” in the Document Footer area.
10. Insert the date in the Page Header area.



Designing A FreeForm Report Using Double Detail Areas

11. Insert the page number in the Page Footer area.
STEP III: DATA FIELDS FROM THE BUSINESS VIEW END ITEM SERIAL

1. Make sure your Object Directory is displayed (F2 Function Key). Use the screen print
on the first page of this handout for placement reference.

2. Select the data fields listed below: You will be inserting these data fields in the 15t Detail
area on the top line of that detail area, so the gray box is in the page header.

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! Acq Cost Serial Nbr
HRH Nbr Mjr LIN
Nomen

Close the Quick_Start! folder.
Open the Serial Hand Rcpt.-Auth folder.
Select the data fields listed below: Insert Auth Qty in the 1st Detail area.

kW

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Serial_Hand_Rcpt.-Auth Auth Qty
Qty On Hand

6. Move Auth Qty object (blue object) down one row and bring the Auth Qty column header

(gray object) down to the row above the detail object.

Insert Qty On Hand in the 51 row of the 2nd Detail area, positioned in line with Auth Qty.

Move the column header (gray object) to be above the detail object (blue object).

Open the Quick_Start!folder.

10.  Select the data fields listed below: You will be inserting these data fields in the 2" detail
area, lining them up under the 14" margin.

© @ N

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! Stock Nbr
Mfr Name

11. Bring the detail object (blue object) down to the 51 Jine.
12.  Bring the column header (gray object) and line it up above the 4th line.

STEP IV: ADDING A PROMPT AND FILTER

1. Insert a Prompt.

2. In the Prompt Label, enter "HRH Prompt”.

3. In the Prompt line, enter "Enter HRH Mjr Nbr”.
4. Click OK.
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5. Insert the prompt in the Page Footer area.
6. Click once on the prompt.
7.  Right-mouse click and select Hide Toggle.
8. Insert a filter.
9. In the Object area pull from the Detail(1) folder the HRH Nbr Mjr.
10. Select = (equal) for the Operator.
11. From the Hidden Page folder, select HRH Prompt for Valuel.
12.  Click Add.
13.  Click OK.
14.  Save your report.
15.  Process your report.
16. At the prompt, enter one of the following HRH numbers:

WI1NWS55 W3Vs10
W1ivsue W46919
W1v5su7 W46920
WOU28A w4T809
W2MKJ2 Ww4T810
W2MKI3 W4XQ85
W3VS09
17.  Click OK.

Example of the finished report:

& EUREKA:Reporter Designer - [(3-87]

@‘Eile Edit Wiew Tools ‘Window Help ;Iilﬂ
Kar|maa|kos|o|
DPAS Double Detail Report
8192002 Double Detail
Acy Cost HEHNbrMjr Nomen SerialNbr LIN
2783800 WINWSS TRE CGO 12T 6000 109-TR-010 #3903 Auth
3
StockMNbr MeName QiyOnHand
2320010907891 UNASSIGNED 1
211200 WINWSS LATHE, ENGINE 3411BLAODIOD L33211 Auih
3
StockMNbr Mifrl¥ame QtyOnHand
3411001364013 UNASSIGNED 2
233200 WINWSS COPIER. 573 XEROX 6100DLAD31 13208 Auth

Ready [Pg: 10f 1 [ o |
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Using Translate Values In A FreeForm Report

Unit of Study: Value translations allow you to substitute one value for another. Translate Value is
similar to a CASE structure of “If — Then — Else” logic.

You can use value translations to:

0 Replace a technical term or code with a familiar term

o Draw attention to a significant value

0 Add more information about certain values
Application: 1n this activity, you will still use the Hand Receipt report. You will create a new custom
column and a condition that will substitute the words "CAPITAL ASSET” in the custom column field, any
time the cost is equal to or exceeds $100,000.

Report Type: Complete listing of assets by major hand receipt holder number (FFPROMPT).

Activity: Student Hands-On with Instructor direction

Instructions:
1. Open FFPROMPT.
2. Scroll over to the right of your report to display the last field.
3. Click on the Custom icon.
4. Double-click on the Detail folder.
5. Double-click on the AcqCost field to move to the Value window.
6. Using the calculator on the right of the window, click on x (multiply).
7. Clickon 1.
8. Change the Character Width to 15.
Cugtom: CUSTOM (prompts.igr)
Custom | Bo[derl Faont I Olutput whenl Translate ﬂotDbiectI HTMLI
Dbject Label, [CUSTOM ™ User Function
Walue
AcqCost =1 ;I 7lalal =
41 5| B
12 3] +
x| o] . |oof ¢
Qolumnsl Objects  Brovwse |Euncti0n| Type: INumeric jv
£ Detall meat;lﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ Vl
(27 Hidden Document Ehi{ﬁg:ﬁ:{ ITE
Aggregate Function: I[None] 'l
Appearance
™ Suppress Duplicates [ Wword wrap
<| I _,I ¥ Snap To Grid ™ Hide
QK I Cancel | Help

9. Click OK.
10. Place the custom object into the detail area.
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11. Change the Custom column heading to Capital/Non-Capital.

& EUREKA:Reporter Designer - [C2-78.iqr]

EE?FiIe Edit Wiew Insert Query Tools ‘Window Help == x|

SEEIEEC I R T
SRS B === T T R A ==
I':& Times New Raman ;I“'IEI ;|| B f U ”g% = |.|'||| ;I |
PO N VI YT IS SV OV =TRSO < AN Y T =TT T = AN e
Top Margin |04
Page 0l
Hoder | 1 |PROMPT REPORT |
1 ¥Name HEHNbrhlja AcqCost Nomen CapitalMNon- Capital
Detal Ofpfame [ HEHWwMp( | AeqCost[ Memen [ jucusTomM
Page Footer| 04
PAGEHO
Document |04
Foater 3 End of Fepoxt
Bottorn 0.
Margin ]
L« | >|
T

12. Double-click on the CUSTOM field.

13. Select the Translate tab.

14. Double-click on the CUSTOM field in the Detail folder.
15. Set the Operator to >= (greater than or equal to).
16. Enter 100000 in Valuel.

17.  Enter CAPITAL in then Become.

18. Click Add Case.

19. Change Otherwise Become to NON-CAPITAL.

prompts.iqr)

Qustoml Bo[derl Faont I Output when Translate |ﬂ0tDbiect| HTMLI

— Change Yalue
Object: Operator: Walue 1: el 2
Wwhen|[CUSTOM |>= =] [100000 |
then Become: ICAF'ITAL

N i

- Object Source Add Caze Delete Caze Modify Case |

LColumns | Objects Erowss
HRHMbrkjr -
AcqCost
MNomen

B CUSTOM Fesult Type: INumeric 'l

(2 Hidden Document |+

Otherwize Become
MON-CAPITAL

QK I Cancel Help

20. Click OK.
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21.
22.

23.

Save you report.

Process your report (using S701 in your HRH prompt).

g?EUREKA:Reporter Designer - [C2-78]
@‘Eile Edit Wiew Tools ‘Window Help

LIS R A RCRO R el e - T2

IPROMPT REPORT |

CapitalNon- Capital
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL —
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL
CAPITAL
HON-CAPITAL
HON-CAPITAL
HON-CAPITAL

s

Activity[Name HEHMbrMjr AcqCost  Nomen

DEFENSE FINANCE & ACCOUNTING SE 701 27143900 TRE COO 12T 6000

DEFENSE FINANCE & ACCOUNTING SE 701 1150200  LATHE, ENGINE

DEFENSE FINANCE & ACCOUNTING SE 701 1356600  COPIER 5VS XEROX

DEFENSE FINANCE & ACCOUNTING SE 701 2763300  TRX LF 6000LE LT-60RS

DEFENSE FINANCE & ACCOUNTING SE 701 1.00  TELEPHONE, STUIII

DEFENSE FINANCE & ACCOUNTING SE 701 253200  BARCODE READER.

DEFENSE FINANCE & ACCOUNTING SE 701 23200  ANSWERING MACHINE

DEFENSE FINANCE & ACCOUNTING SE 701 093300  MONITOR, 19" COLOR.

DEFENSE FINANCE & ACCOUNTING SE 701 310100 COMPUTER, PENTIUM III

DEFENSE FINANCE & ACCOUNTING SE 701 536500  COMPUTER, PENTIUM II

DEFENSE FINANCE & ACCOUNTING SE 701 462200  PRINTER, LASER.

DEFENSE FINANCE & ACCOUNTING SE 701 11000000  SERVER.

DEFENSE FINANCE & ACCOUNTING SE 701 49000  CPU, DESKTOP

DEFENSE FINANCE & ACCOUNTING SE 701 49000  HANDHELD COMPUTER

DEFENSE FINANCE & ACCOUNTING SE 701 49000  HANDHELD COMPUTER
Fnd af Banart

Kl |

Ready |Pg: l1of1

DO NOT close the report — we will continue to use it in the next Unit of Study.

T hon
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Using Output When In A FreeForm Report

Unit of Study: Output When conditions allow you to set up the condition under which certain objects
are included in your output.

Application: We will be using Output When to set specific conditions under which an output object
will be included in your report.

Report Type: Accounting report that shows all assets for the major hand receipt holders, but only
displays the acquisition cost when the condition is met.

Activity: Student Hands-On with Instructor direction

Instructions:

If closed, open FFPROMPT.

Double-click on the AcqCost data object (blue color).

Select the Output When tab.

Set the Operator to <= (less than or equal to).

Enter 5000 for Valuel.

Insert Space When Not Output: Check this box to determine whether or not £ureka
inserts a space in your output when the object for which you are setting the condition is not
output.

oUhwN=

Column: AcqCaost (prompts.igr)

Eolumnl Bo[derl Font  OutputWhen |ﬂ0tDbiect| HTMLI Translate

Output 'wWhen
Object: Operator: Walue 1: alle 2
JacqCast J<- =] |5000 |

¥ Inzert Space When Mot Dutput

— Object Source

Clear |

Columns | Objects Erowse

= Detail
uic
ActivityCd
HRHM bk
AcqCost
MNomen

(27 Hidden Document

KN i

QK I Cancel Help

)

Q\fﬂ\ NOTE:
\O > Output When works best when using multiple areas. For example, if you have two detail
\\// areas, you may only what certain data objects to output when the condition you set is met.

7. Click OK.
8. Save your report.
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0.

& EUREKA:Reporter Designer - [(2-78]

Process your report using S701 at the prompt.

@‘Eile Edit Wiew Tools ‘Window Help

M4 H|>?|@1Q|ri:||z|=a|o\

811212002
6:29 am

uc

HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001
HO1001

ActivityName

DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE
DEFENSE FINANCE & ACCOUNTING SE

HEHMbrMjr
701
701
701
701
701
701
701
701
701
701
701
701
701
701
701

IPROMPT REPORT |

Ready

Notice that the Acq Cost only displays the cost when the condition is met.

s

AcqCost  Nomen
TRE CGO 12T 6000
LATHE, ENGINE
COPIER. SY5 XEROX
TERX LF 6000LE LT-60RS
100 TELEPHOHNE, STUIII
253200  BARCODEREADER
23200 ANSWERING MACHINE
03300  MONITOR, 19" COLOR
30100 COMPUTER, PENTIUM III
COMPUTER, PENTIUR 1T
462200  PRINTER, LASER.
ZERVER.
40000 CPU, DESKTOP
40000  HANDHELD COMPUTER
40000  HANDHELD COMPUTER
End of Report
|
Pgi1ofL

T hon
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Skill Builder: Introduction To FreeForm And Designing A Custom-
ized FreeForm Report

Objectives: You will:

> Review, Introduction to FreeForm & Desighing a Customized FreeForm
Report (Exercise Below)

>  Discussion Questions

>  Practical Exercise to build a Customized FreeForm Report

Complete the following exercise:
1. Filters are used to (Please choose one):
a. Generate duplicate records.
b. Control which rows of detail data for output.
¢. Include spaces in your report.
2. Isit possible to build a Prompt without a Filter? (Yes or No)

Yes No

3. Iam a prompt and I allow the user only to select choices, which prompt type am I?

4. Iam a prompt and I allow the user to select from a choice list, which prompt type am I?

5. Tam a prompt and I allow the user to select multiple choice items, which prompt type am I?

6. Translate Value is similar to a CASE structure of "If - Then - Else" logic? (True or False)
True False

7. When you do not set any Output When condition, every object is output all the time? (True or
False)

True False
8. The F2 Function Key provides information regarding hidden objects? (True or False)

True False
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9. You must be in a FreeForm window to add or edit a user prompt object? (True or False)
True False
Discussion Questions:
1. Discuss the Prompt process:
a. Object label, what goes there. Why is it important to signify it is a prompt?

b. Prompt label, what is entered here?
2. Why do you insert prompts in a report?
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Practical Exercise: Introduction to FreeForm And Designing A
Customized FreeForm Report

Unit of Study: Introduction to FreeForm and designing a customized FreeForm report.

Application: This process is used to allow the user to enter a designated value in the dialog box that
is presented when your document is processed. This prompt consists of text you have entered as a part of
the object definition when building the prompt (i.e., ENTER HRH NBR MJR).

Report Type: A customized Accounting Report by UIC or Mjr HRH to identify assets with a dollar
amount of $1.00.

Instructions:
1. Open a new FreeForm report.

2. Expand the Page Header area an additional 4 blocks.
3. Select the following fields for your FreeForm report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! UIC Acq Cost
HRH Nbr Mjr Nomen
Serial Nbr

4. Add a title, date, time for your report and place the objects in the Page Header area (you can custom-
ize with fonts, etc.).

5. Add a page number to the Page Footer area.

6. Add a prompt for UIC and HRH Nbr Mjr and place in the Page Footer area.

7. Click on the UIC Prompt object.

8. Right-mouse click and select Hide Toggle to hide the prompt object.

9. Repeat to hide the HRH Prompt object.

10. Select the filter icon.

11. If the Detail folder is not open, double-click on it to open it.

12. Double-click on the UIC object.

13. Set the operator to = (equal).

14. Double-click on the Hidden Page folder to open.

15. Double-click on the UIC_Prompt to place it in the Value.

16. Click Add.

17. Repeat steps 12 through 16 for the HRH_Prompt.

18. Double-click on the Acq_Cost field.

19. Set the operator or <= (less than or equal to).

20. Set the value to 1 (for $1.00).

21. Click Add.

22. Click OK.

23. Click on the Print Preview icon.

24. Enter S710 for the HRH Nbr.

25. Enter HQ1010 for the UIC.

26. Click OK.
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27. Save your report as FFPE2.
28. Close your report.

The report results will vary based on how you choose to develop the format.

& EUREKA:Reporter Designer - [C3-99.ige] =&
E’Fi\e Edit Wiew Insert CQuery Tools ‘Window Help ==X

DEHSR@m % BB [ Fx|(eN

A (S Mo @dmBE | Me@ER &MY EiEE H

I'ﬂj Times Mew Roman j“'l[l j‘ﬁ]’i”%; = |l||| L||
T T

0 1y PO T (NI = AT IR L R T P A

Top Margin |0
Page 0 STSTEMDATE e
Homter | — |Acqm5|t|on Cost Equal To or Less Than $1.

1]

J uic Acq Cost| Nomen SerialNbr
Dietail 0] UIC [ HEMMbMie [ hea Cost| Momen [ SealMw [
Page Footer| 0

. BRERE  : Query Prompts [<] PAGENO
Bottom 0
Margin ] Prompts to answer Answers ok I

__ Enter HRH | Cancel |

i Enter LIC

Help

| S -
4 »
Ready [ e

Example of the finished report:

& EUREKA:Reporter Designer - [C3-99.i¢ _=] x|
QFHE Edit Wiew Insert Query Tools Window Help =] x|
DEH SRm § @ - &% (0w

A (@20 D0 FAED BB & 470D 2|
| & Times New Fioman L|“1D LI”?I 'E”%% = |£||I

O e I B B A

]|
ol

=T (R |

Top Margin |0

e |mE Acquisition Cost Equal To or Less Than $1.

] uIc Acq Cost| Nomen Seriallbr
Detail ]
Page Footer| 0
] i Query Prompts PAGENO
Battom 04
Margin 1 Prompts to answer Answers oK I
] Erter HRH | Cancel
g Erter LIC
Help
. = .
4] 3
Ready ML
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Building A FreeForm Query Using The Parent/Child Function

INTRODUCTION

When we use the Parent/Child function, we create at least two documents. The main document is
the “Parent”. A “Child” document is an attachment and an extension of the parent document. This is
done dynamically -- the query for the child document is submitted by the parent whenever it needs to
include output from the child. Any Eureka design document can be used as a child or as a parent
document. The primary reason for including data from another business view is whatever business
view you are using for your report does not contain the data needed in the report.

There are two types of child objects in Eureka
1. Child Document Objects. Each of these represents an entire document.

0 Child objects must first be created in a separate query design window and saved as a
query design file (.igr).

0 Child document objects permit the reuse of documents over and over as part of other
documents. These are building blocks that can speed up the development of queries.

0 Child document objects generate a query that is completely separate from the parent
query. Child objects submits a separate SELECT, SORT, and FILTERS to the database.

0 Child document objects query can also have a child document attached to it.

2. Child Data Objects. Each of these represents a single object from a document.
hild Documen j

The child document object represents one or more documents whose output is included as a part of the
main document, the parent.

Child documents are used almost exclusively for two reasons:

0 To pull data from different business views into one report
O To stop repeating of identical rows caused by mixing certain data fields

Passing values from a parent document to a child document is required when you need a row of
information from the child document for each row in the parent document. If you were using the child
document to provide only a total cost, and you placed it in the document footer of the parent document,
you would not need to pass the values from the parent.

However in most cases you want information from the child document for each row the parent selects, and
you want to make sure the child is looking at the same row as the parent document. That is, if the parent
document is looking at serial number 105, then the parent wants child data for serial number 105. This is
done by passing values to the child document.

The parent can pass the serial number to the child to synchronize the child to the parent, it can also pass
information the child uses to calculate custom data fields, and return them to the parent.

The child document is usually placed on the detail line of the parent document so it will output for each
row in the parent document.

Insert the child document object in the desired area.
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0 If you place the object in the Document Header or Document Footer area, the child object will
appear only once at the beginning of the document or at the end of the document. When a
parent includes detail, this is a more efficient way to include summary data at the beginning or
end of the parent rather than mingled with the detail.

0 If you place the object in the Page Header or Page Footer area, the child will appear once at the
beginning or end of each page. When a document is used as a child object, page header and
footer areas do not appear in child documents. It is recommended to only use these two areas for
small child documents.

0 If you place the object in the Group Header or Group Footer areas, the child will appear once for
each row that appears on your document. This is useful when you want to represent data from
more than one source and database that is different from the parent.

0 If you want the child to show only certain rows, place it in its own detail area, separate from the
other columns in the parent document and set the Output When conditions for the area.

1w CAUTION!
Y Take special care in deciding where to place the child document object. Placing it in a detail

area can result in the child document object being created numerous times and in the
consumption of large amounts of system resources (depending on the nature of the query
generated). Depending on your needs, this may or may not be effective. Similarly, if the child
document object is in a page header or group header area, it is generated once for each page
or group.

OBJECTIVES

Understand and demonstrate the ability to pass information between parent and child objects. Using
a Parent/Child document, you will draw data elements from two separate business views (or data
sources) into a single report. You will present a sample page of this .iqo (finished report) to your
instructor.

APPLICATION

The parent/child function is the only way to pull data from two different business views into a single
report. For example, to generate your own hand receipt that contains both END ITEM SERIAL and
END ITEM BULK business views.

REPORT TYPE

Asset listing with acquisition date and user IDs.

PREREQUISITES

Must be able to create a design document using FreeForm.

Complete the Chapters 1, 2 and 3 of this manual.
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ACTIVITY

Student Hands-On with Instructor direction.

Example of a Parent/Child Report:

g}'EUREKA:Reporter Designer - [PC-Parent]
@‘Eile Edit Wiew Tools ‘Window Help

Kar M2 @Q |k Bs

51702003
IMY PARENT REPORT
StockNbr Nomen SeriallNbr Acy Dt User ID
2320010907891 TRE CGO 12T 6000 23200FR0007 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0002 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0009 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0010 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0011 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0012 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0013 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FRO014 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR00L5 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0016 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0O0L7 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR001E 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0019 20010314 instr1
2320010907891 TRE CGO 12T 6000 23200FR0020 20010314 instr1
2320010907891 TRE CGO 12T 6000 2320FR0001 20010314 instr1
2320010907891 TRE CGO 12T 6000 324234173333 20010314 instr1
2320010907891 TRE CGO 12T 6000 3242305006 20010316 instr1
20N NAN7201 TR 01T ANNN FIATTTENNZ annt rlm A imehdl1
Ready Pgizofz [

STEPS TO PERFORM ACTION (Parent Document)

1. Create a new FreeForm report.

2. In the parent document, add the name of report and the date to the Page Header.

NOTE:

\\\

\/

the file names with “ch1”, “ch2”, and so on.

3. Add the page number and the document name of the report to the Page Footer.

T hon

It is always good practice to end the file name of the parent report with “par” and end the
child report file name with “ch”. If you have more than one child report, you may want to have
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4. Select the following fields for your Parent report from the table below. Make sure that you put them to
the left side of your design document:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog Stock Nbr
Nomen
Serial_Hand_Receipt Serial Nbr

g}'EUREKA:Reporter Designer - [PC-Parent.iqr]

E!File Edit Wiew Insert Query Tools ‘Window Help 18] =

DEHSRE B0~ |Fx e
A kB2 DodEBE Hu@B (N MV EEDR B
JJI':&_! Times Mew Roman j“‘lﬂ j| B I U H%% = |£I I j ‘
: T T T - Y AT N
Top Margin [0
Fage D_: STSTEMDATE
iR IMY PARENT REPORT
_: StockiNbr Nomen SerialNbhr
Netail 04
Page Foater U:
] DOCUMENTHAME PAGENC
Battam 0-
M argin o

2l

ow

5. Save the parent report as PC-Parent.
Child Document

1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must
be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.

2. Select the following fields for your Child report from the table below. Make sure that the fields are
placed approximately to the right of where the last field in parent was placed:
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3. Using the document name icon, insert the report name to the Page Footer.

|

IS ==

[ s e Foan HiFce == - u [[E= = [mE[l =
1 i} 14 1

o i I

12 i 13

StockMNbx

DOCUMENTNAME

PAGENO

T NOTE:
) T | ”\ Notice that the last field in
Figure 1 (Parent Report) \/ the parent report, to the right
ends at around 52, so the
e — =11 child data field should start
IEEEEET == around 6.
[Ix | T b 68 =2
|| Times Mew Raman

(E]

Top Margin a

4. Save the report as PC-Child.
P i EREESRER 5. Process the report.

DOCUMENTHAME
ttam a-

>
I I [rora

Figure 2 (Child Report)I
hild Prompt

To make sure the child document returns information for the same row that the parent is looking at, a
prompt is placed in the child document. The prompt input comes from the parent for each row. Visualize
the parent looking for a row for serial number 105, it gives the serial number to the child prompt and the
child pulls information for that row at the same time the parent is looking at that row.

1. Click on the Prompt icon.
2. For the Object Label, enter Serial Number Prompt.
3. For the Prompt message, enter “"Enter Serial Number”.
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4. Change the Character Width to 20.

User Prompt: Serial_Number_Prompt {childligr) ll
Prompt | Bo[derl Faont I Hat Dbiectl HTMLI Clutput whenl Qonnectionl SAL Dverridel

Sequence Number: |1 E

(= T 5 rial_Murnber Prompt

Prompt: IEnter Serial Mumber

Type: IString 'l
Farmat: I i l Character ‘width: |2D E
r~ Chaoice List
Colurmns | Browse Choice ¥alue To Add:
= ACCOUNTING T o
7 Accounting Add Delete |
COCIPAYIP
bAUTHDF“_ZAT'D " Use Choices Only
g Authorization & Allow User Input
Serial Hand_ : B
CATALOG - [~ &llows Multiple Choices
4 3
— Appearance Diefault Choice:
™ Suppress Duplicates W Snap To Grid I
I~ word ‘Wrap ¥ Hide

QK I Cancel Help

5. Click OK and place anywhere in the Page Footer.

6. Right-click on the Prompt object.

7. Select Hide Toggle. Hiding the Prompt is optional. If you want it displayed on the report, do not
hide.

hild Filter

Once a prompt has been established, we must tell the child report how to limit data to the one serial
number the parent has provided the child prompt for each row the parent report retrieves. The child
filter is used for this purpose.

Click on the Filter icon.

Click on the Columns tab, scroll to the HISTORIES Business View.
Double-click on the History folder.

Double-click on Serial Nbr to move it to the Object field.

Set the Operator to = (equal).

Click on the Objects tab.

Double-click on Hidden Page Folder.

Double-click on Serial_Number_Prompt to move it to Object 1.

NN RAWNE
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9. Click Add.
Sort Order /Filter: C:\Documents and Settings',mgriffi "v ﬂ
Eilter | Sort Order I
— Select Query Data When
OR'd
Obiject: Operator: WValuel: Walues: Group
| [ =l e

0: SerialMbr Equal To Serial Murmber Prompt

Qolumns| Objects |ﬁr0wse| Add Modify Delete
23 Detail .
[P=Hidden Page [ Distinct Yalues Only Filter Types
Sernial_Mumber_Prom Custom Override: ' Cunent
{7 Hidden Detail Dbjects : " Base
—1 | © AdHoc
7 [Quick Filkers
4 | o

QK | Cancel | Help |

In this report, we are interested in the date and who posted this item to the property book. The history

file has a data field called PgmDesc. There is a PgmDesc for all property book transactions. These include
EI INC L/T, EI DEC TI, EI INC RCPT, etc. and must be entered exactly as they appear in the History table.
When this filter is added, this will restrict the child data to postings to the property book only.

10.
11.
12.
13.
14.
15.
16.

17.
18.
19.

Click on the Columns button.

Scroll to the HISTORIES business view.

Double-click on the History folder.

Double-click on PgmDesc to move it to Object field.

Set the Operator to = (equal).

For Value 1, type in EI INC RCPT. Remember to turn your CAPS LOCK on.
Click Add.

Sort Order/Filter: - Documents and Settings',mariffi ";{ Ll
Filker | Sort Order I
— Select Query Data ‘When
OR'd
Object: Operatar: Walued: alued: Graup
Il | =] e

0 PgmDesc Equal To El INC RCPT
0 SerialMbr Equal Ta Serial_Murmber_Prompt

Columns I Obiects Erowse| Sdd | iy Delete
O Detail ]
£ Hidden Page ™ Distinct Yalues Orly Filter Types
£ Hidden Detal Objects ; ' Current
Cuistarn Dwverride;  Base
~1 | adHoc
" Quick Filters

4 | ol

ak I Cancel | Help |

Click OK.
Save the report.
Close the child report.
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In ing the Child D men

1. If closed, open the Parent document.
2. From the menu bar, click Insert>Child Document.

-OR-

3. Click on the child document icon @.

4. Place the child document object in the Detail area, to the right of the other objects.

g}'EUREKA:Reporter Designer - [PC-Parent.iqr]

E!Eile Edit Wiew Insert Query Tools Window Help

DEHSREm | c@o0 = |[F |0 |
A kB2 DodEBE Hu@B (N MV EEDR B

JJI':&_! Times Mew Roman j ||1U j| B I U H%% = |.|'| I j ‘
O v e B e B B B B T JB
Top Margin [0
Page 0] SYSTEMDATE
iR IMY PARENT REPORT
_: StockiNbr Nomen SerialNbhr I
Detail 0] Serialibe | [Ex]
PageFooterU_—
__ DOCUMENTHAME PAGENC
Battam 04
M argin o
4]

Ready

ow

NOTE:
% In almost all cases, the child is anchored to the detail line. In some special reports, the child

~ document may be anchored to the group header or footer.
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Child: CHILD (PC-Parent.iqr) [X]

ChidDocument | Bogder | Guputhn 5. Double-click on the Child Document icon in

I the detail area.
e : _ 6. Object Label: You can label your object if
E:illedgan;:[. IE.\Eureka\Heporter\Des@ner\F’E-EhlId.lqr jJ you WiSh.
IR 7. Click the drop down box under File Name
and click the Child Document that you cre-

Senial Mumber Prompt : SerialMbr on Detail [Area

bl ated.
Answer Uzer Prompt Above 'with Object Below 8 Undel’ Parent Ob]eCtS C“Ck the dI’Op down

RN SciaNooon Ocii P =l " boxand select SerialNbr on Detail[Area]
Appearance - . . ;
¢ Scale to Obinc F SnapToGid [~ wordwiap This is telll_ng you what da_ta fields the Parent
Seale Margis: |25 Z]: [ Hide ¥ Suppress Duplizates document IS Se|eCtIng. It IS aISO the common

(" Concatenate - field between the parent and child docu-

R Append Parent's Filker -

Dl © Evceute Befoe Pant ments. If there are any prompts for the child
wecule before Farenl . . . . .
Fxecutonorder [1 2] report, they will be displayed in this window.

QK I Cancel | Help |

7%, NOTE:
\  Once you select the data field, it will be displayed in the Child’s User Prompts window. This
\\//// means that the child report will receive the selected field that the parent is looking at for each
row of information. This locks the reports together.

9. Select the radio button, Merge Child. This insures the data from the child document will use the
same size and font style as the parent.

[Scale to Object cales the child document to the size of the child document object

Concatenate FEates a single text string from Objects in the child document. Scaling 1S not
used.

10. Click OK.

11. Save your report. The child document is now attached.

- NOTE:
\O > If you do not see the child data, check to ensure that the child data block on the child report is

\% to the right of the most right hand block on the parent report. Even though the data from the
child report will appear on the parent report printout, the column header from the child report
does not get displayed. You must go into the text box and create a column header on the
parent report. Moving the child report icon to the left and right on the parent report will not
move where the child data prints out. This must be done on the child report by moving the
data block.

Since only the data from the child document Detail area is inserted into the parent, you may want to add
column headings in the parent document for the data from the child document.

12. Click on the Text Box icon and add a column heading for the Acquisition Date and place it in the

Page Header area at around the same place as where you placed it in the child document.
13. Repeat for the User ID.
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14. Save your report.
15. Process your report.

Example of the finished Parent/Child report:

g}'EUREKA:Reporter Designer - [PC-Parent]
@‘Eile Edit Wiew Tools ‘Window Help

Kar M2 @Q |k Bs

Notice that the data from
the child report is displayed.

56112003
IMY PARENT REPORT
StockINbr MNomen SerialNhr \ Acy Dt User ID
2320010907891 TRE CGO 152T 6000 23200FR0007 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FRO00E 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR000% 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0010 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0011 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0012 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0013 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0014 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0015 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0016 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0017 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0018 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0019 20010314 instr1
2320010907891 TRE CGO 152T 6000 23200FR0020 20010314 instr1
2320010907891 TRE CGO 152T 6000 2320FRO001 20010314 instr1
2320010907891 TRE CGO 152T 6000 324234175333 20010314 instr1
2320010907891 TRE CGO 152T 6000 3242305006 20010316 instr1
22I0M1 NANTRa1 TRY (40 1T &N 2A72T1ENNS ann1 rlm & imet1
Ready Pgizofz [
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Activity: Designing A Parent/Child FreeForm Report

Unit of Study: Designing a Parent/Child FreeForm Report

Application: The parent/child function is the only way to pull data from two different business views
into a single report.

Report Type: A listing by UIC of the assets over $100,000 with information from both the End Item
Serial Business View (UIC, Nomen, AcqCost, and StockNbr) and the Accounting Business View (Asset Cd,
Acq Dt, Effective Dt. SerialNbr, and DolAmt.

Activity: Student Hands-On with Instructor direction

Example of the finished Report:

g}'EUREKA:Reporter Designer - [C4-14-Parent]
@‘Eile Edit Wiew Tools ‘Window Help ;Iilll

Har M2 @e |k oe

1402002 < " <

IParent/Child Financial Report ||
ure Nomen Acq Cost  StockNbr Asset Cd  AcgDi  Serial Nbr Eff Di
HOMO0I  SERVER HOODDDD TOZSOUTISIZE K 2010314 5644634563446 20010314

T21-5V-0001

T21-5V-0002

T21-5V-0003

T21-5V-0004
T21-5V-0005

20010315 721-5V-0006 20010315
T21-5V-0007

T21-5V-0003

T21-5V-0009 =
Kl | _>l_I

Ready [Pg: 1of 7 [ [ oM

Instructions:

Parent Document

Open a new FreeForm report.

Save your report as PC-Acty-Parent in the folder designated by your instructor.

Click to select the Page Header area. Widen the Page Header Area area to 3 blocks high.
Add the Name of report (text) and the Date to the Page Header area.

Add the document name to the Page Footer area.

kLN
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6. Select the following fields for your report from the table below. (Place to the left as far as
possible).

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! uIC
Nomen
Acq Cost
Stock Nbr

7. Save your report.

Parent Filter

1. Click on the Filter icon.
2. Click on the Objects Tab.
3. Double-click on the Detail Folder.
4. Double-click on AcqCost to place it in the Object cell.
5. Set the Operator to >= (greater than or equal to).
6. Enter 100000 in Valuel.
7. Click Add.
Sort Order /Filter: C:\ Documents and Setting ﬂ
Filter |§0rtDrder|
- Select Query D ata when
OR'd
Obiject: Operator: WValuel: Walues: Group
[Aca_Cost [5= ~| [100000 [ &
Qolumnslgbiects ﬁrowsel Add | Modify Delete
_\l;eﬁl:c [ Distinct Values Only Filter Types
& Mamen & Cument
Custom Override: I
& StockNbr — | AdHoc
7 [Quick Filkers
A | |
QK I Cancel | Help |
8. Click OK.

9. Save your report.
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10. Remember where the last data field is on your report.

Example of Your Parent Design Document:

g}'EUREKA:Reporter Designer - [C4-14-Parent.iqr]

E!Eile Edit Wiew Insert Query Tools Window Help ;Iilﬂ
DEHSREm | c@o0 = |[F |0 |
A kB2 DodEBE Hu@B (N MV EEDR B

I':ﬂ'j Times Mew Roman j ||1D j| B I U H%% = | .|'| I j ‘
N N T e
Top Margin [0
0] SYSTEMDATE - - -
I |Parent/Child Financial Report

uc Nomen Acqg Cost StockNbr

Detai 0 rﬁ Momem [ heqCostf Stockiby |

Page Footer| 0 4
_' DOCUMENTHAME

Battam 04

M argin

| 3

MUM. |
Child Document:
L

Create a new FreeForm report.

Save your report as PC-Acty-Child in the same folder as the PC-Acty-Parent document.
Select the following fields from the table below. (Place these objects in the Detail area begin-
ning at the 6” mark on the ruler. Otherwise, when you attach the Child to the Parent, it will
not show up.

W=

Summarized Report

BUSINESS VIEW: ACCOUNTING TRANSACTIONS

FOLDER(S) DATA ELEMENT(S)

Accounting Stock Nbr Serial Nbr
Asset Cd Eff Dt
Acq Dt Dollar Amt

Right-click on the Stock Nbr data field (blue object).

Select Hide Toggle. This will be used for our Prompt and Filter.

Delete the column heading for Stock Nbr.

Double-click on each data object (blue object).

When the Attributes box comes up, check the Suppress Duplicates box.

®NoU A
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9. Save your query.

Example of the Child Document Design:

D @hem| - - A
[ [T et 00 WO @ =M mm:ﬂws [l a0
HWII—_I -

18, L d¥,

Top Mangir 84

P LT
Hoses | 1

5 S - S | L -
Dt a5 AsiSA | e | __ﬂ

Fage Footar i

Dotom (02
Morgm 3

1] - . !

Child Prompts:

To make sure the Child Document returns information for the same row that the Parent is looking at, a

prompt is placed in the Child Document, the prompt input comes from the Parent for each row.

Visualize the Parent looking for a Row for Stock Number 1234, it gives the Stock Number to the child

prompt and child pulls information for that row at the same time the parent is looking at that row.

uhwn e

© N

Click on the Prompt icon.

Enter StockNbrPrompt for the Object Label.
Enter “"Enter Stock Number” for the Prompt message.

Change the Character Width to 15.
Click OK.

User Prompt: PROMPT {acty-childigr)

Brampt | Bo[derl Fant I Hot Dbiectl HTMLI Output whenl Qonnectionl SGL Dverridel

Object Label: IStOCkN brPrompt

Sequence Number: |1 E

Prompt: IEnter Stock Mumber

Type: IStnng 'l

Format b

Character ‘width: I E

r~ Choice List

I Columns ~ Erowse

P=ACCOUNTING T«
':I:] Accounting

SO CIPAWIP
= AUTHORIZATIO
(27 Autharization
27 Serial_ Hand

Choice ¥alue To Add:
Add Delete |
" Use Choices Only
& Allovs User Input
CATALOG _ILI [ Allow Multiple Choices
»

—Appearance
[ Suppress Duplicates W Snap Ta Grid
I~ ‘word Wrap ™| Hide

Default Choice:

o]

Cancel |

Help

Place the prompt object anywhere in the Page Footer area.

Right-click on the prompt.

Select Hide Toggle to hide your prompt.

Save your report.
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Activity: Designing A Parent/Child FreeForm Report

hild Filters:

Once a prompt has been established, we must tell the child report how to limit data to the one Stock
Number the parent has provided the child prompt for each row the parent report retrieves. The Child
filter is used for this purpose.

Click on the Filter icon.

Click on the Columns tab.

Scroll to the ACCOUNTING TRANSACTIONS business view.
Double-click on the Accounting folder.

Double-click on Stock Nbr to move it to Object.

Set the Operator to = (equal).

Click on the Objects tab.

Double-click on Hidden Page.

Double-click on StockNbrPrompt to move to Object.

Click Add.

CLOXINOUAWN

—

Sort Order/Filter: C:\Documents and Settingsmari |

Eilter | Sort Order I

— Select Query Data When
OR'd
Obiject: Operator: WValuel: Walues: Group

| - =l [ &

0: StockMbr Equal To StockMbrPrompt

Qolumns| Objects |ﬁr0wse| Add Modify Delete
C3 Detail ]
[P=Hidden Page [ Distinct Walues Only Filter Types
StockMbrPrompt Bt Bl & Current
{7 Hidden Detail Dbjects - " Base
— | € AdHoc
7 [Quick Filkers
4 | B

QK | Cancel | Help |

Additional Child Filter:

We want our Child to return the Accounting information for items with a value greater than or equal to
$100,000 only. To do this, we need to filter our Child Data before it is returned to the Parent.

Double-click on the Detail Folder.

Double-click on DollarAmt to move it to Object.

Set the Operator to >= (greater than or equal to).
Enter 100000 in Valuel.

Click Add.

Click OK.

Save your report.

Close your report.

N AWN =
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Activity: Designing A Parent/Child FreeForm Report

ing th

NounhrwnN=

hild D ment:

Open the Parent Capital document.

Click Insert>Child Document from the menu Bar.
Place the Child Document object in the Detail area, to the right of the other objects.
Double-click on the Child Document icon.
Click the drop down button under File Name and select the Child Document that you created.
Click the drop down box for Parent Objects.
Select StockNbr on Detail (Area). This is what the Parent will answer with when the Child

asks the Prompt.
8. Select the radio button Merge Child. This will maintain the font style and size between the
Parent and Child.

9. Click OK.

10. Save and view the report. Do not click on the last page icon as this report is very long.

Child: CHILD {acty-parent.iqr)

Child Document | Bo[derl Output whenl

Object Label: |CHILD

File M ame: IE:\Documents and Settingsmgriffitskdy Documents\MjJ

BTl S tockNbiPrompt < StockMbr on Detail [Area
Prompts:

i
Answer Uzer Prompt Above 'with Object Below
Parent Dbiects:l StockMbr on Detail [Area] j
Appearance
' Scale to Object IV Snap TaGrid 1™ Wword wiap

Siale Margins: |25 [Z]= ™ Hide

¥ | Suppress Duplicates

' Concatenate .
™ Append Parent's Filter

Delimiter:

[T Ewecute Before Parent

Execution order: |1_|§

()3 I Cancel

Help

11. Close the report.
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Activity: Designing A Parent/Child FreeForm Report

Adding H r he Paren hild R :

1. Open the parent report.
2. Click on the text icon and add headers for the following:

Asset Cd Eff Dt
Acq Dt Dollar Amt
Serial Nbr
EF Ele Edit Yiew Insert Query Tools Window Help IR IES

DEW(SEm|i 2o~ |&z o

AreE?E Do EE RMuEes ||ty Bl ER E

[ Times Hw Foman = | = | A T = |
T

|
P | < < P L TN T

| P ILE
Top Margin (0 J
i e =
e 1 |Parent/Child Financial Report I
StockNbr Asset Cd | Acg DM Serial Nhr Eff Di Dollar A1
Detai Olstsslbe T
- g

Pags Footer

Eattom
Margin

[=]
=
I TN O AT YT A
-
|

3. Process your report.

4. To place columns where you want them to print out on the parent document, go to the child
document and move the data fields to the left or right on the detail line. You may need to re-
align the headers after processing the report.

5. Save your report.
6. Process your report to view.
& EUREKA:Reporter Designer - [C4-14-Parent] [_[=]
&), Fle Edit Yiew Took “indow Help REE
Har M @ |koE| o
/1412002 T -
[Parent/Child Financial Report ||
i) (o DNomen Acy Cost  SiockNbr AssetCd  AcyDi Serial Nbr EffDi
HQI00L  SERVER 11000000 7025011725133 K 20010314 5644634563446 20010314
721-87-0001
721-5V-0002
721-5V-0003
721-5V-0004 u
721-57-0005
20010315 721-5Y-0006 20010315
721-5V-0007
721-SV-0008
721-5V-0009 =
Kl | 3
Ready Po:lof 7 [ [um

7. Close your report.
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Skill Builder: Building A Parent/Child FreeForm Report

Skill Builder: Building A Parent/Child FreeForm Report

Objectives: You will:

> Review Building a Parent/Child FreeForm Report (Word Exercise)
> Discussion Questions

> Practical Exercise to build a Parent/Child FreeForm Report
Complete the following exercise:

1. Child Documents are used almost exclusively for:

2. Each document always pulls from different business views. (True or False)
True False

3. If you place the object in Document Header or Document Footer area, the child object will appear
only at the or of the report.

4. Insert the Child document object in the desired area. (Circle all that apply)

a. If you place the object in the Page Header or Page Footer area, the child will appear once at the begin-
ning or end of each page.

b. If you place the object in the Group Header or Group Footer areas, the child will appear once for each
row that appears on your document.

c. If you place the object in the Document Header or Document Footer area, the child object will appear
on every page of the document.

d. If you want the child to show only certain rows, place it in its own detail area, separate from the other
columns in the parent document and set the Output When conditions for the area.

5. Itis recommended, but not mandatory, for Parent/Child reports that you change the orientation to

6. How do you insert the Child Document in the Parent Document?

7. To make sure the child document returns information for the same row that the parent is looking at, a
is placed in the child document.
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Skill Builder: Building A Parent/Child FreeForm Report

8. When you select the radio button Merge Child, this insures the data from the child document will use
the same size and font style as the parent. (True or False)

True False
Discussion Question:

¢ Review the Parent/Child function from beginning to completion. Name the different pro-
cesses involved.
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Practical Exercise: Designing A Parent/Child FreeForm Report

Practical Exercise: Designing A Parent/Child FreeForm Report

In n

n nt R

Unit of Study: Designing a Parent/Child FreeForm Report

Type Of Report: For this practical exercise we will be designing a report that uses the Parent/Child

function to combine two reports. These two reports can be from the same or different Business Views.

For this report we will be using the same business view. This report will first summarize all assets of each

HRH Name listed in the database. That information will be combined with a HRH Name listing of all

assets with the Nomen, StockNbr, SerialNbr, and AcqCost on individual pages.

Instructions: Use the table listed below to build an Accounting Report.

Example of the finished report:

PN

& EUREKA:Reporter Designer - [C4-23-Parent] MEE |
(& Ele Edt View Iools Window Help == x|

H4r W2 aa |k oe| o

Summarized Report

157000
27424200
20472700
30083.00
R RN i (UREKAReporter Designer - [L4-3-Parent]
21501700 [ Bl B Wew Iook Window el

M4 » W W& 0 om

ABE SHERWAN
ALTON MICHAELS-TRAINL
AMY MOSS - TRAINT2
BARNEV KIMBROUGH
BETHANY MARINE- TRAINLS
BETINA L MARTIN

BILLY ZACHMAN

BOB HARRIS - TRAINIT
BRVAN RUSSELL

BURTON L. TAYLOR-TRAINOY
CHIEF TAMES L. HICKMAN
CHIEF LEONARD FITZGIBBONS 19605800
CHIEF MARSHALL MORTON 52300
CINDY BEAN - TRAIND3Z 20793000
CRAIG GARRETT 11223500

80120002

HRHName
ALTON MICHAFLS.TRAINIL

Eetail Report I

CRAIG ROSS - TRAINOZ 20802800 Hamen Smekihr

LEA TRUCKSTRACTORS  ZS2000LEADN0S

View specified page TREC OGO 12T 6000 L300 TERL
LATHE, ENGINE 410001354013
COPIER 5Y5 XEROX 100117760
TRE LFSOLBLT60RS 3930000281005
TELEPHONE, STI I SIEDONNOOIT
BARCODE READER SEFFIFLM
ANSWERING MACHINE  MI000N452825
MOMITGR, 19°COLOR, MI25000001952
COMPUTER, PENTIUM 1L WZ010000565
COMPUTER, PENTIUM I M25010001217
PRINTER. LASER. rJ.{Li.‘llI.l.iJ.{.{l

Create a new FreeForm report.

SerialiNhe
YF-O01.0011
3X0FRD010
I34IIBLOOOTT
G100LL00L L
IELV0011
SIEETO00
BRD-0OLU31
AF0011
100-KM.0011
I-LP00012
135381
L0001

Pobof

=181

El'ﬁ«_

Save your report as PC-PE-Parent in the folder designated by your instructor.

Expand the Page Header area an additional 2 blocks.

Using the document name icon, add the report nhame to the Page Footer area.
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Practical Exercise: Designing A Parent/Child FreeForm Report

5.

Select the fields from the table below and place them to the left in the detail area.

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! HRH Name Serial Nbr
Nomen Acq Cost
Stock Nbr

13.
14.
15.

16.

17.
18.
19.
20.
21.
22,
23.

Expand the Detail area to 2 blocks.

Save your report.

Using the text icon, enter "Detail Report” (enhance the title using the font, border, etc. tabs).
Double-click on each data object (blue object) and check the check box for “Suppress Dupli-
cates”.

Highlight the HRH Name (blue object), go to the tool bar and click on group header icon.
Move both HRH Name objects into the HRHName Group Header area.

Expand the HRH Name Group Header area to 6 blocks.

Detail Report I

HRHMame |0
Group
Header

(R

1

JJ HEHName

1 |HEHHam |

] Nomen _ StockNhe _ Seriallh
Detail Uj Homen | StockNbe | Sexiallbr

=1
.

FPage Foater

Move the HRHName data object (blue object) below the HRHName text object (gray object).
Move all of your object boxes over to the right where the HRHName stops.

Rubberband all the object boxes (gray objects) and move into the HRHName Group Header
area.

Rubberband all the data objects (blue objects) that are in the Detail area and move them up
to the top of the Detail area.

Double-click in the blank area of the HRHName Group Header area.

In the Page Skip group box, set Before Area to 1.

Click OK. This will create a page break.

Add a Document Header area.

Add a second Document Header area.

Expand the new Document Header area to a total of 8 blocks.

Save your report.
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Practical Exercise: Designing A Parent/Child FreeForm Report

hil

1.
2.
3.

D ment:

Create a new FreeForm report.
Save your report as PC-PE-Child in the same folder as PC-PE-Parent.
Select the data elements from the table below:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Quick_Start! HRH Name
Acq Cost
4. Widen the Detail area to 2 more blocks.
5. Double-click on each data element (blue object) and check the check box for “Suppress Dupli-
cates”.

6. Double-click on the blue Acq Cost.

7. Click on the drop down box for the Aggregate function and select sum.

8. Click OK.

9. Save your report.

10. Close your report.

Example of the Child Document Design:

FPage 04 |
Header

] HEHName Acq Cost
Detail 0] HEHHame | Smmideq Cost|

Page Footer| 0 -

Battam 0-
M argin o

Parent Document:

uhwnN =

SweNO

Open PC-PE-Parent.

Click on Child Document icon.

Insert the child document icon in the Document Header(1) area.
Double-click on the Child Document icon.

In the File Name, click the browse button and go to the directory where the child report is
saved.

Select the PC-PE-Child document to insert your Child Summary report.
Click radio button for Merge Child.

Click OK.

Save your report.

Process your report.
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Child Data Objects

Child Data Objects

INTRODUCTION

A child data object represents the data fields from one document (a child document) that you include
as part of another document (a parent document). Two or more reports must be written. The parent
report must contain the child document object (which should be hidden)

OBJECTIVES

Understand and demonstrate the ability to pass information between parent and child objects. Using
a Parent/Child document, you will draw data elements from two separate business views (or data
sources) into a single report.

APPLICATION

For this report you will demonstrate the ability to use one data field and incorporate it into the Parent
Report. You have been asked to design a report. In this report we will use Document Number from
the Document Register Business View.

REPORT TYPE

Asset Listing, by HRH Nbr Mjr, listing Nomen, Stock Nbr, Serial Nbr with Acq Cost plus listing the doc-
ument nbr from the document register.

PREREQUISITES

Two (or more) reports must be written. The parent report must contain the child document object
(which should be hidden).

ACTIVITY

Student Hands-On with Instructor direction

CH?2 163
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Child Data Objects

Example of the finished child data report:

g}'EUREKA:Reporter Designer - [PC-CDO-Parent]

@‘ File Edit Yiew Tools Window Help ;Iilll
Kar|maa|kos|o|
=
IPARENT REPORT
StocklNbr Nomen SerialNbr AcqCost HEHNbrMjr  Document Mbr
1005000739421 RIFLE 5 56N M1641 FE20875-01 44500 WOU28L
1005000739421 RIFLE 5 56N M1641 FE20875-02 44500 WOU28L
1005006789828 RFLE 7.62MM MM GR 14 ROQ222-01 31600 WOU28L4
1005006789828 RFLE 762MM MM GE W14 RO222.02 31600 WOU28L4
1005013368265 FIOMIL AUTO TV 1 42071131-01 38500 WOU28L
1005013368265 FIOMIL AUTO TV 1 42071131-02 38500 WOU28L
1430010469594 WIGHT VISION 5GT TRAC BH2982525-01 2309000 WOU28L
1430010469594 WIGHT VISION 5GT TRAC BH2982525-02 2309000 WOU28L
2320000021959 TRUCE, 34 TON 532-Fv-020 2822200 WOU28L
2320010907891 TRE CGO 152T 6000 109-TR-020 2783800 WOU2EL
3411001364013 LATHE, ENGINE 3411BLADD2O 2783800 WOU2EL
3610011207764 COPIER. 5Y5 XEROX 6100DLADD021 233200 WOU2EA —
375001T054306 TRIMMEER, WEEDEATER 000002-B43 72300 WOU28L
375001T054306 TRIMMEER, WEEDEATER 000002-Ba4 73200 WOU28L
3930000251015 TR LF 6000LE LT-60RS AF-001-Z020 1258700 WOU2E4A W3SBSV10%6
5180001000927 TELEPHONE, STU III 51805T00031 100 WOU2E4s
5180001000927 TELEPHONE, STU III 532-BV-001 54300 WOU28L
5180001000927 TELEPHONE, STU III 532-BV-002 54300 WOU28L =
[« | i
Ready Pgi1ofL [ I_IW_
Example of the design document:
& EUREKA:Reporter Designer - [Untitled5] =18 %]
EX Fie Edit View Insert Query Tooks Window Help == x|

DEH|GRE|: k@ |Ffy(ew|
N LR TR R -

Hp Times Mew Foman ﬂ“TU ﬂ‘ B i O H; E |.\'| j'
e e e e T
Top Margin a |
Fage Hoader 0 | SYSTEMDAT
] ‘ Parent Report I
] StockNbr | Nomen | Seriall¥br | AcqCost|  HRHNbrMji
I [
Detail 0
Page Footer 0]
i DOCUMENTHNA PAGENC
Battor Margin {0
<
e e e 1)
CH2 164
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Child Data Objects

STEPS TO PERFORM ACTION (PARENT DOCUMENT)

1. Create a new FreeForm report.
2. If not the default, change the orientation to Landscape.
3. In the parent document, add the name of report and the date to the Page Header.

\ﬂ"’“\ NOTE:
XG > Itis always good practice to end the file name of the parent report with “par” and end the child
\/ report file name with “ch”. If you have more than one child report, you may want to have the

file names with “ch1”, “ch2”, and so on.

4. Add the page number and the document name you will assign to the report to the Page Footer area.
5. Select the following fields for your Parent report from the table below. Make sure that you put them to
the left side of your design document:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog Stock Nbr Nomen
Serial_Hand_Receipt-Auth | garig Nbr Acq Cost
Hand_Receipt_Holder HRH Nbr Mijr

6. To limit the information to the HRH Nbr Mjr of choice, we will filter on the HRH Nbr Mjr.
7. Click on the Filter icon.

8. Open the Detail folder.

9. Double-click on HRH Nbr Mjr to move it to the Object field.

10. Set the Operator to “Like".

11. Enter W* (cap locks on) in Valuel.

12. Click Add.

13. Click OK.

14. Save your report as PC-CDO-Parent.

15. Process your report.

Child Document

1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must
be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.

2. Select the following fields for your Child report from the table below. Make sure that the fields are
placed approximately to the right of where the last field in parent was placed:

BUSINESS VIEW: DOCUMENT REGISTER

FOLDER(S) DATA ELEMENT(S)
Doc_Nbr_HRH Doc Nbr
HRH Nbr Mjr
Stock Nbr
CH?2 165
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Child Data Objects

3. Add the file name you will assign to the report to the Page Footer area.
4. Save your report as PC-CDO-Child.
5. Process your report.

hil

Prom

To make sure the child document returns information for the same row that the parent is looking at, a
prompt is placed in the child document. The prompt input comes from the parent for each row. Visualize
the parent looking for a row for serial number 105. The parent gives the serial number to the child prompt
and the child pulls information for that row at the same time the parent is looking at that row.

We will be using HRH Nbr Mjr and Stock Nbr for the prompts.

WoNOUThWNE

Click on the Prompt icon.

For the Object Label, enter HRH Nbr Mjr Prompt
For the Prompt message, enter “"Enter HRH Nbr Mjr”.
Change the Character width to 6.

Click OK and place anywhere in the Page Footer area.
Right-click on the Prompt icon and Hide Toggle.
Click on the Prompt icon.

For the Object Label, enter “Stock Nbr Prompt”.
For the Prompt Message, enter "Enter Stock Nbr”.
Change the Character Width to 15”.

Click OK and place anywhere in Page Footer area.
Right-click on the Prompt and Hide Toggle

Child Filt

Once a prompt has been established, we must tell the child report how to limit data to the one serial
number the parent has provided to the child prompt for each row the parent report retrieves. The child
filter is used for this purpose.

NN AW

CH 2

Click on the Filter icon.

If not open, click on the Objects tab and open the Detail and Hidden Page folders.

In the Detail folder, double-click on the HRH Nbr Mjr to move it to the Object field.
Set the Operator to = (equal).

In the Hidden Page Folder, double- click on HRH Nbr Mjr Prompt to move to Valuel.
Click Add.

In the Detail folder, double-click on Stock Nbr to move it to the Object field.

Set the Operator to = (equal).
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Child Data Objects

11.
12.
13.

In

ounhwwn =

® N

10.

In the Hidden Page folder, double-click on Stock Nbr Prompt to move it to Valuel.
Click Add.

Sort Order/Filter: C:\Documents and Settings'mariffit'My Documents'Eu... [E3

Eilter | Sort Order I
Select Query Data ‘When
OR'd
Object: Operator: Objectl: ialues: Group
IStockor |= j IStock_Nbr_F'rom[ ID_E

0: HRHMbrr Equal Ta HRH _Mbr_Mir Prompt

0: StockMbr Equal To Stock Mbr Prompt

Qolumnslgbiects ﬁrowsel fdd | ey [
) Detail i

%) Dochbr [ Distinct Walues Only Fiter Types

E| HRHMbrbdjr Custom Overide: f€) Curent

&) Stockhbr ustom Override: ¢ Base
= Hidden Page 1 AdHoc

& HRH_Mbr_tir_Prom = Quick Filters

B Stock_Mbr_Frompt

QK I Cancel | Help |

Click OK.
Save your report.
Close the Child report.

rting the Child D men

If closed, open the Parent document.

From the menu bar, click Insert>Child Document OR Click on the child document icon @.

Place the child document object in the Detail area, to the right of the other objects.

Double-click on the Child Document icon in the Detail area.

Click the drop down box under File Name and click the Child document that you created.

Under Parent Objects, click the drop down box and select HRH Nbr Mjr on Detail (Area). This is
telling you what data fields the Parent document is selecting.

In the Child’s User Prompts window, highlight Stock Nbr Prompt.

Under Parent Objects, click the drop down box and select Stock Nbr on Detail (Area). This is tell-
ing you what data fields the Parent document is selecting.

Mark the radio button, Merge Child. This insures the data from the child document will use the
same size and font style as the parent.

Click OK, it is now attached, save the report.

Inserting Child Dat

badi i

No» A

CH 2

On the parent report, highlight the child document icon, right click and select Hide Toggle.

Select Insert>Child Data from the menu bar or click on the Child Data icon from the menu bar.
The Child Object window appears. In the child document area, click on the drop down arrow and
select the child report you designed. This will open up the Object In Query Area.

In the Object Label, enter "Doc Nbr”.

Change the Character Width to 14"

For the Object Query, click on the drop down arrow and select Doc Nbr on Detail (Area).

Click OK.
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Child Data Objects

8.  Your cursor becomes a precision pointer. Drop the pointer in the detail area next to the last data
object.

9. Click on the text icon (abc).

10. Enter “Document Nbr”. In the Font tab, check the radio buttons for bold and underline.

11. Place in the Page Header area above the Child Data Object.

12. Save your report.

13. Process your report.

This may take a few minutes to process.

g}'EUREKA:Reporter Designer - [PC-CDO-Parent]

@‘ File Edit Yiew Tools Window Help ;Iilll
Kar|maa|kos|o|
=

IPARENT REPORT

StocklNbr Nomen SerialNbr AcqCost HEHNbrMjr  Document Mbr
1005000739421 RIFLE 5 56N M1641 FE20875-01 44500 WOU28L

1005000739421 RIFLE 5 56N M1641 FE20875-02 44500 WOU28L

1005006789828 RFLE 7.62MM MM GR 14 ROQ222-01 31600 WOU28L4

1005006789828 RFLE 762MM MM GE W14 RO222.02 31600 WOU28L4

1005013368265 FIOMIL AUTO TV 1 42071131-01 38500 WOU28L

1005013368265 FIOMIL AUTO TV 1 42071131-02 38500 WOU28L

1430010469594 WIGHT VISION 5GT TRAC BH2982525-01 2309000 WOU28L

1430010469594 WIGHT VISION 5GT TRAC BH2982525-02 2309000 WOU28L

2320000021959 TRUCE, 34 TON 532-Fv-020 2822200 WOU28L

2320010907891 TRE CGO 152T 6000 109-TR-020 2783800 WOU2EL

3411001364013 LATHE, ENGINE 3411BLADD2O 2783800 WOU2EL

3610011207764 COPIER. 5Y5 XEROX 6100DLADD021 233200 WOU2EA —
375001T054306 TRIMMEER, WEEDEATER 000002-B43 72300 WOU28L

375001T054306 TRIMMEER, WEEDEATER 000002-Ba4 73200 WOU28L

3930000251015 TR LF 6000LE LT-60RS AF-001-Z020 1258700 WOU2E4A W3SBSV10%6
5180001000927 TELEPHONE, STU III 51805T00031 100 WOU2E4s

5180001000927 TELEPHONE, STU III 532-BV-001 54300 WOU28L

5180001000927 TELEPHONE, STU III 532-BV-002 54300 WOU28L =
« | i
Ready Pgi1ofL [ I_IW_
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Hot Objects

Hot Objects

Unit of Study: A hot object is an object on your document that is linked to a second document.
When you are viewing the output, clicking the hot object tells £ureka to process the linked-to document
and to display its output in a new window. A hot object is not a Fureka object type; any component object
can be made hot by filling out entries on the Hot Object tab for that object. Columns in a report that have
been designated as hot object columns will be blue in color.

Activity: Student Hands-On with Instructor direction
Instructions:
1. Open or create a FreeForm report.

2. Expand the Page Header area 2 more blocks.
3. Select the following fields for your FreeForm report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)

Quick_Start! Stock Nbr

Nomen

Serial Nbr
4. Using the text icon, add the title of the report and date to the Page Header area.
5. Using the Document Name icon, add the document name to the Page Footer area.
6. Add the page number to the Page Footer area.
7. Process your report.
8. Save the report as PC-HOTOBJ-Parent.

& EUREKA:Reporter Designer - [C4-34-Parent.igr]

E!Eile Edit Wew Insert Query Tools ‘Window Help = x|
DEFE|glem|ime - 7z e
A ReE@2 DOEEE HMUEE N v |[fEBR E |

I’ﬁ' Times Mew Foman j“‘lﬂ j| B 7 U ”g% = |.|'I|| = ‘
O I [ P I [ I [ [ N = A I = A W [ W
Top Margin |0
Fags ] SYSTEMDATE
Hoader : ‘ HOT OBJECT REPORT I
] StockNbr Nomen SerialNbr
Dietail 0
Page Footer 04
] DOCUMENTHAME PaGENC
Bottom 0
Margin ]

4]
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reatin hild for H j

Instructions:

1. Open a new FreeForm report.
2. Select the following fields for your FreeForm report:

BUSINESS VIEW: HISTORIES

FOLDER(S) DATA ELEMENT(S)
History Doc Nbr

3. Drag Document Number to the Detail area.

4. Using the text icon, add a title for your report and place in the Page Header area. Enhance your title
using the font, border, etc. tabs.

5. Add the date to the Page Header area.

g}'EUREKA:Reporter Designer - [C4-34-Child.igr]
E!Eile Edit Wiew Insert Query Tools Window Help _|ﬁl|1|

DEH SR s 2B |FX |
A kB2 DodEBE Hu@B (N MV EEDR B
I':ﬂ'j Times Mew Roman j“‘lﬂ j| B 7 U H%% = |.|'|| j‘
N N T e
Top Margin [0
Pae 0] FETERDATER HOT OBJECT CHILD |
__ | Doclhx
Detail 0 | Doclbr |
Page Footer| 04
Bottom o
M argin o
|
Primary Selected Ohbject: SYSTEMDATE [ o |
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r

Prompt fora H j

hil

To make sure the child pulls up the information that is needed, a prompt will need to be created.

el

5.
6.
7.

N AWN =

Click on the prompt icon.

Enter “SerialNbrPrompt” in the Object Label.
Enter “"Enter Serial Number” in the Prompt.

Change the Character Width to 20.

User Prompt: PROMPT {Untitled1}

Brompt | Bo[derl Fant I Hot Qbiectl HTMLI Output whenl Qonnectionl SGL Dverridel

Object Label: ISeriaINbrF’rompt Sequence Number: |1 E
Prompt: IEnter Serial Mumber
Type: IStnng 'l
Format i Character ‘width: I E
r~ Chaoice List
Columns | Browse Choice ¥alue To Add:
A ACCOUNTING T«
[:| Azcounting Add Delete |
[:| CIPAWIP
3 AUTHORIZATIO " Use Choices Only
[:I Autharization & Allovs User Input
D Bulk Ha”d R I™ Allow Multiple Cheices
Catalog
™ Require Input
- Appearance Default Choice:
I Suppress Duplicates ¥ Snap To Grid
I~ word ‘Wrap ™| Hide

()3 I Cancel

Click OK.

Place the prompt object in the Page Footer area.
Right-click on SerialNbrPrompt and click Hide Toggle.

Addi Filter to the Hot Object Child

Now you must tell the child what to do with the prompt information that the parent will send.

Click on the filter icon.

From the Object directory, click on the Columns tab.

Scroll to the HISTORIES business view.
Select the History folder.

Double-click on Serial Nbr to move it to the
Set the operator to = (equal).

Click on the Objects tab.

Double-click on the Hidden Page folder.

Object.
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9. Double-click on SerialNbrPrompt to move it to Object1.

10. Click Add.

11. Click OK.

Sort Order /Filter: Untitled3

Eilter | Sort Order I
— Select Query Data ‘When
Object: Operator: WValuel: ialues:

OR'd
Group

hE

IMbrPrompt

A i

Calurnng Im ﬁrowsel At Modify Delete
] Detail }
= Hidden Page [ Distinct alues Only Filter Types
SenialMbrProm % Curent
B SerialNbPrompt Bt e
ustom Override:  Bass

=/ AdHee

" Quick Filters

12. Save your report as PC- HOTOBJ -Child.

13. Close the report.

Creating the Hot Object

uhwnN =

Open the Parent report, if you previously closed it.
Double-click on the Serial Nbr object in the Detail area.
Click on the Hot Object tab.

File Name: Click the drop down box and select the Hot Object child that was created.
Parent Objects: Click the drop down box and select SerialNbr on Detail (Area).

Calumn IMNbr (Hot

Eolumnl Bo[derl Faont I Output when Hot Object | HTMLI Iranslatel

— Diocument Link

User Prompts:  [EIRIEMXI = alNbr on Detail [Area

Parent Objects:

™ Append Parent's Filter

V¥ Generate Static File on HTML Export
™ Generate Static File on Output File Export

File Name:  [Hat Object Chidiar =

Export File Mame: I J

IV Display &s Link.

()8 I Cancel

Help
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© 0N o

Click OK.

Save your report.

Process your report.

Click on a BLUE serial number to obtain additional information about the item.

& EURE] porter Designer - [C4-34-Parent] MEE|)
(@ File Edt vew Took Window Help —|&@ 5||

KO o @ e a

HOT OBJECT REPORT

StockNbr Nomen
2320000021999 TRUCK, 314 TON

prospaenny TRICE 34 TON & EUREKA:Reporter Designer - [C4-34-Child] MEE|
2320000021990 TRUCK, 34TON (@, Fle Edt Vew Toos window Help JAETET]|
BA000021999 TRICK, 34 TON
000021999 TRICK, 34 TON
BAO001999 TRUCK, 34 TON
000021999 TRUCK, 34 TON
000021999 TRUCK, 34 TON
000021999 TRUCK, 34 TON
000021999 TRUCK, 34 TON
000021999 TRICK, 34 TON
2320000021999 TRUCK, 34TON 81202002 HOT OBJECT CHILD
BA000021999 TRICK, 34 TON Dotb
000021999 TRICK, 34 TON WIsATHL0TS00L *
BAO001999 TRUCK, 34 TON
000021999 TRUCK, 34 TON
000021999 TRUCK, 34 TON SRRV
000021999 TRUCK, 34 TON FLFVOIE
Ready

13
Ready Pg:1of1 [ |
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Introduction To Enhanced Eureka

This section of the Eureka training and reference manual describes some of those functions which in
most cases are not “routine” to the every day user. Among the topics covered are inserting charts

and crosstabs into your reports and queries. You will also learn how to generate labels with informa-
tion drawn from your DPAS data. Finally, you will learn how to create and use a Personal Data Mart.

OBJECTIVES

You will gain a familiarity with the advanced functions found in this chapter, so that you can use them
when the occasion arises.

APPLICATION

A chart may be an excellent way to represent items on your Property Book, for example, number of
items entered into the property book per month, in order to show trends in how work is distributed.
A Personal Data Mart can be a tool used to facilitate your work in developing reports remotely from
your on-line database, or to limit the amount of data which your report will look at.

PREREQUISITES
A fundamental understanding of FreeForm documents.
ACTIVITY

Student Hands-On with Instructor direction
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Charts

Unit of Study: Chart objects generate their own query that is completely separate from the initial
main document query. A chart object is used to illustrate graphically your report output.

Eureka allows you to include eight different types of charts in your document:

Three-dimensional area charts

Two-dimensional and three-dimensional bar charts
Two-dimensional and three-dimensional line charts
Two-dimensional and three-dimensional pie charts
Scatter chart

[ iy W WAy

Experiment with different chart types for displaying your data. As a general rule, the more complex your
data, the simpler a chart type you should start with.

Application: Property listing with output to include a chart object to illustrate graphically your data
results.

Report Type: Asset listing by HRH Nbr Mjr, HRH Name with Bar Cd and Acq Cost.
Activity: Student Hands-On with Instructor direction
Instructions:

1. Create a new FreeForm report.
2. Select the following fields for your FreeForm report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Hand_Receipt_Holder HRH Nbr Mjr
HRH Name
Serial_Hand_Receipt Bar Cd
Acq Cost
CH2 176
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3. Save your report as CHART.
4.  Process your query.

& EUREKA:Reporter Designer - [Untitled1] = E |

& Ele Edit Wew Iools Wwindow Help

]|

KO @ e ae|c

HEHMbchjr  HEHName BarCd
5701 KEN MOCRE - TRAIND1 167240
5701 KEN MOORE - TRAINO1 167241
5701 KEN MOCRE - TRAIND1 167242
5701 KEN MOORE - TRAINO1 167244
5701 KEN MOCRE - TRAIND1 167243
5701 KEN MOORE - TRAINO1 7231001101
5701 KEN MOCRE - TRAIND1 HQ0001
5701 KEN MOORE - TRAINO1 1593001
5701 KEN MOORE - TRAINO1 1593002
5701 KEN MOCRE - TRAIND1 0334201
5701 KEN MOORE - TRAINO1 1593003
5701 KEN MOCRE - TRAIND1 1593004
5701 KEN MOORE - TRAINO1

5701 KEN MOCRE - TRAIND1 Ho0o1
5701 KEN MOORE - TRAINO1 HQO02
3202 MARK MURFHY 1663321
5802 MARK MURPHY 1663301
5702 CRAIG ROSS - TRAINO2 167246
3702 CRAIG ROSS - TRAINO2 167247
5702 CRAIG ROSS - TRAINO2 167248

ArqCost
27430.00
1130800
1356600
2TE3300
100
253200
23200
93300
310100
5365.00
462200
110000.00
49900
459,00
49900
273700
536300
27439 00
1150200
1356600 -

Ready

Close the report viewer.

Select the chart icon ﬂl from the tool bar.

oN O u

NOTE:

object to the desired size.

Place the chart object into the Page Footer area of your document.
Click on the chart object and drag out to enlarge the icon to about half a page.

& EUREKAReporter Designer - [Untitled1] HEE|
EF Fle Edt Wew Insert Query Tools Window Help |
DEHERBE| B |FE (e
RS lslsla =l - R E ===
[ Toes e Foman HFT =|e 2o =m0
0, e e B e By A 5y B L [~
Top Marain | 0
Fage ] ‘
Header 1
] HRHNbrMjy HRHName BarCd AcqCosi
Detail ad
Page Footer 04
]
7] —
4| = »
| I R

9. Double-click on the chart icon.

CH 2
1 October 2004

. A chart is only as big as the chart object that is placed on your report. You will need to resize
~~ the object by grabbing the handles (click on the object once to get the handles) and drag the
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10. Select the Chart Types button.

11. Select 3D Pie.

x|

2D PIE 2D LINE

3D PIE |3D AREA| 3D LINE

Cancel |

12. Title: Enter $ By HRH Nbr Mjr.

13. Click on the Objects button.

14. Double-click on the Detail folder.

15. Click, drag and drop the Acq Cost field to the Pie Slice Values. This field is grayed out, but you will
still be allowed to drag the object into the field.

16. Click, drag and drop the HRH Nbr Mjr to Pie Slice Labels. This field is grayed out, but you will still
be allowed to drag the object into the field.

17. In the Chart Attributes group, check Display Legend.

18. In the Gradient group, accept the default of None.

Top Down White at the top blending to black at the bottom.
Center Out White in the center blending to black at the outside.
Bottom Up White at the bottom blending to black at the top.

o\ NOTE:

ie Chart: CHART (chartl.igr)

Chart IBD_IdErl Olutput ﬂheml Filter | Font | Ennnect\nnl Sort Order ﬂntDbiEctl HTMLI SEld v

Object Labet[CHART Tite[$ By HRH Nor M

Pig Chart Data ~ Chart Attribut

¥ Display Labels

™ "% of Total" Labels
¥ Display Legend

Pig Slice Values IACEICUSl

Fie Slice Labels; [HAHNEMi

i~ Gradient
1+ None = Center Out
" TopDown ¢ Bottom Lp

Summary | [ Appearance
 Bum W Snap To Grid

1 Court

Chart Tyupe

2

LColumns | Objects | Browse
AcqCost

HHName " Average I Hide
8 HRHNEM ;
= || © Min ™ Append Parent's Filter
s  Man ¥ Native SOL Translate Yalug | _Chart Tvpes..

ak. I Cancel I Help

\ o
N\ > Background gradients take precedence over other chart backgrounds. They are always white-

\ :
+”  to-black blends.

CH 2
1 October 2004
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19. In the Summary group, select Sum.

Chart Attributes
Draw Grid Select this check box to include grid lines in the output.
Percentile Bar Chart Select this check box to have calculations expressed as a percentage of the overall total. For pie

charts, which are always percentile charts, this item is called "% of Total” Labels and controls
whether labels are shown as totals or percentages.

Display Labels Select this check box if you wish to output labels along the axes of the chart. (Horizontal axis labels
appear only when you use a Group By object.)

Display Legend Select to show an index of the colors/patterns corresponding to different Area Labels column values.
(Only available when you use a Group By object.)

20. Do not change Appearance.

Snap To Grid This has been defined in Chapter 3.
Hide This has been defined in Chapter 3.
Append Parent’s Filter This has been defined in Chapter 4, Parent/Child.

If you use the chart dialog box’s Filter tab to define a filter, selecting this check box
combines the two filters using an AND relationship — rows must meet both filters in order
to be included in the chart.

Unless you tell it otherwise, Eurekaincludes all database rows. To have your chart include
only those rows that are included in your document, make sure that the Append Parent’s
Filter option is selected.

Native SQL Translate Value This check box controls whether Fureka Reporter Designer

Q Includes value translation requests as part of its query for chart information, or
Q Performs value translations itself

By default, Eureka does not include value translation requests as part of its query. Check
this box to have it do so. When this is done, sorting and grouping are based on the
translated value (when your database manager or ODBC database driver supports the SQL
syntax required to do this). If you want sorting and grouping based on the untranslated
value, make sure this box is not checked.

21. Select the Filter tab.

22. Click on the Objects tab.

23. Double-click on the HRH Nbr Mjr to add to the Object.
24. Set the Operator to Between.

25. Set Valuel to W1DCO03.

26. Set Value2 to W1NW54.

CH2 179
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27. Click Add.

28. Click OK.
29. Save your report.
30. Process your report.

& EUREKA:Reporter Designer - [C5-2]

HEHMbrMjr HREHName AcyCost
701 KEN MOORE - TRAINOL 27439.00
701 KEN MOORE - TRAINOL 11502.00
701 KEN MOORE - TRAINOL 13566.00
701 KEN MOORE - TRAINOL 21633.00
701 KEN MOORE - TRAINOL 1.00
701 KEN MOORE - TRAINOL 7251001101 253200
701 KEN MOORE - TRAINOL HOo001 23200
701 KEN MOORE - TRAINOL 1593001 933.00
701 KEN MOORE - TRAINOL 1593002 3101.00
701 KEN MOORE - TRAINOL 0334201 536500
701 KEN MOORE - TRAINOL 1593003 462200
701 KEN MOORE - TRAINOL 1593004 110000.00
701 KEN MOORE - TRAINOL 49900
701 KEN MOORE - TRAINOL HOo01 49900

$ By HRH Nbr Mjr

- Ticcie
- icci
- g
- Tigall
- IR
l:l T IHCAL
- T
- T e

31. Close your report.
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Crosstabs

Unit of Study: A crosstab object is an object that outputs an entire cross-tabulation document. It
uses three component objects: columns, rows, and aggregate. The crosstab provides an aggregate
calculation, such as total, count, etc. for the aggregate object for each different combination of values in
the other two objects.

Crosstabs are similar in appearance and function to a matrix, or spreadsheet-style, document. Like chart
objects, crosstab objects generate a query that is completely separate from the original document query.

A chart object is used to illustrate graphically your report output.

Think of a crosstab as a special type chart. It is similar to appearance and function to a matrix or
spreadsheet-style document. The rules which applied to creating a chart object, generally are the same
for a crosstab object.

A crosstab object outputs an entire cross-tabulation document (a crosstab, for short) (think of an Excel
spreadsheet). In its simplest form, a crosstab uses three component objects. Each must be a column or a
custom object from your Metadata file.

O An object defined in your Metadata file for the crosstab's vertical columns. We call this the
columns object. These values are listed across the top of the crosstab.

0 An object for crosstab lines. We call this the rows object. These values are listed at the beginning
of each line of the crosstab.

0 An object to be summarized in the cells of the crosstab. We call this the aggregate object.

The crosstab provides an aggregate calculation, such as total, minimum, average, etc., for the aggregate
object for each different combination of values in the other two objects.

Crosstabs are stored in files separate from your design document. This allows the same crosstab to be
reused as a building block in additional design documents.

Activity: FSC Inventory with output to include crosstab to illustrate graphically your data results.
Report Type: FSC Inventory listing to include HRH Nbr with sum of property value.

Activity: Student Hands-On with Instructor direction
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Instructions:

1. Create a new FreeForm report.

2. Select the crosstab icon | from the tool bar.

3. Insert the crosstab object into the detail area of your document.
4. Double-click on the crosstab icon.

AN CLC) 5. Crosstab File Name: Enter FSC Inven-

tory. Eureka will automatically add the .igr

Lrosstab 1 Bo_rder] Dutputwhen} Font } Qunnectiom] Filter ] SEL Dvemde} ﬂolDb\ecl] HTML]

Object Label: [(ROSST | Crosstab File Name: [FSC Invetary.ir E extension.
Swapdsis | Cokmns ’Fsci 6. Click on the Columns tab (if it isn't already
Ros: Coam il e ety selected).
HRHNGH wm R rr— 7. Scroll to the END ITEM SERIAL Business
Sheet Grouns View. . .
P ColmnTaisls [ Row Tolds 8. Double-click on the Quick_Start! folder.

Aggregate Appearance Style
" Scale to Object

LColumnz Obiects | Browse

= Wick_Start : i:':nt IE a:ja: to Grid w,,m NOTE:
e \ > Select objects within each entry box in
C M T medPamicfle Eressah Ses.. ~” the order they should be used. To
change the order, they must be
% | oo | o | removed and re-added. To remove an
0

object, select it and press Delete.

9. Click, drag and drop the FSC field to the Columns window.

10. Click, drag and drop the HRH Nbr Mjr field to the first Rows window.

11. Click, drag and drop the Acq Cost to the second Rows window. The Aggregate radio button will
default to Sum.

m\\ NOTE:

The Swap Axis button swaps the definition for columns and rows. After clicking this button,
the columns that were used to define crosstab columns are used for the crosstab rows. The
columns that were used to define crosstab rows are used for the crosstab columns.

12. Column Title: Enter FSC Inventory.
13. Row Title: Enter HRH.
14. De-select the Scale to Object in the Appearance area.

=7 NOTE:
K > If you want to include totals for the columns and/or rows, then check the appropriate box(es).
Th|s default is checked.
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15. Click on the Crosstab Styles button.
16. Select the style with the red border.

Crosstab Styles m

17. Click on the Filter tab.
18. Click on the Objects button in the Object

directory. Crosstab | Border | Output’when | Font | Connection Eiter IS_D_L Dveride | Hot Object | HTML |
19. Double-click on the Acq Cost field to move - Select Query Data Wwhen
it to Object. Dbject Operstor. Valie] Yalus2 B
20. Set the Operator to > (greater than). | [ =l | &
21. et Vauel to 10000. S
22. Click Add.
23. Double-click on the FSC field to move it to
Ob] ect. Lolumng | Objects Srovies Add Iacify [elete
24. Set the Operator to Between. = A
25. Set Valuel to 3411. Sustor Oerid ® B
26. Set Value2 to 3930. - :gi::;m
27. Click Add.
28. Click OK. r |
29. If your default page setting is not already set
to Landscape, change your page setup to 0K | Concd | e
Landscape.

30. Save your report as CROSSTAB.
31. Process your report.

Example of finished report:

EUREKA:Reporter Designer - [C5-9]

B Fle Edt Vew Tooks Window Help =12
M4y M| eaa |k os| -

FSC Inventory

Wag020 12587.00 12527.00
o W4TE10 12587.00 12587.00
| | W4 0s6 12587.00 12527.00
= BZTA2 12387.00 12587.00

CLOREENVCY 12587.00 12587.00 —
WDCTAG 12387.00 12587.00
Sum 503513200 526080.00 1265799.00 2301011.00

| »
Ready Pordofs  [lo0% [ O
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Three-Dimensional Crosstabs

Eureka can also create a three-dimensional crosstab. Place a database column in the Sheet Groups control
of the dialog box. When Sheet Groups are used, Eureka outputs a separate crosstab (170t necessarily a
separate “sheet” or “page”) for each different value in the column. For instance, using Manufacturer as
the Sheets column will generate separate crosstabs for each manufacturer as well as combined totals for
all manufacturers.

- NOTE:
\?\/////\ If you want to prevent sheets from being split between two pages, do not select the Scale to

Object option for the crosstab. When you select Scale to Object, Eureka will split sheets over
pages (depending on the size of the object, the size of your page, and similar factors).

ing Multipl lumn, Row I, and Sheet Object

More than one database column can be used in the above objects. When multiple database columns are
used, Eureka outputs a line (or column or sheet) for every combination of values.

Building an ing Cr Librari

Each crosstab object refers to and/or creates a child object, allowing you to build a library of crosstab
objects to use in different documents.

To use an existing crosstab design file as a crosstab object:

1. Open the crosstab dialog box.

2. Click the Browse button J next to the Crosstab File Name input box. Eureka opens a file selection
dialog box.

3. Select the file containing the crosstab you want to include. Eureka reads the file and displays its val-
ues in the dialog box.

If a password was assigned to the document, Eureka prompts you for the password before loading the file.
A password is assigned by opening the crosstab design (*.iqr) file in Fureka Passwords cannot be
assigned in the crosstab dialog box. Make any desired changes to the crosstab object and click OK. Be
sure to change the file nhame shown at the bottom of the dialog, so you do not overwrite the file that was
imported.
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Graphics

Unit of Study: Graphics represent a type of output object that will be included in your document
when it is viewed or printed.

Application: This process is for adding graphics (output objects) to a new or existing document.
Report Type: Open the FFACTY report.

Activity: Student Hands-On with Instructor direction

Instructions:

Open your FFACTY report.

Select the graphic icon El from the tool bar.

1
2
3. Place the graphic object in the left-hand side margin of the Document Header area.
4.  Double-click the graphic object.

Graphic: GRAPHIC {C3-53.igr) ll

5. Enter a label for your graphic object.
6. Set the Height to 1.04.
7. Set the Width to 1.04.

Graphic |1mage.-"Border| Hot Dbiectl HTMLI Output whenl

Object Label: |GF‘JL‘~F'H'E
vy
Appearance ) m-m\ NOTE .

\ .
Height:[1.0¢ (Elin, v~ > Use the Height and Width to make
wiah [T 57 Bl \\\///% your graphic larger or smaller.

A graphic is only as big as the graphic object
that is placed on your report.

You can also resize the object by clicking on the
object once, and then grab the handles and
drag the object to the desired size.

QK I Cancel Help |
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Click on the Image/Border tab.
If you want a border around your graphic,
click on the list box and select the desired

Graphic: GRAPHIC {C3-59.igr)

0 ®

Graphic Image/Berder | Hot Object | HTML | Dutput when

X A A i — Border Sample
Line Weight. You can also set the point size, Line Weight ROy,
add shadowing and use customized settings. fnone) e
10. If you want a background for your graphic, [ Shadow %
select a pattern; otherwise, check the I~ Use Custom Settings Custeri |
Transparent check box.
. . — Background
11. If deSII‘ed, Change the border, ShadOW, f|”, I Transparent  Pattem: lm Border Calor... |
ar!d/or pattern CO|or(s)' . Image Shadow Eolor...l
12. CI|Ck on the browse button neXt tO F|Ie File: M ame: |EI:\Eureka\Heporter\Designer\SampJ :
Fill Calar... |
Name. & Steteh ToFit ¢ Seale Vertical
13. Change Look In: to C:. C BestFit € Scale Harizantal _Patim Coi..|

14. Double-click on Eureka.

15. Double-click on Reporter.

16. Double-click on Designer.

17. Double-click on the Sample folder.
18. Double-click on the World.bmp file. |

Background Image EHE

1 ~FTP.T Cloew CICRIVERS

1 Accesszk Clpiscover (T epet.fig

Cares Caoen Cletc

1 askar ClDocuments and Settings J

j S;:g:;l; Background Image EHE
. Look jr: | ‘3 Eureka =l « ® ek E-

I I |

Reporker

File hame: I
Files of type: |B|tmap Files [*.b

Look jn: I A Reporter j & = EB-

Background Image HE ‘

et Y Background Image HE
Lok in: I — Designer j = I‘j‘ =
B B ckoround Image BE
1 Cubes . :
File name: 1 Profiles Look jn: I — Sample j - ¥ B
Clremedy | Rl
Files of type: = slogo.bmp

Y helpbutton, bmp

File narne: | Tenmplate ¥ MyEureka,bmp
Filez of type: '

File name:

Filez of type:

File name:  [w/ORLD EMP Open

Files of type: | Bitmap Files (*.bmp) =l Cancel |
Help |
i

You will notice that in the Sample area, a picture of your graphic is displayed.
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19. Click OK.

Example of the Desigh Document:

& EUREKA:Reporter Designer - [C3-59.igqr]

Q@ Edit Wiew Insert Query Tools ‘Window Help ;Iilil
DEHERkem @ m@8c [Ff% ®x
A eaE20 Do EnE|uFEeE||R My B2 o

[F Times New Roman EHie =t o == = |l = |
L LT T AT <O 0 T . T T T T A L= O |~
Top Margin |04
Docunent i Global Sports
Header N y \
Page 0 S
U ! e [Hand Receipt Report by
_ HEHNhrMjr | HEHName __ OfficeName
UIC Group |04
Header | me e
Didiz 0 | COUNTER | HRHNGMj| HEHNSwe | omsNsmeam 0 —
Page Footer| 0
‘_ DOCTMENTHAME PAGENO
Document |04
foster - End of Renart >
< | »
Roady UM

20. Click OK.
21. Save your report.
22. Process your report.

Example of the finished report:

E T e e L] HEE
@_ Ele Edit “ew Tools Window Help - |5|5|

HMar MM |QQ | Eaa o

Global Sparts

e =
31136200 Hand Receipt Report by UIC |
HEHMNbiMjr ~ HEHName OfficeName
Uc  HQio0i _
1 5701 KEN MOOEE - TRAINOL LOGISTICS
2 5802 MARK MURPHY INTEL
-
| r
Wiew specified page |Pg: lof 1l muM

23. DO NOT close the report — we will continue to use it in the next Unit of Study.
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Creating Icons For Your Desktop

Unit of Study: This process will show you how to create a report icon for your desktop.

Application: When you want your documents to be viewed, printed, or exported directly from
Windows by creating a program item or shortcut represented by an icon that you designate to be in

Start>Programs>Accessories.

Report Type: Open the report FFACTY

Activity: Student Hands-On with Instructor direction

Instructions:

1. Open the FFACTY report.
2. Select Tools from the menu bar.

3. Select Auto Shortcut Builder... from the program group.

Preferences...
Database Connection Defaults. ..

Cache Defaults... \
Disconnect \\\/

CObject Styles Editaor...

HTML Defaults. .. \\"’g\ NOTE:
rﬁ\ > You cannot create an icon for a NOT YET SAVED document!!!

Auto Shorkcut Builder ...
ODEC Data Source Administrator ..

[MECadata Manager..
EUEE ViEWEL .
Publisher...

4. Description: Eureka will default this field with
your report title. Depending on which radio but-
ton you select (View, Print, or Export), it will be a
part of your Description.

5. Accept the default View.

Auto Shortcut Builder [ %]

— Shartcut tem Infarmation

Drescription: IEUF!EKA:F!eporter Designer Wiew - C3-59

@ View O Print Export Pragram Group:

Export Farmat: I E=Fieport Output File * l

Current |con:

lcon Path: IEI:\Eureka\Heporter\Designer\rptviewer J

2 |

— Command Line nfarmation

View Select this if you want to view your report on the
screen.

Print Select this to sent your report directly to your
default printer.

Export Select this to export your report to another applica-
tion.

Command Line: I"E:\E ureka'Reporter\Designerptviewsr. exe” MODE=\ie

‘Working Directory: I"E:\E ureka'Reportert\Designer”

6. Export Format: If you selected Export, you will

QK I Cancel | Help |

need to select the export format.

7. Click on the Program Group list box and select Accessories (All Users). Your icon will be save to

the Program Group that you specify.
8. Click on the list box for Current Icon.
9. Select your desired icon.
10. Click OK.
11. Save your report.

12. Close your report and return to your desktop.
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13. Click on the Start button.
14. Select Programs.
15. Select Accessories.

16. Select Eureka-Reporter Designer View_FFACTY.

Your report will be automatically processed and displayed.

& EUREKA:Reporter Designer - [C5-16]

@‘Eile Edit Wiew Tools ‘Window Help

=@l x|
W< » M 2@ e (@

Global Sparts

311312002 IHand Receipt Report by UIC |
HEHNbrMjr HRHName OfficeMame

uc HQ1001 .

1 3701 KEN MOORE - TRAINOL LOGISTICS

2 5802 MARK MURFHY INTEL

-
| »
‘iew specified page

[Pg: 10f 1 [ o |

17. Close the output window.
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Creating Labels

Unit of Study: To create labels in Fureka, you can use the Avery label templates. Templates are
predefined design documents that you can use as a model for a new document. These templates include
objects on them but are not linked to specific columns. You also have the option of creating custom
templates of your own.

Labels in are created with a new document from a template. When you select New From Template from

the File menu, £ureka opens a file selection dialog box. Use the List Files of Type control to select the type
of template you want to start with. Select the template you want to use. Most templates distributed with
Eureka are installed into the template subdirectory of the £ureka directory. Templates for use with Avery
mailing labels are installed into template\avery. When you click Open, the selected template is loaded and
a new window for it is opened with the name Untitled.

Application: This process involves the use of predefined design templates to specify specific data you
want to appear on a label.

Report Type: Label design listing Stock Nbr, Nomen, Bar Cd, Location, Serial Nbr, plus who the
property is assigned to.

Activity: Student Hands-On with Instructor direction

Instructions:

Click File>New From Template.

Look in: Select C:.

Double-click on the Eureka folder.

Double-click on Reporter.

Double-click on Designer.

Double-click on Template.

Double-click on the Avery folder.

Change Files of type to Mailing Labels (*.iqm).
Select A4_I17160.igm.

VWoONOTUhWN =

After choosing a label design, it will produce a screen similar to the above, depending on what label design
was selected.

& EUREKA:Reporter Designer - [Untitled3]
EF File Edit Wiew Insert Query Tooks Window Help = =] x|

DEH(SEm| ) @ | F [P
AT @20 Do E @mE [ EE K e =
EX] Hho  EifE s w == =] = ‘

19 NP =0 PO PO =0 NP L0 0 NP -0 NP = N L . AP =P =T PP =P - P O = = Y = 1)

Top Margin

[ [
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Column: BarC

Colurnn | Bo[derl Faont I Olutput whenl Hat Dbiectl HTMLI Iranslatel

Business ViEWZIEND ITEM SERIAL

Eolumn:IBar Cd

Obiect Labe [EEIRE Type:
IString
Falder: I Serial Hand_Receipt
Farmat:
Character width:

LColumnz Browse Aggregate Function:
[P=Serial Hand Feca [Mone] =
[l acC
il ADP Owrer C HFPEEETED
[ 40P Sp=1d 1 ™ Suppress
[ At Rpt Mbr Duplicates
[l 4 Cd ™ word ‘Wrap
[ Acq Cost
[ Aeq Dt ¥ Snap To Grid
! [ Action Cd _,I_I Cha

fr

QK I Cancel Help |

17. Save your report as Label.

18. Process your report.

a}'EUREKA:Reporter Designer - [C5-26]

10. Double-click on COLUMN.

11. Scroll to the END ITEM SERIAL business
view.

12. Scroll to the Serial_Hand_Receipt folder.

13. Double-click on Bar Cd.

14. Click OK. You are returned to the Design
Document.

15. Click OK.

16. Using the table below, repeat the steps for

the remaining label fields.

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog Stock Nbr
Nomen
Serial_Hand_Receipt | |,
Serial Nbr
Hand_Receipt_Holder | ppy Nbr Mjr

@_Elle Edit Wwiew Tools Window Help

== x|

4> M2

167240

e |k BE|o

167241

167242

TRK CGO 12T 6000
2320010407891
324234105333
BLDG 24

5701

167244

TRKLF 6000LB LT-60RS
3300002510148
436346AFG44

BLDG 24

570

HQoo01

AMNSWERING MACHINE
TO1000M 452825
AF-001

5701

0334201

FARARL T AT A

Yiew specified page

19. Close the report viewer.
20. Close your report.

LATHE, ENGIME
3411001364013
77483

BLDG 24

5701

167243
TELEPHOME, STU I
518000M000927
32423GR

BLDG 24

570

1593001

MONITOR, 18" COLOR
0260000014952
133004103

BLDG 24

5701

1503003

AT S A me e

COPIER Y3 XEROK
3610011297764
A00XE12

BLDG 24

5701

7251001101
BARCODE READER
8383311PLM
BRD-001-001

570

1593002

COMPUTER, PEMTILIM Il
026010000568

SHEY44

BLDG 24

5701

1503004

e

|Pa: 1 0f 1

o
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Creating A Personal Data Mart

INTRODUCTION

A Personal Data Mart (PDM) is intended for the user who wants to create a subset of data on his/her
own machine and run queries against it. While a user needs to define only one document in creating
a PDM, that PDM may serve as a data source for multiple users with many documents.

The user will create a document that uses all of the rows and columns that he/she generally queries.
It is important to remember that the PDM contains data for a particular query. The data is local (on
your PC or Local Area Network (LAN)) and it is permanent, i.e., it is NOT dynamic like the other .ipr
documents we have created. Once the PDM has been established, other design documents can use it
as their data source. Personal Data Marts are generally used to create relatively large local data
stores that are refreshed on a set schedule.

OBJECTIVES

You will learn the fundamentals of creating your personal data set. In this exercise, you will create a
QuickQuery report with all of the data elements from the End Item Serial Business View, QuickStart!
folder. You will then export that report to your desktop as your Personal Data Mart.

APPLICATION

The three main reasons that users develop Personal Data Marts are for speed in running reports
against limited data; as an aid in development of reports; and to be able to work off-line with their
specific set of data. Creating a PDM is the first step in the process.

PREREQUISITES

A familiarity with Eureka; all previous prerequisites.
ACTIVITY

Student Hands-On with Instructor direction
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STEPS TO PERFORM ACTION

1. Open a QuickQuery without the Wizard.
2. Select the fields from the table below:

BUSINESS VIEW: CATALOG

FOLDER(S) DATA ELEMENT(S)
Catalog ADP Cmpn Cd Stock Nbr
LIN Yr Svc Life
Nomen
Mfr Part Nbr

3. Move the selected fields to the workspace.

§-‘IEUREKA:Reporter Designer - [Untitled1]
I‘E__! Fle Edit Yiew Insett Query Tools ‘Window Help ==
DEHSRm|) c@o - Fo o |
Bl |t e L%y By H|
|CI1' Times Mew Roman j“m j| B F U |§ E— ‘M“ j|
[ 0P enpli i [Nomen StockNhrLHAA | VrSveLife |MfrName =l
R51144 | CHARGER, RADIO 054721407 W 10 | U ABSIGHNED
WaE432 | AMMO BALL, 7620 100501LP004 0| UNABSIGHED
LEA-AIRCRAFT 150000LEAQ001 3| UNAZSIGED
LEA-SHIPSAWATER CRAF | 190000LEAQ002 3 | UNABSIGHED
LEA-RAILWAY EQUIPLE | 220000LEAQ003 3| UNABSIGHED
258630 | TRE. AMEB MTIEAL 2310001779301 10 | UM ABSIGNED
F32639 | TRE AME M71841 2310001775202 10 | UM AZSIGNED
FEE6A39 | TRE AME MT1241 2310001775203 10 | UM ASSIGHNED
258630 | TRE. AME MT1EAL 2310001779304 10 | UM ABSIGNED =
58639 | TRE. AMBE MTIEAL 2310001779305 10 | UNASSIGNED
FE8639 | TRE AME M71841 2310001779206 10 | U ABSIGHNED
258630 | TRE. AME MT1EAL 2310001779307 10 | UM ABSIGNED
58639 | TRE. AMBE MTIEAL 2310001779308 10 | UNASSIGNED
FE8639 | TRE AME M71841 2310001779209 10 | U ABSIGHNED
258630 | TRIC AMEBE MT18AL 2310001779210 10 | UNABSIGNED
58630 | TRE AMB MTIEAL 2310001779311 10 | UM ABSIGNED
FE8639 | TRE AME M71841 2310001779212 10 | U ABSIGHNED
258630 | TRIC AMEBE MT18AL 2310001779213 10 | UNABSIGNED
258630 | TRE. AMEB MTIEAL 2310001779314 10 | UM ABSIGNED
F38639 | TRE AME M71841 2310001779215 10 | UM ABSIGHED
258630 | TREL AMBE MT18AL 2310001779216 10 | UNABSIGNED
0 TD ARAD RATIG A1 2ANN1TTOT A0 TTHT A QISTELRTTTY =
RIdTrecara 51 TR IR =l
Fort T

4. Save the query as YOURNAME-PDM (for example, JOHN-PDM).

- NOTE:
\(/ The reason that we are saving the PDM as a query/report is so that, if we choose, we can
7 “refresh” the data for the elements we have selected. There are two alternatives for updating

your PDM from the larger database from which it was created. One is to again run the report
from which the data was created, and export it again as an *.iqd to the SAME NAME. The
second method would be to delete from your desktop, or the place where the PDM is stored,
the *.iqd, rerun the query as above, and save the PDM again, either with the same name or a
different name. This prevents any possible confusion on which is the correct version of the
PDM to use.
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5. Select Eile from the menu bar.
6. Select Export from the program group.

Mew. .. Chrl+M
Open... Chrl+O
Close

Mew From Template,.. Chrl+T

Save Chrl+5
Save As...

Page Setup...
Print... Chrl+P
Prink Setup...

Print Preview Chrl4+-i

Export...

Repork Server 3

Send Mail

1 Melanie-POM.igr
2 C5-26.igr
3 C3-59.igr
4 C5-16.igr

Exit

7. In Save in, change to Desktop.

8. Change Save as type to Personal Data Mart (*.iqd).

Save jn: I 225 Desktop j ﬁl

My Computer E,:I Sustainment Manuals
E‘,EI_ Metwark Meighborhood
|1 For Coop Capacity Test OMLY

tnpl & Training
A Mavy Files

File name: Melanie.iqgd Export I
Save as type: | Personal Data Mart [*igd) j Cancel |

HTHL File [* hitrn)

Feport Qutput File [*.iga]

Data File [* cav]

9. Click Export.
10. Close your report without saving.
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Using A Personal Data Mart

_iy CAUTION!
Y Your PDM is only as good as the last database update! Since your PDM is running from your

hard drive, the data cannot be refreshed unless you export new data.

INTRODUCTION
This process will show you how to use your Personal Data Mart as your source of data for a report.

OBJECTIVES

You will learn the fundamentals of using your Personal Data Mart. In this example, you will create a
QuickQuery without the wizard, with six data elements drawn from those used in the PDM.

APPLICATION

The user has developed a report that has only those fields required to draw specific data wanted and
designated the PDM. As an example, a user can export the PDM to a notebook computer’s hard
drive. From there, the user can develop his/her report and run it against their PDM as the Knowledge
Base rather than the dpas.igk which is standard. The resulting reports can be run against any Knowl-
edge Base, and the PDM can also be refreshed.

PREREQUISITES
The prerequisites found in Creating a PDM; a PDM has been created and named.
STEPS TO PERFORM ACTION

1. Open a new QuickQuery report without the wizard.
2. Select Tools from the menu bar.

Connestion | Ereferences | HTML Defauks | Cache| 3. Select Database Connection Defaults... from
r Defau:;I;Jt:tzl:isrzjonnectlc.‘ the program group.
4. Select (Personal Data Mart) from the Data
Source list box.
5. Click the browse button for the Personal Data
Mart.

[ | 1
Fagsyyand:

Senvern Hanes

Database ame:

[ i s s s 6. Look in: Select Desktop.
Default Metadata File: [C\Program Files\D 0DADPAS D pas igk [ 7. Click YOURNAME'PDM.iqd
Persoral Data Matt: | [ 8. Click Open.
- Downlaad Metadata File fram Fiepart Server 9. Click OK.
servertlame | e 10. If your Object Directory is not displayed, depress
R [eae ] the F2 Function Key.

11. Double-click on the YOURNAME-PDM.

0K I Cancel I Help I
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12. You can now select the fields you want to use in your query.

13. Select from any or all of the fields from the PDM for your report. NOTICE how quickly the data is
added, since it is coming from your hard drive, and does not have to negotiate the Internet or your
Local Area Network (LAN).

& EUREKA:Reporter Designer - [Untitled1] = [F 1] |
El

[osu anal
[t e Py
|
,_

LIN
MM ame
MfrParthbr
StockMbrLHAA
‘Yi5velife

[ MldlRecora [t DRIl

I I

From this point, you can treat this report as you would any other report. The only difference is the data
source is your PDM rather than your activities’ database in Dayton, OH.
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Toolbars, Status Bars And Operators
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i

QuickQuery Objects Toolbar

The QuickQuery Objects Toolbar provides shortcuts for adding objects to a report.

Column Object. Inserts a database column object.

database. Examples would be calculations, substrings, or concatenations.

CH 2

1 October 2004

Custom Object. This is used in order to create data fields that are needed but not in the

Ouickq Queries Tooll

[ ¢ B E |43 TT%Y B

The QuickQuery Queries Toolbar allows you to add attributes to your report.

Query Wizard Icon. Creates or modifies a query using the wizard.

Requery Icon. Allows you to run the query again.

Group By Icon. Groups rows by the selected column(s).

Remove Groups Icon. Removes all row groupings.

Sort Ascending Icon. Sorts the rows by selected column(s) in ascending order.

Sort Descending Icon. Sorts the rows by selected column(s) in descending order.

Apply Filter Icon. Applies filter to the current section.

Clear Filter Icon. Clears the current filter.

Quick Filter Icon. Allows you to select a quick filter.
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Filter Icon. This is used to apply search criteria to your report.

Style Profiles Icon. Add or modify QuickQuery styles.

Clear Object Style Icon. Clears the formatting of the selected column(s).

Update/New FreeForm. Update/new FreeForm with QuickQuery layout changes.

FreeForm Obj Toolbar

' maE=2 @O @ EEB | & E YR

Select Object. This is helpful when you want to terminate object placement. You can also hit
the <ESC> key to de-select or terminate an object placement.

Column Object. This is the same as selecting it from the Objects Directory.

Text Object. This is used to add text to your report, as well as modify Column headings or add a
Report title.

Custom Object. This is used in order to create data fields that are needed but not in the
database. Examples would be calculations, substrings, or concatenations.

Prompt Object. This is used to prompt the report user for information such as UIC, Hand
Receipt Number, etc.

Child Data Object. This is used to return a specific piece of information from one document (the
Child) and use it in another (the Parent or another child).

Date Object. This is used to place the system date on the report.

Time Object. This is used to place the system time to the report.

Page Number Object. This is used to place page number(s) on your report.

Counter Object. This is used to display the count of detail records or database rows output on
your report.

Report Name Object. This is used to place the name of the report file on your report. This is
not the title of the report.
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Graphic Object. This is used to place a bitmap image on your report.

Chart Object. This is used to place a chart on your report. This includes Bar, Pie, and Scatter
charts.

Crosstab Object. This is used to provide an entire crosstab document in/on your report.

Object Linking and Embedding (OLE) Object. This is used to embed objects that are created
by another application to your report.

Child Document Object. This is used to connect a £ureka document (child) that you include as
part of another Eureka document (parent or another child).

FreeForm Queries Toolbar
x|stv EEE E|

Wizard Icon. This is used to invoke the Wizard in FreeForm.

Sort Icon. This is used to sort the report by whatever data field is chosen by the user.

Filter Icon. This is used to apply search criteria to your report.

Group Header Icon. This is used to add a data Group Header Area at the beginning of your
report. This is not accessible until you select a column or custom object.

Group Footer Icon. This is used to add a data Group Footer Area at the end of your report.
This is not accessible until you select a column or custom object.

Page Header/Footer Icon. This is used to place data or text that will appear at the top or
bottom of each page of your report.

Document Header/Footer Icon. This is used to place data or text that will appear on the first
or last page of your report.

Update FreeForm Layout Icon. This rearranges all of your objects to form a neat, logical
design after you have added columns to a FreeForm document by using a QuickQuery window.

201

1 October 2004



Menu Items

Menu Items

Menu items are grouped by functions; the File menu is for tasks such as opening and closing files, savings
files and printing files.

File M
File:
I_New... Y Q New - Opens a new report
Cpen... Chrl O Open - Opens an existing report
Close Q Close — Closes the active report
O New From Template — Opens a template as model for new document
Mew From Template... Ctrl+T O Save - Saves the active report
Save Ctrl+s O Save As — Saves the active report to a new name
Save As... O Page Setup — Sets up the layout, margins, and point defaults
Page Setup... O Page Border — Sets up the border parameters
— FiheE Q Print - Prints using your Windows default dialog box
s S e O Print Setup - Sets up the print specification using the Windows dialog box
Q Print Preview — Generates all pages for the formatted report and gives the
Frink Preview el ability to view the document before it is printed
Expart. .. Chrl+E O Export — Sends the report to a common separate file such as text, Excel, HTML
Report Server » | O Report Server — Executes queries on a database server
I O Send Mail — emails the report to other users on the same mail server
1 Melanie-PDM, iqr
Z C5-26.iqr
3 C3-50.igr
4 C5-16.iqr
Exit
Edit Menu =
O Undo — Reverses the last action el Curtt=
Redo ChrlH4-4
O Redo - Reverses an undo
O Cut - Removes a selected object Cuk CErl+
O Copy - Copies a selected object to the clipboard Copy CErl+iC
O Paste - Places copied objects to the desired area Paste Chrl+Y
O Paste Link — Places a linked OLE object by pasting a non-E£ureka Reporter Paste Link
Designer object from the Clipboard Delete Dl
O Delete — Removes the selected object
O Select All Toggle - Selects all the objects for editing, or deselecting Select All Togle
0O Hide Toggle - Hides or reveals selected objects Hide Toggle
O Attributes — Selects the current objects format artributes. .
Q Border — Displays border dialog box for the active window Border. ..
O Font - Displays the font dialog box for the selected object Font...
O Hot Object - Sets hot object attributes for selected objects Hat Object...
Q HTML - Sets HTML attributes for selected objects -
O Output When - Sets Output When attributes for selected objects ot lélwh
O Translate Value — Invokes the translate value dialog for the active window HEREE BT
O Prompt SQL — Edit the SQL query associated with a user prompt object Translate Value. .
O Prompt Connection - Changes the database connection for a selected Prompt SQL...
user prompt object F‘rD.mpt Connectian. ..
Object
CH?2
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View Menu
View

Toolbars, ..
Skatus Bar

Ohject Directary Fz
Area Object List F4

Freeze Columns
Unfreeze Columns

Margins

Horizantal Ruler

Wertical Ruler

Area Labels

arid

Show Object Format  Chrl+F
Show Object Colors  Chrl+3

Zoarm In
Zaarn Cuk
100%

OCo0D0 o

0o

ocoooodoo

a
Q

Toolbars — Displays toolbar dialog box for selecting toolbar

Status Bar — Toggles on and off the display of the status toolbar

Object Directory — Toggles on and off the display of the object directory

Area Object List — Toggles on and off the display of the area object list
Freeze Columns — Keeps at least one column stationary at all times in order to
help identify the content of the rows

Unfreeze Columns — Allows the frozen column to scroll

Margins - Controls the display of a document’s page margins. Turning them off
lets you see more of the document. Margins are always shown in output
windows.

Horizontal Ruler — Controls the display of a document’s horizontal ruler.
Vertical Ruler — Controls the display of a document’s vertical ruler.

Area Labels — Controls the display of a document’s area labels.

Grid — Controls the display of the document’s grid lines.

Show Object Format — Controls whether each object’s output format is shown
Show Object Colors — Controls whether each object’s name or format is shown:
In a “container” with the background differently colored for each type of object,
or As black text with no background

Zoom In - Increases the magnification of QuickQuery

Zoom Out - Displays more of your QuickQuery screen at one time

O 100% - Displays the QuickQuery in normal view size

Insert Menu

O Column — Inserts column objects that references an object defined in the knowledge Insert
base Column

O Text - This is used to add text to your report, as well as modify Column headings or add Text
a Report title Custorn

O Custom - This is used in order to create data fields that are needed but not in Frompt
the database. Examples would be calculations, substrings, or concatenations Ststern »

QO Prompt - This is used to prompt the report user for information such as UIC, Hand araphic
Receipt Number, etc Chart

O System - Inserts objects such as current date, time, page number, count, and report Crosstab
name Child Document

O Graphic - This is used to place a bitmap image on your report hild Data

O Chart - This is used to place a chart on your report. This includes Bar, Pie, and Scatter J. »
charts

Q Crosstab — This is used to provide an entire crosstab document infon your report

O Child Document — This is used to connect a Fureka document (child) that you include as part of another Eureka
document (parent or another child)

O Child Data - This is used to return a specific piece of information from one document (the Child) and use it in
another (the Parent or another child)

O Area — Inserts area objects such as document header and footer, detail area, and page header and footer to the
design window
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Query Menu

QO Wizard - Enables the query wizard
B 0O TM1 Cube Wizard - Creates TM1 Cubes
Wizard. .. Q

TM1 Cube Wizard..

Sort Order — Displays the sort order/filter dialog box to set the sort order for the
columns used in the query
Filter — Displays the sort order/filter dialog box for setting the column filters

a
i;t:rgrder“' used in the query
Quick Elltetn, O Quick Filters — Displays a pick list of saved filters

Q Setup - Displays a dialog box for setting the grid size, the password, units of
3stup... measure, and row and time limits for the query

Default Font..,

Database Conneckion Owverride. .

SCL Crverride. ..
Cache Owverride. ..

Quickuery Propetties. ..

Wiew

Refresh Cache

a

a

Default Font — Displays the dialog box for setting font attributes and alignment
for new objects

Database Connection Override — Displays the dialog box that allows you to
override the default options for connecting to the database

SQL Override — Displays the dialog box for creating a query from scratch or
editing the queries that the user generates

Cache Override — Displays the dialog box for setting cache properties that are
specific to your current document

QuickQuery Properties — Displays the dialog box for controlling the on-screen
appearance or the row and column titles

O View - Uses notepad to display the SQL syntax for the query
O Refresh Cache - Empties the data cache and refills it from your database

Tools Menu

Q

Tools

Preferences — Displays the preferences dialog box for setting the master data
source

Preferences. ..
Database Connection Defaults. .

O Database Connection Defaults — Displays default database connection options, HTML Defaults. ..
login ID, password, and default metadata file and knowledge base Cache Defaults. .,
O HTML Defaults — Controls default settings for creating HTML files P
O Cache Defaults — Enables cache and sets cache preferences to specify cache
duration Cuickiquery Skyles Edicar...
O Disconnect — Discontinues the current database connection g;t;f;:Et;;tof:'c':j:rd';n'imstratm
O QuickQuery Styles Editor — Displays dialog box to define rules which control
the font, color, borders, and text alignment of a specified document Metadata Manager. .
O Auto Shortcut Builder — Displays a dialog box to create an icon or program item U o=t oo
to process your active design document Publisher .
O ODBC Data Source Administrator - Displays a dialog box used to add and
modify the ODBC driver
O Metadata Manager - You can have the £ureka Metadata Manager substitute pre-defined user-friendly column
names for the actual column names used in your database. This is only available to the database administrator
O Cube Viewer — This option is disabled with the DPAS application
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Menu Items

Window Menu
Window

FreeFarm
QuickQuery

Cascade
Tile

0o0

Free Form — Shows a current QuickQuery document in a FreeForm window
QuickQuery — Shows a current FreeForm document in a QuickQuery window

Cascade — Rearranges and sizes all nhon-minimized windows so that they are next to each
other

Tile — Rearranges and resizes all non-minimized windows so that they are next to each
other within an objects window

Arrange Icons Q Arrange Icons — Neatly arranges the icons for all minimized windows
O Contents — Displays a list of topics in the help system Wp
Q Search for Help On — Displays a search dialog box for key words et f
O How to Use Help - Displays a dialog box to let you type the word you want to find LB
0O Obtaining Technical Support — States useful information for obtaining product Seareh for Hep on,.,

technical support How Tl i
O About Eureka Reporter Designerer — Displays product information such as

name, version, copyright information, and current system resources Bt Tedicd St

aring Tecnnical Suppar
Raou: EUREKCA Reporter Designer..,
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Changing Your Eureka Password

Changing Your Eureka Password

INTRODUCTION

This process will show you the procedures used to change your password in Eureka Anytime you
change your login or password for DPAS, you must also change them to the same for Eureka. When
you change your password in DPAS, you will get a pop-up message to change your password in
Eureka.

OBJECTIVES

To allow the user to understand when and how to change the Eureka password.
APPLICATION

You have just changed your DPAS password and now you need to change it in Eureka

PREREQUISITES

Eureka Reporter Designer is correctly loaded and configured.

ACTIVITY
Instructor-led demonstration
STEPS TO PERFORM ACTION

1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
2. Select Eureka from the program group.

ct Query Type [ x| STEP 1:

e If you get the wizard, click Finish; other-
wise, go to the next step.

what type of query would you like?

(Customers by M’:rﬂ';‘:
Region (O

Begion  Omt®  company  phened ' Summary

AfRricds EPOD0Z Sharts Jdak (A0 34~ r G[Uuped D Btail
Aprricds SPOOWD Shaortlg THeGhoe (60869132

Americes 300001 Saccer Mank {34 T " Overall Summary
Apwrkds AEMIL  Fhet Feat [ TS| 444190

Africas  SETO0Z S0 T Yau Deap Ltd (303(677-192 € Create TM1 Cube
Aprricds SPO00L Sharts Wdrddause (202|224-123

AHRricds SO0 Sharts Carducah [ 24| Fre-T3z

Apwrkds 20Ul Sautumesters Sparts  (208] E3F-ET . .
Buane  SPOOTD Snortd SCelr AR LPADEELD Thiz type of query allaws you ta list
Burape  EAVOOL Brvar SpoctsGmoe 304 352 detail infarmation frorm pour databaze.
Burape  SPO003 Sportscenelinfed 43455524 For example, all orders.

Eurape. SPOO3 Sportsd Lebure Pk LSLATL AT34
Eurane SPOORS Sporhereh DU Gm  39L 34102
Eurane FOO0OL Faatleg 4 LT E

Fike Mamee. 117_gat e Paga: L

[ Do not show this wizard in the: future.

< Black I Mest » I Finigh Cancel Help
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STEP 2:

a. From the menu bar, select Tools.
b. Select Database Connection Defaults...

Lonnection | Preferences I HTHL Defaults I Lache I

— Default Database Connection
Data Source: I LI

Login [D: |

Fassword: I

Server Name: I

D atabase Mame: I

™ Prompt For Data Source at Buntime

Default Metadata Fils: I

Perzonal Data Mart: I

]
|

Download kMetadata File from Report Server

;I Refresh §ervers|
Fetrieve |

Server Mame: I

Host Marne: |

o |

Cancel | Help

Tools

Preferences...

Database Conneckion Defaulks, .
HTML Defaults, ..
Cache Defaults, ..

[MiSCamnes

Object Skyles Editor. ..
Gt Stk Buider,.
QDEC Diata Source Administrator ..

[Metadata anager:..
e MiEWEr .
Publisher. ..

STEP 3:

a. Data Source: Make sure that your DPAS Site
ID is displayed.

b. Login ID: Make sure that your DPAS User ID

is displayed.

Password: Enter your NEW DPAS password.

Server Name: Leave this field blank.

Database Name: Leave this field blank.

Prompt For Data Source at Runtime: Do

not check this box. If checked, you will be

prompted to enter your DPAS Site ID each time

you run a report.

g. Default Metadata File: Browse for where
the DPAS programs reside on you workstation.
If all the defaults were taken during installa-
tion, then the path is normally: C:\Program
Files\DOD\DPAS\DPAS.iqk.

o ao

If you are unable to locate the DPAS.igk file, click on the START button, select Eind (or Search if using
Windows ME or 2000), Eiles or Folders..., enter dpas.igk look in the Local Hard Drives.

h. Server Name: Leave this field blank.
i. Host Name: Leave this field blank.
j.  Click OK.

207



Installation Of The Eureka Reporter Viewer

Installation Of The Eureka Reporter Viewer

INTRODUCTION

There are occasions when you may want to provide a report electronically to a person who does not
have DPAS or Eureka installed on their own PCs. In those cases, you have the choice of “exporting”
your Eureka file in another format, such as Microsoft Excel (.xls), or text (.txt). Another alternative
available is for the people to whom you regularly submit reports to have the Eureka Reporter Viewer
installed, instead of the full Eureka Reporter Designer. (Note: Eureka Reporter Viewer provides the
QuickQuery tool set only.) (dpaspr.exe, 9,448,006 bytes)

OBJECTIVES

The instructions below are general and provide the guidelines of how to install only the Eureka
Reporter Viewer. Whoever is responsible for installing DPAS and Eureka in your organization should
still have the responsibility to install the Reporter Viewer.

APPLICATION

As described in the introduction section above, the Reporter Viewer is intended for those who do not
want or need the full DPAS and Eureka Reporter Designer installation.

PREREQUISITES

A login and password for software downloads from the DPAS Homepage, similar to any other DPAS
download.

ACTIVITY

None
STEPS TO PERFORM ACTION

As with SUPRA NT, the installation of £ureka Reporter Viewer is simply a matter of reading the screen
prompts throughout the installation process and following the directions provided.

1. If installed, remove the existing version of Eureka Reporter Designer via the Control Panel “"Add/
Remove Programs” applet prior to installing the £ureka Reporter Viewer program.

To install Eureka Reporter Viewer, click on the Start button.

Select Run from the program group.

w N
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Run [ 7 x| STEP 1:
Type th f , folder, or d . and
Windows il open for o o a. Open: Enter the full path of where you downloaded the
aoere | | d_paspr.exe file.
¥ | Furiit Separate fdememiSpace b- CI|Ck OK.
] I Cancel | Browse. .. |

STEP 2:

. Prior to installation of thiz product, you should first aninstall your current version of TG to
® Click Ies- avoid compatiblity problems between old and new versions of the zoftware.
wifindows/ NT Administartors who are performing the installation should read the file
exprireq.rtf for instructions on creating registry entries for individual users.

Continue with Install 7

nstallation Folder STE P 3 .

Fleaze enter the folder vx_lhere the _files should be unpackec_l.
If the folder does not exist, vou will be prompted to create it. a. Insta"ation Folder: Accept the defau It Of
“c:\dpasinst”.

Inztallation Faolder b CI |Ck Fi n iSh

Browse... |

I rztalShield

< Back I Finizh I Cancel

% NOTE:
X\/ This window will prompt you to choose a directory in which to unpack the files that will be used
\(/ to install Eureka. The default unpacking directory is "c:\dpasinst", the same directory in which
the DPAS GUI and Supra NT programs are normally unpacked). The files begin unpacking in
the directory specified.

If there had been DPAS GUI or Supra NT installations prior to running this installation, AND
if the unpacking directory was not deleted, an "Overwrite Protection” window will appear at
this time. If this window appears, click on the "Yes to All” button to overwrite all temporary
files left over from the DPAS GUI and/or Supra NT installations.
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STEP 4:

Welcome to the InstallShield Wizard for [ ] CIICk uext> .
EUREKA:Reporter Yiewer

The InztallShield® wizard will install EUREKA:Reporter
Wiewer on your computer. To continue, click Mest.

Cancel

STEP 5:

Fleaze enter the activation key provided with the software. Thiz key iz

a. Enter the key that was g iVen to you in the Insta”at|on located on the media on which the software was shipped. [t may also
N have been emailed or faxed to you or someone in your organization. An
Instructions. activation key must be entered in order ta continue with the installation.
b. Click OK.

MOTE: The activation key, a hexadecimal number, consists of numbers
and letters. Therefore, it beging with the number 0 [zero] followed by the
letter '=" and will contain some combination of the numbers 0 [zera]

\\-!ﬁw\m\ NOTE : through 9 and the letters 'a' through '
\Q > The Eureka key code IS case sensitive.
v

()8 I Cancel

STEP 6:

Choose Destination Location
Select folder where Setup will install files.

o C(Click Next>.

Setup will inztall EUREK.A:Reporter Yiewer in the following folder.

To install to this folder, click Mext. To install to a different folder, click Browse and select mn‘m\ NOTE .
\ L]

another folder. a\
\\O > The default directory is
\/ C:\Eureka\Reporter\Viewer. If
you wish to install this program in
the default directory, then click
Next>.

" Destination Folder

b i Browse... |

o Euskeesareine : If you want to specify a desired pro-
IFstalEH il gram directory location, click on the
Cancel | Browse button and select the
desired directory.
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EUREKA:Reporter Setup E

ODBC Drivers

STEP 7:

e (Click Next>.

Select each ODBC driver you wish to inzstall by clicking on itz check box. [The dBASE driver iz
installed by default to support the Global Sports sample datazource. |

[ Excel Workbook Ok
[ INFORMIA oK
[ Openlngres 0K |+

" Destination Folder

\’O\ NOTE:

\ > Do not select any ODBC drivers.
\v/% Leave the checkmark next the dBASE
(it cannot be cleared and gets
installed by default).

CAWINNT Systema2 ‘
Space Required on C: 15810 K TS
Space Available on C: 35288582 K. ﬂl
| Frstal Shield
< Back Mest » | Cancel |
STEP 8:

Program Folder

e (lick Next>.

xo“\ NOTE:

" > The default folder is Eurekal
\\/ Reporter Viewer. You may specify a
different folder, if desired.

Setup will place shortcuts ta the program files inta the folder displayed in the Program Folders
field. Please type in a new program folder name or select one from the E xisting Folders list.

PFrogram Folders:

Ezisting Folders:

Adrmin Star
Administrative Tools
Adobe Acrobat 4.0
Dell Accessonies
Developer 2000
Developer 2000 for T
Developer 2000 R2.1

DOD Business Systems LI
| Frstal Shield
< Back | Mest » I Cancel |
STEP 9:

Confirm Selections

e C(Click Install>.

Fleaze review the selections you have made. Click Back to change selections, click Install to
begin copying files.

Current Settings:

Application destination directorny: -
C:A\Eureka\Reporteriiiewer

Program folder:
EUREKA Reporter Yiewer

ODBC driver directory:
C:Aw MM T S pstem32

ODBC drivers to install:
|

| Frstal Shield

o

The program files are now installed on the
computer with a status bar to indicate setup
progression.

< Back

Cancel |
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STEP 10:

a. Uncheck the "Display the Release Notes”
and “Launch EUREKA Reporter Viewer now
check boxes.

b. Click Finish.

EUREKA:Reporter Setup

Installation complete

”

The EUREK.A:Reporter Yiewer inztallation iz complete, Setup
can display the Releaze Motes and launch EUREKA:Reporter
Wigwer,

Chooze the options you want below.

¥ Launch ELREKA:Reporter Yiswer now.

TN NOTE:
m\ Release notes are not available with

\// " this version. Also, the Adobe Acrobat
Reader was removed from this
software bundle to reduce the size of
the self-extracting executable for
quicker downloads. Therefore, cgee [ Fnsh | | Ceed
leaving either of these boxes checked
will result in an error message at the
completion of the installation.

This completes the installation of Fureka Reporter Viewer.
Notice for Windows NT users:

The administrator for the Windows NT client may, depending upon the permission settings, have to grant
the user access to the executables that were installed with this process. They are:

Eureka Reporter Viewer: igpersnl.exe
File Clean-up:
You have completed the installation and have determined that you no longer have a need for the software

package(s). You can delete the files that were downloaded from the Web site and the files that were
unpacked during the installation process (all files located in the unpacked directory "c:\dpasinst").
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Chart Types

Bar Chart

—Bar Chart D ata

Bar Data: I

Bar Labels: I

Group by: I
[optional]

Hariz Az Title:

Wert Az Title: I

0 Bar Data - Place the object for which you want

to summarize values in the Bar Data control.
This object determines the height of the bars.
Bar Labels - Place the object for which you wish
to see bars in the Bar Labels control. A different
bar will be calculated for each value in this
object.

Group By - In the Group By control, place the
object you wish to group by, if any. Eureka
creates a different group of bars for each value
in this object. Each group includes one bar for
each value in the Bar Label object. Each bar
represents the calculated value for the Bar Data
object for a single particular combination of Bar
Label object value and Group By object value.

For instance, if the Bar Labels object is Class and the Group By object is Sport, there will be one group of
bars for each sport. Each of the groups will have one bar for each different Class value. For two-
dimensional charts, the groups are placed next to each other. For three-dimensional charts, the Group By
object is used as the X-axis and the Bar Label object is used as the Z-axis. If there were no Group By

object, there would be a single group of bars.

0 Horiz Axis Title - Enter a label to describe the Bar Labels object or the Bar Labels and Group By

objects.

0O Vert Axis Title - Enter a label to describe the Bar Data object.

Pie Chart

0 Pie Slice Values - This is the object that controls the Pie Slice Values: |
size of the pie slices.

0 Pie Slice Labels - There will be a slice calculated for
each value in this object.

CH 2
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— Pie Chart Data

Pie Slice Labels: I
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Scatter Chart

— Scatter Chart D ata

Line [1ata: I

Line Labels: I

Group by: I
[optional]

Hariz Az Title:

Wert Axiz Title: I

0 Line Data - Place the object for which you want

to summarize values in the Line Data control.
This object controls the point heights — it is the
Y-axis object.

Line Labels - In the Line Labels control, place
the object for which you wish to calculate points.
The object is the X-axis object unless you use a
Group By object, in which case it becomes the Z-
axis object. (Since scatter charts are two-
dimensional, the Z-axis points are differentiated
from each other by color.)

0 Group By - Add a Group By object if you want to chart three separate objects. Eureka creates a

different set of points on the chart for each value in this object. This object is used as the X-axis object.
0 Horiz Axis Title - Enter a label to describe the Line Labels object or Line Labels and Group By objects.
O Vert Axis Title - Enter a label to describe the Line Data object.

Area Chart

0 Area Data - Place the Y-axis object in the Area Data.
This is the object for which areas are plotted (i.e., itisthe | 4.\ et |
object which you want to summarize).

0 Area Labels - Place the X-axis object in the Area Labels Group by: |
control. If you are using a Group By object, place the Z-
axis object here. There will be an area calculated for
each value in this object.

0 Group By - In the Group By control, place the object you

—Area Chart Data

area Data: I

[optiomnal]

Huonz Awis Title:

Wert Az Title: I

wish to group by, if any. The Group By object is used as the X-axis object and the Area Labels object is

used as the Z-axis object.

0 Horiz Axis Title - Enter a label to describe the Area Labels object or the Area Labels and Group By

objects.

0O Vert Axis Title - Enter a label to describe the Area Data object.

Line Chart

— Line Chart Data

Lire: [ ata: I

Line Labels: I

Group by I
[optional]

Hariz Az Title:

Wert Az Title: I

0 Line Data - Place the object for which you want

to summarize values in the Line Data control.
This object controls the line height — it is the Y-
axis object.

Line Labels - In the Line Labels control, place
the object for which you wish to calculate points
along on the line(s). There will be a separate
point plotted for each value in this object. This
is the X-axis object unless you use a Group By
object, in which case it becomes the Z-axis
object.

0 Group By - When you place an object here, Eureka uses it as the X-axis object. (A separate line is
drawn for each value in the Line Labels Object; it becomes the Z-axis object.) Each line has points
plotted for each separate value in the Group By object.

CH 2
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For instance, if the Line Labels object is Class and the Group By object is Sport, there will be one line
for each Class value. Each line will have points plotted bar for each Sport. If there was no Group By
object, there would be a single line that would have a separate point plotted for each Class value.

0 Horiz Axis Title - Enter a label to describe the Line Labels object or the Line Labels and Group By

objects.
0 Vert Axis Title - Enter a label to describe the Line Data object.
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Style Profiles

INTRODUCTION

Style profiles allow you to control the appearance of your QuickQuery by defining rules that apply
style attributes.

OBJECTIVES

You will demonstrate an ability to establish style profiles for your own QuickQuery Reports.
APPLICATION

Style Profiles is another tool to determine how your data will be represented on-screen or in print.
PREREQUISITES

Complete Chapters 1 and 2 of this manual.
ACTIVITY

The Style Profiles Dialog Box - Using Style Profiles to Control the Appearance of a QuickQuery.

It BE (MU LYY By | STEPL:

¢ Select the Style Profiles icon OR select Tools and
then QuickQuery Styles Editor

This dialog box lets you define rules which control the font, color, borders, and text alignment of your
document. Each rule applies to those parts of your document which meet the condition (e.g., Even Rows,
0Odd Rows, Group Data, etc.) that you select for the rule. One or more rules can be saved as a Style
Profile, which can be applied to other documents.

When you first open this dialog box, the Rules section lists the rules which control text meeting these
conditions: Even Rows, Odd Rows, and Detail Data. (These conditions are always fulfilled in a QuickQuery
document that has more than one detail row.) If you open the Editor and select an existing Style Profile
from the drop-down list at left, the Rules section displays a list of the rules that have been defined in the
selected Style Profile. Each rule is accompanied by a checkbox, which can be used to turn the application
of the rule off or on.
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STEP 2:

a. Double-click on the rule that you
want to set your attributes to.

H H em VYendor Date Amount
b. CIK_:k Apply t.O assign your Style' Golf Clubs | Alcanzar 1002096 |$2,164.45 [l
This onIy assigns the rule to the cur- Golf Clubs | Rapide 425096 [$1,12205 Dietsil Dt ¥

rent query. _ oot auts Teeaorine. [orse sorosn

c. Click Save As... to save this style to ¥ ,520.05

. - Snowy Skilz | Alabarse 12M86 | §3,001.23

use in Other querles' Snowy Skiis | Mogul Maniza 1142786 | $2,115.30

Snow Skis |Rollo 11428196 | $3,699.31

$6,515.64

Even Rows
Save Az... |

QK | Apply Cancel Help

STEP 3:
Description Font |EOI0r I Bordersl Align I
Qutine: She: a. Define rules for Odd Rows, Even Rows, or Detail Data by
5 Bold ltalc 10 double-clicking the rule name, or rule the condition and
Bookshefoymbat2 ] e S (N E clicking the Edit button (located directly above the Rules
BENE ot | O list). This opens the Rule dialog box for the selected condi-
_ tion. Add new rules by clicking the Add Rule button. This
1 Sakeon Freve inserts an untitled entry in the rules list and opens the Rule
7 Underine dialog box, where you can select a condition and define the
—Testeolor———— AaBchXx)yZz I‘U|eS tO apply tO |t.
[ et -] b. Click the Font tab and change the attributes for your
styles, such as font types, size, and effects.
c. Click on the other tabs to add borders, colors, etc.
O e | 4. ciick OK.

As you define rules, the example QuickQuery in the Editor displays the cumulative effect of the defined
and selected rules on the appearance of your document.

You can apply the rules you have defined to your document at any time by selecting the Apply button.

STEP 4: Style Prafiles
. . | | Rules:
¢ Once you have completed your profile, click nK 4
tem Vendor Date Amount
save As"' Golf Clubs | Alcanzar 10/2095 | $2,164.45 ~
Golf Club| Ranida 47257 | $1 122, | | |Petel Detw =
. . . Golf Clubs | Follo 164196 | $3,659.00
Notice that this screen will show an example of bt Liah ToetOfF In 820 8573 27
your prOfile. Snow Skiis | Alabarse 12495 |$3,001.23
T N T T
55,515.54
Even Rows
Save Az

Ok I Apply Cancel Help
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¢ Profile

Save thiz profile as: K I a. Save this profile as: Give your profile a name.
|| b. Click OK.

Cancel |

Applying A New Style

When you create a new QuickQuery report, you can apply your new style for that report.

Click on Tools>QuickQuery Styles Editor from the menu bar.
Change the Profile to the style you want to use.

Click OK.

Create and process your report.

PN

alzlzl
EF e [ pew fowt guaey ook fncoe twp =l =]
DFH &Ra o g R
Wl ! . S W By 6B
[ Trms HewFmar o R
[ e
e iz | =0 Moo Fr ] =
11509.00 167EA1  STON  BLOG T4 FAIIG01TE40LE FTIIR
156600 16720 am BLDG 3 BTS00

2TRT00 JATRAS  STE!  BIPE M
T 5 =

25700 TTSIOOIIO S70] | UNASSTENED
T |mgood =M UNASTIGHED

SOOIOIRET 1FIONTDE
sl | seers

SERVER
| COMIUTER, LAFTOP

COMPUTER, LAFTOP
COMFUTER, LAFTOF

|LATIHE, THENE T
COFTER S¥6 XERON | FEIOLIZRTTEA SOOEXIZT

TRE LFA0OLELT-60FD (900000ZAI01S | SOMAFOLIE
TELEPHONE. STU ITT S18000N000027 S24Z3ER1

|BARCGER BEATER SEFHIFLM | BED00L00
MACHT AF-002
n COLOR__(TRO0D001S52 (1330040
0100 1583008 STer  BIbE § FENTIUM | TEFSS10000548 S46V4S
e T e I T

i

5. Save your report.
6. Close your report.
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What If Statements

This report writer uses the document, filter to solve WHAT IF statements. As long as the conditions in the
IF statement or statements do not contradict one another one report may be used. Otherwise, filters in
child reports must be used, and their outputs may be placed on multiple detail lines. (You can have more
than one detail line.)

You need to consider how to solve the following WHAT IF statements:

If Acquisition Cost is greater than or equal to $10,000 and Effective Date is greater than or equal to
19960101, and UIC starts with A (Army), then process the information.

A second statement:

If Acquisition Cost is greater than or equal to $10,000 and the Effective Date is greater than or equal to
19960101 and UIC starts with N (for Navy), than process information.

In addition, we want the Army information, and the Navy information to print out in separate groups. We
will use multiple filters to satisfy the WHAT IF statements.

Creating What If Statements:

e 1. Create a new FreeForm report.
A hECBBOSER KUK & #Y JEDe e 2. Add a Document Header area.
,I'NM:Q"‘W A 2 A 3. Add a report title to the Document Header
m area.

: 4. Add a Document Footer area.
o | [EXAMPLE DPAS REPORT | 5. Using the text object, add End of report
s to the Document Footer area.

i ',E - s — 6. Add the date and name of file to the Page
::,,. b |m— Header area.
= | m:,,:m 7. Add the page number to the Page Footer
Bosombiagn |17 = - darea.
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Adding from th i Dir

1. Select the following fields for your report and add to the Detail area of your report:

BUSINESS VIEW: END ITEM SERIAL

FOLDER(S) DATA ELEMENT(S)
Catalog Nomen
Serial Hand_Receipt Serial Nbr
Eff Dt
Acq Cost
Unit UIC

2. Right-click on the UIC data object (blue object) and select Hide Toggle.
3. Delete the UIC column heading (gray object) from the Page Header area.

Applying Multiple Filters:

1. Click on the Filter icon.
2. From the Objects tab, double-click on the Detail folder.
3. Double-click on AcqCost to move into the Object.
4. Set the Operator to >= (greater than or equal to).
5. Set Valuel to 10000.
6. Click Add.

7. Double-click on EffDate to move into the Object.

8. Set the Operator to >= (greater than or equal to).
9. Set Valuel to 19960101.

Sort Order /Filter: Untitled6

10. Click Add.

Filter ort Order
_Selifuu‘jy;t'aw 11. Double-click on the Hidden Detail Objects folder.
Dbt : _ _ o 12. Double-click on UIC to move into the Object.
ject: Operator: WValuel: ialues: Group R
| [Ge =l [ & 13. Set the Operator to Like.
0: AcqCost Greater Than or Equal To 10000 14. Set Valuel to W*l
g EID! Grealr Than o Equa To 19950101 15. Click Add.
UIC Is ke 16. Double-click on UIC to move into the Object.
_ : 17. Set the Operator to Like.
E_j'“;;f;! Qoo om0 | Modt _' 2k | 1| 18 Set valuel to N*,
B Noren L e 19. Change the OR'd Group to 1.
j E;glebrLHAS Custam Overide: _ :: Bace 3(1) g:|c:: cA;Ij(d
&| AcqCost AdHoc
_qﬂdde: Detail Objects @ @Al 22' S I '
. Save the report as What If.
dr I+

QK I Cancel | Help |
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1.

r ing Information

Click on the Custom icon.

Custom: CUSTOM (Untitled1.igr)

Custom | Bo[derl Faont I Olutput whenl Iranslatel Hot Qbiectl HTMLI

m Column:

. Type in Group for the Object Label.
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Structured Query Language (SQL)

SQL is the language the report writer uses to talk to the computer, to tell it to bring up the data that has
been asked for in the report. In older report writers the person writing the report had to write out the
SQL. In today’s report writers, the report writer constructs SQL. Each time a block of data is added to the
report, the report writer writes additional SQL. When you tell the report how to sort, and what to filter on,
it will add more SQL.

There are occasions with Eureka, that makes it necessary to actually go into the SQL language, which is
called syntax, and change it. There are two primary situations when the SQL will need to be edited. One
is when you wish to sort on a custom data field. The second is if a compound statement is entered into
the filter that includes AND, and OR.

Before examples are provided on how to modify the SQL for the two reasons mentioned above, it is
necessary to have some understanding of how to read the SQL.

There are command words in the SQL. The most often used commands are:

SELECT
FROM
WHERE

These must exist in every report. The most common optional commands are:

ORDER BY
GROUP BY

The SELECT command is constructed as you add data blocks to your report. If it is desired to construct a
report from the History file that will provide a list of all ADP equipment turned in for a specific time, such

as a year, and be broken down into months. First it would be necessary to select a data field that would

indicate that an item is ADP, this data field would be the ADP RPTB CD. Also, it would be necessary to pull
the transaction date of the action, this data field is called LHAZ DT.

When these two data fields are added to the report, the report writer would construct the following:

SELECT
TO."CTLG_ADP_RPTB_CD",
TO.”LHAZ_DT”

To explain, it must be understood that DPAS system is a collection of files or tables. They will be called
files for this discussion. Each file has a purpose: there is the catalog file which houses basic catalog
information, the end item serial file which houses the bulk of the equipment on your property book, the
serial asset. There is a component file, a hand receipt holder file, and a file for each specific job in the
system. In report writing, these files may or may not be joined together, or as it is called “linked” together.

Therefore in the SELECT statement the report writer indicates which file the data field is from. Each of the
files, such as end item serial, have a program name, it is like a short name for the file, for instance, the
catalog file program name is LHAA. The end item serial file is named LHAF. The SQL uses these short
names. It is not necessary to memorize these short names, but it will be helpful if you construct very
many reports. The SELECT statement also further abbreviates the program name of files by assigning it a
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“T" number. If a report selects from two or three files, the first file you select a data field from will be “T0”,
the second file you selected from, “T1" and so on. The data field itself has a naming convention that
indicates the home file for the data field. For instance, STK NBR, its home file is the catalog, it may also
appear in the serial asset file, but the first part of its data field name will always start with CTLG, which
indicates its home file is the catalog file.

So in the SELECT statement above, the first data field selected is home to the catalog file, the second from
the history file, however, both are being selected from the History business view and pulled from the
history file which is called LHAZ. Therefore both have T0 assigned to them. But notice the ADP RPTB CD
has CTLG at the first of it indicating its home file is the CTLG file, LHAA. Note there will be a comma after
each data field selected, except the last one.

So the SELECT statement is saying:

“Computer” go pull the ADP RPTB CD and the LHAZ DT. Go back and re-read the select
statement.

FROM Command

This command word tells the computer from which file in the DPAS system it will find the data field
desired.

From
“LHAZ" TO

The FROM statement indicates the data is to be pulled from the file LHAZ. Note the LHAZ isin™ ", then TO
follows outside of the quotes. This is a statement that TO is an abbreviation for LHAZ. It should be noted
that when reading and editing SQL, each comma, each period, each quote is critical, and must be in the
correct place. So now the report writer can tell the computer I want certain data fields, and where it gets
those data fields from.

WHERE Command

The WHERE clause or statement has a two fold purpose. In the business views of DPAS, there is a primary
file, such as End Item Serial. The primary file is the end item serial file, called LHAF. But in the End Item
Serial business view, there are “links” to other files. To link files together, which makes the computer look
at them like one large file, there is a linking statement in the WHERE clause. The linking statement is the
first of the two part WHERE clause. To link files together, there is a requirement - there must be at least
one data field that is common to both files. Such as STK NBR is found both in the Catalog file and the End
Item Serial file, so these two files could be linked together with the following linking statement in the
WHERE clause:

Where
TO0."CTLG_STK_NBR” = T1."CTLG_STK_NBR”

Do not forget the TO and the T1 are short names for the file names.
The second part of the WHERE clause is what has been placed in the filter, and will usually be enclosed in

parenthesis ( ). These must be upper case 9 and uppercase 0, not brackets. If it is just one simple
statement in the filter, it may not be in parenthesis.
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In the report being constructed, if it was desired to prompt for a beginning date (BEGDT) and an ending
date (ENDDT), the WHERE clause statement for the filter would look like this:

(TO.”LHAZ_DT between ‘BEGDT'and ‘ENDDT")
The entire WHERE clause would look like this:

Where T0.”"CTLG_STK_NBR"” = T1."CTLG_STK_NBR" ((the linking part of the statement))
And (T0.”"LHAZ_DT between ‘BEGDT’ and ‘ENDDT’) ((the filter part of the statement))

ORDER BY Command

This is the command used when a sort is desired. It is the last statement in the SQL. It would look like
this if it were to be sorted by date:

Order by
TO."LHAZ_DT"

The entire SQL for the report would be:

Select
TO.”"CTLG_ADP_RPTB_CD",
TO0.”LHAZ_DT”

From

“LHAZ" TO
Where

T0."CTLG_STK_NBR"” = T1.”"CTLG_STK_NBR"
And (T0."LHAZ_DT between ‘BEGDT’ and ‘ENDDT’)

Order by
TO."LHAZ_DT”

All of this is compressed more in the actual syntax.

To elaborate on one of the two occasions when it may be necessary to edit the SQL, sorting with a custom
data field. Suppose a report is desired from the History business view that list ADP equipment that has
been turned in for the past year, but broken down into months. All that is desired is a count of those items
for each month, then a total at the end of the report.

First, the ADP RPTB CD will be used to indicate which items are ADP, secondly the LHAZ DT will be used to
determine the date of the transaction, and last a data field called PGM DESC will be used to indicate the
action was a turn in. From experience it will be learned a turn in action will be a PGM DESC of EI DEC TI.
This means End Item Decrease Turn In.
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The problem is to sort, or group by month. It will be necessary to create a Group Header for Month.
DPAS does not have a data field of MONTH. It will be necessary to construct a Custom data field using the
Substring method learned earlier in the course (refer to page XX). The substring will use the LHAZ DT
data field, and start at position 5 of the data field for a total of 2 spaces. This custom data field will be
called MONTH. To create a MONTH group header, click on the data field, and click the group header icon.
This causes an automatic sort by MONTH in the Order by clause. The problem is this: the Order By
statement the SQL constructs will look like this:

Order by
SUBSTR (T0.”LHAZ_DT",5,2)

When the report is started, the above statement will generate an error message of “Invalid Command
End”. To correct this problem, you must edit the SQL. To do this, on the top of the screen, click QUERY,
then click SQL OVERRIDE, click the button labeled GENERATE SQL, go to the bottom of the SQL and place
the cursor to the right of the “y”, of Order by, delete out all of SUBSTR (LHAZ_DT,5,2), and replace it with
the number 1. The reason for this is the substring custom data field is the first item in the select list under
the SELECT command. If it had been the third item on the select list, a number 3 would have been
inserted. Now the report will run. Now it is important to remember to go to the top of the box and put a
check mark into the box labeled “Use SQL Override”, if you do not do this the change you made will not
work. Also, if the Generate SQL button is accidentally pressed after the changes to the SQL have been
made, it will re-write the SQL back to what it was before the modification. Incidentally, the SQL syntax is
not space sensitive, nor is it important that a statement be on the same line or below the command words.

The second of the two reason why it may be necessary to edit the SQL is compound AND, OR Statement in
the filter. This report writer has a flaw of re-arranging filter statements.

Suppose a report was desired to list computers that cost $1000 or more for HR # 0101 or HR # 0102.

The following was entered into the filter, don't forget the numbers on the left indicate whether an AND, or
an OR is between two statements.

0 Acq_Cost Greater Than or Equal To 1000

0 Nomen is Like **COMPUTER*’ (the single quotes will not be visible here)
0 HRHNbrMjr Equal To 0101

1 HRHNbrMjr Equal To 0102

This statement is saying all data must meet the criteria of costing $1000 or more, and having the word
COMPUTER in its nomenclature, and be on the hand receipt of HR 0101 OR HR 0102. It will look fine
when you click OK. Save the report, then go back and look at the filter, it will now look like this.

0 Acq_Cost Greater Than or Equal To 1000
0 HRHNbrMjr Equal To 0101

0 Nomen Is Like **COMPUTER*’

1 HRHNbr Mjr Equal To 0102.

This rearranging of the filter desired has totally changed the results of the report. The version that had
been put into the filter would have pulled any data that had the word COMPUTER in its Nomen and cost
$1000 or more, and from either HR 0101, or HR 0102. Now the report will pull up data that is from HR
0101 and cost $1000 or more and has the word COMPUTER in its Nomen, OR anything from HR 0102.

To correct this you must go into QUERY, SQL OVERRIDE, GENERATE SQL, then edit the SQL to look like
what was placed into the filter, making sure to place in all commas, single or double quotes and periods.
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	2. Enter an Object Label of your choice.
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	2. Double-click on Actual_Cost.
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	6. Distinct Values Only: Check this box when you want to eliminate any duplicate rows.
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	8. Click OK.

	Sorting Columns
	1. Highlight the Nomen field by clicking once in the heading area.
	2. Click on the (to sort in ascending order) or (to sort in descending order) from the toolbar.
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	3. Change the name of Acq Cost to Actual Cost or a comparable term.
	4. Delete the ARC.
	5. Group on the Nomen.
	6. Count on the Nomen.
	7. Build a Custom Column labeled Over/Short.
	8. Subtract the Qty On Hand from Auth Qty, which will equal the Over/Short column.
	9. Filter for HRH Nbr Mjr Like W*.
	10. Sum on the Acq Cost.
	11. Save the report in the Eureka folder on your Desktop as QQACTY.
	12. Close the report.

	Skill Builder: QuickQuery Without The Query Wizard
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	7. You display the shortcut attributes menu by doing a ____________________ ______________________ with your ____________________.
	8. Where is the keypad located that enables you to create numerical calculations?

	Practical Exercise: QuickQuery Without The Query Wizard
	1. Open a new QuickQuery report without the Wizard.
	2. Select the following fields for your QuickQuery report:
	3. Change the name of the Acq Cost column.
	4. Delete the Local Use column.
	5. Group on Nomen.
	6. Build a Custom column labeled Total Cost.
	7. Multiply Qty On Hand by Acq Cost.
	8. Change the Format to Windows Numeric.
	9. Filter on HRH Nbr Mjr Like W*.
	10. Sum for on the Custom column.
	11. Save the report to the Eureka folder on your Desktop as QQPE.
	12. Close your report.
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	1. Open a new QuickQuery report without the Wizard.
	2. Depress the F2 Function Key if your object directory is not open.
	3. Select the following fields for your QuickQuery report:
	4. Double-click on the Acq Cost column heading.
	5. Click on the drop down arrow for the Aggregate Function.
	6. Scroll and select Sum.
	7. Click OK.
	8. View report.
	9. Close the report.
	10. DO NOT save the report.

	Building A Quick Filter In QuickQuery
	1. Open a new QuickQuery report without the wizard.
	2. Depress the F2 Function Key if your object directory is not open.
	3. Select the following fields for your QuickQuery report:
	4. In the Fund Code Column, highlight one cell of Fund Code PA.
	5. Click on (Apply Filter Icon). This will apply a filter to the current section. This action will automatically filter your report to show only the assets with the fund code of PA.
	6. At the menu bar, select Query>Filter>Save As.
	7. The Filter Name Screen will come up. Enter Fund Code PA in the window.
	8. Click OK.
	9. Click on (Clear Filter Icon). This action will clear your document of the Quick Filter.
	10. At the menu bar select Query>Quick Filters…
	11. Highlight Fund Code 98.
	12. Click OK. Your document is now filtered again by the fund code of 98.
	13. Clear the filter by using the Clear Filter Icon.
	14. Repeat the process for Fund Code PA (start at Step 4 through Step 8).
	15. After filtering by PA, save your report as QQFILTER, we will be using it in the next exercise.

	Building Translate Values Using QuickQuery
	1. If closed, open QQFILTER report.
	2. Double-click on the Dollar Amt column heading.
	3. The Column Dollar Amt window will appear.
	4. Select the Translate tab.
	5. Double-click on the Detail folder in the Object Source.
	6. Double-click on Dollar Amt to move it to the Object field.
	7. Set the Operator to >= (greater than or equal to).
	8. Enter 100000 in Value1.
	9. Then Become: Enter “CAPITAL ASSET”.
	10. Click Add Case.
	11. Otherwise Become: Enter “NON-CAPITAL”.
	12. Click OK.
	13. Save your report.
	14. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Exporting Your Query
	1. If closed, open the report named QQFILTER.
	2. Select the Export icon .
	3. Select File from the menu bar.
	4. Select Export… from the program group.
	5. Change Save in to Desktop.
	6. Change Save as type to Excel File (*.xls).
	7. Click Export.
	8. Close your report.
	9. Double-click on QQFILTER.xls from your Desktop.

	Emailing Your Query
	1. Open the QQFILTER report.
	2. Select File from the menu bar.
	3. Select Send Mail… from the program group.

	Page Setup
	1. Select File from the menu bar.
	2. Select Page Setup… from the program group.
	a. Page Size: This option is not available in QuickQuery.
	b. Page Margins: Your page margins are defaulted to the current Windows settings, but you can change, if needed.
	c. Page Layout: Page layout controls how documents that are wider than your printer’s page size are printed (when they are not scaled to fit the page).
	d. Printing: This option is not available in QuickQuery.
	e. Center on Page: Select how you want your output displayed on you page.
	f. Orientation: This option is not available in QuickQuery.
	g. Grid: This option is not available in QuickQuery.
	h. Select the Header/Footer tab.
	a. Click the location where you want to insert the item (for example, if you want it centered on the first line of the header, select the header page and click in the first cell under Centered.
	b. Use the tools along the side of the screen to change the font, enter the application name, file name, add page numbers, and add the date to your report.
	c. Click the Footer tab.
	a. Delete the page number from Right Aligned.
	b. Click in the first cell of the Centered column.
	c. Enter Page and then add a space.
	d. Click on .
	e. Position your cursor after the $P.
	f. Enter Of and add a space.
	g. Click on . This will cause your page numbers to read: Page X of XX.
	h. Distance to Frame: To change the distance between the header or footer and the frame containing the QuickQuery, enter the distance you need in the Header and Footer boxes.
	i. Page Numbering: If you wish the page numbering to begin with a specific number other than 1, enter it in this box.
	j. Select the QuickQuery tab.
	a. Titles and Gridlines: Check or uncheck the desired title or gridline box to control the appearance of your query for printing.
	b. Save As Defaults: If you want to save your settings to use with future queries, click this button.
	c. Click OK.

	Introduction To FreeForm
	Getting Oriented With FreeForm
	a. Area Level: Change this when you use the same area multiple times. This will designate the process order. For example, you may have two detail areas.
	b. Area Description: This is the description of the area. This description does not print on the report.
	c. Print Options: This is used in conjunction with multiple area levels. This will tell when certain rows to print.
	d. Area Height: This sets the area height of your report.
	e. Reset Page Number to: This will reset the page number after each page break, area, or group. For example, if your report breaks for each Hand Receipt Holder Number, it would reset the page back to whatever page number you specify.
	f. Spacing: If you want to leave space before or after an area object, enter the amount of space you want.
	g. Page Skip: Use these controls to have Eureka skip to the top of the next page before or after this area is output. A value of 1 causes output to skip to the next page. A value of 2 causes a blank page to be output. A value of 3 causes 2 bl...
	h. Click OK.
	a. Select File from the menu bar.
	b. Select Page Setup from the program group.
	c. Page Size: Allows you to adjust the size of your page. Your page size is defaulted to the current Windows settings, but you can change if needed.
	d. Page Margins: Your page margins are defaulted to the current Windows settings, but you can change if needed.
	e. Page Layout: Allows you to use multiple columns.
	f. Center on Page: Select how you want your output displayed on your page.
	g. Orientation: This will allow you set how you want your page to print.
	h. Scale to Fit: Controls what happens when you print your document to paper with different dimensions than are specified for your document. When Scale to Fit is checked, Eureka scales the document to fit the page. It either enlarges or reduc...
	i. Scale: Allows you to select al exact scaling percentage.
	j. Use Grid: To assist in creating FreeForm documents with a neat appearance, you can specify that objects are to be placed on an alignment grid which appears only in the FreeForm window (and not in output).
	k. Cell Height: You can enter the vertical spacing for objects.
	l. Cell Width: Enter the horizontal spacing.
	m. Save As Defaults: To have your changes from the Page tab apply to future documents as well as to the current document, select Save As Defaults after making your changes. To have your changes apply only to future documents, select Cancel af...
	n. Click OK.

	Building A FreeForm With The Query Wizard
	1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group.
	a. Select Detail.
	b. Click Next>.
	a. Select the following fields from the table below:
	b. Click Next>.
	a. We are going to filter on a field that we are not dis playing in our report. To do this, click on the icon.
	b. Scroll up to the END ITEM SERIAL Business View.
	c. Open the Unit Folder.
	d. Select the UIC field.
	e. Make sure that the operator is set to equal (=).
	f. Filter on UIC W0U6AA. Remember to turn your CAPS LOCK on!
	g. Click Next>.
	a. Double-click on Nomen.
	b. The sort order defaults to Ascending, but if you want to change it, click on the A->Z but ton.
	c. Click Next>.
	a. Click on Entire Document.
	b. Sum on the Acq Cost.
	c. Click Finish.
	a. Delete the UIC column heading.
	b. Click the Print Preview button to process your report.
	a. Click on the to close your output window.
	b. Close your report without saving it.

	Designing A Customized FreeForm Report Without The Query Wizard
	1. While in DPAS, select the Ad Hoc Reports icon, or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group or from you computer desktop, double-click the Eureka Reporter Designer icon.
	3. If the Wizard displays, click Finish.
	4. Select Tools from the menu bar.
	5. Select Preferences… from the program group.
	6. Uncheck Use Query Wizard and Default To QuickQuery View.
	7. Click OK.
	8. Select File from the menu bar.
	a. Make any necessary changes.
	b. Click Save As Defaults.
	c. Click OK.
	d. If your Object Directory is not displayed, depress the F2 Function Key to display it.
	e. Select the data fields from the table below. Click, drag, and drop the field(s) to the Detail Area of your FreeForm report. Remember, if the tip of the arrow is not inside the Detail Area, a column header will not be produced.
	a. After you have selected your data objects, depress the F2 Function Key to remove the object directory because it covers part of your design document.
	b. Save your report as FFQUERY before pre viewing it.
	a. Close the output window by clicking on the icon.
	b. DO NOT close the report - we will continue to use it in the next Unit of Study.


	Page Header/Footer Areas
	1. Click in the area. The area will be surrounded in blue with black handles (small blocks).
	2. There is one handle that is solid in color. Click on that handle (it will change to a two-way arrow).
	3. Hold the click, and the drag down to make as large as you want. If you do this, you will need to move your objects to where you want them.

	Selecting Multiple Objects
	Adding Document File Name Objects
	1. Click on the Document Name icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Report Name from the program list.
	5. Place the object on the left side of the Page Footer area.
	6. Double-click on the report name object.
	7. Make any necessary changes.
	8. Click OK.
	9. Process your report.
	10. Save your report.

	Changing Column Headings
	1. Double-click on the Acq Cost field.
	2. Enter Actual Cost over the displayed value.
	3. Import File: Click this button to import text into the value field.
	4. Appearance: Select the appearance option(s) for your report. Refer to Adding Document File Name Objects for defini tions of the Appearance options.
	5. Click OK.
	6. Process your report.
	7. Save your report.

	Changing Fonts
	1. Click on the Actual Cost column heading.
	2. Using the Formatting Toolbar change the font, point size, color, alignment, and characteristics of your font.
	3. Process your report.
	4. Save your report.
	5. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Document Header/Footer Areas
	1. Click on the Document Header/Footer icon.
	2. Select Insert from the menu bar.
	3. Select Area from the program group.
	4. Select Document Header or Document Footer from the program list; this will allow you to insert either the document header or the document footer, depending on which area you selected.

	Adding Text Objects
	1. Click on the text icon.
	2. Select Insert from the menu bar.
	3. Select Text from the program group.
	4. Do not change the Object Label.
	5. In the Value window, enter the desired title for your report.
	6. Click OK.
	7. Place the text object in the center of the Page Header area of your report.
	a. Click the text object once. Notice the solid black box in the center of the bottom of the box.
	b. Place the tip of your mouse arrow on the black box until you get a two-way arrow.
	c. Hold down the left mouse button and pull down, enlarging the box until the lower lines are dis played. If Word Wrap was not selected, then doing this will only enlarge the font of your text.
	4. Save your report.
	5. DO NOT close the report -- we will continue to useit in the next Unit of Study.


	Adding Date Objects
	1. Click on the date icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Date from the program list.
	5. Place the date object on the left side of the Page Header area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Adding Time Objects
	1. Click on the time icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Time from the program list.
	5. Place the time object below the date object in the Page Header area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report -- we will continue to use it in the next Unit of Study.

	Adding Page Number Objects
	1. Click on the page number icon.
	2. Select Insert from the menu bar.
	3. Select System from the program group.
	4. Select Page Number from the program list.
	5. Place the page number object in the center of the Page Footer area.
	6. Process your report.
	7. Close the report viewer.
	8. Save your report.
	9. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Adding Counter Objects
	1. Since we are going to add the counter object in the first column, you will need to move all of your col umn headings and detail objects over to the right.
	2. Click on the counter icon.
	3. Select Insert from the menu bar.
	4. Select System from the program group.
	5. Select Count from the program list.
	6. Place the counter object to the left of your columns in the Detail area.
	7. Delete the Counter column heading.
	8. Process your report.
	9. Close the report viewer.
	10. Save your report.
	11. Close your report.
	Activity: Designing A Customized FreeForm Report Without The Query Wizard
	1. Create a new FreeForm report.
	2. Enlarge your Page Header.
	3. Using the counter icon insert counter in the Detail area.
	4. Delete the Counter column heading.
	5. Select the following fields for your FreeForm report:
	6. Insert the date and time in the Page Header area.
	7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in the Page Header area.
	8. Add a Document Footer area.
	9. Add “End of Report” in the Document Footer.
	10. Insert the document name, using the document name icon, in the Page Footer area.
	11. Using the page number icon, insert a page number in the page footer.
	12. Save your report as FFACTY for later use.
	13. Close your report.

	Skill Builder: Designing A Customized FreeForm Report Without The Query Wizard
	1. Name any two features that distinguish FreeForm from QuickQuery.
	2. FreeForm is a powerful tool set that allows you to: (Circle all that apply)
	a. Use multiple areas of the same type.
	b. Specify Output when conditions that determine, row by row, when objects (and areas) should or should not be included in your output.
	c. Add date and time to your reports
	d. All of the above
	e. None of the above
	3. The F4 Function Key opens the ________________ ______________ ______________.
	4. Folder Names are at the top level of the tree and are indicated in all caps? (True or False)
	5. Why is it important when dropping data objects inside the detail area to make sure the tip of the arrow is inside the detail area?
	6. Name the three areas your FreeForm window defaults to when it is opened.
	7. Eureka will not allow you to change the column headings of your data objects. (True or False)
	8. Match the Tool Bar Icons with the correct definition. Insert the alpha character on the blank line.
	1. Discuss the advantages of using FreeForm.
	2. Summarize the process of the report you completed in the previous activity.
	3. What types of reports are needed at your facility?


	Practical Exercise: Designing A Customized FreeForm Report Without The Query Wizard
	1. Create a new FreeForm report.
	2. Enlarge your Page Header area.
	3. Using the counter icon, insert the counter object in the detail area
	4. Delete the Counter column heading.
	5. Select the following fields for your FreeForm report:
	6. Insert the date and time in the Page Header area.
	7. Using the text box icon, give your document a title name and customize with fonts, etc., and place in the Page Header area.
	8. Add a Document Footer.
	9. Add “End of Report”. in the Document Footer.
	10. Insert the document name, using the document name icon, in the Page Footer area.
	11. Using the page number icon, insert page number in the page footer.
	12. Save the report as FFPE1 for later use.
	13. Print (if a printer is available) the report for the Instructor.
	14. Close your report.

	Building A Sort Order In A FreeForm Report
	1. Create a new FreeForm report.
	2. If your object directory is not open, depress the F2 Function Key.
	3. Select the following fields for your FreeForm report:
	4. Process report for viewing.
	5. Close the output window.
	6. Click .
	7. Highlight the HRH Nbr Mjr field.
	8. Click the arrow to move the field into the Ordered Objects window.
	9. Click OK.
	10. Process the report for viewing (go to the second page of the report; this is where the HRH Nbr Mjr starts).
	11. Try sorting on different fields and processing the report to see how your report will look.
	12. Close and DO NOT save the report.

	Group Header/Footer Areas
	1. Open the FFACTY report.
	2. From the Detail Area, click once on the field you want to group. We will be grouping on the UIC.
	3. Select Insert from the menu bar.
	4. Select Area from the program group.
	5. Select Group Header from the program list.
	6. Select the Group Header icon .
	7. Move the field(s) that you want in the Group Header from the Detail area. We will be grouping by UIC.
	8. Move the UIC column heading to the far left of the Group Header area.
	9. Move the UIC data object (blue object) next to the UIC column heading (gray object).
	10. Process the report and view.
	11. Close the report viewer.
	12. Save the report.
	13. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Building A Page Break In A FreeForm Report
	1. Each HRH Report or UIC report starting at the top of a new page.
	2. Each time a new UIC is reached, page numbering re-starting from one.
	1. If closed, open the FFACTY report.
	2. Double-click in the blank portion of the UIC Group Header area.
	3. In the Page Skip group, change Before Area from 0 to 1.
	4. Click OK.
	5. Save your report.
	6. Process your report to view the results.
	7. Close your report.

	Inserting A Filter In A FreeForm Report
	1. Open a new FreeForm report.
	2. In Page Setup, make sure that the Height is set to 8.5 and the Width is set to 11.
	3. Enlarge the Page Header area an additional 3 blocks.
	4. Select the following fields for your FreeForm report:
	5. Add a title for your report, date, and time for your report to the Page Header area.
	6. Add the document name and the page number to the Page Footer area.
	7. Add a Group Header for the MfrName.
	8. Move the MfrName column heading and data object into the Group Header area.
	9. Select the filter icon to display the filter dialog box.
	10. Double-click on the Detail folder.
	11. Double-click on UIC to move it to the Object Window.
	12. Select the drop down arrow and chose “like” for the operator.
	13. Enter W* for the value. Remember to turn your Caps Lock on.
	14. Click Add.
	15. Double-click on MfrName Group Header.
	16. Double-click on MfrName to move it to the Object Window.
	17. Select the drop down arrow and chose “like” for the operator.
	18. Enter *DELL* for the value. Remember to turn your Caps Lock on.
	19. Click Add.
	20. Click OK.
	21. Save your report as FFFILTER.
	22. Process and view your report.
	23. Close the output window.
	24. Select the filter icon to display the filter dialog box.
	25. Double-click on UIC, from the Detail folder, to move it to the Object Window.
	26. Select the drop down arrow and chose “like” for the operator.
	27. Enter W* for the value. Remember to turn your Caps Lock on.
	28. Change the OR’d Group from 0 to 1. This will set an OR condition.
	29. Click Add.
	30. Double-click on MfrName, from the MfrName Group Header, to move it to the Object Window.
	31. Select the drop down arrow and chose “like” for the operator.
	32. Enter *GATEWAY* for the value. Remember to turn your Caps Lock on.
	33. Click Add.
	34. Click OK.
	35. Save your report.
	36. Process and view report.
	37. Close your report.

	Hiding An Object In A FreeForm Report
	1. Select the Prompt object in your Page Footer area as the object to be hidden.
	2. Right-mouse click to display shortcut commands.
	3. Select Hide Toggle.
	4. You can see the hidden prompt by displaying your Area Object List by depressing the F4 Function Key.
	5. Click on Hidden Document and your prompt will display in the Hidden Document area of your design document.
	6. To hide it again, simply click on Hidden Page in the Area Object List.
	7. Save your report.
	8. Process your report.
	9. Close your report.

	Inserting A Prompt In A FreeForm Report
	1. Open a new FreeForm report.
	2. Enlarge the Page Header area.
	3. Select the following fields for your FreeForm report:
	4. Add a title, date, and time for your report to the Page Header area and customize with fonts, etc.
	5. Add the document name, using the document name icon, to the Page Footer area.
	6. Add the page number to the Page Footer area.
	7. Add a Document Footer area.
	8. Add “End of Report” in the Document Footer area.
	9. Save your report as FFPROMPT.
	10. Select the prompt icon from the tool bar.
	11. Object Label: Enter HRH Prompt in the Object Label. This is where you would enter the descriptive name for your prompt.
	12. Sequence Number: Accept the default of 1. If you have more than one prompt, you can designate the order in which it will run by changing the sequence number.
	13. Prompt: Enter “Enter HRH”. This is the prompt instruction.
	14. Type: Accept the default of String. If you selected a cost or date field, you can change the format of that field.
	15. Format: The field displays the characteristics of the data (string, numeric, or date). These come from the database file structure.
	16. Character Width: Select the amount of characters you want to display.
	17. Choice Value To Add: Leave this field blank. This field will allow you to enter the fields that the user will select. The choices will display in the window to the left.
	18. Use Choices Only: Do not select this radio button for this report. Use this field to only select choices from a choice list. You cannot type an entry for the prompt. The choice list will consist of the entries you add to the Choice List.
	19. Allow User Input: Accept this default radio button for this report. This radio button allows you to type an entry for the prompt or make a selection from a drop down box. If you have defined a choice list, you can choose from the choice l...
	20. Allow Multiple Choices: Do not check this box for this report. Check this box to select multiple items from the choice list. Each choice is added to the value of the user prompt object. Choices are separated by semi-colons (;) or commas (...
	21. Require Input: Do not check this box for this report.
	22. Appearance: Refer to Designing A Customized FreeForm Report Without The Query Wiz ard for definitions for the appearance options.
	23. Default Choice: Leave the Default Choice blank for this report. If you want a specific value to be defaulted in the prompt, enter the default choice.
	24. Click OK.
	25. Place the prompt in the Document Footer area.
	1. Select Filter icon.
	2. In the Objects window, double-click the Detail folder.
	3. Double-click on HRHNbrMjr to move it to Object.
	4. Set the Operator to = (equal).
	5. In the Objects window, double-click on the Document Footer folder.
	6. Double-click HRH_Prompt to move it to Value1.
	7. Click Add.
	8. Click OK.
	9. Save your report.
	10. Process your report.
	11. When prompted, enter W1NW54.
	12. Click OK.
	13. Close the output window.
	14. Save your report.
	15. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Designing A FreeForm Report Using Double Detail Areas
	1. Create a new FreeForm report.
	2. Save your as FFDOUBLEDETAIL.
	1. Insert a Document Header area.
	2. Insert a Document Footer area.
	3. Insert a Detail Area:
	a. Click on Insert from the menu bar.
	b. Click on Area from the program group.
	c. Click on Detail Area from the program list.
	4. Enlarge the Page Header area 2 more blocks (for a total of 5 blocks).
	5. Enlarge the first Detail area 3 more blocks (for a total of 4 blocks).
	6. Enlarge the second Detail area 2 more blocks (for a total of 5 blocks).
	7. Click on the text icon and type a title that will go in the Document Header area; remem ber, to use the font tab and enlarge and bold the text plus add any other preferences you may want.
	8. Repeat Step 7 for the Page Header area.
	9. Add “End of Report” in the Document Footer area.
	10. Insert the date in the Page Header area.
	11. Insert the page number in the Page Footer area.
	1. Make sure your Object Directory is displayed (F2 Function Key). Use the screen print on the first page of this handout for placement reference.
	2. Select the data fields listed below: You will be inserting these data fields in the 1st Detail area on the top line of that detail area, so the gray box is in the page header.
	3. Close the Quick_Start! folder.
	4. Open the Serial Hand Rcpt.-Auth folder.
	5. Select the data fields listed below: Insert Auth Qty in the 1st Detail area.
	6. Move Auth Qty object (blue object) down one row and bring the Auth Qty column header (gray object) down to the row above the detail object.
	7. Insert Qty On Hand in the 5th row of the 2nd Detail area, positioned in line with Auth Qty.
	8. Move the column header (gray object) to be above the detail object (blue object).
	9. Open the Quick_Start!folder.
	10. Select the data fields listed below: You will be inserting these data fields in the 2nd detail area, lining them up under the 1¹” margin.
	11. Bring the detail object (blue object) down to the 5th line.
	12. Bring the column header (gray object) and line it up above the 4th line.
	1. Insert a Prompt.
	2. In the Prompt Label, enter “HRH Prompt”.
	3. In the Prompt line, enter “Enter HRH Mjr Nbr”.
	4. Click OK.
	5. Insert the prompt in the Page Footer area.
	6. Click once on the prompt.
	7. Right-mouse click and select Hide Toggle.
	8. Insert a filter.
	9. In the Object area pull from the Detail(1) folder the HRH Nbr Mjr.
	10. Select = (equal) for the Operator.
	11. From the Hidden Page folder, select HRH Prompt for Value1.
	12. Click Add.
	13. Click OK.
	14. Save your report.
	15. Process your report.
	16. At the prompt, enter one of the following HRH numbers:
	17. Click OK.


	Using Translate Values In A FreeForm Report
	1. Open FFPROMPT.
	2. Scroll over to the right of your report to display the last field.
	3. Click on the Custom icon.
	4. Double-click on the Detail folder.
	5. Double-click on the AcqCost field to move to the Value window.
	6. Using the calculator on the right of the window, click on x (multiply).
	7. Click on 1.
	8. Change the Character Width to 15.
	9. Click OK.
	10. Place the custom object into the detail area.
	11. Change the Custom column heading to Capital/Non-Capital.
	12. Double-click on the CUSTOM field.
	13. Select the Translate tab.
	14. Double-click on the CUSTOM field in the Detail folder.
	15. Set the Operator to >= (greater than or equal to).
	16. Enter 100000 in Value1.
	17. Enter CAPITAL in then Become.
	18. Click Add Case.
	19. Change Otherwise Become to NON-CAPITAL.
	20. Click OK.
	21. Save you report.
	22. Process your report (using S701 in your HRH prompt).
	23. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Using Output When In A FreeForm Report
	1. If closed, open FFPROMPT.
	2. Double-click on the AcqCost data object (blue color).
	3. Select the Output When tab.
	4. Set the Operator to <= (less than or equal to).
	5. Enter 5000 for Value1.
	6. Insert Space When Not Output: Check this box to determine whether or not Eureka inserts a space in your output when the object for which you are setting the condition is not output.
	7. Click OK.
	8. Save your report.
	9. Process your report using S701 at the prompt.

	Skill Builder: Introduction To FreeForm And Designing A Custom ized FreeForm Report
	1. Filters are used to (Please choose one):
	a. Generate duplicate records.
	b. Control which rows of detail data for output.
	c. Include spaces in your report.
	2. Is it possible to build a Prompt without a Filter? (Yes or No)
	3. I am a prompt and I allow the user only to select choices, which prompt type am I?
	4. I am a prompt and I allow the user to select from a choice list, which prompt type am I?
	5. I am a prompt and I allow the user to select multiple choice items, which prompt type am I?
	6. Translate Value is similar to a CASE structure of "If - Then - Else" logic? (True or False)
	7. When you do not set any Output When condition, every object is output all the time? (True or False)
	8. The F2 Function Key provides information regarding hidden objects? (True or False)
	9. You must be in a FreeForm window to add or edit a user prompt object? (True or False)
	1. Discuss the Prompt process:

	a. Object label, what goes there. Why is it important to signify it is a prompt?
	b. Prompt label, what is entered here?
	2. Why do you insert prompts in a report?


	Practical Exercise: Introduction to FreeForm And Designing A Customized FreeForm Report
	1. Open a new FreeForm report.
	2. Expand the Page Header area an additional 4 blocks.
	3. Select the following fields for your FreeForm report:
	4. Add a title, date, time for your report and place the objects in the Page Header area (you can custom ize with fonts, etc.).
	5. Add a page number to the Page Footer area.
	6. Add a prompt for UIC and HRH Nbr Mjr and place in the Page Footer area.
	7. Click on the UIC Prompt object.
	8. Right-mouse click and select Hide Toggle to hide the prompt object.
	9. Repeat to hide the HRH Prompt object.
	10. Select the filter icon.
	11. If the Detail folder is not open, double-click on it to open it.
	12. Double-click on the UIC object.
	13. Set the operator to = (equal).
	14. Double-click on the Hidden Page folder to open.
	15. Double-click on the UIC_Prompt to place it in the Value.
	16. Click Add.
	17. Repeat steps 12 through 16 for the HRH_Prompt.
	18. Double-click on the Acq_Cost field.
	19. Set the operator or <= (less than or equal to).
	20. Set the value to 1 (for $1.00).
	21. Click Add.
	22. Click OK.
	23. Click on the Print Preview icon.
	24. Enter S710 for the HRH Nbr.
	25. Enter HQ1010 for the UIC.
	26. Click OK.
	27. Save your report as FFPE2.
	28. Close your report.

	Building A FreeForm Query Using The Parent/Child Function
	1. Child Document Objects. Each of these represents an entire document.
	2. Child Data Objects. Each of these represents a single object from a document.
	Child Document Objects

	1. Create a new FreeForm report.
	2. In the parent document, add the name of report and the date to the Page Header.
	3. Add the page number and the document name of the report to the Page Footer.
	4. Select the following fields for your Parent report from the table below. Make sure that you put them to the left side of your design document:
	5. Save the parent report as PC-Parent.
	Child Document

	1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.
	2. Select the following fields for your Child report from the table below. Make sure that the fields are placed approximately to the right of where the last field in parent was placed:
	3. Using the document name icon, insert the report name to the Page Footer.
	4. Save the report as PC-Child.
	5. Process the report.
	Child Prompts

	1. Click on the Prompt icon.
	2. For the Object Label, enter Serial Number Prompt.
	3. For the Prompt message, enter “Enter Serial Number”.
	4. Change the Character Width to 20.
	5. Click OK and place anywhere in the Page Footer.
	6. Right-click on the Prompt object.
	7. Select Hide Toggle. Hiding the Prompt is optional. If you want it displayed on the report, do not hide.
	Child Filters

	1. Click on the Filter icon.
	2. Click on the Columns tab, scroll to the HISTORIES Business View.
	3. Double-click on the History folder.
	4. Double-click on Serial Nbr to move it to the Object field.
	5. Set the Operator to = (equal).
	6. Click on the Objects tab.
	7. Double-click on Hidden Page Folder.
	8. Double-click on Serial_Number_Prompt to move it to Object 1.
	9. Click Add.
	10. Click on the Columns button.
	11. Scroll to the HISTORIES business view.
	12. Double-click on the History folder.
	13. Double-click on PgmDesc to move it to Object field.
	14. Set the Operator to = (equal).
	15. For Value 1, type in EI INC RCPT. Remember to turn your CAPS LOCK on.
	16. Click Add.
	17. Click OK.
	18. Save the report.
	19. Close the child report.
	Inserting the Child Document

	1. If closed, open the Parent document.
	2. From the menu bar, click Insert>Child Document.
	3. Click on the child document icon .
	4. Place the child document object in the Detail area, to the right of the other objects.
	5. Double-click on the Child Document icon in the detail area.
	6. Object Label: You can label your object if you wish.
	7. Click the drop down box under File Name and click the Child Document that you cre ated.
	8. Under Parent Objects, click the drop down box and select SerialNbr on Detail[Area]. This is telling you what data fields the Parent document is selecting. It is also the common field between the parent and child docu ments. If there are an...
	9. Select the radio button, Merge Child. This insures the data from the child document will use the same size and font style as the parent.
	10. Click OK.
	11. Save your report. The child document is now attached.
	12. Click on the Text Box icon and add a column heading for the Acquisition Date and place it in the Page Header area at around the same place as where you placed it in the child document.
	13. Repeat for the User ID.
	14. Save your report.
	15. Process your report.

	Activity: Designing A Parent/Child FreeForm Report
	1. Open a new FreeForm report.
	2. Save your report as PC-Acty-Parent in the folder designated by your instructor.
	3. Click to select the Page Header area. Widen the Page Header Area area to 3 blocks high.
	4. Add the Name of report (text) and the Date to the Page Header area.
	5. Add the document name to the Page Footer area.
	6. Select the following fields for your report from the table below. (Place to the left as far as possible).
	7. Save your report.
	1. Click on the Filter icon.
	2. Click on the Objects Tab.
	3. Double-click on the Detail Folder.
	4. Double-click on AcqCost to place it in the Object cell.
	5. Set the Operator to >= (greater than or equal to).
	6. Enter 100000 in Value1.
	7. Click Add.
	8. Click OK.
	9. Save your report.
	10. Remember where the last data field is on your report.
	1. Create a new FreeForm report.
	2. Save your report as PC-Acty-Child in the same folder as the PC-Acty-Parent document.
	3. Select the following fields from the table below. (Place these objects in the Detail area begin ning at the 6” mark on the ruler. Otherwise, when you attach the Child to the Parent, it will not show up.
	4. Right-click on the Stock Nbr data field (blue object).
	5. Select Hide Toggle. This will be used for our Prompt and Filter.
	6. Delete the column heading for Stock Nbr.
	7. Double-click on each data object (blue object).
	8. When the Attributes box comes up, check the Suppress Duplicates box.
	9. Save your query.
	1. Click on the Prompt icon.
	2. Enter StockNbrPrompt for the Object Label.
	3. Enter “Enter Stock Number” for the Prompt message.
	4. Change the Character Width to 15.
	5. Click OK.
	6. Place the prompt object anywhere in the Page Footer area.
	7. Right-click on the prompt.
	8. Select Hide Toggle to hide your prompt.
	9. Save your report.
	1. Click on the Filter icon.
	2. Click on the Columns tab.
	3. Scroll to the ACCOUNTING TRANSACTIONS business view.
	4. Double-click on the Accounting folder.
	5. Double-click on Stock Nbr to move it to Object.
	6. Set the Operator to = (equal).
	7. Click on the Objects tab.
	8. Double-click on Hidden Page.
	9. Double-click on StockNbrPrompt to move to Object.
	10. Click Add.
	1. Double-click on the Detail Folder.
	2. Double-click on DollarAmt to move it to Object.
	3. Set the Operator to >= (greater than or equal to).
	4. Enter 100000 in Value1.
	5. Click Add.
	6. Click OK.
	7. Save your report.
	8. Close your report.
	1. Open the Parent Capital document.
	2. Click Insert>Child Document from the menu Bar.
	3. Place the Child Document object in the Detail area, to the right of the other objects.
	4. Double-click on the Child Document icon.
	5. Click the drop down button under File Name and select the Child Document that you created.
	6. Click the drop down box for Parent Objects.
	7. Select StockNbr on Detail (Area). This is what the Parent will answer with when the Child asks the Prompt.
	8. Select the radio button Merge Child. This will maintain the font style and size between the Parent and Child.
	9. Click OK.
	10. Save and view the report. Do not click on the last page icon as this report is very long.
	11. Close the report.
	1. Open the parent report.
	2. Click on the text icon and add headers for the following:
	3. Process your report.
	4. To place columns where you want them to print out on the parent document, go to the child document and move the data fields to the left or right on the detail line. You may need to re- align the headers after processing the report.
	5. Save your report.
	6. Process your report to view.
	7. Close your report.

	Skill Builder: Building A Parent/Child FreeForm Report
	1. Child Documents are used almost exclusively for:
	2. Each document always pulls from different business views. (True or False)
	3. If you place the object in Document Header or Document Footer area, the child object will appear only_________at the _____________or _____________of the report.
	4. Insert the Child document object in the desired area. (Circle all that apply)
	a. If you place the object in the Page Header or Page Footer area, the child will appear once at the begin ning or end of each page.
	b. If you place the object in the Group Header or Group Footer areas, the child will appear once for each row that appears on your document.
	c. If you place the object in the Document Header or Document Footer area, the child object will appear on every page of the document.
	d. If you want the child to show only certain rows, place it in its own detail area, separate from the other columns in the parent document and set the Output When conditions for the area.
	5. It is recommended, but not mandatory, for Parent/Child reports that you change the orientation to ___________.
	6. How do you insert the Child Document in the Parent Document?
	7. To make sure the child document returns information for the same row that the parent is looking at, a _______________ is placed in the child document.
	8. When you select the radio button Merge Child, this insures the data from the child document will use the same size and font style as the parent. (True or False)


	Practical Exercise: Designing A Parent/Child FreeForm Report
	1. Create a new FreeForm report.
	2. Save your report as PC-PE-Parent in the folder designated by your instructor.
	3. Expand the Page Header area an additional 2 blocks.
	4. Using the document name icon, add the report name to the Page Footer area.
	5. Select the fields from the table below and place them to the left in the detail area.
	6. Expand the Detail area to 2 blocks.
	7. Save your report.
	8. Using the text icon, enter “Detail Report” (enhance the title using the font, border, etc. tabs).
	9. Double-click on each data object (blue object) and check the check box for “Suppress Dupli cates”.
	10. Highlight the HRH Name (blue object), go to the tool bar and click on group header icon.
	11. Move both HRH Name objects into the HRHName Group Header area.
	12. Expand the HRH Name Group Header area to 6 blocks.
	13. Move the HRHName data object (blue object) below the HRHName text object (gray object).
	14. Move all of your object boxes over to the right where the HRHName stops.
	15. Rubberband all the object boxes (gray objects) and move into the HRHName Group Header area.
	16. Rubberband all the data objects (blue objects) that are in the Detail area and move them up to the top of the Detail area.
	17. Double-click in the blank area of the HRHName Group Header area.
	18. In the Page Skip group box, set Before Area to 1.
	19. Click OK. This will create a page break.
	20. Add a Document Header area.
	21. Add a second Document Header area.
	22. Expand the new Document Header area to a total of 8 blocks.
	23. Save your report.
	1. Create a new FreeForm report.
	2. Save your report as PC-PE-Child in the same folder as PC-PE-Parent.
	3. Select the data elements from the table below:
	4. Widen the Detail area to 2 more blocks.
	5. Double-click on each data element (blue object) and check the check box for “Suppress Dupli cates”.
	6. Double-click on the blue Acq Cost.
	7. Click on the drop down box for the Aggregate function and select sum.
	8. Click OK.
	9. Save your report.
	10. Close your report.
	1. Open PC-PE-Parent.
	2. Click on Child Document icon.
	3. Insert the child document icon in the Document Header(1) area.
	4. Double-click on the Child Document icon.
	5. In the File Name, click the browse button and go to the directory where the child report is saved.
	6. Select the PC-PE-Child document to insert your Child Summary report.
	7. Click radio button for Merge Child.
	8. Click OK.
	9. Save your report.
	10. Process your report.

	Child Data Objects
	1. Create a new FreeForm report.
	2. If not the default, change the orientation to Landscape.
	3. In the parent document, add the name of report and the date to the Page Header.
	4. Add the page number and the document name you will assign to the report to the Page Footer area.
	5. Select the following fields for your Parent report from the table below. Make sure that you put them to the left side of your design document:
	6. To limit the information to the HRH Nbr Mjr of choice, we will filter on the HRH Nbr Mjr.
	7. Click on the Filter icon.
	8. Open the Detail folder.
	9. Double-click on HRH Nbr Mjr to move it to the Object field.
	10. Set the Operator to “Like”.
	11. Enter W* (cap locks on) in Value1.
	12. Click Add.
	13. Click OK.
	14. Save your report as PC-CDO-Parent.
	15. Process your report.
	1. Create a new FreeForm report. If the parent report has been set to landscape, the child report must be set to landscape also. Otherwise, when you attach the Child to the Parent, it will not show up.
	2. Select the following fields for your Child report from the table below. Make sure that the fields are placed approximately to the right of where the last field in parent was placed:
	3. Add the file name you will assign to the report to the Page Footer area.
	4. Save your report as PC-CDO-Child.
	5. Process your report.
	1. Click on the Prompt icon.
	2. For the Object Label, enter HRH Nbr Mjr Prompt
	3. For the Prompt message, enter “Enter HRH Nbr Mjr”.
	4. Change the Character width to 6.
	5. Click OK and place anywhere in the Page Footer area.
	6. Right-click on the Prompt icon and Hide Toggle.
	7. Click on the Prompt icon.
	8. For the Object Label, enter “Stock Nbr Prompt”.
	9. For the Prompt Message, enter “Enter Stock Nbr”.
	10. Change the Character Width to 15”.
	11. Click OK and place anywhere in Page Footer area.
	12. Right-click on the Prompt and Hide Toggle
	1. Click on the Filter icon.
	2. If not open, click on the Objects tab and open the Detail and Hidden Page folders.
	3. In the Detail folder, double-click on the HRH Nbr Mjr to move it to the Object field.
	4. Set the Operator to = (equal).
	5. In the Hidden Page Folder, double- click on HRH Nbr Mjr Prompt to move to Value1.
	6. Click Add.
	7. In the Detail folder, double-click on Stock Nbr to move it to the Object field.
	8. Set the Operator to = (equal).
	9. In the Hidden Page folder, double-click on Stock Nbr Prompt to move it to Value1.
	10. Click Add.
	11. Click OK.
	12. Save your report.
	13. Close the Child report.
	1. If closed, open the Parent document.
	2. From the menu bar, click Insert>Child Document OR Click on the child document icon .
	3. Place the child document object in the Detail area, to the right of the other objects.
	4. Double-click on the Child Document icon in the Detail area.
	5. Click the drop down box under File Name and click the Child document that you created.
	6. Under Parent Objects, click the drop down box and select HRH Nbr Mjr on Detail (Area). This is telling you what data fields the Parent document is selecting.
	7. In the Child’s User Prompts window, highlight Stock Nbr Prompt.
	8. Under Parent Objects, click the drop down box and select Stock Nbr on Detail (Area). This is tell ing you what data fields the Parent document is selecting.
	9. Mark the radio button, Merge Child. This insures the data from the child document will use the same size and font style as the parent.
	10. Click OK, it is now attached, save the report.
	1. On the parent report, highlight the child document icon, right click and select Hide Toggle.
	2. Select Insert>Child Data from the menu bar or click on the Child Data icon from the menu bar.
	3. The Child Object window appears. In the child document area, click on the drop down arrow and select the child report you designed. This will open up the Object In Query Area.
	4. In the Object Label, enter “Doc Nbr”.
	5. Change the Character Width to 14”.
	6. For the Object Query, click on the drop down arrow and select Doc Nbr on Detail (Area).
	7. Click OK.
	8. Your cursor becomes a precision pointer. Drop the pointer in the detail area next to the last data object.
	9. Click on the text icon (abc).
	10. Enter “Document Nbr”. In the Font tab, check the radio buttons for bold and underline.
	11. Place in the Page Header area above the Child Data Object.
	12. Save your report.
	13. Process your report.

	Hot Objects
	1. Open or create a FreeForm report.
	2. Expand the Page Header area 2 more blocks.
	3. Select the following fields for your FreeForm report:
	4. Using the text icon, add the title of the report and date to the Page Header area.
	5. Using the Document Name icon, add the document name to the Page Footer area.
	6. Add the page number to the Page Footer area.
	7. Process your report.
	8. Save the report as PC-HOTOBJ-Parent.
	Creating a Child for Hot Objects

	1. Open a new FreeForm report.
	2. Select the following fields for your FreeForm report:
	3. Drag Document Number to the Detail area.
	4. Using the text icon, add a title for your report and place in the Page Header area. Enhance your title using the font, border, etc. tabs.
	5. Add the date to the Page Header area.
	Creating a Prompt for a Hot Object Child

	1. Click on the prompt icon.
	2. Enter “SerialNbrPrompt” in the Object Label.
	3. Enter “Enter Serial Number” in the Prompt.
	4. Change the Character Width to 20.
	5. Click OK.
	6. Place the prompt object in the Page Footer area.
	7. Right-click on SerialNbrPrompt and click Hide Toggle.
	Adding a Filter to the Hot Object Child

	1. Click on the filter icon.
	2. From the Object directory, click on the Columns tab.
	3. Scroll to the HISTORIES business view.
	4. Select the History folder.
	5. Double-click on Serial Nbr to move it to the Object.
	6. Set the operator to = (equal).
	7. Click on the Objects tab.
	8. Double-click on the Hidden Page folder.
	9. Double-click on SerialNbrPrompt to move it to Object1.
	10. Click Add.
	11. Click OK.
	12. Save your report as PC- HOTOBJ -Child.
	13. Close the report.
	Creating the Hot Object

	1. Open the Parent report, if you previously closed it.
	2. Double-click on the Serial Nbr object in the Detail area.
	3. Click on the Hot Object tab.
	4. File Name: Click the drop down box and select the Hot Object child that was created.
	5. Parent Objects: Click the drop down box and select SerialNbr on Detail (Area).
	6. Click OK.
	7. Save your report.
	8. Process your report.
	9. Click on a BLUE serial number to obtain additional information about the item.

	Introduction To Enhanced Eureka
	Charts
	1. Create a new FreeForm report.
	2. Select the following fields for your FreeForm report:
	3. Save your report as CHART.
	4. Process your query.
	5. Close the report viewer.
	6. Select the chart icon from the tool bar.
	7. Place the chart object into the Page Footer area of your document.
	8. Click on the chart object and drag out to enlarge the icon to about half a page.
	9. Double-click on the chart icon.
	10. Select the Chart Types button.
	11. Select 3D Pie.
	12. Title: Enter $ By HRH Nbr Mjr.
	13. Click on the Objects button.
	14. Double-click on the Detail folder.
	15. Click, drag and drop the Acq Cost field to the Pie Slice Values. This field is grayed out, but you will still be allowed to drag the object into the field.
	16. Click, drag and drop the HRH Nbr Mjr to Pie Slice Labels. This field is grayed out, but you will still be allowed to drag the object into the field.
	17. In the Chart Attributes group, check Display Legend.
	18. In the Gradient group, accept the default of None.
	19. In the Summary group, select Sum.
	20. Do not change Appearance.
	21. Select the Filter tab.
	22. Click on the Objects tab.
	23. Double-click on the HRH Nbr Mjr to add to the Object.
	24. Set the Operator to Between.
	25. Set Value1 to W1DC03.
	26. Set Value2 to W1NW54.
	27. Click Add.
	28. Click OK.
	29. Save your report.
	30. Process your report.
	31. Close your report.

	Crosstabs
	1. Create a new FreeForm report.
	2. Select the crosstab icon from the tool bar.
	3. Insert the crosstab object into the detail area of your document.
	4. Double-click on the crosstab icon.
	5. Crosstab File Name: Enter FSC Inven tory. Eureka will automatically add the .iqr extension.
	6. Click on the Columns tab (if it isn’t already selected).
	7. Scroll to the END ITEM SERIAL Business View.
	8. Double-click on the Quick_Start! folder.
	9. Click, drag and drop the FSC field to the Columns window.
	10. Click, drag and drop the HRH Nbr Mjr field to the first Rows window.
	11. Click, drag and drop the Acq Cost to the second Rows window. The Aggregate radio button will default to Sum.
	12. Column Title: Enter FSC Inventory.
	13. Row Title: Enter HRH.
	14. De-select the Scale to Object in the Appearance area.
	15. Click on the Crosstab Styles button.
	16. Select the style with the red border.
	17. Click on the Filter tab.
	18. Click on the Objects button in the Object directory.
	19. Double-click on the Acq Cost field to move it to Object.
	20. Set the Operator to > (greater than).
	21. Set Value1 to 10000.
	22. Click Add.
	23. Double-click on the FSC field to move it to Object.
	24. Set the Operator to Between.
	25. Set Value1 to 3411.
	26. Set Value2 to 3930.
	27. Click Add.
	28. Click OK.
	29. If your default page setting is not already set to Landscape, change your page setup to Landscape.
	30. Save your report as CROSSTAB.
	31. Process your report.
	1. Open the crosstab dialog box.
	2. Click the Browse button next to the Crosstab File Name input box. Eureka opens a file selection dialog box.
	3. Select the file containing the crosstab you want to include. Eureka reads the file and displays its val ues in the dialog box.

	Graphics
	1. Open your FFACTY report.
	2. Select the graphic icon from the tool bar.
	3. Place the graphic object in the left-hand side margin of the Document Header area.
	4. Double-click the graphic object.
	5. Enter a label for your graphic object.
	6. Set the Height to 1.04.
	7. Set the Width to 1.04.
	8. Click on the Image/Border tab.
	9. If you want a border around your graphic, click on the list box and select the desired Line Weight. You can also set the point size, add shadowing and use customized settings.
	10. If you want a background for your graphic, select a pattern; otherwise, check the Transparent check box.
	11. If desired, change the border, shadow, fill, and/or pattern color(s).
	12. Click on the browse button next to File Name.
	13. Change Look In: to C:.
	14. Double-click on Eureka.
	15. Double-click on Reporter.
	16. Double-click on Designer.
	17. Double-click on the Sample folder.
	18. Double-click on the World.bmp file.
	19. Click OK.
	20. Click OK.
	21. Save your report.
	22. Process your report.
	23. DO NOT close the report - we will continue to use it in the next Unit of Study.

	Creating Icons For Your Desktop
	1. Open the FFACTY report.
	2. Select Tools from the menu bar.
	3. Select Auto Shortcut Builder… from the program group.
	4. Description: Eureka will default this field with your report title. Depending on which radio but ton you select (View, Print, or Export), it will be a part of your Description.
	5. Accept the default View.
	6. Export Format: If you selected Export, you will need to select the export format.
	7. Click on the Program Group list box and select Accessories (All Users). Your icon will be save to the Program Group that you specify.
	8. Click on the list box for Current Icon.
	9. Select your desired icon.
	10. Click OK.
	11. Save your report.
	12. Close your report and return to your desktop.
	13. Click on the Start button.
	14. Select Programs.
	15. Select Accessories.
	16. Select Eureka-Reporter Designer View_FFACTY.
	17. Close the output window.

	Creating Labels
	1. Click File>New From Template.
	2. Look in: Select C:.
	3. Double-click on the Eureka folder.
	4. Double-click on Reporter.
	5. Double-click on Designer.
	6. Double-click on Template.
	7. Double-click on the Avery folder.
	8. Change Files of type to Mailing Labels (*.iqm).
	9. Select A4_I7160.iqm.
	10. Double-click on COLUMN.
	11. Scroll to the END ITEM SERIAL business view.
	12. Scroll to the Serial_Hand_Receipt folder.
	13. Double-click on Bar Cd.
	14. Click OK. You are returned to the Design Document.
	15. Click OK.
	16. Using the table below, repeat the steps for the remaining label fields.
	17. Save your report as Label.
	18. Process your report.
	19. Close the report viewer.
	20. Close your report.

	Creating A Personal Data Mart
	1. Open a QuickQuery without the Wizard.
	2. Select the fields from the table below:
	3. Move the selected fields to the workspace.
	4. Save the query as YOURNAME-PDM (for example, JOHN-PDM).
	5. Select File from the menu bar.
	6. Select Export from the program group.
	7. In Save in, change to Desktop.
	8. Change Save as type to Personal Data Mart (*.iqd).
	9. Click Export.
	10. Close your report without saving.

	Using A Personal Data Mart
	1. Open a new QuickQuery report without the wizard.
	2. Select Tools from the menu bar.
	3. Select Database Connection Defaults… from the program group.
	4. Select (Personal Data Mart) from the Data Source list box.
	5. Click the browse button for the Personal Data Mart.
	6. Look in: Select Desktop.
	7. Click YOURNAME-PDM.iqd.
	8. Click Open.
	9. Click OK.
	10. If your Object Directory is not displayed, depress the F2 Function Key.
	11. Double-click on the YOURNAME-PDM.
	12. You can now select the fields you want to use in your query.
	13. Select from any or all of the fields from the PDM for your report. NOTICE how quickly the data is added, since it is coming from your hard drive, and does not have to negotiate the Internet or your Local Area Network (LAN).

	Toolbars, Status Bars And Operators
	Menu Items
	Changing Your Eureka Password
	1. Select Ad Hoc Reports icon or select Ad Hoc from the menu bar.
	2. Select Eureka from the program group.
	a. From the menu bar, select Tools.
	b. Select Database Connection Defaults...
	a. Data Source: Make sure that your DPAS Site ID is displayed.
	b. Login ID: Make sure that your DPAS User ID is displayed.
	c. Password: Enter your NEW DPAS password.
	d. Server Name: Leave this field blank.
	e. Database Name: Leave this field blank.
	f. Prompt For Data Source at Runtime: Do not check this box. If checked, you will be prompted to enter your DPAS Site ID each time you run a report.
	g. Default Metadata File: Browse for where the DPAS programs reside on you workstation. If all the defaults were taken during installa tion, then the path is normally: C:\Program Files\DOD\DPAS\DPAS.iqk.
	h. Server Name: Leave this field blank.
	i. Host Name: Leave this field blank.
	j. Click OK.

	Installation Of The Eureka Reporter Viewer
	1. If installed, remove the existing version of Eureka Reporter Designer via the Control Panel “Add/ Remove Programs” applet prior to installing the Eureka Reporter Viewer program.
	2. To install Eureka Reporter Viewer, click on the Start button.
	3. Select Run from the program group.
	a. Open: Enter the full path of where you downloaded the “dpaspr.exe” file.
	b. Click OK.
	a. Installation Folder: Accept the default of “c:\dpasinst”.
	b. Click Finish.
	a. Enter the key that was given to you in the Installation Instructions.
	b. Click OK.
	a. Uncheck the “Display the Release Notes” and “Launch EUREKA Reporter Viewer now” check boxes.
	b. Click Finish.

	Chart Types
	Style Profiles
	a. Double-click on the rule that you want to set your attributes to.
	b. Click Apply to assign your style. This only assigns the rule to the cur rent query.
	c. Click Save As... to save this style to use in other queries.
	a. Define rules for Odd Rows, Even Rows, or Detail Data by double-clicking the rule name, or rule the condition and clicking the Edit button (located directly above the Rules list). This opens the Rule dialog box for the selected condi tion. ...
	b. Click the Font tab and change the attributes for your styles, such as font types, size, and effects.
	c. Click on the other tabs to add borders, colors, etc.
	d. Click OK.
	a. Save this profile as: Give your profile a name.
	b. Click OK.
	1. Click on Tools>QuickQuery Styles Editor from the menu bar.
	2. Change the Profile to the style you want to use.
	3. Click OK.
	4. Create and process your report.
	5. Save your report.
	6. Close your report.


	What If Statements
	1. Create a new FreeForm report.
	2. Add a Document Header area.
	3. Add a report title to the Document Header area.
	4. Add a Document Footer area.
	5. Using the text object, add End of report to the Document Footer area.
	6. Add the date and name of file to the Page Header area.
	7. Add the page number to the Page Footer area.
	1. Select the following fields for your report and add to the Detail area of your report:
	2. Right-click on the UIC data object (blue object) and select Hide Toggle.
	3. Delete the UIC column heading (gray object) from the Page Header area.
	1. Click on the Filter icon.
	2. From the Objects tab, double-click on the Detail folder.
	3. Double-click on AcqCost to move into the Object.
	4. Set the Operator to >= (greater than or equal to).
	5. Set Value1 to 10000.
	6. Click Add.
	7. Double-click on EffDate to move into the Object.
	8. Set the Operator to >= (greater than or equal to).
	9. Set Value1 to 19960101.
	10. Click Add.
	11. Double-click on the Hidden Detail Objects folder.
	12. Double-click on UIC to move into the Object.
	13. Set the Operator to Like.
	14. Set Value1 to W*.
	15. Click Add.
	16. Double-click on UIC to move into the Object.
	17. Set the Operator to Like.
	18. Set Value1 to N*.
	19. Change the OR’d Group to 1.
	20. Click Add.
	21. Click OK.
	22. Save the report as What If.
	1. Click on the Custom icon.
	2. Type in Group for the Object Label.
	3. Click on the Function button and scroll to SUBSTR.
	4. Double-click on SUBSTR, to move into the Value area.
	5. Remove everything except the left parenthe sis.
	6. Click on the Objects tab.
	7. Double-click on UIC, to place it next to the left parenthesis (no space).
	8. After the UIC, type in “,1,1)” (without the quotes). It should read SUBSTR (UIC,1,1).
	9. Click OK.
	10. Place the object in the Page Footer area.
	11. Click once on the Custom field “Group” that we just created.
	12. Click the Group Header icon.
	13. Move the Custom Field “Group” into the Group Header area of the report.

	Structured Query Language (SQL)


